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Chapter

1
General Information

Safety Information

RF Energy Exposure and Product Safety Guide For Two-Way Radios
ATTENTION!

Before using this product, read the RF Energy Exposure and Safety Guide that ships with the radio which contains
important operating instructions for safe usage and RF energy awareness and control for Compliance with applicable
standards and regulations.

Copyrights

The Motorola products described in this document may include copyrighted Motorola computer programs. Laws in
the United States and other countries preserve for Motorola certain exclusive rights for copyrighted computer
programs. Accordingly, any copyrighted Motorola computer programs contained in the Motorola products described
in this document may not be copied or reproduced in any manner without the express written permission of Motorola.
© 2014 Motorola Solutions, Inc. All Rights Reserved.

No part of this document may be reproduced, transmitted, stored in a retrieval system, or translated into any language
or computer language, in any form or by any means, without the prior written permission of Motorola Solutions, Inc.

Furthermore, the purchase of Motorola products shall not be deemed to grant either directly or by implication,
estoppel or otherwise, any license under the copyrights, patents or patent applications of Motorola, except for the
normal nonexclusive, royalty-free license to use that arises by operation of law in the sale of a product.

Disclaimer
Please note that certain features, facilities, and capabilities described in this document may not be applicable to or
licensed for use on a particular system, or may be dependent upon the characteristics of a particular mobile subscriber
unit or configuration of certain parameters. Please refer to your Motorola contact for further information.

Trademarks
MOTOROLA, MOTO, MOTOROLA SOLUTIONS, and the Stylized M Logo are trademarks or registered
trademarks of Motorola Trademark Holdings, LLC and are used under license. All other trademarks are the property
of their respective owners.
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European Union (EU) Waste of Electrical and Electronic Equipment (WEEE)
directive

The European Union's WEEE directive requires that products sold into EU countries must have the crossed out
trashbin label on the product (or the package in some cases).

As defined by the WEEE directive, this cross-out trashbin label means that customers and end-users in EU countries
should not dispose of electronic and electrical equipment or accessories in household waste.

Customers or end-users in EU countries should contact their local equipment supplier representative or service centre
for information about the waste collection system in their country.

Open Source Software (OSS) Legal Notices
For details on OSS Legal Notices visit Motorola Online (emeaonline.motorolasolutions.com) or browse the CPS Plus
disc.

Icon Conventions

The following graphic icons, which help identify situations or settings crucial to proper radio operation and user
safety, are used throughout this document:

Danger: The signal word DANGER with the associated safety icon indicates information that, if
disregarded, will result in death or serious injury.

Warning: The signal word WARNING with the associated safety icon indicates information that, if
disregarded, could result in death or serious injury, or serious product damage.

Caution: The signal word CAUTION with the associated safety icon indicates information that, if
disregarded, may result in minor or moderate injury, or serious product damage.

Caution: The signal word CAUTION may be used without the safety icon to state potential damage or
injury that is not related to the product.

Important: IMPORTANT statements contain information that is crucial to the discussion at hand, but is
not CAUTION or WARNING. There is no warning level associated with the IMPORTANT statement.

Note: NOTE contains information more important than the surrounding text, such as exceptions or
preconditions. They also refer the reader elsewhere for additional information, remind the reader how to
complete an action (when it is not part of the current procedure, for instance), or tell the reader where
something is located on the screen. There is no warning level associated with a note.

Suggestion: SUGGESTION indicates a recommendation from Motorola that does not require to be
followed, but might be helpful. There is no warning level associated with SUGGESTION.

Using this Guide

The following special notations are used throughout the text to highlight certain information or items:
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Table 1: Special Notations

Example Description

MENU key or EMERGENCY button Capital letters indicate a name of a key or button.

Entering TMO tone Italic words indicate a name of the tone.

Powering Off Bold words indicate the soft menu items, MMI strings, or
messages displayed on the radio.

Setup → Tones → All Tones Bold words with the arrow between indicate navigation
structure in the menu items.

Feature and Service Availability

This guide describes all available radio features and services. Your service provider may have customized your radio
to optimize its use for your individual needs. Check with you service provider to find out the differences from this
guide.

General Information | 17
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Chapter

2
Getting Started

This chapter contains basic information on how to use the radio.

Product Technical Information

Table 2: Product Technical Information

Description Value

Maximum Voltage 4.2 V

Maximum Current 0.5 A

Maximum RF Power 1 or 1.8 W (switchable)

Maximum Speaker Load 0.5 W at 8 Ω

Antenna Impedance 50 Ω

Operating Temperature Range -25 °C to +60 °C

Operating Time Duty Cycle Class 4 (1 W) Class 3L (1.8 W, 380–
430 MHz only)

05/05/90

05/35/60

Talk Time

> 23 h

> 17 h

3.5 h

> 20.5 h

> 15.5 h

2.5 h

Note: The communication system determines the radio transmit and receive time (operating cycle time).
During overload, or beyond the systems specifications at high ambient temperatures, the thermal control
cuts down the RF power output, which reduces the radio coverage range.

Before Power On

Read this section before you power on your radio for the first time.

Attaching the Antenna
Procedure:

1 Insert the screw-in base of the antenna into the antenna terminal on the top of the radio.
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2 Turn clockwise until snug.

Installing the Battery
Procedure:

1 Remove the battery from its protective case.
2 Insert the battery top into the compartment as illustrated.

3 Carefully press the battery bottom downward until it clicks into place.

Note:

• Your service provider can configure the radio to turn on automatically after you insert the battery.
• Your radio always powers up, if you remove the battery for a period shorter than 3-5 seconds.

Related Links
Removing the Battery on page 21
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Removing the Battery
Prerequisites: Turn off the radio.

Procedure:

1 Push the latch.
2 Lift the battery out.

Related Links
Installing the Battery on page 20

Charging the Battery
Depending on a charger type, you can charge a battery alone or/and a battery attached to a radio.

Charging a battery attached to a radio can be done with the radio either turned on or off. Charging with the radio
turned off is recommended since this is more efficient (the battery charges faster).

Important: Motorola approved chargers provide optimum performance. Other chargers may not fully
charge your Motorola Lithium-Ion battery or may reduce the life of the battery.

Prerequisites:

Do not charge the battery in a hazardous area.

Procedure:

1 Connect the charger to an appropriate power source (100–240 V, 12 V), according to the specification of the
charger.

2 Perform one of the following actions:

• Desktop chargers – insert the battery or the radio with the battery attached into the appropriate socket of the
charger. Ensure that the battery/radio made good connection with the charger and that the LED on the charger
is indicating that charging is in progress

• Travel chargers and car chargers – connect the charger to the radio with the battery attached. Ensure that the
charger is firmly connected to the radio and that the radio display is indicating that charging is in progress.
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Note: If the radio cannot detect the charger and displays the Detecting Charger or Reconnect Radio
to the Charger messages, ensure that the charger is connected correctly and that the pins on the radio
and the charger are clean.

Post requisites: The battery may heat up during charging. After charging, make sure that the battery and the radio are
within the operating temperature range before using the radio.

Charging Indicators
When your radio is turned on while charging, it displays an icon of the battery in charging.

When your radio is turned off while charging, it displays the icon of the battery in charging and backlights the
display.

Table 3: Battery Icons

Battery Capacity Battery Charge Progress

Empty

5%–10%

Low

10%–20%

Middle

20%–90%

Full

90%–100%

Empty

5%–10%

Low

10%–20%

Middle

20%–90%

Full

90%–100%

Low Battery Indication
The radio indicates low battery level by playing an audible alert when the battery charge falls to a preset level. The
low battery alert can be programmed by your service provider to 5, 10, or 20 per cent of remaining capacity. The
default setting is 5 per cent. The service provider also configures how frequently the alert repeats.
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Controls and Indicators
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Table 4: Controls and Indicators

Annotation Description

1 EMERGENCY button
Table continued…
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Annotation Description

Press and hold EMERGENCY button to enter Emergency operation. When your radio is off,
press and hold to power on in Emergency Mode.

2 ROTARY KNOB

• Rotate to set the volume.
• Press and rotate to select a different talkgroup.
• Press and hold the ROTARY KNOB to lock/unlock it. Powering off also unlocks a locked

ROTARY KNOB.

3 EARPIECE

4 SIDE button

The ROTARY KNOB and SIDE buttons programming are paired. When the ROTARY KNOB is set
to Volume or Dual, the SIDE buttons support the One-Touch Button feature. By default, the
upper SIDE button is set to Backlight feature and the lower SIDE button is set to Screen Saver
feature.

Note: The required time to press and hold SIDE button to activate an One-Touch
Button feature is set as default to 0,1 second.

5 PTT (Push-To-Talk)

• Press and hold to talk in simplex calls or to initiate a group call, release it to listen.
• Press to send status and text messages.

6 SOFT key

Press left or right SOFT key, to select the option that appears on the screen directly above the
them.

7 SEND key

Press to initiate or answer duplex calls, or send messages.

8 SPEAKER

9 KEYPAD

Use the keypad to enter alphanumeric characters for dialing, contact entries, and text
messages.

Your radio supports the One-Touch Button feature that allows you to activate commonly
used features by pressing and holding assigned key (0-9, * and #).

Note: The required time to press and hold assigned key to activate an One-Touch
Button feature is set as default to 1 second.

10 SPEAKER CONTROL key

Press the SPEAKER CONTROL key to activate the earpiece Speaker LOW or speaker Speaker
HIGH.

Note: In an Emergency Group Call, the speaker is activated regardless of the
speaker setting.

11 ACCESSORY CONNECTOR

Table continued…
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Annotation Description

Provides connection for accessories and cable for data transfer.

Note: It is recommended to turn off the radio before connecting accessories.

12 ANTENNA

13 LED

14 TOP MICROPHONE

Activated during Simplex, high audio calls such as Group Calls.

15 EXTERNAL ANTENNA CONNECTOR

Used with the digital car kit to connect the RF signal to the external antenna.

16 DISPLAY

Provides alphanumeric text and images within 65,536 colors and 130 x 130 pixels with
backlight, scalable fonts, and contrast.

17 MENU key

• From the home screen, press to enter the main menu.
• Used to enter the context-sensitive menu.

18 ON/OFF/END/HOME key

• Press and hold to turn on/off your radio.
• Press to end calls.
• Press to return to the home screen.

19 AUDIO ACCESSORY CONNECTOR

Provides connection for audio accessories.

Note: It is recommended to turn off the radio before connecting accessories.

20 NAVIGATION key

Press up, down, left or right NAVIGATION key for list scrolling, while moving around the
menu hierarchy, or for alphanumeric text editing.

From the home screen, press to activate one of the following:

• down NAVIGATION key — enters Recent Calls menu item.
• up NAVIGATION key — changes My Groups talkgroup folder.
• left and right NAVIGATION key — toggles through the talkgroups.

21 BACKLIGHT SENSOR

Your radio keypad can be illuminated whenever the backlight is on. The keypad backlight
sensor determines whether there is a need to light up the keypad backlight, by measuring the
ambient light intensity. This feature can improve power saving. When the radio is in the
battery charger, the keypad backlight remains illuminated and the BACKLIGHT SENSOR is
ignored.

Table continued…
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Annotation Description

22 BOTTOM MICROPHONE

Note: A detailed list of compatible accessories is included in Accessory Leaflet, part number: 6866537D83.
To obtain the document, contact your service provider.

Display

This section presents the radio's default home screen elements.

Table 5: Display

Annotation Description

1 Status icon area

2 Text display area

3 SOFT key area

4 MENU/Context sensitive icon

The color of the SOFT key area changes according to the mode the radio is in.

Table 6: Colors of the SOFT Key Area

Color Mode or State

Light blue Normal TMO and DMO Modes

Light red Emergency Mode or Disaster Alert Call

Olive Local Site Trunking Mode

Yellow Call Out — Standby

Red Call Out — Alert

Green Call Out — Accepted

Blue Radio Messaging Service (RMS)

Grey Radio User Assignment (RUA) — Limited service
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Related Links
Display on page 87
Display on page 87
Setting Time and Date on the Display on page 89

Configurable Idle Screen
Your service provider can configure the information that is displayed on the home screen below the status icon area.
Depending on the radio configuration and services supported, the following information can be displayed:

• Network alias
• Range alias
• Talkgroup alias
• Time and date
• Home mode display
• RMS/FMS
• ISSI
• Radio status
• Audio profile name
• Radios supporting SIM Card End-to-End Encryption: OPTA, BSI registration status

Status Icons

Status icons appear when your radio is engaged in certain activities or when you have activated certain features.

The icons can appear in normal or large size. To manually enable/disable large status icons, go to Menu → Setup →
Display → Extended Status Icons.

Table 7: Status Icons

Icon Description

Trunked Mode Operation

In Service

No Service

Signal Strength – The more bars, the stronger the signal.

RF Power — Indicates the High RF Power is enabled. Shows the signal strength. The more
bars, the stronger the signal.

Migration — Displayed when your radio is registered to the foreign network.

Broadcast Call — Displayed when the radio is in the Broadcast Call.

Scan — Indicates talkgroup scanning is activated in the radio.

Priority Scan — Indicates that priority scanning is activated in the radio.

Table continued…
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Icon Description

Data Connected — Displayed when the data connection is idle (standby).

Data Transmit/Receive — Displayed when the data connection is active. Number 1, 2, 3, or
4 indicates how much bandwidth is used during transmission (25%, 50%, 75%, or 100%).

Direct Mode Operation

Direct Mode Call — Displayed when the radio is receiving a Direct Mode call. The more
bars, the stronger the signal.

 or
High RF Power: idle or transmitting — Displayed when the High RF Power option is
enabled and the radio is either in the idle mode or transmitting a call.

High RF Power: receiving — Displayed when the High RF Power option is enabled and the
radio is receiving a call.

Direct Mode — Displayed when the radio is in Direct Mode (radio-to-radio
communication).

DMO Gateway Communication Mode — Indicates that gateway is selected. The icon has
the following states:

• Solid — while the radio is synchronized with the gateway.
• Blinking — while the radio is not synchronized or during attachment.
• No icon — during a radio to radio and repeater call.

DMO Repeater Communication Mode — Displayed when the Repeater or GW + Rep
option in DMO Mode is selected. This icon has the following states:

• Solid — while the radio has detected the repeater (for example when the radio receives a
presence signal).

• Blinking — while the radio has not detected the repeater or during attachment.
• No icon — during a radio to radio and gateway call.

General Icons

All Tones Off and Duplex and Simplex Ring Muted — Indicates that all alert tones are off
and both duplex an simplex ring volume is set to 0.

• Volume is set to 0 (when Volume Adj. Mode is set to Common).
• Both simplex and duplex ring volume is set to 0 (when Volume Adj. Mode is set to

Individual).

Simplex Ring Muted — Indicates that simplex ring volume is set to 0 and duplex ring
volume is set to more than 0.

Duplex Ring Muted — Indicates that duplex ring volume is set to 0 and simplex ring volume
is set to more than 0.

Vibrate On — Indicates that the radio vibrates to alert you of an incoming call.

Vibrate then Ring — Indicates that the radio vibrates and rings to alert you of an incoming
call.

Low Audio — Indicates that the audio mode is changed to low.

Table continued…
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Icon Description

High Audio — Indicates that the audio mode is changed to high.

 /  /  /

 / 

Audio Profile Selected — Indicates that an audio profile associated with a particular icon is
active. The icons can be either solid or blinking. For details on audio profiles available on
the radio, contact your service provider.

Earpiece Connected — Indicates that the earpiece is connected.

GPS Icon

• Solid - the radio has a location fix
• Blinking - the radio is acquiring a location fix. This is an optional setting and may not be

enabled on your radio.

RUI Logged on — Indicates that you are logged on into the radio.

RUI Pseudo Log On — Indicates that you are in pseudo logged on state.

RUI Packet Data — Indicates Pseudo Log On state when the Packet Data feature is activated
and active data session is in progress.

RUI Packet Data — Indicates Pseudo Log On state when the Packet Data feature is activated
and the external device sets up data connection with the radio.

Battery Strength — Shows the charge of your battery.

Battery Charging — Indicates that the battery is charging.

Emergency — Appears while the radio is in Emergency Operation.

Disaster Alert Call — Appears while the radio is in the Disaster Alert Call.

List Scrolling — Displayed to indicate that the ROTARY KNOB is in list scrolling mode.

New Message Has Arrived — Indicates a new message just arrived.

New Message(s) in Inbox — Indicates that you have unread messages in your Inbox.

Unread (New) WAP Message — Indicates that new page was loaded to the browser.

Call-Out — Indicates Call-Out alert.

Call-Out Alert Arrived — Indicates a receipt of a new Call-Out message.

Call-Out Alert Unread — Indicates unread alert in the CO Box.

Table continued…

Getting Started | 29

 |   |  Send Feedback

http://docsurvey.motorolasolutions.com


Icon Description

End-to-End Encryption (E2EE)
Solid, when the E2EE is enabled

• for the selected talkgroup,
• for the highlighted private number,
• for the manually entered private number,
• when transmitting voice in Group Calls,
• when transmitting voice in Simplex Private Calls.

Blinking, when the End-to-End Encryption is enabled

• when receiving voice in Group Calls,
• when receiving voice in Simplex Private Calls,
• during encrypted Duplex Private Calls.

SDS End-to-End Encryption
Solid, when the E2E status of an SDS message, or the E2E status of a message recipient
address.
In High Security mode, when your radio processes only the encrypted information, this
icon is always visible in when you are in the messages menu (for example, Inbox).

Unread (New) WAP Message — Indicates that you have not entered WAP Box since last
WAP message was received (Blinks when the priority is high).

WAP Message Icon — Displayed next to the priority in the message list view.

WAP Message Time — Displayed next to the create date in the message list view.

WAP Message Expiration — Displayed next to the expiry date in the message list view.

WAP Message Title Icon — Displayed next to the title along with the text in the message
list view.

Keys Locked — Indicates that keys are locked.

Non Secured Call — Air Encryption Unavailable
Blinking, indicates that Air Encryption is not available when the radio:

• Is in the Local Site Trunking Mode.
• Attempts to connect to a gateway.

Not Secured Call — Air Encryption Unavailable
Alternately blinking, indicates that Air Encryption is not available when the radio:

• Is in TMO Mode.
• Communicates through a gateway.

Not Secured Call — Air Encryption Unavailable
Blinking, indicates that Air Encryption is not available in DMO Mode. The icon appears
after the PTT button is pressed.

Table continued…
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Icon Description

Remote Control
Indicates that the radio is being remotely controlled and some commands are being
executed in the background. For example, when the radio is controlled via special SDS
messages or triggered to send a GPS location report.
The icon is not visible in the Extra Zoom Mode.

Related Links
Air Encryption on page 78

Powering On the Radio

Procedure:

1 Press and hold ON button.
2 Your radio performs a self-check and registration routine.
3 After successful registration, your radio is in service.

Note: Your radio powers on without visible and audible notification if Covert Mode is activated.

Unlocking Your Radio

Your radio may be locked at power up. To unlock it after powering on, enter the code at the prompt. Your radio enters
the default home display.

Note: The unlock code is originally set to 0000. Your service provider may change this number before you
receive your radio.

Related Links
PIN Protect on page 76
Changing PIN Codes on page 77
Writing Text on page 38

Unblocking Your Radio
Prerequisites: You blocked your radio by entering incorrect PIN code for three times (by default).

Procedure:

1 Radio displays Unit BlockedEnter PUK.
2 Enter 8–digit PUK (Personal Unblocking Key) number.

Note: The PUK is an eight-digit master code provided by your service provider.

3 Enter the new PIN code twice.
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Locking/Unlocking the Keys/Buttons

Press MENU key and * key.

Note: The EMERGENCY button is not locked. Entering Emergency Mode unlocks all keys.

Related Links
Keylock Setup on page 77

Holding Your Radio

The radio has two microphones: a top microphone for simplex dispatcher/private calls and a bottom microphone for
duplex telephone-like calls.

Also, the radio is equipped with an internal speaker for high audio (located at the middle of the unit) and an internal
earpiece for low audio (located at the top of the unit).The audio can be routed either to the speaker or the earpiece
using the Audio Toggle menu (MENU → Setup → Audio → Audio Toggle) or the assigned One-Touch Button.

Note: When possible, it is recommended to speak into the top microphone.

Simplex Calls
When using high audio, hold the radio a vertical position with its top microphone 5 centimeters to 10 centimeters
away from your mouth. Speak into the top microphone. Listen through the internal speaker. Keep the antenna at least
2.5 centimeters from your head and body.

Duplex Calls
When using low audio, hold your radio as you would a telephone. Speak into the bottom microphone. Listen via the
earpiece. Keep the antenna at least 2.5 centimeters from your head and body.

Lapel/Shoulder Use
For Group and Private Calls turn your head towards your shoulder/lapel, and speak directly into the top microphone.
Listen through the internal speaker.

Speakerphone Use
Place your radio 30 centimeters to 60 centimeters away from you. In a noisy environment, you move the radio closer
to you for better transmission.
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Setting Flip Display

When and where to use:

The feature is useful for a user who has to wear the radio on a shoulder, belt, or lapel and at the same time wishes to
read the display upside down.

Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Display → Flip Display.
3 Select one of the following:

• On – to activate this feature.
• Off – to deactivate this feature.

Entering TMO / DMO Mode

Procedure:

1 From the home screen, press Optns.
2 Select Trunked Mode / Direct Mode.

Related Links
Selecting Network Operation Mode on page 101
Networks on page 101

Transmit Inhibit Mode

The Transmit Inhibit Mode is a mode in which the radio sends no radio transmissions. It is recommended to activate
the mode in RF sensitive areas, for example hospitals, airplanes, where safety can be jeopardized due to transmission
radiation.

To activate, select MENU → More . . . → Networks → TXI Mode → Activate.

In this mode, the radio does not transmit under any circumstances except for the Emergency Calls. All the functions
and keys which cause transmission, for example registration to the network, changing talkgroup or folder, sending
SDS messages, or pressing the PTT button are disabled. Any transmission trial causes the radio to display Not
Allowed In TXI Mode notification and to play a tone.

Your radio can still receive:

• Group calls.
• Messages — stored in the Inbox.
• Private call attempts — stored in the Missed Calls list, without the option to respond.

When no danger to safety exists anymore (for example, you leave the RF sensitive area), you can deactivate the
Transmit Inhibit Mode and the radio returns to standard operation.

You can deactivate the mode by selecting MENU → More . . . → Networks → TXI Mode → Deactivate, pressing
One-Touch button, or implicitly when initiating an Emergency Call.
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Note: RF Transmissions from the radio are prevented under the following conditions:

• TXI Mode is activated.
• Battery is removed.
• The radio is turned off.

On entering or exiting the transmit inhibit mode, when the radio is camped on a cell, it sends a specially designated
SDS status message. This SDS message indicates to the SwMI that the radio is entering or exiting transmit inhibit
mode.

Mobility procedures that do not require the radio to send an uplink transmission are performed except for cell
reselection.

In transmit inhibit mode the radio joins group calls for any group that the radio is monitoring, but the transmitting on
that call is still prohibited.

The radio also displays any incoming SDS messages to the user. The missed call feature is active in the transmit
inhibit mode and allows checking what calls were missed. However, the radio attempts to prevent call setup
retransmission from being recorded as separate calls.

If you initiate an emergency call, the radio immediately leaves transmit inhibit mode and attempts to start the
emergency call if the radio is in service.

If the radio is turned off in the transmit inhibit mode, on turning on the radio asks whether to exit the transmit inhibit
mode. If you choose No, the radio turns off.

Selecting Talkgroups

From the home screen, use one of the following methods:

• Press left or right NAVIGATION key. Press Select to confirm.
• Select Optns → TG by abc. Enter a talkgroup name and select the talkgroup name from the list.
• Select Optns → TG by Folder. Select a folder and then a talkgroup name.
• Press ROTARY KNOB and rotate it until the required talkgroup name is displayed. Press Select to confirm.

Note: If the ROTARY KNOB mode is set to Scroll, then you do not need to press it to enter the scrolling
mode.

Note: Your radio can have an access up to three levels of the folder structure.

Talkgroup Icon Selection

Table 8: Talkgroup Icon

Icon Description

Displayed when the talkgroup is from a different network than the one currently selected.
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Using Timed Talkgroup Change

This feature allows you to switch a selected talkgroup between the currently selected talkgroup and a predefined
talkgroup (TMO or DMO), making the predefined talkgroup the selected talk group for a predefined time by using a
One-Touch button. After the timer expires, your radio returns to the previously selected talkgroup.

Prerequisites: Timed Talkgroup Change is assigned to a One-Touch button.

Procedure:

1 Press and hold and hold the One-Touch button.
2 Your radio switches the selected talkgroup to the predefined talkgroup for a predefined amount of time.

During the predefined time the radio initiates or joins group communication (SDS, status SDS, or call) on the
predefined talkgroup as the selected talkgroup.

Your service provider can assign a function to the second press of the One-Touch button to:

• Return to previously selected talkgroup
• Restart the predefined time
• No action

3 When the timer expires (potentially after being restarted a number of times) the radio switches to the previously
selected talkgroup.

Activating Talkgroup Scanning

When and where to use: If you want to monitor any TMO Group Call in the defined talkgroup list.

Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Group Setup → Scan → Scanning.
3 Select Select List and then a list name.

Your radio displays list name Selected.
4 Select Scanning → On.

Your radio is scanning on the predefined scan list.
Related Links

Scan on page 94

Broadcast Call

The Broadcast Group Call (also called Site Wide Call) is a high-priority group call from the console operator (or
dispatcher) to all users located at one or more sites. The radios are configured to monitor a Broadcast Call, but you
cannot talk back. The call can be received as a normal Broadcast Call or an Emergency Broadcast Call. The Broadcast
Call preempts an ongoing Group Call that has the same or lower call priority.
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Ambience Listening (AL) Call

This feature allows a dispatcher to make a special call that allows listening to the conversations and background
noises within the range of a particular radio’s microphone. The call is set up without any indication to the affected
radio, and any lower priority ongoing voice call may be preempted.

After accepting the call, the radio transmits in a simplex call without any action from or indication to the user. The
Ambience Listening Call automatically ends when you initiate any voice call, switch to Emergency or TXI Mode, or
send Emergency Alarm.

One-Touch Button Feature

The One-Touch Button feature allows for quick activation of functions by pressing and holding keys or buttons
assigned to those functions.

Table 9: One-Touch Button Features

Feature Description

Backlight Toggle Toggles the backlight settings.

Change Audio Profile Change to the specific audio profile.

Change Talkgroup Changes the talkgroup to the programmed one by your service
provider.

Covert Mode Turns on/off the Covert Mode.

Display Time Displays universal time on the home screen.

Double Push PTT Sends the D- PTT tone to the currently used talkgroup.

Enable/Disable Howling Suppression Turns on/off Howling Suppression.

Extra Zoom On/Off Turns on/off Extra Zoom.

Flip Display Rotates the display by 180 degrees.

GPS Report Sends a message with the radio’s GPS location to a dedicated
address.

Hi/Low Audio Toggles high/low audio.

Initiate Call-Out Fallback Alert Sends Call-Out Fallback Alert.

PABX Call Initiates a PABX call to a predefined entry in the contact list.

Phone Call Initiates a phone call to a predefined entry in the contact list.

Previous Talkgroup Changes the selected talkgroup of the radio to the talkgroup (DMO or
TMO) that was selected previously.

Private Call Initiates a private call (simplex or duplex) to a predefined entry in the
contact list or to the last group call originator.

Rotary Switches Lock/Unlock Locks/unlocks the Rotary Switches.

RUA/RUI Log On/Off Asks for the credential or logs off the radio.
Table continued…
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Feature Description

Screen Saver Activation Turns on/off the Screen Saver feature.

Scroll Audio Profiles Scrolls through all available audio profiles.

Sending Predefined Message Sends a predefined message to a dedicated address.

Sending Status Sends a dedicated status message to a dedicated address.

Sending User Defined Message Sends a user defined message to a dedicated address.

Speaker Enable/Disable Per Call Enables the loudspeaker for a duration of the ongoing call..

Timed Talkgroup Change Makes a predefined talkgroup the selected talk group for a specified
amount of time. While using the predefined talkgroup, the second
press of the One-Touch Button results in: returning to the previously
selected talkgroup, restarting the predefined time, or no action
(depending on configuration). After the timer expires, the radio
returns to the previously selected talkgroup.

TMO / DMO Switch Toggles between TMO and DMO modes.

TMO Talkgroup Scan Turns on/off the Talkgroup Scan feature in TMO Mode.

Toggle RF Power Class Toggles the RF Power Class between High and Normal.

Transmit Inhibit Mode (TXI) Turns on/off the Transmit Inhibit Mode.

Turn On/Off Repeater Mode Turns on/off the Repeater Mode.

Volume Down • Press to decrease the volume by one level.
• Press and hold to continuously decrease the volume to its

minimum level.

Volume Up • Press to increase the volume by one level.
• Press and hold to continuously increase the volume to its

maximum level.

Your service provider can assign one-touch functions only to the side buttons and keypad keys.

Note: If the One-Touch Button feature is enabled, the One-Touch Dial is disabled. If no feature is assigned
to a button, your radio displays an Unassigned Button message.

Terminal Temporary Disable/Enable

Your radio is provided with a feature that allows your service provider to disable it temporarily in case it is stolen.
When your radio is disabled or is powered up in disabled state, it looks and acts like it is turned off.

If your radio is found, your service provider can enable it again over the air. After your radio is enabled, you may
resume normal operation.

Terminal Permanent Disable

Your radio is provided with a feature that allows your service provider to disable it permanently in case it is stolen or
lost. When your radio is disabled permanently, it becomes inoperable. After a Permanent Disable your service
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provider cannot enable your radio. It is recommended to Permanent Disable your radio only when you do not expect
to recover it. If it is recovered then a Permanent Disable radio can be reactivated by returning it to Motorola.

Note: This is a selling feature.

High/Low Audio Toggle

The user is able to switch from the external earpiece to the main speaker using SPEAKER CONTROL key and is not
required to disconnect the external earpiece or PHF.

The states of the routed audio are:

• Speaker HIGH — indicates that audio is routed to the main speaker.
• Speaker LOW — indicates that audio is routed to the earpiece or PHF earpiece, and not to the main speaker.

Using High Audio
When and where to use: Use it when placing and receiving a Group, Phone and Private calls.

Procedure:

1 Hold your radio in a vertical position with its top microphone 5–10 centimeters away from your mouth.
2 Speak into the top microphone and listen through the internal speaker.

Keep the antenna at least 2,5 centimeters from your head and body.

Using Low Audio
When and where to use: Use it when placing and receiving a Phone, PABX, and Duplex Private calls.

Procedure:

1 Hold your radio as you would a telephone.
2 Speak into the bottom microphone and listen through the earpiece.

Keep the antenna at least 2,5 centimeters from your head and body.

During the Call

During the call, label of the right SOFT key indicates the next possible change. Accessory default setup is:

Table 10: During the Call

Soft Key Label Audio Setting

Spkr Audio goes to the main speaker (Speaker HIGH is displayed)

Erpce Audio goes to the earpiece (Speaker LOW is displayed)

PHF Audio goes to the Personal Hands Free (Speaker LOW is displayed)

Writing Text

Every time that you see text entry screen, refer to this section.
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Related Links
Unlocking Your Radio on page 31

Selecting Text Entry Modes
Prerequisites: Your radio displays the text entry screen.

Procedure:

1 Press MENU → Entry Mode.
2 Select one of the following:

• Primary — for entering alphanumeric characters.
• Numeric — for entering numbers only.
• Symbol — for entering symbols only.
• Secondary — for entering alphanumeric characters (this mode is optional and you have to add it to the list). It

is convenient when you use one language, and sometimes wish to switch to another one.

Note: In the text entry screen, you can also press # key repeatedly to toggle through the entry modes.

Selecting Text Entry Methods and Languages
Prerequisites: Your radio displays the text entry screen.

Procedure:

1 Press MENU → Entry Setup.
2 Select one of the following:

• TAP — Enter letters, numbers, and symbols by pressing an alphanumeric key one or more times.
• iTAP — Let the radio predict each word as you press an alphanumeric key.

Note: You can use these methods in the languages programmed in the radio.

Text Entry Icons
In the text entry screen, icons tell you which text entry mode and method you are using. A character counter displayed
on the text entry icon, indicates the amount of characters that can be entered.

Press the # key to toggle through the text entry modes.

Table 11: Text Entry Screen Icons

Primary Icon Secondary Icons Description

TAP — no capitals

TAP — capitalise first letter only

TAP — all capitals

iTAP — no capitals

iTap — capitalise first letter only

Table continued…
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Primary Icon Secondary Icons Description

iTap — all capitals

Numeric Icon Description

Enter numbers.

Symbolic Icon Description

Enter punctuation and symbols.

Keys Usage
List of keys and characters in Alphanumeric Mode (TAP/iTAP).

Table 12: Keys Usage

Key Alphanumeric Mode (TAP/iTAP) Symbol Mode

0 to 9 keys Numeric Mode:

• Press to enter digit at insertion point.
• Press and hold any numeric key to enter TAP

alphanumeric mode.
• To exit TAP alphanumeric mode, press and hold

any numeric key.

0 key Press to cycle through single shift, caps lock, and
lower case.

+ - × * / \ [ ] = < > § #

1 key . , ? ! 0 1 @ ’ ” - ( ) / : _ ; + & % × * = < > € £ $ ¥ ¤ [ ] { } \ ~ ^ ¿ ¡ § #

2 key A B C 2

a b c 2

@ _ \

3 key D E F 3

d e f 3

/ , ;

4 key G H I 4

g h i 4

” & ’

5 key J K L 5

j k l 5

( ) [ ] { }

6 key M N O 6

m n o 6

¿ ¡ ~

7 key P Q R S 7

p q r s 7

= < >

Table continued…
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Key Alphanumeric Mode (TAP/iTAP) Symbol Mode

8 key T U V 8

t u v 8

€ £ $ ¥ ¤

9 key W X Y Z 9

w x y z 9

# % *

Table 13: Other Keys

Key Description

Any numeric key • In TAP press any key to reject word completion and continue with text entry A new
completion will be displayed, if available, after the time-out for TAP expires.

• Press and hold to enter Numeric mode from TAP or iTAP alphanumeric.

* key • Press to insert a space.
• In TAP press to dismiss a word completion and insert a space.
• Enter a newly created word into the user dictionary.
• Press and hold to enter a carriage return.

# key • Press once to cycle through all entry modes (Symbol, Numeric, Primary, and
Secondary (if configured).

• Press and hold to return to the default entry mode.

Select Press to select the highlighted choice and place it in the main text area.

Delete • Press once to delete the last entered character.
• Press and hold to clear the entire main text area.

Up NAVIGATION key • In TAP press to reject word completion and scroll up.
• In TAP press to change previously entered small letter to capital.

Down NAVIGATION key • In TAP press to reject word completion and scroll within the text area.
• In TAP press to change previously entered capital letter to small.

Left NAVIGATION key • Press to navigate to the left. Press and hold to repeat.
• In TAP, if a word completion is available, press to reject the completion.

Right NAVIGATION key • Press to navigate to the right. Press and hold to repeat.
• In TAP if a word completion is available, press to accept the word.

MENU If a context-sensitive menu is active, opens the Context Sensitive Menu.

Writing in iTAP Alphanumeric
Prerequisites: Your radio displays the text entry screen.

When and where to use: It allows you to write quicker. For example, try to write David 232!

Procedure:

1 Press MENU → Entry Setup → Prim..
2 Select iTAPEnglish and press Back.
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3 Press MENU → Entry Mode.
4 Select Primary.
5 Press 3 key.

The alternative row opens and shows D E F 3.
6 Continue entering the letters by pressing one key for each letter. Press 2, 8, 4, and 3 keys.

Note: Automatic shift to upper case is used at the beginning of a message, after punctuation followed
by space, or for the first letter of a word created as a new contact entry.

The alternative row highlights David.
7 Press * key.
8 Press 2 key and scroll the alternative row by pressing right NAVIGATION key to reach 2.

It automatically changes the entry mode to Numeric.
9 Press 3 and 2 keys.
10 Press and hold 1 key until 0 at the end changes to ..

The alternative row highlights 232..
11 Scroll the alternative row by pressing the right NAVIGATION key to reach the required symbol.
12 Press Select.

You have entered David 232!.

Writing in TAP Alphanumeric
Prerequisites: Your radio displays the text entry screen.

Procedure:

1 Press MENU → Entry Setup → Seco..
2 Select TAPEnglish and press Back.
3 Press MENU → Entry Mode.
4 Select Secondary.
5 Press the key labeled with the desired character, once for the first character, twice for the second, and so on.

Example:
To enter letter s, press 7 key four times. To enter number 7, press the 7 key five times. If you do not
press a key for a few seconds, the character is accepted, and the cursor moves to the next position.

Word Locking
Prerequisites: Your radio displays the text entry screen.

When and where to use: To add the words that are not in the dictionary.

Procedure:

1 Press MENU → Entry Setup.
2 Select iTAPEnglish.
3 Try to enter the word. Scroll the alternate line for a word option. Each option is successively highlighted and

partially locked.
4 Enter the second part of the word. The first part remains unchanged (locked). The newly entered letters are

highlighted and then locked while you scroll to the next word option.
5 Press * key. The word is placed in the text area with a space and automatically added to the dictionary.
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Adding Words to the Dictionary
Each language comes with its own dictionary. You can create words (including alphanumeric abbreviations). Once
you enter a word followed by space, it is automatically stored in the dictionary and appears as a choice whenever you
press the same key combination in the future.

Home Display Text Message

Your radio is provided with a feature that allows your service provider to send special text messages to the display.
The message stays on the home screen until a new message is received. Power cycle your radio to replace the Home
Display message to the predefined one.
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Chapter

3
Modes

This chapter contains information on available modes that the radio can operate in.

Using Networks

Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Networks.
3 Select one of the following:

• Trunked Mode
• Direct Mode
• TXI Mode

Your radio switches to the selected mode.

Trunked Mode Operation

Trunked Mode Operation requires the switching and management infrastructure. This operation mode enables various
voice and data communication types (for example, group calls, short data service messages) and access to the
infrastructure-related features (for example, packet data).

Figure 1: Trunked Mode Operation
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Entering TMO Mode
Procedure:

1 From the home screen, press Optns.
2 Select Trunked Mode.

Selecting Talkgroups
From the home screen, use one of the following methods:

• Press left or right NAVIGATION key. Press Select to confirm.
• Select Optns → TG by abc. Enter a talkgroup name and select the talkgroup name from the list.
• Select Optns → TG by Folder. Select a folder and then a talkgroup name.
• Press ROTARY KNOB and rotate it until the required talkgroup name is displayed. Press Select to confirm.

Note: If the ROTARY KNOB mode is set to Scroll, then you do not need to press it to enter the scrolling
mode.

Note: Your radio can have an access up to three levels of the folder structure.

Making Group Calls in TMO
The Group Call is received by all members of the selected group who have their units turned on and are in range.

Procedure:

1 Press and hold the PTT button.
2 Wait for the Talk Permit tone (if configured) and then speak into the microphone. Release the PTT button to

listen.

Note: To cancel making a group call, do one the following actions before the talk permit is granted
(depending on your service provider’s settings):

• Release the PTT button.
• Press the END key (default).

When the call is canceled, your radio displays Call Cancelled message (if configured by your service
provider).

Receiving Group Calls in Idle
Procedure:

1 The radio receives a Group Call.

Note: The incoming Group Call is signalled by a Receiving Group Call tone.

2 To respond, press and hold the PTT button.

Receiving Group Calls during Ongoing Group Calls
While in active Group Call, your radio receives a Group Call with a higher priority.

One of the following occurs:

• Your radio is forced to end the current group call and automatically join the incoming one.
• Your radio displays incoming group call screen with options:

• Join — ends current Group Call and starts the incoming one.
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• End — cancels the incoming Group Call.

Dynamic Group Number Assignment (DGNA)
DGNA allows the network operator to dynamically manage talkgroups on your radio over the air interface. Using
DGNA, the network operator can:

• Add talkgroups.
• Attach or select newly added talkgroups.
• Delete talkgroups.
• Modify parameters of existing talkgroups.

All the above operations are performed by transmitting data to your radio.

DGNA Reception
When a DGNA message is received, your radio plays a tone and displays a message Talkgroup list updated. If
enabled by your service provider, your radio displays all added and deleted talkgroup list.

When your service provider deletes (de-assigns) the currently selected talkgroup, depending on the settings, the radio
can perform one of the following actions:

• Enter the “No Group” state – the radio does not attach to any talkgroup automatically.
• Attach to the last selected TMO talkgroup. If the last selected TMO talkgroup is not available (it was deleted), the

radio enters the “No Group” state.
• Attach to a default talkgroup configured by your service provider. If the default talkgroup is not available (it was

deleted), the radio enters the “No Group” state.

At each talkgroup change, an appropriate notification is shown on the display.

If the DGNA message is received to delete all talkgroups, your radio displays All Talkgroups Deleted. To exit the
DGNA display, you can use the BackSOFT key or the END key.

DGNA Auto Select Group
If the DGNA Auto Select is configured, whenever your radio receives a DGNA, it switches to the added talkgroup.

DGNA Auto Reselect Group
If the DGNA Auto Reselect is configured, whenever a talkgroup assigned by the network operator via DGNA is
deassigned without the user action, the radio returns to the previously selected group.

Viewing DGNA Talkgroups
Prerequisites: Your radio receives the DGNA message.

Procedure:

1 To view the added talkgroups details press View.
2 Scroll through the list to select required talkgroup.
3 To select the DGNA group, press Attach.

Broadcast Calls Initiated by Users
This feature allows you to make a Broadcast Call from the radio that is initiated on the predefined talkgroup. Your
service provider predefines the alias and the priority of the Broadcast Call.

Note: If the type of the encryption is defined by the SIM Card, the Broadcast Call is always clear.
Otherwise if the radio uses other encryption service the type of the encryption used for that Call is up to the
encryption settings of that service.
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Note: This feature is not supported on the Dimetra infrastructure.

Initializing Broadcast Calls
Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Services → Broadcast.

Your radio displays the predefined alias and the Broadcast Call icon.
3 To start the call press the PTT button.

Phone and PABX Calls
The Phone Call allows you to call a landline telephone number or a cellular mobile phone number. The Private
Automatic Branch Exchange (PABX) Call allows you to call local (office) extension numbers.

Private Call
The Private Call, also called point-to-point, or individual call, enables calling between two individuals. No other radio
can hear the conversation. This call type can be carried out in two ways:

• Duplex call (if the system allows), in TMO Mode. Both parties can speak at the same time.
• Simplex call, in TMO or DMO Mode. Only one party can speak at a time.

When a DMO Private Call takes place, radios not involved in this call receive the channel busy indication. The radios
are identified using its radio numbers.

Related Links
Emergency Individual Calls (Private or MS-ISDN) on page 56

Making Private Calls
Procedure:

1 From the home screen, enter a number.
2 If Private is not the first type of call presented, press Ctype repeatedly to select it.
3 When you are in the following mode:

a TMO — For simplex calls, press and release the PTT button. You hear a ringing tone. Otherwise, press and
hold the PTT button. Wait for the talk permit tone before talking, and release the PTT button to listen. For
duplex calls, press and release the SEND key. You hear a ringing tone.

b DMO — Only simplex calls are available. Press and hold the PTT button. Wait for the talk permit tone before
talking, and release the PTT button to listen.

4 To end the call, press the END key.

Assistance Call
This feature allows you make a private call to ask for assistance during normal and non-critical situations.

Note: Your service provider can configure the number, priority, and the type of the call (simplex or
duplex).

You can start an Assistance Call in one of the following way:

• Dial a predefined number and press SEND key.
• Menu → More . . . → Services → Assistance Call
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Call Modification
Call Modification is a feature that allows your service provider to modify the call in order to optimize it and adjust to
a current situation.

Modification can cover:

• Call priority — modified during call setup.
• Call type — modified during call setup.
• Call encryption — modified during an ongoing call (but not in the transmission phase).

When the call is modified, your radio displays Call Modified message.

When a recently modified call requires the PTT button to transmit, your radio displays Call ModifiedUse PTT.

All modifications are made by your service provider and the radio only follows them. You have no influence on
ongoing call modifications.

When call priority is changed to emergency:

• The display indicates that an Emergency Group Call has been received.
• The radio plays a special audio alert.

Note: If a Group Call is modified into an Emergency Group Call, no emergency related features are
triggered.

If call modification requested by your service provider cannot be followed by the radio (due to its settings), the radio
rejects it and displays Service Not Available message.

Local Site Trunking

This mode is also called as Fallback Mode and it allows more than one radio from the same site to communicate when
the link between the site and the network central controller fails. Entering and exiting Local Site Trunking (that is,
returning to System Wide Services) is done automatically. In this mode some services are unavailable.

Note: Your service provider can disable this mode.

Entering Local Site Trunking
When your radio receives a Local Site Trunking indication from the system, the following occurs:

• Your radio plays an Entering Local Site Trunking tone.
• Display shows the Local Area Service message.
• Display icons and soft keys turn olive.

Note: Noticeable only on the color display.

• Any call in progress is dropped upon entering Local Site Trunking Mode.

If configured by your service provider, this message/alert is periodically repeated to remind you that your radio is still
operating in Local Site Trunking Mode. The following features are available:

• Registration
• Attachment
• Group Call
• Emergency Call
• Emergency Alarm
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Note: Your service provider can turn on/off all the visual and audio indications, when you enter Local Site
Trunking Mode.

Exiting Local Site Trunking
When the link with the central network controller is reestablished, your radio exits Local Site Trunking, and the
following occurs:

• Your radio plays an Exiting Local Site Trunking tone.
• Any call in progress during Local Site Trunking is dropped.
• Display icons and soft keys turn blue.

Note: Your service provider can turn on/off all the visual and audio indications, when you exit Local Site
Trunking Mode.

Direct Mode Operation

Direct Mode Operation is a mode of simplex operation where radios communicate directly.

Figure 2: Direct Mode Operation

Entering DMO Mode
To enter the DMO Mode:

• From the home screen, press the MENU key. Select More . . . → Networks → Direct Mode.
• From the home screen, select Optns → Direct Mode.

Selecting Talkgroups
From the home screen, use one of the following methods:

• Press left or right NAVIGATION key. Press Select to confirm.
• Select Optns → TG by abc. Enter a talkgroup name and select the talkgroup name from the list.
• Select Optns → TG by Folder. Select a folder and then a talkgroup name.
• Press ROTARY KNOB and rotate it until the required talkgroup name is displayed. Press Select to confirm.
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Note: If the ROTARY KNOB mode is set to Scroll, then you do not need to press it to enter the scrolling
mode.

Note: Your radio can have an access up to three levels of the folder structure.

Making Group Calls in DMO
The Group Call is received by all members of the selected group who have their units turned on and are in range.

Procedure:

1 Press and hold the PTT button.
2 Wait for the Talk Permit tone (if configured) and then speak into the microphone. Release the PTT button to

listen.

Receiving Group Calls in Idle
Procedure:

1 The radio receives a Group Call.

Note: The incoming Group Call is signalled by a Receiving Group Call tone.

2 To respond, press and hold the PTT button.

Private Call
The Private Call, also called point-to-point, or individual call, enables calling between two individuals. No other radio
can hear the conversation. This call type can be carried out in two ways:

• Duplex call (if the system allows), in TMO Mode. Both parties can speak at the same time.
• Simplex call, in TMO or DMO Mode. Only one party can speak at a time.

When a DMO Private Call takes place, radios not involved in this call receive the channel busy indication. The radios
are identified using its radio numbers.

Related Links
Emergency Individual Calls (Private or MS-ISDN) on page 56

Making Private Calls
Procedure:

1 From the home screen, enter a number.
2 If Private is not the first type of call presented, press Ctype repeatedly to select it.
3 When you are in the following mode:

a TMO — For simplex calls, press and release the PTT button. You hear a ringing tone. Otherwise, press and
hold the PTT button. Wait for the talk permit tone before talking, and release the PTT button to listen. For
duplex calls, press and release the SEND key. You hear a ringing tone.

b DMO — Only simplex calls are available. Press and hold the PTT button. Wait for the talk permit tone before
talking, and release the PTT button to listen.

4 To end the call, press the END key.
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Private Call With Presence Check
This feature allows you to see if the calling party is available in DMO. When this feature is enabled, you can only
initiate a Private Call if the called radio is present on the same channel and responds with a presence check
acknowledgement.

Otherwise your radio displays Party Not Available.

Talkgroup for Individual Calls
Talkgroup for Individual Calls is a talkgroup that operates on a separate frequency allocated for individual (private)
calls only. Using this talkgroup optimizes frequency resources and helps not to block other talkgroups. The only
supported call types are: private calls and emergency calls (both private and group). Use this talkgroup each time you
need to make a private call.

When you select a Talkgroup for Individual Calls, your radio is not able to receive or initiate any group or broadcast
calls with priority lower than Emergency.

When you have selected a Talkgroup for Individual Calls and press the PTT button to start a Group Call, the radio:

• Rejects the call
• Plays a tone
• Displays the Individual Calls Only message

Communication through Repeaters
Radios that are out of range and cannot communicate directly one with another in DMO Mode can do it through the
repeater. The repeater is a radio that repeats all communication on a chosen channel, and as a result increases radios’
DMO range.

DMODMO

When the radio connects to a repeater, it plays a tone, displays the Repeater available message, and shows an
appropriate icon. When the radio looses connection with the repeater, it plays a tone, displays the Repeater not
available message, and the repeater icon is blinking.

Communication through Gateways
Gateway provides connectivity between radios operating in DMO Mode and the TETRA network, so that the DMO
radios can communicate with the TMO radios.
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DMO

TMO

TMO

When the radio connects to a gateway, it plays a tone, displays the Gateway available message and shows an
appropriate icon. When the radio looses connection with the gateway, it plays a tone, displays the Gateway not
available message, and the gateway icon is blinking.

Selecting DMO Group Call Options
When and where to use: Helps to communicate with other radio users on the same talkgroup through the Gateway or
Repeater.

Procedure:

1 From the home screen, press Optns.
2 Press Config.
3 Select one of the following:

• MS - MS — Your radio can communicate only with other radios within its range.
• Gateway — Your radio uses a gateway to communicate with the infrastructure.

• Automatic — Your radio uses the first available gateway for that talkgroup.
• Specific — Your radio uses only the Gateway with the specified Gateway address for that talkgroup. If

your radio displays Selected Gateway:None, press Edit to enter the current gateway address.
• Repeater — Uses the first available repeater for that talkgroup.
• GW + Rep — Uses the first available gateway or repeater for that talkgroup.

• Automatic — Uses the first available gateway for that talkgroup.
• Specific — Uses only the Gateway with the specified Gateway address for that talkgroup. If your radio

displays Selected Gateway:None, press Edit to enter the current Gateway address.

Note: When the Gateway and the Repeater cannot be communicated even though a talkgroup to use
them is configured, the radio attempts the direct MS-MS communication.

When your radio detects the appropriate Gateway and/or the Repeater, the Gateway and/or Repeater icons turns solid,
respectively.

Transmit Inhibit Mode

The Transmit Inhibit Mode is a mode in which the radio sends no radio transmissions. It is recommended to activate
the mode in RF sensitive areas, for example hospitals, airplanes, where safety can be jeopardized due to transmission
radiation.
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To activate, select MENU → More . . . → Networks → TXI Mode → Activate.

In this mode, the radio does not transmit under any circumstances except for the Emergency Calls. All the functions
and keys which cause transmission, for example registration to the network, changing talkgroup or folder, sending
SDS messages, or pressing the PTT button are disabled. Any transmission trial causes the radio to display Not
Allowed In TXI Mode notification and to play a tone.

Your radio can still receive:

• Group calls.
• Messages — stored in the Inbox.
• Private call attempts — stored in the Missed Calls list, without the option to respond.

When no danger to safety exists anymore (for example, you leave the RF sensitive area), you can deactivate the
Transmit Inhibit Mode and the radio returns to standard operation.

You can deactivate the mode by selecting MENU → More . . . → Networks → TXI Mode → Deactivate, pressing
One-Touch button, or implicitly when initiating an Emergency Call.

Note: RF Transmissions from the radio are prevented under the following conditions:

• TXI Mode is activated.
• Battery is removed.
• The radio is turned off.

On entering or exiting the transmit inhibit mode, when the radio is camped on a cell, it sends a specially designated
SDS status message. This SDS message indicates to the SwMI that the radio is entering or exiting transmit inhibit
mode.

Mobility procedures that do not require the radio to send an uplink transmission are performed except for cell
reselection.

In transmit inhibit mode the radio joins group calls for any group that the radio is monitoring, but the transmitting on
that call is still prohibited.

The radio also displays any incoming SDS messages to the user. The missed call feature is active in the transmit
inhibit mode and allows checking what calls were missed. However, the radio attempts to prevent call setup
retransmission from being recorded as separate calls.

If you initiate an emergency call, the radio immediately leaves transmit inhibit mode and attempts to start the
emergency call if the radio is in service.

If the radio is turned off in the transmit inhibit mode, on turning on the radio asks whether to exit the transmit inhibit
mode. If you choose No, the radio turns off.

Emergency Operations

Emergency Operations are used in critical situations.

Pressing and holding the EMERGENCY button, or entering the Emergency Number and pressing the SEND key,
activates one or more services (depending on your service provider settings):

• Emergency Alarm
• SDS Status
• Silent Emergency
• Hot Microphone operation
• Emergency Individual Call (Private or MS-ISDN)
• GPS location information
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Note: It is possible to turn on the radio by pressing the EMERGENCY button. Depending on the service
provider settings, the radio can start Emergency Operations automatically. If the radio is PIN-protected
(except for SIM PIN), Emergency Operations will bypass the PIN lock for the duration of the Emergency
Operations.

When starting Emergency Operations, any ongoing voice call is aborted or cleared down, and any packet data transfer
in progress is aborted. However, the session is kept open.

During Emergency Operations, the radio rejects phone, PABX, and private calls, and does not monitor the talkgroups
in the selected scan list.

To terminate Emergency Operations, press the rightSOFT key.

Emergency Group Call
The Emergency Group Call has the highest communication priority that means it is the pre-emptive kind of call.
Emergency Group Call is available in both TMO and DMO. During Emergency Operations, Emergency Group Call
can be started by pressing pressing the EMERGENCY button. The radio can also support Hot Microphone operation,
which allows the Emergency Call to be conducted without pressing the PTT button.

If the radio receives an incoming group call with emergency priority, the display shows that an emergency call has
been received, and a special audio alert is played.

An emergency group call can be configured as:

• A non-tactical call – initiated on a talkgroup preprogrammed by your service provider. When in non-tactical
emergency mode, you cannot switch talkgroups.

• A tactical call – initiated on the currently selected talkgroup.

In TMO, if the radio enters Emergency Operations while the Emergency Broadcast Call is active, the radio continues
on the call without initiating any calls and sends the Emergency Alarm.

When the Emergency Group Call you participate in terminates, your radio can behave in several ways, depending on
your service provider settings:

• If you are the call initiator, the radio can either stay in the Emergency Mode, or return to TMO.
• If you are not the call initiator, the radio always returns to TMO.

Making Emergency Group Calls
Prerequisites: Ensure that your radio is in Emergency Mode.

Procedure:

1 Press and hold the PTT button.
2 Wait for the talk permit tone (if configured) and talk.
3 Release the PTT button to listen.

Note: It is possible to cancel making an emergency group call in TMO. To do this, perform one of the
following actions before the talk permit is granted (depending on your service provider settings):

• Release the PTT button.
• Press the END key (default).

When the call is canceled, your radio displays Call Cancelled message (if configured by your service
provider).

Receiving Emergency Group Calls
The radio receives an Emergency Group Call from a selected pre-programmed group. An incoming call is indicated
by an appropriate tone, status icon, and red color of the display.
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Non-Tactical Emergency
In Non-Tactical Emergency, the radio switches to a designated Emergency talkgroup when starting Emergency
Operations. This talkgroup is used for the complete duration of the Emergency Operations (you cannot change the
talkgroup).

In TMO, it is possible to configure the radio to make Emergency Non-Tactical Group Calls without sending
attachment. If this is set, the radio assumes implicit attachment after receiving a temporary address.

In DMO, the Non-Tactical Emergency proceeds on the same frequency as the previously selected talkgroup. The
service provider can designate any ITSI address to be used for Emergency Operations, (this can be an Open Group –
broadcast address).

After exiting from Non-Tactical Emergency, the radio goes back to the previously selected talkgroup.

Emergency Individual Calls (Private or MS-ISDN)
The Emergency Individual Calls are Simplex or Duplex Calls with emergency priority. On pressing the
EMERGENCY button, the radio initiates an Individual Call to the provisioned address (private or MS-ISDN). During
this kind of call all user indications are unavailable and all other services are rejected. Emergency Operation ends as
soon as the Emergency Individual Call is ended.

Related Links
Private Call on page 48

Emergency Alarm
The Emergency Alarm is a special status message sent to the infrastructure while starting the Emergency Operations.
The radio can wait for infrastructure acknowledgment for this alarm and attempts retries.

Each time the radio enters the Emergency Operation, it sends the Emergency Alarm. When the Emergency Alarm is
sent successfully, the respective audible tone sounds.

In addition, once the radio is in the Emergency Operation on pressing the EMERGENCY button, an additional emergency
alarm is sent (exception: during Hot Microphone transmission).

The message can be dispatched both in TMO and DMO.

Emergency SDS Status
Radio sends a status message with a preprogrammed value to the destination address set by your service provider.
Emergency SDS Status is available in TMO only. If no status acknowledgment or negative acknowledgment is
received, the radio retries sending the message. Status is not resend if Emergency Alarm or Hot Microphone is
configured.

Emergency Hot Microphone
The Hot Microphone allows you to talk without pressing the PTT button during Emergency Operations. The
transmission continues for a provisioned amount of time. Pressing the PTT button before the Hot Microphone time
expires ends the Hot Microphone operation. Then normal PTT operation in Emergency group call takes over (that is,
the transmission is ongoing for the time the PTT button is held).

Subsequent EMERGENCY button presses during the Emergency Operation restarts the Hot Microphone
transmission.

If a talk permit is granted to another member of the group, the Emergency Call received tone is played. If configured,
the radio automatically attempts to get talk permit again.

Pressing EndSOFT key or END key ends the Hot Microphone operation.
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Alternating Hot Microphone
The Alternating Hot Microphone is an enhancement of the Hot Microphone. After activation, the radio alternately
enters transmission phases (your microphone is active) and reception phases (you can only listen) for an amount of
time precisely determined by your service provider.

If this feature is enabled, you can initiate the Alternating Hot Microphone by pressing the EMERGENCY button. If you
want to finish earlier or skip the transmission phase, press the END key.

The Alternating Hot Microphone terminates when one of the following conditions is met:

• The radio exits the Emergency Mode.
• The Alternating Hot Microphone timer expires.
• The PTT button is pressed.
• The right SOFT key is pressed (only during the transmission phase).

Note: When the radio goes out of the service, it enters the reception phase and the Alternating Hot
Microphone is on hold. When the radio is back to the service, the Hot Microphone transmission and the
Alternating Hot Microphone resume.

Note: When you are in the Emergency Mode, pressing the EMERGENCY button restarts the Alternating Hot
Microphone.

Silent Emergency Mode
The Silent Emergency Mode is a type of emergency services that provides no audible indications and no keypad tones
at the entrance. All the display indications are as in the home mode. However, the radio cannot use any services
except for:

• Receiving Ambience Listening
• Sending Silent Emergency Alarms
• Sending GPS location reports

Note: If you try to activate any other feature, it is blocked.

If the Silent Emergency feature is enabled, the radio enters Silent Emergency Mode on pressing the EMERGENCY
button. After entering this Mode the radio stays in TMO or switches to it, depending on the actual state. Once in
TMO, the radio sends Silent Emergency Alarm.

Note: If the radio is in a private or group call, the radio waits until the call ends and then enters the Silent
Emergency Mode.

The radio keeps re-sending the alarm until successful sending is confirmed. After the alarm is successfully delivered,
the radio stays in Silent Emergency Mode and waits for the Ambience Listening.

Your radio exits the Silent Emergency Mode, under the following conditions:

• Press MENU and then # key within 3 seconds.
• Press MENU simultaneously with right NAVIGATION key.
• Press both SOFT keys simultaneously.
• No success in sending the Silent Emergency Alarm and the maximum number of retries has been reached.
• The control room terminates the Silent Ambience Listening.
• The Ambience Listening is disconnected due to another reason.

If you turn off the radio in the Silent Emergency Mode, the radio switches to pseudo power off state. In this state, the
radio appears to be turned off. However, the radio is still on and in the Silent Emergency Mode. On turning the radio
on during the pseudo power off state, the radio acts as during turning on and still is in the Silent Emergency Mode.
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Invisible Emergency
It is possible for the service provider to disable visual and audible indications of performing Emergency Operations
on the radio. The purpose of this feature is to hide the fact of using Emergency Operations in a critical situation (e.g.
direct attack on the user) and thus to provide additional layer of safety.

Emergency Mode by Dialing
This feature allows you to trigger Emergency Mode by dialing a predefined number. It initiates the same Emergency
services as you would use the EMERGENCY button. Your radio can store up to eight Emergency numbers.

Note: If this Emergency Mode was triggered by Emergency number (not by EMERGENCY button), you can
press the END key to exit the Emergency Mode.

Disaster Alert
Disaster Alert call is a broadcast emergency call initiated by the radio, with emergency pre-emptive priority that
everyone in a broadcast area can hear. This feature is specifically designed for catastrophic situations, such as
earthquakes, and has the highest priority over other calls. All radios under Disaster Alert display emergency
notification on their screens. The alert message, its duration and destination talkgroup can be configured in the
codeplug.

In order to initiate Disaster Alert, switch the radio to Disaster Alert mode and press PTT button. When the call ends,
the radio will exit the Disaster Alert state.

During Disaster Alert, other functionality is impacted:

• When Disaster Alert begins, any other ongoing services are terminated.
• No other services can interrupt this type of call.
• Hot Mic functionality cannot be used.
• Speech can only be in Clear mode, even if any of the encryption services are enabled. The only exception is E2E

Encryption.

Note: Not all infrastructures support this feature. Please consult with your service provider before enabling
this feature.

Initializing Disaster Alert Calls
Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Services → Disaster Alert.

Your radio enters Disaster Alert Mode and it displays Disaster Alert icon.
3 To start the call press PTT.

Your radio displays Disaster AlertIn Use.

Exiting Emergency Operations
Prerequisites: Make sure that your radio is engaged in Emergency Operations.

Procedure:

1 If your radio screen displays Emergency Mic On, press End.
2 Press and hold Exit.

Note: If an Emergency Operation was triggered by Emergency number (not by EMERGENCY button), you
can press the END key to exit the Emergency Operation.
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3 If your radio displays Do you want to exit?, press Yes to exit.

Your radio exits Emergency Operations.

Repeater Mode

The Repeater Mode provides repeater connectivity between radios operating in the DMO Mode.

Figure 3: Repeater Mode Operation

DMODMO

A DMO repeater is used to extend the DMO range by retransmitting received information from one radio to another.
It retransmits group calls, private calls and data on a given frequency.

The repeater sends presence signal periodically on a free channel to allow other radios to synchronize on a given
frequency.

Only the radios on the same talkgroup can communicate with each other through the repeater.

Note: This is a selling feature.

Entering the Repeater Mode
To enter Repeater Mode, use one of the following ways:

• From the home screen, select Optns → Repeater Mode.
• From the home screen, press MENU key. Select More . . . → Networks → Repeater Mode.

Setting Monitor Option
Procedure:

1 From the home screen, press Optns.
2 Press Monitor.
3 Select one of the following:

• Off — Your radio works as a repeater only, no operation is available.
• Receive Only — Allows you to listen.
• Receive&Transmit — Allows you to listen and transmit by pressing PTT.
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Encryption in the Repeater Mode
While in the Repeater Mode, the radio supports Air Encryption and is able to repeat encrypted calls and messages.

If SCK keys installed on the radio are invalid:

• The radio transfers calls and messages without deciphering them (provided that the encryption level is not the
highest).

• The LED indicator turns orange.
• On pressing the PTT button, Channel Busy or DMSCK is Invalid message appears.
• You cannot make any call.
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Chapter

4
GPS Location Service

The GPS Location Service feature uses information from Global Positioning System (GPS) satellites orbiting the
Earth to determine the approximate geographical location of your radio.

The GPS Location Service availability, accuracy, and the position calculation time vary depending on the
environment in which you use the radio. The GPS Location Service can assist your dispatcher or colleagues in many
ways such as more efficient deployment of resources or locating your radio when you trigger your emergency service.

The radio can display the location information directly on the screen or send it over the air to your dispatcher to
display it in the control center. Check your radio configuration details with your service provider.

Important: Where the signals from satellites are not available, the GPS Location Service does not work.
This situation usually happens when your radio cannot establish a view of a wide area of open sky, for
example, when the GPS antenna is covered or facing the ground. Such situations include being:

• In underground locations
• Inside buildings, trains, or other covered vehicles
• Under any other metal or concrete roof or structure
• Near a powerful radio or television tower
• In extreme temperature outside the operating limits of your radio

Even if your location information can be calculated in such situations, it may take longer to do so. Therefore, in any
emergency situation, always report your location to your dispatcher. Where adequate signals from multiple satellites
are available, your GPS Location Service feature provides a location, most probably near to your actual location.

The radio can be triggered to send Location Reports in various circumstances, for example:

• Upon a request
• Entering Emergency Mode
• At specified time intervals
• At specified distance intervals

The Location Reports can be sent both in TMO and DMO by using:

• SDS messages
• Packet Data

The radio can be configured to give audio-visual notifications upon sending the Location Reports.

Depending on the radio settings, viewing the radio position and the status of the visible satellites is available. The
position may consist of longitude and latitude, UK, or Irish grid coordinates.

Note: This is a selling feature.

Related Links
Location on page 103
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Enhancing GPS Performance

Sometimes the GPS feature is unable to complete a location calculation successfully. You hear an audible tone
indicating that your radio cannot see the satellites.

To maximize the ability of your radio to determine a location fix please note the following guidelines:

• Stay in the open — The GPS feature works best where there is nothing between your radio and a large amount of
open sky. If possible, go outside, away from tall buildings and foliage. While the performance in a building is
improved by moving closer to windows, glass with certain sun shielding films may block satellite signals.

• Position your radio to enhance reception — Signals from GPS satellites are transmitted to your GPS antenna,
which is in your radio antenna. Hold your radio away from your body, giving the antenna clear access to satellite
signals. Do not cover the antenna area with your fingers or anything else.

• Stand still — If possible, stand still until your radio is finished determining your location. Moving your radio at a
walking pace while your radio is calculating your approximate location may substantially decrease GPS
performance.

Enabling GPS

Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Location → Interface.
3 Select On.

Note: Your service provider can enable this feature.

GPS Icon

When GPS is enabled, the following icon is displayed in the status icon area:  Depending on the current GPS state,
the icon can be solid – GPS has a fix, or blinking – GPS is searching for a fix. The blinking GPS icon can be disabled/
enabled by your service provider.

GPS Different Location Displays

Table 14: Different Location Displays

Latitude / Longi-
tude UK Coordinates Irish Coordinates UTM Coordinates MGRS Coordi-

nates

Time Time Time Time Time

Latitude 2–Letter Code 1–Letter Code 3–Letter Code 3–Letter Code and 2–
Letter Code

Longitude Easting and Northing
Coordinate

Easting and Northing
Coordinate

Easting and Northing
Coordinate

Easting and Northing
Coordinate

Altitude Altitude Altitude Altitude Altitude
Table continued…
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Latitude / Longi-
tude UK Coordinates Irish Coordinates UTM Coordinates MGRS Coordi-

nates

Satellites Satellites Satellites Satellites Satellites

• Time — indicates when the last time the location was calculated. The time is provided in Universal Time
Coordinated.

• Letter Code — grid zone or square on the map for different coordinate standard
• Latitude — expressed in degrees, minutes, and seconds.
• Longitude — expressed in degrees, minutes, and seconds.
• Number of satellites — used to calculate the location. In general, more satellites make for better accuracy. The

maximum is 12 satellites.
• Easting — refers to the eastward-measured distance expressed in meters.
• Northing — refers to the northward-measured distance expressed in meters.

Note: Skipping each digit of easting and northing coordinates decreases the accuracy by the factor of 10.

Viewing Your Position

Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Location → Position.
3 Scroll to view the results about the last time your location was calculated.

Note: To refresh your position:

• Select Position — the radio refreshes its position automatically
• Press Refresh

Changing GPS Accuracy

Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Location → Accuracy.
3 Select one of the following:

• Medium (default) — Power consumption optimization is combined with less position accuracy.
• High – Better position accuracy is combined with less power consumption optimization.

Note: If connected to an external charging device, the radio automatically enters the High mode.

GPS – Things to Keep in Mind

Where adequate signals from multiple satellites are not available, the GPS feature of your radio does not work. Such
situations include but are not limited to:

• In underground locations
• Inside of buildings, trains, or other covered vehicles
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• Under any other metal or concrete roof or structure
• Near a powerful radio or television tower
• When your GPS antenna is covered (for example, by your hand or other object) or facing the ground
• In temperature extremes outside the operating limits of your radio

Even where location information can be calculated in such situations, it may take longer to do so. Therefore, in any
emergency situation, confirm your location with your dispatcher.

Furthermore, please note that even where adequate signals from multiple satellites are available, your GPS feature
provides only an approximate location, often within 20–100 meters from your actual location.
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Chapter

5
Main Menu

This chapter contains information on items in the main menu.

You can enter the menu items during a call. If you are viewing a menu when a new call starts, the radio exits the
menu.

Important: Some menu items are model specific and may not be activated or available on your radio.

Scrolling through the Menu

Procedure:

1 From the home screen, press the MENU key.
2 Scroll to the required item by pressing NAVIGATION keys. Press the SOFT key assigned as Select or right NAVIGATION

key to select.
If the menu item contains a further set of menu items, repeat step 2.

Note: You can use shortcuts to access frequently used items.

Menu Icons

The following icons make it easy to identify the menu items at first glance.

Table 15: Menu Icons

Menu Icon Description

Main Menu Items / Context Sensitive Menu

It is assigned to MENU when the main menu items / context-sensitive menu are active.

Messages

Send status messages,
Send text messages (free text or according to user defined or predefined templates),
Received messages in Inbox.

Contacts

Add, search, edit, or erase entries in the contact list.

Table continued…
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Menu Icon Description

Browser

Starts the WAP browser.

Security

Lets you turn on/off and verify security features, and change passwords.

Setup

Allows you to customize your radio.

More...

Contains additional setup menu items.

Group Setup

Contains additional menu items for Scanning Talkgroups features.

Favorites

Contains shortcuts to frequently used talkgroups and contact numbers.

My Info

Displays information about your radio and its numbers.

Recent Calls

Contains a list of recent calls.

Shortcuts

Allows you to view and manage shortcuts to menu items.

RUI

Allows you to log in and log out of the radio.

Networks

Allows you to select a network.

Location

Displays location of your radio.

Packet Data

Allows you to send data from your radio to other devices.

Services

Allows you to manage Broadcast, Assistance and Disaster Calls.
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Messages

This feature allows you to send and receive text messages. A message can contain up to 1000 characters, depending
on your service provider settings.

Pressing the PTT button when a message is highlighted can cause one of the following actions, depending on your
service provider settings:

• The radio ignores the PTT button request.
• The radio starts a Private Call with the message sender.
• The radio starts a Group Call on a currently selected talkgroup.

New Message
This menu item allows you to create a new message.

Sending Messages to Private/Phone
Procedure:

1 From the home screen, press the MENU key.
2 Select Messages → New Message.
3 Enter your message and press Send.
4 If needed, select Private/Phone.
5 Enter recipient number or press abc to choose it from your contacts.

Note:

For Private target selection, you can enter either Individual Short Subscriber Identity (ISSI) or Group
Short Subscriber Identity (GSSI) of the recipient.

ISSI – a unique, individual ID assigned for each radio.

GSSI – in Dimetra called Group ID or Talkgroup ID.
6 Press Send, or SEND key, or the PTT button.

Sending Messages to Groups
Procedure:

1 From the home screen, press the MENU key.
2 Select Messages → New Message.
3 Type your message and press Send.
4 If needed, select Group.
5 Select a group to send the message.

Sending Store and Forward Messages
Prerequisites: Your service provider enables the Store and Forward feature.

Procedure:

1 From the home screen, press the MENU key.
2 Select Messages → New Message.
3 Press MENU key and select Message Setup → On/Offline users.
4 Enter your message and press Send.
5 If asked for the Target selection, select one of the following:
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• Private – enter the private number or press abc to choose the destination number from the contact list.
• Phone – enter the phone number or press abc to choose the destination number from the contact list.

Note: Your service provider can enable to send a Store and Forward message to a talkgroup.

6 Select Send, or press SEND key or PTT button.

Delivery Report
Delivery Report is an acknowledgment that the radio can request upon sending a message to an individual recipient.
You can define what type of Delivery Report your radio requests, or turn on/off this feature.

If the Delivery Report is received shortly after the message was sent, the radio:

• Displays a pop-up with one of the following messages:

• Message Sent – if no Delivery Report is requested (and when a Store and Forward message has been received
at the Store and Forward server)

• Message Delivered – if the Delivery Report is requested and the message has been received by the target radio
• Message Read

– if the Consumed Delivery Report is requested and the message is opened on the target radio
• Message Failed – if the Delivery Report is requested and the message has not been received by the target

radio within a defined time period
• Saves the Delivery Report in Outbox along with a copy of the message.

If the Delivery Report is received after a longer period of time, the radio:

• Saves the Delivery Report in Outbox along with a copy of the message.
• If Delivery Report Notifications functionality is configured by your service provider, the radio also:

• Temporarily saves a Delivery Report message in Inbox. The notification disappears after it is read.
• Displays New Message icon.
• Displays New Delivery Status notification screen (if possible).

Viewing Delivery Reports
Procedure:

1 From the home screen, press the MENU key.
2 Select Messages → Inbox.
3 Find a required message and select Read.
4 Press MENU key.
5 Select Delivery Status.

Configuring Delivery Reports
Prerequisites: Your service provider enabled the delivery report configuration.

Procedure:

1 From the home screen, press the MENU key.
2 Select Messages → New Message.
3 Press MENU key and select Delivery Report.
4 Select one of the following:

• None — the radio does not request any delivery report.
• Received — the radio requests reports on your messages that were received.
• Consumed — the radio requests reports on your messages that were read.
• Both — the radio requests reports on your messages that were received and read.
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Inbox
It contains up to 100 new or old incoming messages.

Table 16: Inbox Icons

Icon Description

Unread (New) Message

Read (Old) Message

Sender Information in Message View — name or number

Time and Date Stamp in Message View — arrival time and date

Delivery Status Received — delivery status for Store & Forward messages

Messages sub-menu indicates the number of the messages. If the indication is for example 2/4, it means that two
unread and four read messages are in the Inbox.

Entering the Inbox
Procedure:

1 From the home screen, press the MENU key.
2 Select Messages → Inbox.

Note: The status (if any) of the list is displayed for a few seconds:

• No New or Old Messages — The screen returns to the previous display within a few seconds.
• Inbox Full — Select Ok.

Receiving New Messages
Procedure:

1 New message received.

Your radio displays an animation and plays a New Mail Received tone.
2 Select one of the following:

• Read — opens the entire message.
• Back — dismisses the message. You can access the message later from the Inbox.

Using Submenus in the Inbox and the Outbox
Procedure:

1 From the home screen, press the MENU key.
2 Select Messages → Inbox or Outbox.
3 Highlight the required message and press MENU key.
4 Select one of the following:

• Store — Saves a message as a template. Change the default template name and press Ok.
• Delete — Deletes the selected message. Press Yes to confirm.
• Delete All — Deletes all the messages in the Inbox/Outbox. Press Yes to confirm.
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• Reply (only for Inbox) — Invokes the edit screen with the old message as default text and the message
originator as a recipient. After editing, press Send, the PTT button, or the SEND key to send.

• Resend (only for Outbox) — Invokes the edit screen with previously entered text with the same recipient.
After editing, press Send, the PTT button, or the SEND key to send.

• Forward — Invokes the edit screen with the old message to send it to a different participant. After editing,
press Send, the PTT button, or SEND key to send.

• Refresh — Re-orders the message list and displays the new messages.
• Delivery Status (only for Outbox) — Shows the date and time of the message when it sent, delivered, read,

and expired was not delivered, expired was not read, failed unknown.

Embedded Number
This feature allows you to call a number from a message or to start a group call with the message sender talkgroup.

Storing Numbers from Messages
Prerequisites: Embedded Number feature is enabled by your service provider.

When and where to use: You can save the sender's or embedded number from the message to a new or existing
contact.

Procedure:

1 From the home screen, press the MENU key.
2 Select Messages → Inbox.
3 Highlight the required message and select Read.
4 Press the PTT button.
5 Radio displays a list of the numbers (including the senders number).
6 Highlight the required number and press Store.
7 Highlight required contact and press View.

Note: To store a number for a new contact, select [New Contact] and fill out the required fields. Press
Done to save it..

8 Select Edit.
9 Choose the Type of the new number and press Done.

Calling Numbers in Messages
Prerequisites: Embedded Number feature is enabled by your service provider.

When and where to use: You can return a voice call to the sender of a message or to any number that is embedded in
the message text.

Procedure:

1 From the home screen, press the MENU key.
2 Select Messages → Inbox.
3 Highlight the required message and select Read.
4 Press the PTT button.
5 Radio displays a list of the numbers (including the senders number).
6 To call, highlight to the required number and press the PTT button or the SEND key.
7 Select Ctype to choose the type of call (Private, Phone, or PABX).
8 Press the PTT button or the SEND key.

Making Group Calls on theTalkgroup of the Message Sender
Prerequisites: Embedded Number feature is enabled by your service provider.
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Procedure:

1 From the home screen, press the MENU key.
2 Select Messages → Inbox.
3 Highlight the required message and press the PTT button.

Immediate Message
When the new immediate message is received, radio plays the New Mail Received tone and displays the content
overlapping your previous screen. All immediate messages are stored in the Inbox. If the radio is in PIN Lock state,
immediate message is displayed after correct PIN is entered.

Note: This is a selling feature.

Outbox
Outbox stores all sent messages.

Table 17: Outbox Icons

Icon Description

Delivery in Progress

Delivery Accomplished

Delivery Failed

Successful Outgoing Message

Failed Outgoing Message

CO Box
CO Box contains incoming and outgoing Call-Out messages arranged chronologically with the newest at the top of
the list. Clicking Select on a Call-Out message headline displays more detailed information on the item.

When the radio is in normal mode, you are able to browse through all messages in the CO Box. However, if the radio
is in the Call-Out mode, you can only browse through the information regarding the currently ongoing Call-Out
message.

Related Links
Call-Out on page 116

RMS Box
RMS Box stores all incoming and outgoing Radio Messaging System (RMS) messages, both Status messages and
Free Text messages.

WAP Box
Each WAP Push message can be loaded immediately or stored as a message in WAP Box. Then it can be accessed by
pressing MENU → Messages → WAP Box. All the WAP Push messages are passed to the browser.
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Related Links
WAP on page 109
WAP Push on page 116

Templates
This feature is used to store up to 100 predefined and your message templates. Each of the Inbox and Outbox
message can be stored as a template. Each template name and text can be edited afterwards.

Sending User-Defined Templates
Procedure:

1 From the home screen, press the MENU key.
2 Select Messages → Templates.
3 Highlight the required template name and press Send.
4 Do one of the following:

• Enter the number or press abc to select the name from your contact list. Press Send.
• Select required talkgroup from the TalkGroup List.

Setting User-Defined Templates
Procedure:

1 From the home screen, press the MENU key.
2 Select Messages → Templates.
3 Highlight the required template and press MENU.
4 Select one of the following:

• View — Displays template text.
• Delete — Deletes the template.
• Edit Text — Opens edit screen with the template text. Edit the text and press MENU. Select Save Changes to

save edited template, or Store to save the edited template as a new one.
• Edit Name — Opens edit screen with the template name. Press Ok to save the template.

Predefined Templates
Predefined message templates are programmed into your radio. You are allowed to perform limited edit operations of
the predefined template. You can send it, but you are not able to store the edited template or erase it from the
predefined template list.

Viewing Predefined Templates
Procedure:

1 From the home screen, press the MENU key.
2 Select Messages → Predefined.
3 Highlight the required template and press MENU key.
4 Select View.

Sending Predefined Templates
Procedure:

1 From the home screen, press the MENU key.
2 Select Messages → Predefined.
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3 Highlight the required template and press Send, the PTT button, or the SEND key.

Note: You can edit the predefined template before you send it. Press the MENU key and select Edit. Edit
screen opens with the template text. You are only allowed to replace the existing text.

Status Messages
The radio allows you to send two types of status messages: statuses and targeted statuses. Your service provider
determines which type is enabled on the radio.

Statuses can be sent either to a selected talkgroup or to a private number programmed by your service provider.
Targeted statuses can be sent to any talkgroup defined for the radio or to any private number (from the contact list or
entered manually).

Viewing a Status Message Number
Procedure:

1 From the home screen, press the MENU key.
2 Select Messages → Send Status.
3 Press the MENU key and select View.

Sending Status Messages
This procedure allows you to send status messages to either a selected talkgroup or a programmed private number.
Only one option can be enabled at a time.

Prerequisites:

• If sending statuses to talkgroups is enabled: switch to the talkgroup to which you want to send a status message.
• If sending statuses to private numbers is enabled: no action is needed, the private number is set up by your service

provider

Procedure:

1 From the home screen, press the MENU key.
2 Select Messages → Send Status.
3 Do one of the following:

• Highlight the required status message and press Select, the PTT button, or the SEND key.
• If the status list is empty, enter a 5 digit status message number and press Send.

Targeted Status Messages
This feature enables sending status messages to user selectable addresses. By default, targeted status messages can be
sent to private or talkgroup addresses. Your service provider may restrict valid addresses to numbers stored in
Contacts.

Sending Targeted Status Messages
Procedure:

1 From the home screen, press the MENU key.
2 Select Messages → Send Status.
3 Do one of the following:

• Highlight the required status message and press Select, the PTT button, or the SEND key.
• If the status list is empty, enter a 5 digit status message number and press Send.

4 Do one of the following:

• Enter the number or press abc to select the name from your contact list. Press Send.
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• Select required talkgroup from the TalkGroup List.

The display shows one of the following delivery reports:

• Status Sent.
• Status Failed.

Contacts

This sub-menu stores all your contact numbers. Each entry requires the following information:

• Name — if you store more than one number to one contact, this entry is required.
• Type — each contact must be assigned to one of the following types:

Table 18: Contact Types

Contact Icon Description

Private

Cannot have a speed dial number.

Mobile

Home

Work

PABX

Other

Pickers

Indicate more than one number in a contact.

• # (number) — each contacts entry must contain a number.
• Speed # — accept the default Speed Dial number or change it.

Creating Contacts
Procedure:

1 From the home screen, select Contcs.
2 Select [New Contact].
3 Highlight Name and press Change. Enter the name of your contact and press Ok.
4 Highlight Type and press Change. Select the required type of your contact.

Note: You can use the left and right NAVIGATION keys to select the type of your contact from the
Contact Details screen.

5 Highlight # (number) and press Change. Enter the number of your contact and press Ok.
6 If needed, highlight Speed # and press Change. Enter the speed dial number (1– 1000) of your contact and press

Ok.
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Note: If the entered number exist, the radio displays Overwrite? message. Press Yes to confirm, or No
to enter the speed dial number again.

7 Press Done.

You have create a contact with one number. To add additional number repeat steps 4–6.

Editing Contacts
Procedure:

1 From the home screen, press Contcs.
2 Highlight the contact you want to edit.
3 Press the MENU key.
4 Press Edit.
5 Highlight one of the following entries and press Change to edit:

• Name
• Type
• # (number)
• Speed #

6 Press Done.

Deleting Numbers
Procedure:

1 From the home screen, press Contcs.
2 Select a contact you want to edit.
3 Use left or right NAVIGATION keys to choose the required number.
4 Press MENU.
5 Select Delete number.

Note: If an entry contains only one number, deleting the number deletes the entry.

6 Press Yes.

Deleting Contacts
Procedure:

1 From the home screen, select Contcs.
2 Highlight a contact you want to delete.
3 Press the MENU key.
4 Select Delete contact.
5 Select Yes.

Checking Capacity
When and where to use: To see how many numbers are stored in the radio.

Procedure:

1 From the home screen, select Contcs.
2 Press the MENU key.
3 Select Capacity.
4 Select one of the following:
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• Private
• Phone / PABX
• Contact

Dialing through the Contact List
Procedure:

1 From the home screen, press Contcs.
2 To highlight the required contact, use up and down NAVIGATION keys, or enter up to 12 characters of the contact

name.
3 If the contact has more than one number, use left and right NAVIGATION keys to select the required number.
4 Press the PTT button to initiate a simplex call with a Private number. Otherwise use the SEND key to initiate a

duplex call.

Browser

This menu item activates a WAP browser that allows you to browse the Internet from your radio.

Related Links
WAP on page 109

Security

This sub-menu stores all your security settings.

PIN Protect
This feature allows you to enable PIN code authentication at the next power on. This code protects your radio against
unauthorized use.

If you are unable to unlock the radio, you can only send or receive Emergency Calls and adjust the volume level with
the ROTARY KNOB.

Related Links
Unlocking Your Radio on page 31
Changing PIN Codes on page 77

Protecting the Radio with a PIN Code
Procedure:

1 From the home screen, press MENU → Security → PIN Protect.
2 Select On.
3 Enter 4-digit PIN code. By default it is 0000 (four zeros).

Suggestion: To increase security, set your own PIN code.

Post requisites: Each time you turn on the terminal, PIN code is required.

Unblocking Your Radio
Prerequisites: You blocked your radio by entering incorrect PIN code for three times (by default).
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Procedure:

1 Radio displays Unit BlockedEnter PUK.
2 Enter 8–digit PUK (Personal Unblocking Key) number.

Note: The PUK is an eight-digit master code provided by your service provider.

3 Enter the new PIN code twice.

Changing PIN Codes
Procedure:

1 From the home screen, press the MENU key.
2 Select Security → Change Code.
3 Radio prompts for the Old Code. Enter currently used 4-digit security code (default setting is 0000).
4 If the entered code matches the old code, radio prompts for the new code twice.

Your radio displays Code Accepted.
Related Links

Unlocking Your Radio on page 31
PIN Protect on page 76

Keylock Setup
The keypad lock feature allows locking the keypad to prevent pressing a key accidentally. The keypad lock/unlock
can be invoked by using an appropriate option from the radio menu or by using a predefined menu shortcut. By
default press MENU, and then * key.

Your service provider can determine which of the following elements are additionally inoperative while the keypad is
locked:

• The PTT button
• Side buttons
• The ROTARY KNOB

• The ON/OFF/END/HOME key

The EMERGENCY button is always operative.

Related Links
Locking/Unlocking the Keys/Buttons on page 32

Keypad Lock Notification
When the keypad is locked, your service provider can configure one of the following instructions:

• None — no notification is displayed.
• Notification Only — Keys Locked is displayed.
• Notification and Instruction — Press Menu * to lock/unlock keypad is displayed.

Setting Automatic Keylock Delay
Procedure:

1 From the home screen, press the MENU key.
2 Select Security → Keylock Setup → Delay.
3 Use up and down NAVIGATION keys to change the minutes and press Done.
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Setting Keylock on Startup
Procedure:

1 From the home screen, press the MENU key.
2 Select Security → Keylock Setup → Start Locked.
3 Select On/Off.

Air Encryption
Air Encryption is a feature that enables encryption of entire communication between the radio and infrastructure,
which results in increased security of calls, messages, and data.

If configured by your service provider, the radio plays a sound and displays Call & Data Not Encrypted when
encryption is on and you receive a clear call (unencrypted). This feature provides service confidentiality between you
and the system.

In the TMO Mode, when Air Encryption is enabled on you radio but cannot be supported due to an infrastructure

failure, the following icon appears on the display: .When encryption is not available in the DMO Mode, the radio

displays: .

This menu item allows you only to view air encryption state.

Note: This is a selling feature.

Related Links
Status Icons on page 27

Viewing the Air Encryption State
Procedure:

1 From the home screen, press the MENU key.
2 Select Security → AirEncrypt.
3 Your radio displays:

a Air Encryption Is Off.
b Air Encryption Is On.

Air Encryption Key Deletion
Please check with your service provider whether the radio is provided with Air interface encryption keys. You can
delete the Air interface encryption keys from the radio by entering the following sequence: **00##.

Note:

• It takes a minute for this feature to delete all the encryption keys from the radio. During this time, do
not remove the battery.

• Deletion is performed in idle TMO/DMO or Emergency Operation.

Caution: Using this feature will disable the radio, and your service provider will need to re-enable the
radio.

K Validity
K (Key) is a secret key the infrastructure uses to authenticate the radio in the system. It is part of the authentication
that provides service confidentiality between your radio and the system.
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Verifying K Validity
Procedure:

1 From the home screen, press the MENU key.
2 Select Security → K Validity.
3 Your radio displays:

• K is Valid — the infrastructure can authenticate your radio.
• K is Invalid — the infrastructure is unable to authenticate your radio. Please call your service provider to

restore the key to your radio.

SCK (Air Interface Encryption Class 2)
SCK (Static Cipher Key) is a secret key used for the Air Interface Encryption Class 2. It may be used to encrypt calls
and data in TMO and DMO. The SCK air interface encryption provides service confidentiality between radios and
infrastructure when in TMO, and between radios when in DMO. A radio is capable of being loaded with up to 32
SCKs. Specific keys are used for encrypting the air interface.

Any mismatch between radios and/or infrastructure impacts communication – only those using the same key as the
transmitting party are able to decode and hear the communication.

TMO SCK
Use of SCKs in TMO needs to be enabled by your service provider. The SCKs used in TMO are called TMSCKs.

DMO SCK
Use of SCKs in DMO needs to be enabled by your service provider. The SCKs used in DMO are called DMSCKs.

Changing DMO SCK
Procedure:

1 From the home screen, press the MENU key.
2 Select Security → DMO SCK.
3 Press Next.
4 Radio displays Change to version .
5 Select one of the following:

• Yes — to change the key. Your radio displays Key version changed.
• No — to leave the key. Your radio displays Code Not Changed.

Verifying TMSCK Validity
When and where to use: To ensure that the TMSCKs in the radio are valid and can be used for the air interface
encryption.

Procedure:

1 From the home screen, press the MENU key.
2 Select Security → TMSCK Validity.
3 The radio displays:

• TMSCK is Valid – the radio can work encrypted in TMO.
• TMSCK is Invalid – the radio cannot work encrypted in TMO. Please contact your service provider to restore

SCKs to your radio.
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Verifying DMSCK Validity
When and where to use: To ensure that the DMSCKs in the radio are valid and can be used for the air interface
encryption.

Procedure:

1 From the home screen, press the MENU key.
2 Select Security → DMSCK Validity.
3 The radio displays:

• DMSCK is Valid – the radio can work encrypted in DMO.
• DMSCK is Invalid – the radio cannot work encrypted in DMO. Please contact your service provider to restore

SCKs to your radio.

Covert Mode
This feature enables you to completely shut down all visible and audible alerts and notifications making the radio
unnoticeable even in a silent and dark environment.

When your radio is in the Covert Mode, you cannot enter the following menu items of the Setup menu.

• Vibrate.
• Set Volume
• Tones
• Backlight (in Display menu item)

When the Covert Mode is turned on:

• All tones are set to Off (corresponding to All Tones menu entry).
• Group audio is set to Spkr Cntrl (corresponding to Audio Toggle menu entry).
• The private speaker is set to Off (this setting causes all the calls are routed through the earpiece).
• Backlight is set to Disabled (corresponding to Backlight menu entry).
• The LED indicator is switched off.

The radio powers up in the mode set before turning off. Thus if the Covert Mode was set before turning off, the radio
turns on in the Covert Mode .

When the Covert Mode is turned off, all the changed settings are reverted to the previous state.

This feature can be used as the One-Touch Button.

Activating the Covert Mode
Procedure:

1 From the home screen, press the MENU key.
2 Select Security → Covert Mode.
3 Select one of the following:

• On — all tones are set to off, and the backlight and the LED are disabled immediately. The group audio is
routed to the earpiece. The radio displays Covert Mode On.

• Off — all settings for tones, backlight and audio are restored. The radio displays Covert Mode Off.

Setting to Vibrate in the Covert Mode
Procedure:

1 From the home screen, press the MENU key.
2 Select Security → Covert Mode → Vibrate.
3 Select one of the following:
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• On — To restore all vibrations.
• Off — To disable all vibrations.

SDS Remote Control
SDS Remote Control is a feature that enables to remotely control behavior and configuration of the radio via special
SDS messages. The messages can be sent both in TMO and DMO (including the Repeater Mode) by any radio
capable of controlling other radios. During the execution of the Remote Control messages, depending on your service
provider settings, the radio can play a tone, vibrate, or display an appropriate icon in the status icon area.

Note: This is a selling feature.

Setting SDS Remote Control
When and where to use: To enable/disable support of special SDS messages that allow remote control of the radio.

Procedure:

1 From the home screen, press the MENU key.
2 Select Security → Remote Control.
3 Select On to enable, or Off to disable remote control.

Setup

This sub-menu allows you to change your radio configuration.

Vibrate
This sub-menu allows you to determine if your radio vibrates, or rings, or both vibrates and rings when receiving a
call.

Setting Default Vibrate
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Vibrate.
3 Select one of the following:

• Vibe then Ring
• Vibe Only
• Ring Only

Setting Detail Vibrate
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Vibrate → Details....
3 Select one of the following:

• Duplex Calls — Sets the vibrate settings for Phone, PABX, and Duplex Private calls.
• Simplex Calls — Sets the vibrate settings for Simplex Private Calls.
• Group Call — Sets the vibrate settings forGroup Calls.
• Messages — Sets the vibrate settings for status messages and text messages.
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4 Select the required setting, and press Select.

Note: If you choose Duplex Calls, Simplex Calls or Messages, the settings available are Vibe then
Ring (for messages it is Vibe & Ring), Vibe Only or Ring Only. If you choose Group Call, the
settings available are Vibe On or Vibe Off only.

Ring Style
This sub-menu allows you to set the incoming call ring style.

Setting Ring Style
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Ring Style.
3 Select one of the following:

• Duplex — To set the new ring style to all duplex calls.
• Simplex — To set the new ring style to all simplex calls.

Note: Upon entry into this sub-menu, the display shows the current ring style used.

4 Scroll to the desired style and press Select.

Note: New ring style is played immediately for a few seconds. If necessary, adjust the volume level.

Set Volume
This menu item allows you to adjust the Simplex, Duplex, Earpiece, Speaker, and Keypad tone volume.

Related Links
Volume Adjustment Mode on page 84

Setting Volume
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Set Volume.
3 Select one of the following:

• Duplex Vol — sets the volume level for duplex ringtones.
• Simplex Vol — sets the volume level for simplex ringtones.
• Earpiece Vol — sets the volume level for the earpiece.
• Speaker Vol — sets the volume level for the speaker.
• Keypad Vol — sets the volume level for keypad tones.

Note: If the display shows only one option Volume, you can adjust all of the above settings at once.
You have the option to change the settings individually when the Volume Adj. Mode is set to
Individual.

4 Press right or left NAVIGATION key to change the value.

Note: When the battery level is low it is not recommended to attach the 4 Ohm speaker to the radio as it
can cause reset or shutdown of the radio.

Related Links
Setting Volume Adjustment Mode on page 85
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Language
This sub-menu allows you to change the language of the radio.

Setting Language
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Language.
3 Select desired language.

Data Setup
This menu item allows you to set up your radio to transmit and receive data from the external device.

To connect your radio accessory connector to the external device, use the PMKN4025 cable. The external device
must run an application complying with the TETRA standards.

Note:

• Data services are available only in TMO Mode.
• Data services are blocked in TXI Mode.
• When set to Voice Only, the built in data modem is disabled to conserve battery power.

Setting Data Function
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Data Setup.
3 Select one of the following:

• Voice Only — Your radio receives and transmits voice calls only.
• Data Only — Your radio acts as a modem. It rejects incoming and outgoing voice calls (except for Emergency

Calls), status and text messages.
• Voice & Data — Your radio acts as a modem but voice calls have priority over data calls and can interrupt

them.

Audio
This menu item allows you to adjust your radio audio settings.

Audio Profiles
An audio profile is a set of audio parameters, such as the volume of alert tones, that are configured by your service
provider to fit a particular operating environment. For example, the audio parameters can be adjusted to situations
when the radio operates inside a building or on a noisy street.

If programmed, the radio displays a name of a currently used audio profile (on the home screen) and/or an appropriate
icon associated with the profile (in the status icon area).

Your service provider can configure a maximum of ten audio profiles.

For a detailed description of a specific audio profile, contact your service provider.
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Setting Audio Profiles
When and where to use: To adjust the audio parameters of the radio its current operating environment.

Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Audio → Audio Profile.
3 Select a required profile.

Howling Suppression
The howling suppression is a mode increasing the stability of the acoustic feedback loop. The radio eliminates
howling caused by the feedback loop from the receiving radios to the sending radio in simplex calls. You can toggle
the howling suppression during an active call.

To enable this anti-howling function, you can either use the radio menu or the corresponding One-Touch Button.

Setting Howling Suppression
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Audio → Howling Suppr..
3 Select required setting.

Note: Your service provider can set up the state of the howling suppression on powering up the radio.
Depending on the settings, the radio can either disable the howling suppression or set the last
remembered state.

Audio Toggle
You can control audio routing (speaker/earpiece) for any private or group call through the dedicated SPEAKER CONTROL

key. You can also define through the menu to have all group calls in high audio or controlled by the SPEAKER CONTROL

key.

Setting Audio Toggle
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Audio → Audio Toggle.
3 Select one of the following:

a Always Loud — The audio sound comes from the speaker (high audio only).SPEAKER CONTROL key is disabled.
b Spkr Cntrl — The audio goes through the earpiece or the speaker. You can switch between low and high

audio by pressing SPEAKER CONTROL key.

Volume Adjustment Mode
You can set the volume to Individual or Common. When it is set to Individual, the volume level for Voice, Duplex,
Simplex, Earpiece, Speaker and Keypad can be set per user preferences. When set to Common, the audio has one
setting for all items.

Related Links
Set Volume on page 82
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Setting Volume Adjustment Mode
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Audio → Volume Adj. Mode.
3 Select one of the following:

• Individual — You can set Duplex, Simplex, Earpiece, Speaker and Keypad per your preferences in MENU

→ Setup → Set Volume.
• Common — You can set one value for all the items in MENU → Setup → Set Volume.

Related Links
Setting Volume on page 82

Tones
This field sets the volume level for the tones set.

Keypad Tone
You can activate/deactivate keypad tone at every key press.

Setting Keypad Tone
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Tones → Keypad Tone.
3 Select one of the following:

• On — Activates keypad tone.
• Off — Deactivate keypad tone.

All Tones
You can activate/deactivate all tones.

Setting All Tones
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Tones → All Tones.
3 Select one of the following:

a On — Activates all the tones.
b Off — Deactivates all the tones.

Talk Permit
You can set a different tone upon pressing the PTT button.

Setting Talk Permit
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Tones → Talk Permit.
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3 Select one of the following:

• No Tone — No tone heard upon pressing the PTT button.
• Short Tone — Short tone heard upon pressing the PTT button.
• Normal Tone — Factory-default tone heard upon pressing the PTT button.

Clear to Send
You can activate/deactivate tone for the transmitting radio that the receiving radio is ready to accept the transmission.

Setting Clear to Send
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Tones → Clear to send.
3 Select one of the following:

• Tone On — Activate clear to send tone.
• Tone Off — Deactivates clear to send tone.

Periodic Alert
You can activate/deactivate periodic tone indication for the missed calls, the unread messages, and low battery level.
For each notification, your radio generates an unread message tone with the amber LED color indication.

Setting Periodic Alert
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Tones → Periodic Alert.
3 Select one of the following:

• Alert — Activates/deactivates periodic tone.
• Period — Indicates the time between each periodic tone.

D-PTT Tones
This menu item contains the settings for the Double PTT feature.

The Double PTT feature allows you to send a tone pattern (single, double, or triple) when the radio is in idle or the
Group Call mode by pressing the PTT button twice.

After the D-PTT tone is played, the user can press and hold the PTT button once again to get the permission to talk.
Otherwise, if the user presses the PTT button while the D-PTT tone is played, it is ignored.

After the D-PTT tone is sent keeping the PTT button pressed, it results in permission to talk. The D-PTT tone is not
audible on a sending radio.

Note: This feature needs to be enabled by your service provider.

Setting D-PTT Tones
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Tones → D-PTT Tones.
3 Select one of the following:
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• D-PTT Mode — Activates/deactivates D-PTT tone.
• Tone Style— Indicates how many times the D-PTT tone is played.

Display
This menu item allows you to adjust your radio display settings.

Related Links
Display on page 26
Display on page 26
Setting Time and Date on the Display on page 89

Setting Flip Display
When and where to use:

The feature is useful for a user who has to wear the radio on a shoulder, belt, or lapel and at the same time wishes to
read the display upside down.

Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Display → Flip Display.
3 Select one of the following:

• On – to activate this feature.
• Off – to deactivate this feature.

Setting Font Level
When and where to use: To increase/decrease text size so you can adjust the interface readability to existing
conditions.

Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Display → Font Level.
3 Select one of the following:

• 1 – small font size
• 2 – medium font size
• 3 – large font size

Note: In some languages number of available font levels can be limited.

Setting Large Idle Font
When and where to use: To enable/disable large font on the home screen.

Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Display → Large Idle Font.
3 Select On to enable, or Off to disable displaying large font on the home screen.

Note: Large Idle Font is not available in some languages.

Main Menu | 87

 |   |  Send Feedback

http://docsurvey.motorolasolutions.com


Setting Extra Zoom
Enabling Extra Zoom simultaneously changes three settings: switches Font Level to the largest possible one,
activates Large Idle Font, and sets Extended Status Icons to Idle Only

If you modify any of these settings, for example decrease the font level, the radio leaves the Extra Zoom Mode.
However, to restore all the three previous settings, you need to manually change the values of Font Level, Large Idle
Font, and Extended Status Icons. If you cannot restore a setting, contact your service provider.

Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Display → Extra Zoom.
3 Select On to enable or Off to disable extra zoom.

Note: Extra Zoom is not available on radios using the SIM card encryption.

Setting Extended Status Icons
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Display → Extended Status Icons.
3 Select one of the following:

• Disabled – the radio always displays icons in normal size.
• Idle Only – the radio displays enlarged icons only on the home screen.
• Always – the radio displays enlarged icons both on the home screen and when browsing though the radio

menu.

Setting Screen Saver
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Display → Screen Saver.
3 Select one of the following:

• Activate — To activate/deactivate this feature.
• Text — To set the text on the screen saver when this feature is activated.

Setting Backlight
When and where to use: To save the battery power.

Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Display → Backlight.
3 Select one of the following:

• Auto – backlight is triggered by turning on the radio, by pressing any key on the device or on the accessory
that is connected to it. Also charging or getting signal from the services like: Call-Out message, RUA request,
DGNA and TX timeout during priority call are going to turn on the backlight.

• Semi Auto – backlight is turning on when you are switching on the radio, pressing assigned button to the
backlight feature, or charging.

• Disabled – backlight is disabled and the display is always dimmed.
• On – backlight is always on.
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Note: Setting the backlight intensity level by pressing the BACKLIGHT key changes the LED, keypad
backlight, and EMERGENCY button backlight intensity.

Setting Wallpaper
When and where to use: To change the look of the home screen.

Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Display → Wallpaper.
3 Select one of the following:

• On — To activate this feature.
• Off — To deactivate this feature.

Setting Contrast
When and where to use: This feature sets the contract of the display to enhanced visibility of the interface.

Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Display → Contrast.
3 Use left and right NAVIGATION key to change the value.
4 Press Ok.

Time and Date
This sub-menu controls the displayed time and date on the home screen.

Note: If the Home Display Text Message feature is enabled, Home Mode Display Text may cover time and
date, depending on the Configurable Idle Screen settings.

Note: Infrastructure synchronizes the time and date. When not within the infrastructure signal range you
can set the values manually.

Setting Time and Date on the Display
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Time & Date → Display.
3 Select one of the following:

• Time & Date — Your radio displays time and date.
• Time Only — Your radio displays time only. Format Date sub-menu is disabled.
• Date Only — Your radio displays date only. Format Time sub-menu is disabled.
• Off — Your radio does not display time nor date. Format menu is disabled.

Related Links
Display on page 26
Display on page 87

Setting the Time Format
Prerequisites: If MENU → Setup → Time & Date → Display is set to Time & Date or Time Only.
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Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Time & Date → Format → Format Time.
3 Select one of the following:

• 12-Hour — Displays the time with am (before noon) or pm (after noon) indication.
• 24-Hour.

Setting the Time Manually
When and where to use: If the time cannot update automatically through the infrastructure.

Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Time & Date → Set → Set Time.
3 Enter current time using NAVIGATION keys or keypad.
4 Press Done.

Setting the Date Format
Prerequisites: If MENU → Setup → Time & Date → Display is set to Time & Date or Date Only.

Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Time & Date → Format → Format Date.
3 Select (D — day, M — month, Y — year):

• DD/MM/YY
• MM/DD/YY
• DD-MON-YY
• YY/MM/DD

Setting the Date Manually
When and where to use: If the time cannot update automatically through the infrastructure.

Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Time & Date → Set → Set Date.
3 Enter current time using NAVIGATION keys or keypad.
4 Press Done.

Setting Time Offset
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Time & Date → Set → Time Offset.
3 Enter time offset using NAVIGATION keys.

Note: You can adjust the offset value, with 15 minute steps, up to 14 hours ahead or behind.

4 Press Done.
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Setting Automatic Updates for the Time and Date
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Time & Date → System Update.
3 Select one of the following:

• Off — All the infrastructure informations are ignored. The radio uses internal time and offset.
• Time Only — Time displayed is calculated from the offset programmed by your service provider added or

subtracted from the infrastructure time.
• Time & Offset — Time and offset are updated after receiving from the infrastructure.

Energy Economy
Energy Economy (EE) is a mode of operation to save battery life. Your radio does not monitor all downlink time
slots of the Main Control Channel. If the radio is in the charger, Energy Economy mode is not needed.

Enabling Energy Economy
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Energy Economy → EE Selection.
3 Select one of the following:

• On — Activates Energy Economy feature.
• Off — Deactivates Energy Economy feature.

Viewing the Energy Economy Status
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Energy Economy → EE Status.
3 The Energy Economy status is displayed as:

• Energy Ecnmy Is Supported By System
• Energy Economy Is Currently Not Supported By System

Transmission Power Class
Transmission Power feature enables your radio to choose whether to transmit with Class 3L or Class 4. The signal
strength icon indicates when the radio uses this feature.

Selecting RF Power
When and where to use: If you are entering the area that requires higher signal strength.

Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → RF Power.
3 Select one of the following:

• Hi RF Power — Activates this feature.
• Normal RF Pwr — Deactivates this feature.
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Note:

• Changing RF Power Class to Normal RF Pwr during calls may result in dropping the call. The
power level may be not sufficient to sustain the transmission.

• Battery consumption is higher when Hi RF Power is selected.

Note: This is a selling feature.

Book On
This menu item allows you to edit RUA/RUI feature settings to automatically accept or reject book on requests.

Related Links
RUI on page 101
RUA/RUI on page 108

Editing Book On Settings
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Book on Setup.
3 Select one of the following:

• Book on Accept — Radio accepts all the book on requests.
• Book on Reject — Radio rejects all the book on requests without any notification.

Rotary Knob
This menu item allows you to set all the related functionality of the ROTARY KNOB.

Setting Rotary Knob Mode
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Rotary Knob → Rotary Mode.
3 Select one of the following:

• Dual — Both modes are available. Turn the ROTARY KNOB to adjust the volume or press and then turn to
switch to a different talkgroup.

• Volume — The knob is used only as a volume control. Turn it clockwise to increase the audio volume level.
• Scroll — The knob is used only to change the talkgroup, or in the menu to scroll menu items.

Note: If you choose Scroll and the display shows:

• Scroll Selected — To adjust volume level go to the main menu, select Setup → Set Volume.
• Function Keys are set to Adjust Volume — You can use your programmable SIDE buttons to

adjust volume.

Note: The ROTARY KNOB and the SIDE buttons are paired. When the ROTARY KNOB mode is set to
Volume or Dual, the SIDE buttons support the One-Touch Button feature.

Related Links
One-Touch Button Feature on page 36
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Setting Rotary Lock
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Rotary Knob → Rotary Lock.
3 Select one of the following:

• Locked — Locks ROTARY KNOB, you can unlock it by selecting Unlocked or by pressing and holding ROTARY

KNOB.
• Unlocked — Unlocks the ROTARY KNOB.
• Disabled — Locking function is unavailable. Your ROTARY KNOB is unlocked all the time.

Setting In Keypad Lock
When and where to use: To set behavior of the rotary knob when the keypad is locked.

Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Rotary Knob → In Keypad Lock.
3 Select one of the following:

• Lock None — Scrolling and volume setting functionality is available.
• Lock Volume — ROTARY KNOB can be only used for scrolling.
• Lock Scroll — ROTARY KNOB can be only used for setting the volume.
• Lock Both — Scrolling and volume setting functionality is unavailable.

Setting Rotary Knob Wrap Around
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Rotary Knob → Wrap Around.
3 Select one of the following:

• On — Scrolling through the talkgroup list is looped or is moved to the next folder.
• Off — Scrolling through the talkgroup list stops after reaching first or last talkgroup in the current selected

folder.

Note: Only when Wrap Around is set to On and the Scroll Range is set to Scroll To Next, you are
able to scroll through all the talkgroups and folders.

Setting Rotary Knob Scroll Range
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Rotary Knob → Scroll Range.
3 Select one of the following:

• Stay In Range — Scrolling through the talkgroups in the current folder only.
• Scroll To Next — Scrolling through all the talkgroups and folders.

Note: Only when Wrap Around is set to On and the Scroll Range is set to Scroll To Next, you are
able to scroll through all the talkgroups and folders.

Main Menu | 93

 |   |  Send Feedback

http://docsurvey.motorolasolutions.com


Setting Rotary Knob Talkgroup Selection
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Rotary Knob → Confirm TG Sel..
3 Select one of the following:

• On — You need to confirm the talkgroup selection by pressing Select or pressing the PTT button to
immediately start a call on a new talkgroup.

• Off — Attaches to the selected talkgroup without any additional prompt

Setting Rotary Knob Function Keys
Procedure:

1 From the home screen, press the MENU key.
2 Select Setup → Rotary Knob → Function Keys.
3 Select one of the following:

• Auto — Sets the SIDE buttons according to the Rotary Mode.

Note: If the Rotary Mode is set to:

• Dual or Volume — Display shows Auto Selected (OTB), volume can be set only through
ROTARY KNOB.

• Scroll — Display shows Auto Selected (Volume), volume can be set only through SIDE buttons.
• Volume Adjust. — Sets the SIDE buttons to adjust volume level.
• OTB Feature — Sets the SIDE buttons to the predefined One-Touch Button features.

Group Setup

This sub-menu allows you to set the scanning and my groups folder.

Scan
This menu item allows you to activate/deactivate scanning, view the active scan list, and edit the scan lists. This
feature is available only for the TMO Mode. Your radio joins any group call as long as this group is defined in the
scan list and scan is turned on.

Related Links
Activating Talkgroup Scanning on page 35

Activating Talkgroup Scanning
When and where to use: If you want to monitor any TMO Group Call in the defined talkgroup list.

Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Group Setup → Scan → Scanning.
3 Select Select List and then a list name.

Your radio displays list name Selected.
4 Select Scanning → On.

Your radio is scanning on the predefined scan list.
Related Links
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Scan on page 94

Setting Talkgroups in the Active Scan List
When and where to use: If you want to edit talkgroups in the active scan list.

Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Group Setup → Scan → Active List.

Note: If Scanning is Off is displayed, go to More . . . → Group Setup → Scan → Scanning → On to
enable scanning.

3 Select View and highlight the required talkgroup.
4 Press MENU.
5 Select one of the following:

• Delete — Erases this group from the active scan list.
• Priority and select new priority to Low, Medium or High.

Setting Scan Lists
When and where to use: If you want to set up any scan list.

Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Group Setup → Scan → Scan Lists.
3 Highlight required scan list and press MENU to see additional settings:

• Rename — Enters new name for that scan list.
• Capacity — Displays the number of assigned and unassigned talkgroups for the scan list.
• Clear — Deletes all the talkgroup assigned to that scan list.
• Add Group — Adds a talkgroup to the scan list. Select one talkgroup from your talkgroup folders and assign

appropriate priority.
• Edit — Changes the priority of the required talkgroup or deletes it.

Deleting Talkgroups from Scan Lists
Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Group Setup → Scan → Scan Lists.
3 Highlight the required scan list and press MENU → Edit.
4 Highlight the required talkgroup and press MENU → Delete.

My Groups
My Groups is equivalent to Favorites (next section). Both menu items contain shortcuts to favorite talkgroups and
contact numbers, as well as allow to perform the same operations. For a detailed description of the feature, please
refer to Favorites.

Favorites

Favorites contains shortcuts to frequently used talkgroups and contact numbers that are organized in favorite folders.
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To quickly access favorite folders, from the home screen press the up NAVIGATION key. To scroll through items inside
favorite folders, you can either use the NAVIGATION keys or the ROTARY KNOB.

Favorite Folders
Favorite talkgroups and contact numbers are stored in favorite folders. The folders are common for all types of
talkgroups and contact numbers, which means that in one folder you can have items available in different modes.
Additionally, to indicate the type of each item, the radio displays a small icon next to it.

By default the radio has one favorite folder that can store up to 128 favorite items. However, you can create two
additional folders inside Favorites and give them meaningful names reflecting their content.

If Favorites contains only one favorite folder and it is empty, the only operations you can perform are adding an item
to the folder, renaming the folder, and creating a new folder.

Favorite Talkgroups
You can add any talkgroup programmed in the radio to Favorites. The radio adjusts the mode it is in according to the
currently selected favorite talkgroup. For example, if the radio is in DMO and you select a TMO talkgroup, the radio
switches to TMO, and vice versa.

Scrolling through favorite talkgroups during an ongoing group call does not terminate the call. Also deleting a
currently selected talkgroup from Favorites during an ongoing call does not lead to the call termination.

If before powering off the last selected talkgroup was a talkgroup from Favorites, the radio:

• On powering up in DMO attaches to the last selected favorite DMO talkgroup.
• On powering up in TMO attaches to the last selected favorite TMO talkgroup.

To make a call on a favorite talkgroup, use the standard procedures for group calls described in this document.

Favorite Contact Numbers
You can add any contact number from Contacts to Favorites. In case of contacts containing more than one contact
number, you need to use the right or left NAVIGATION key to specify which particular contact number to add. There are
no limitations regarding adding single contact numbers assigned to one contact – you can add all contact numbers as
separate entries. Removing a single contact number from Contacts automatically removes it from Favorites.
Similarly, removing a contact from Contacts automatically removes all the related contact numbers from Favorites.

It is impossible to make a call to a favorite contact number during emergency operations.

Making Private Calls to Favorite Contact Numbers
Procedure:

1 To select a contact number you want to call, from the home screen do one of the following:

• Press the right or left NAVIGATION key.
• Go to Optns → TG by Folder, select the required favorite folder, and highlight the contact number.

2 When you are in the following mode:
a TMO — For a simplex call, press and release the PTT button. You hear a ringing tone. Otherwise, press and

hold the PTT button. Wait for the talk permit tone before talking, and release the PTT button to listen. For a
duplex call, press and release SEND key. You hear a ringing tone.

b DMO — Only simplex call is available. Press and hold the PTT button. Wait for the talk permit tone before
talking, and release the PTT button to listen.

3 To end the call, press the END key.

Adding Folders to Favorites
Prerequisites: Favorites contains less than three favorite folders.
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Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Favorites.
3 Select [New Folder].
4 Enter a name and select Ok.

Adding Contact Numbers to Favorites
Procedure:

1 From the home screen, press the MENU key.
2 Select Contacts
3 Highlight a contact that you want to add to Favorites and using the left or right NAVIGATION key select the required

number.
4 Press the MENU key and select Add to Favorites.
5 Select a folder you want to add the contact number to and press Select.

Adding Talkgroups to Favorites
Prerequisites:

To add a DMO talkgroup, ensure that the radio is in DMO.
To add a TMO talkgroup, ensure that the radio is in TMO.

Procedure:

1 From the home screen, press the Optns key.
2 Select one of the following:

• TG by Folder – contains talkgroups arranged by folders.
• TG by abc – contains talkgroups arranged alphabetically.

3 Find and highlight a talkgroup that you want to add to Favorites.
4 Press the MENU key and select Add to Favorites.
5 Select a folder you want to add the talkgroup to and press Select.

Related Links
Entering DMO Mode on page 50

Managing Folders in Favorites
Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Favorites.
3 Highlight a required folder.
4 Press the MENU key.
5 Select one of the following:

• Rename Folder – changes the name of the folder. Enter a new folder name and press Ok.
• Delete Folder – removes the selected folder from Favorites. Press Yes to confirm deletion.

Note: You cannot delete the last favorite folder or a folder that contains at least one non-erasable
item.
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Deleting Items from Favorites Folder
When and where to use: To delete a single contact number or a talkgroup from a favorite folder.

Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Favorites.
3 Select a folder containing the item you want to remove.
4 Highlight the item and select Delete. Press Yes to confirm deletion.

Deleting All Items from Favorite Folders
When and where to use: To delete all contact numbers and talkgroups stored in a favorite folder.

Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Favorites.
3 Select a required folder.
4 Press the MENU key and select Delete All. Press Yes to confirm deletion.

My Info

This sub-menu allows you to view your own private, phone, and radio info.

Viewing and Modifying Personal Information
Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → My Info.
3 Select one of the following:

• My Private Num – displays your radio private number.
• My Phone Num – displays your radio phone number.

Note: To modify the displayed phone number, select Edit. Type the number and press Ok.

• Radio Info – displays radio information: manufacturer, product type, ISSI, TEI, Serial Number, and OPTA.

Note: OPTA information is optional.

Recent Calls

You can view the history of all calls:

• Dialed — calls you initiated.
• Received — calls you answered.
• Missed — calls you received but not answered or rejected.

Each list of calls may contain up to 50 numbers, the most recent call being at the top of the list. If the number of a
recent call is stored in the contact list, the name associated with the number appears in the recent calls list. A number
dialed more than once, appears only once in the list.
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Viewing Recent Calls
Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Recent Calls.
3 Select one of the following:

• Dialed
• Received
• Missed

4 Select a required call from the list.
5 Press the MENU key.
6 Select View.

Suggestion: Press down NAVIGATION key to bypass first two steps.

Note: Call time information is only available if the time and date are set in the radio. Call duration is
not available in the missed calls list.

Calling from Recent Calls
Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Recent Calls.
3 Select one of the following:

• Dialed (from the home screen press SEND key to access Dialed Calls list)
• Received
• Missed

Note: From the home screen press down NAVIGATION key, to access Recent Calls menu item.

4 Highlight the required call and press the PTT button for private calls or press theSEND key to make a phone call.

Note: Phone calls are only available in TMO Mode.

Storing Recent Calls to Contacts
Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Recent Calls.
3 Select Dialed, Received or Missed.
4 Press Store.

Note: If Store is not assigned to the left SOFT key, the number is already stored in your contact list.

5 To store the number as a new entry, select [New Contact]. Or, to store the number to an existing entry, select the
entry, and press View then select Edit.

6 With the contact type field highlighted, scroll left or right to display the contact type you want to assign the
number.

7 Select Done.
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Deleting Recent Calls
Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Recent Calls.
3 Select Dialed, Received or Missed.
4 Press MENU on the required call.
5 Select Delete.

Note: To erase all the calls, select Delete All.

Shortcuts

This sub-menu allows you to set up shortcuts to access frequently used menu items.

Creating Menu Shortcuts
When and where to use: To assign a shortcut for the menu item.

Procedure:

1 From the home screen, press the MENU key.
2 Scroll to the item you want as a shortcut.
3 Press and hold MENU when the item is highlighted.

Example:
Creating a shortcut to the All Tones options.

1 From the home screen, press the MENU key.
2 Select Setup → Tones.
3 Highlight All Tones and press and hold MENU until Assign Shortcut for:All Tones is

displayed.
4 Select Yes and ShortcutsKey:1 is displayed.
5 Press Done.

Note: To use this shortcut, from the home screen, press MENU and the key 1.

Editing Menu Shortcut Lists
Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Shortcuts.
3 Highlight a required shortcut and press MENU.
4 Select one of the following:

• Edit — Changes the assigned key. Type required number and press Ok.

Note: Type a number between 1–20.

• Delete — Erases highlighted shortcut. Select Yes to confirm.
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• Delete All — Erases all the shortcuts. Select Yes to confirm.

RUI

This menu item allows you to log in/out to the radio.

Related Links
RUA/RUI on page 108
Book On on page 92

Logging On
Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → RUI → Log on.
3 Highlight:

• User ID and press Select to enter User ID List. If you are a new user on this radio, select [New User ID] and
enter your user ID. Otherwise select your user ID from the list.

• Second line and press Edit, to enter user ID and press Ok.
4 Select User PIN, enter your credentials, and press Ok.
5 Logging screen is displayed.

Logging Off
Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → RUI → Log off.
3 Press Accept.

Networks

This menu item allows you to switch between the radio operation modes.

Related Links
Entering TMO / DMO Mode on page 33
Selecting Network Operation Mode on page 101

Selecting Network Operation Mode
Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Networks.
3 Select one of the following:

• Networks Sel — Selects the network to which the radio is allowed to register.
• Trunked Mode — Switches to the mode using infrastructure.
• Direct Mode — Switches to the mode without using infrastructure.
• Repeater Mode — Switches to the Repeater Mode.
• TXI Mode — Select Activate to stop sending any radio transmission.
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Note: If the radio is in TXI Mode, it is not possible to switch from Direct Mode to Trunked Mode
or Repeater Mode.

Related Links
Entering TMO / DMO Mode on page 33
Networks on page 101

Selecting Your Network
Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Networks → Networks Sel → Home Only.
3 Your radio registers to the home network. If several home networks are defined, the radio registers to the first

available network on the list.

Using the Select Net Registration
Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Networks → Networks Sel → Select Net.
3 Select the required network from the list.

Your radio registers to the selected network.

Using the Foreign Network Registration
When and where to use: Use this feature to migrate to another predefined network, when you are out of the range of
your network and your radio displays the No Service message.

Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Networks → Networks Sel → Foreign Nets.

Using Any Network
When and where to use: Your radio has lost its home network coverage and can register to any network. Only clear
authentication is supported on any network.

Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Networks → Networks Sel → Any Network.
3 Your radio selects and registers to the network automatically from the predefined list.

Using the Migrate To Registration
When and where to use: Use this feature to migrate to another predefined network, when you are out of the range of
your network and your radio displays the No Service message.

Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Networks → Networks Sel and choose one of the following option:

• Migrate to... — Selects the required network form the list. To view the network ID press MENU key then
press Select.

• Auto — Your radio automatically attaches to the predefined network.
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Location

See the GPS Location Service for more information.

Related Links
GPS Location Service on page 61

Viewing Your Position
Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Location → Position.
3 Scroll to view the results about the last time your location was calculated.

Note: To refresh your position:

• Select Position — the radio refreshes its position automatically
• Press Refresh

Changing GPS Accuracy
Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Location → Accuracy.
3 Select one of the following:

• Medium (default) — Power consumption optimization is combined with less position accuracy.
• High – Better position accuracy is combined with less power consumption optimization.

Note: If connected to an external charging device, the radio automatically enters the High mode.

Packet Data

The Packet Data (PD) Service allows you to transfer data in a TETRA system using the Internet Protocol (IP).

Note: To transfer data from a standard computer over the air, connect the computer via the data cable
PMKN4025 with your radio. Your service provider has to setup additional applications on your computer.

If set up by your service provider it is possible to accelerate the transmission by using the Multi-Slot Packet Data
(MSPD) Service.

Note: This is a selling feature.

Viewing Data Statistics
Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Packet Data.
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Note: Data services are only available in TMO Mode. The data option must be set to Voice & Data or
Data Only.

3 Select one of the following:

• Sent Data — the number of KBs sent and throughput since current Packet Data activation is displayed.
• Received Data — the number of KBs received and throughput since current Packet Data activation is

displayed.
• Bandwidth — active data session percentage is shown.
• Failed Transfer — the percentage of failed sent/received packets.

Note: N.A. — standby packet data session.

Viewing Encryption Status
Procedure:

1 From the home screen, press the MENU key.
2 Select More . . . → Packet Data → Encryption.
3 The encryption state of the ongoing packet data session is displayed:

• Packet Data Channel Clear
• Packet Data Channel Encrypted
• EncryptionN/A (clear)
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Chapter

6
Features

Private Call

The Private Call, also called point-to-point, or individual call, enables calling between two individuals. No other radio
can hear the conversation. This call type can be carried out in two ways:

• Duplex call (if the system allows), in TMO Mode. Both parties can speak at the same time.
• Simplex call, in TMO or DMO Mode. Only one party can speak at a time.

When a DMO Private Call takes place, radios not involved in this call receive the channel busy indication. The radios
are identified using its radio numbers.

Related Links
Emergency Individual Calls (Private or MS-ISDN) on page 56

Making Private Calls
Procedure:

1 From the home screen, enter a number.
2 If Private is not the first type of call presented, press Ctype repeatedly to select it.
3 When you are in the following mode:

a TMO — For simplex calls, press and release the PTT button. You hear a ringing tone. Otherwise, press and
hold the PTT button. Wait for the talk permit tone before talking, and release the PTT button to listen. For
duplex calls, press and release the SEND key. You hear a ringing tone.

b DMO — Only simplex calls are available. Press and hold the PTT button. Wait for the talk permit tone before
talking, and release the PTT button to listen.

4 To end the call, press the END key.

Radio Messaging System (RMS)

The Radio Messaging System (RMS) feature enables radio to receive and send RMS messages through the TETRA
network using the Short Data Service.

There are two types of RMS messages:

• RMS Status – a predefined code that is sent bidirectionally between the radio and the service provider. The radio
can have up to ten statuses that are assigned to numeric keys from 0 to 9. The latest received or sent RMS status is
kept on the home screen until the next power cycle. A received RMS status is displayed in blue color font on the
home screen.

RMS Free Text – a unidirectional message containing free text that is sent to the radio by the service provider.
Since this type of message is longer, the radio displays only its beginning on the home screen and to read its
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remaining part, you need to go to Menu → Messages → RMS Box. The latest RMS free text is kept on the home
screen until the next power cycle.

RMS free text messages and incoming and outgoing RMS statuses (with the exception of RMS statuses sent) are
stored in the RMS Box. Its capacity is maximum ten entries for incoming and outgoing RMS messages. If the RMS
Box is full, any new incoming or outgoing RMS message overwrites the oldest message (received or sent).

The radio receives and sends RMS messages only from and to the numbers predefined by your service provider.

Note: This is a selling feature.

RMS Icons
Table 19: RMS Icons

Icon Description

RMS Status Received

Indicates a new RMS status message just arrived.

RMS Status Sent

RMS Box Read Message

RMS Box Unread Message

Sending an RMS Status
Prerequisites: Your service provider enabled this feature and the radio is in the RMS mode.

When and where to use: To send a predefined RMS status using numeric keys.

Procedure:

1 Press and hold a required key. If you press the key for too short, the radio initiates a Private/Phone/PABX call.

One-Touch Dial

This feature allows you to call by pressing and holding one of the keys (1-9).

Note: If the One-Touch Button feature is enabled, One-Touch Dial is disabled. If no feature is assigned to a
button, your radio displays an Unassigned Button message.

Talkgroup Dialing by Index

This feature allows you to attach to any talkgroup by dialing its index, instead of choosing it from the talkgroup
folders and lists.

Note: It is also known as Talkgroup Speed Dial.
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Viewing the Talkgroup Speed Number
Procedure:

1 From the home screen, press Optns.
2 Select one of the following:

• TG by Folder then select the folder and highlight the required talkgroup.
• TG by abc enter up to 15 characters to narrow the talkgroup names and highlight the required talkgroup.

3 Press MENU → View.

Example:
Radio displays SpeedNum1*, which means that this talkgroup speed number is 1.

Selecting Talkgroups by Index
Procedure:

1 From the home screen, enter talkgroup speed number and *.
2 Press Attach.

Suggestion: To start a group call, press the PTT button.

Phone and PABX Calls

The Phone Call allows you to call a landline telephone number or a cellular mobile phone number. The Private
Automatic Branch Exchange (PABX) Call allows you to call local (office) extension numbers.

Making Phone or PABX Calls
Procedure:

1 From the home screen, enter the number.
2 If Phone or PABX are not the first type of call presented, press Ctype repeatedly to select it.
3 Press SEND key.

Phone/PABX Speed Dial

This feature allows you to dial Phone/PABX by a shortened number of up to three digits instead of the full number.
The Phone/PABX Speed # number is assigned when the dialed number is added in the contact list.

Note: This feature is available only in TMO Mode.

Using the Phone/PABX Speed Dial
Procedure:

1 From the home screen, enter the predefined Phone/PABX speed dial number and # key.
2 Press SEND key.
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DTMF Overdial

This feature allows you to communicate with an automated answering device (for example, the voice mail or
answering machine) during an on-going private, phone or PABX call.

While in an on-going private, phone or PABX call, press the DTMF keys (0-9, *, #). When pressed, the DTMF key
sounds a tone and the entered digit is displayed on the screen.

Short Number Dial

This feature allows you to dial part of the full number of the person you wish to call. Your radio automatically
completes the number.

Your radio number is 4282564.

1 Dial 564 (instead of 4282564, the full number).
2 To place the call, press the PTT button or the SEND key.

RUA/RUI

Radio User Assignment (RUA) and Radio User Identity (RUI) enables authentication service. Only the successful
logon on any temporary radio, provides the full access and your permanent radio functionality, so you can be still
reached with your permanent number. A logon failure results in limited service.

You can differentiate the RUA/RUI state by the interface color:

• Blue — you are logged on
• Gray — you are logged off

Radio States
• Full Service — user logon was successful. Your radio has full functionality.
• Limited Service — user not logged on. Specified by the service provider.
• Pseudo Log On — occurs only in the Local Site Trunking (LST). You radio has full functionality available

(depending on the service provider settings) except some services like forwarding calls. The RUI Pseudo Log On
icon is displayed.

Book On
Your service provider assigns particular radio to one person for a predefined period of time. You are only going to see
the screen with your login and the full service is granted.

Force Off
Your service provider can log you off. Radio displays Force Off.

Note: This is a selling feature.

Related Links
RUI on page 101
Book On on page 92
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WAP

Wireless Application Protocol (WAP) is a standard for application layer network communications in a wireless
communication environment such as TETRA network. The protocol is used to access the mobile web from a radio
through a WAP browser.

Note: This is a selling feature.

Related Links
WAP Box on page 71
WAP Push on page 116

WAP Browser
The Openwave Mobile Browser is a WAP-compliant user agent. The WAP browser provides all of the basic services
of a computer-based web browser. Whenever any preemptive display interrupts the browser session, the browser
needs manual reactivating to return. The WAP browser does not support right-to-left languages (as Arabic and
Hebrew); English is used instead. For the content in these languages, the characters are not displayed.

Note: Depending on the radio configuration and the network conditions, the WAP browser may not display
images properly (or may display them with a delay).

Entering the Browser
Prerequisites: From the home screen, press the MENU key. Set Setup → Data Setup to Data Only or Voice & Data.

Procedure:

1 From the home screen, press the MENU key.
2 Select Browser.
3 Optional: Exit the browser by pressing and holding the END key.

Entering Browser Menu Panes
Prerequisites: You are in the browser.

Procedure:

1 Press Menu or MENU key.
2 Usually, it brings up the Navigate pane, or the last browser menu pane.

Note: If the web page you navigated to has two or more soft keys/options, the Options pane pops up.
From here, you may scroll to other panes with the left or right navigation keys Or you may select
Browser Menu and then scroll to the required pane.

Tips for Browsing
Create and use the following for easy browsing.

Creating Bookmarks through the Navigate Pane
Procedure:

1 Enter the browser and browse to the required page.
2 Press Menu to enter the browser menu.
3 Select Mark Page.
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4 The screen displays the title and URL of the marked page.
5 To save it:

a Press Save (or Select) to save the page in bookmarks.
b Select Menu and select an option:

• Save — Confirms the bookmark creation.
• Edit — Allows you to edit the title, folder, choice, and URL of the created bookmark.

Creating Bookmarks through the Bookmarks Pane
Procedure:

1 Enter the browser.
2 Scroll to Bookmarks pane.
3 Select Organise (if there are no saved bookmarks), or More... .
4 Select Menu.
5 Scroll to New Bookmark.
6 Enter the bookmark title and URL, and select its location.
7 Press Save.

Using Bookmarks
Procedure:

1 Enter the browser.
2 Scroll to Bookmarks pane.
3 Scroll to the required bookmark and select Go. The bookmark downloads the selected page from the web.

Creating Hotkeys
Procedure:

1 Enter the browser.
2 Scroll to Bookmarks pane.
3 Scroll to the required bookmark.
4 Press MENU. Select Hotkeys.
5 Select an unassigned key (0–9).
6 Click Assign. The display shows the bookmark and its assigned hotkey.

Using Hotkeys
Procedure:

1 Enter the browser.
2 Press and hold a hotkey to download the corresponding bookmarked page from the web.

Saving Pages
When and where to use: Save a page for off-line browsing.

Procedure:

1 Enter the browser and browse to the required page.
2 Press Menu.
3 Scroll to Tools pane.
4 Select Save Page. Edit the proposed page title if required. Scroll down and select Save. The page will be saved in

the Bookmarks Saved Pages folder.
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Selecting Saved Pages
Procedure:

1 Enter the browser.
2 Scroll to Bookmarks pane.
3 Select Organise (if there are no saved bookmarks), or More... .
4 Select Go to enter the Saved Pages folder.
5 Select a saved page and press Ok. The display shows the saved page. Depending on the saved page, you may

browse the web from here.

Disabled Packet Data Service
If there is no Packet Data Service, your radio displays Error:No Network Available when entering the browser for
the first time. Select left SOFT key to retry entering, or right SOFT key to enter the browser menu.

When re-entering the browser with previously available Packet Data, the radio displays the last browsed page, or the
last page to which you navigated off-line.

Disabled Browser Entry
Browser entry is disabled:

• During any type of voice call, except Ambience Listening Call
• In DMO Mode
• During Emergency Mode
• During PIN lock
• Service provider has not configured this feature
• When the radio is disabled

Note:

• Browser entry is enabled during Ambience Listening (AL) Call. If you navigate to previously stored
pages, the AL state remains.

• When you activate Packet Data for the first time, AL is disconnected, and you have the same look and
feel as if you were not in AL before.

Keys Usage
When the browser is active, the following usage described occurs inside or outside the editor.

Table 20: Browser Keys Usage

Key Press Action

0–9 key In the editor: enters a digit and/or character
depending on the text entry mode selected.
Outside the editor: in a numbered list, selects the
required item list.

0–9 key (hold) In the editor: standard use.
Outside the editor: hotkey for navigating to the
numbered bookmark.

* key (press or hold) In the editor, inserts a space.
Table continued…
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Key Press Action

# key (press or hold) Brings up the Text Input pane, while in editor.
Otherwise, sounds a wrong key press.

Left or right SOFT key Selects the option that appears in the display directly
above the left and right soft key (part of the page).

Up NAVIGATION key While in list of options, moves up one line.

Up NAVIGATION key (hold) Moves up on page.

Down NAVIGATION key While in list of options, moves down one line.

Down NAVIGATION key (hold) Moves down on page.

Left NAVIGATION key Moves to the previous pane.
In the editor: moves left.

Left NAVIGATION key (hold) Functions as backward.

Right NAVIGATION key Moves to the next pane.
In the editor: moves cursor to the right and inserts
space if at the end of the word.

Right NAVIGATION key (hold) Functions as forward.

Center of NAVIGATION keys (hold) Auto-repeat.

MENU key Brings up the browser menu.

END key Press to deactivate the browser.

SEND key Disabled in browser active state.

ROTARY KNOB Used for volume adjustment only.

EMERGENCY button Deactivates the browser. The radio enters Emergency
Mode.

Browser Menu Panes Overview
The browser menu includes the following panes:

Table 21: Browser Menu Panes

Menu Pane Description

Navigate Provides access to the home page and commonly used items.

Bookmarks Provides access, editing, and storage options to stored bookmarks and saved
pages.

History Provides access to recently visited pages and shows the position of the currently
loaded page in the history stack.

Tools Provides access to applications and utilities.

The following panes are displayed according to the context:
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Table 22: Additional Menu Panes

Menu Pane Description

Options Displayed only when there are additional options for the pane or page.

Image Displayed only when an image is selected. Provides access to image details,
storage, and display use.

Input Text Displayed only in text entry mode. Provides access to text entry mode (for
example: symbol).

Navigate Pane
You can select one of the following items:

• Home — for loading the home page.
• Open Page — for entering the URL.
• Search — item disabled.
• Mark Page — for creating (saving) a bookmark for the current document. A title and URL for the bookmark are

displayed, and the root folder is chosen for the location.
• Forward — for navigating to the document located one step forward in the navigation history. If there is no

forward history, this item is disabled.
• Reload — for reloading the current document.
• Advanced... — see following section.

Advanced...
From the Navigation pane select Advanced... to see the following options:

• Settings...

• Downloads — for setting download preferences. You may deactivate the downloading of images and objects.
The browser displays a special icon instead of the images and objects.

• Scroll Mode — for setting the scrolling mode and speed.
• Key Press Timeout — for setting key press time-out. This time-out is used for text entry.
• Set Proxy — select the WAP Proxy (1, 2, 3). The browser connects to the web via the selected proxy or

gateway. The network provider installs and configures the proxy. To establish a secure session, select a secure
proxy. Please ask your service provider which proxy is configured for a secure session. Though you can
choose your home page, the service provider may decide to force its own home page on your terminal.

• Circuit Prompt — for turning on/off the circuit prompt.
• Resend Data Prompt — for turning on/off the data re-send prompt.

• Security...

• Secure Prompt — for enabling/disabling the browser to inform you that it replaced a non-secure connection
with a secure connection, and the other way around.

• Current Certificate — for viewing the digital certificate identifying the server that delivers the current
document. A Certificate Authority (CA) digitally signs and thus authenticates this certificate. Up to ten
additional custom WTLS certificates can be added to the default list of certificates installed. Please ask your
service provider if you wish to have these custom WTLS certificates added.

• CA Certificates — for viewing the digital certificates installed in the browser and digitally signed by
Certificate Authorities (CA).

• Send Referrer — for turning ON/OFF sending of the HTTP Referrer header as part of HTTP requests. The
Referrer header provides the URL of the link source to the server.

• Authentication — for turning ON/OFF the caching of HTTP Authentication credentials. HTTP
Authentication protects access to content on the server. If you try to access a protected content, you enter your
credentials (user name or password).
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• Clear... — for clearing of browser data: history, cache cookies, or auto-fill.
• Restart Browser — for restarting the browser.
• About... — for showing the information about the current version of Openwave Mobile Browser.

Bookmarks Pane
If there are bookmarks in the root folder, select More... to access the Options pane. If the root folder is empty, select
Organise... then press MENU key to access the Options pane. The Options pane allows you to manage bookmarks.
The Saved Pages folder contains snapshots of saved pages.

Working with the Options Pane for Selected Bookmarks
Procedure:

1 From the Bookmarks pane select More... .
2 Scroll to a bookmark.
3 Press MENU to open the Options pane for that bookmark.
4 Select one of the following:

• Back — for displaying the page associated with the bookmark (page is downloaded if not available in cache).
• Details — for modifying the bookmark title and URL.
• Delete — for deleting the bookmark.
• New Bookmark — for creating a new bookmark.
• New Folder — for creating a new folder.
• Move — for moving this bookmark to a new folder (or in Bookmarks).
• Delete All — for deleting all bookmarks.
• Hotkeys — for assigning hotkeys to available bookmarks.

Working with the Saved Pages Folder
Procedure:

1 From the Bookmarks pane select Saved Pages folder.
2 The browser displays the page (snapshot) saved using Save Page in Tools pane.
3 Scroll to a saved page.
4 Press Menu to open the Options pane for the saved page.
5 Select one of the following:

a Back — for displaying this page saved on its cache.
b Details — for modifying the page title and URL of the saved page.
c Update Page — for replacing the saved version with the current version (to be downloaded from server).
d Delete — for deleting this page from its cache.
e Delete All — for deleting all the saved pages from its cache.
f Cancel — for exiting this pane and returning to the last page displayed.

History Pane
This pane displays the list of recently visited pages (up to nine history entries can be listed). Each history entry shows
its title, if present. Otherwise, No Title is displayed.

Navigating to Recently Visited URLs
Procedure:

1 Select the URL.
2 Press Ok.
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Tools Pane
Procedure:

1 From the Tools pane select More...
2 Scroll to a document.
3 Select MENU key to open the Options pane for that document.
4 Select one of the following:

• Show URL — For displaying the current page URL.
• Save Page — For creating a snapshot for the current document.
• Find Text — For finding a text string in the current document.
• Copy Text — For copying text from the current document to the clipboard.

Options Pane
This pane is specific to the page or pane being displayed.

Image Pane
This pane appears in the browser menu when you enabled the download of images through Navigate pane >
Advanced... > Settings... .

The following items are available:

• Save — for saving the image in the terminal.
• [Send] — for sending the image to the destination of your choice.
• Reload — for reloading the image.
• Details — for displaying the image details.
• Show Image — for showing the image on its own page.

Text Input Pane
Prerequisites: This pane is visible when the browser menu is opened and text entry field is active.

When and where to use: To input the text for the URL.

Procedure:

1 Select the URL.
2 Press abc.

The text input pane opens up.
3 Select www.
4 Scroll the required extension (for example: .com).
5 Press .com. The screen displays the URL with the selected extension.

Table 23: Browser Text Input Icons

Mode Soft Key Action

Alphabetic characters - lower case abc Enter text in lowercase.

Alphabetic characters - upper case ABC Enter text in uppercase.

Numeric 123 Enter numbers and symbols.

http mode www Enter
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WAP Push
WAP push allows WAP content to be pushed to a radio. This push is carried out by sending a specially formatted
(Push Access Protocol) XML document to the Push Proxy Gateway, that in turn forwards the document to the radio.

A WAP push message is an encoded message including a link to a WAP address. On receiving a WAP push, a WAP
enabled radio automatically gives the option to access the WAP content. The implemented WAP push is compliant to
WAP 2.0 standard.

The radio supports WAP 2.0 through a proxy only. Proxy-less connections are not supported.

This is a selling feature.

Related Links
WAP Box on page 71
WAP on page 109

New WAP Messages
Types of the WAP Messages and their priorities:

Note: Your service provider sets the priority of the message.

• Push Message

• High — animation and the icon (blinking) are displayed with the New WAP Message tone.
• Medium — animation and the icon are displayed with the New WAP Message tone.
• Low — icon is displayed with the New WAP Message tone.
• Delete — available only if you are is in WAP Box, the text WAP Message deleted remotely is displayed,

otherwise there is no indication.

Note: Animation is not displayed if you are in a call, or in Emergency Mode, or in Call Out, or in
message editor, or PIN lock state, or switching to DMO.

• Load Push Message

• High — browser opens to the user with the New WAP Message tone.
• Low — the icon is displayed with the New WAP Message tone.

Note: Browser does not open if you are in a call, or in Emergency Mode, or in Call Out, or in message
editor, or PIN lock state, or switching to DMO.

Viewing WAP Messages
Procedure:

1 From the home screen, press the MENU key.
2 Select Messages → WAP Box.
3 Select the required message.
4 Select Go to to view the message in the browser.

Call-Out

This feature allows you to receive Call-Out alerts. On receiving the Call-Out messages, the radio interrupts current
services and attends to the Call-Out alert without any further delay. After call-out alert has been cleared, the radio
exits Call-Out mode and reverts to normal mode. During Call-Out mode you are only able to receive Emergency
Calls.
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Note: To read an entire Call-Out message, scroll down the screen by pressing the down NAVIGATION key.
The length of the message is indicated by the vertical red bar on the left of the screen.

Figure 4: Call-Out Message

Note: This is a selling feature.

Related Links
CO Box on page 71

Types of Call-Out Alerts
There are four types of the Call-Out alerts:

• Normal Call-Out – an alert message that is sent by a dispatcher either to a single radio or to a group of radios.
• Storm Plan – an alert message that is sent by a dispatcher to a group of radios. To raise its reliability, it is sent

several times. You are not able to respond to the Call-Out alert and any key press takes you to the information
phase.

• Fallback Mode – an alert message that is limited only to voice communication. To initiate this type of Call-Out,
press a One-Touch key predefined by your service provider. It can be cleared manually.

Note: Fallback is only possible when the radio is in Local Site Trunking.

• Test Call-Out – a special Call-Out alert that is sent by the dispatcher to test this feature. On receiving the Test
Call-Out, the radio plays a tone and displays Test Call-Out. To respond and clear the alert, press the Test
OKSOFT key.

Call-Out Modes Interaction
Call-Out feature operation is different in other modes:

• TXI Mode — you can read the message but you cannot respond to it. You have an option to leave the TXI Mode
by pressing soft key or reject the Call-Out message.

• DMO Mode — Call-Out is not supported.
• Emergency Mode — all Call-out alerts are ignored.

Call-Out Service Phases
In the Call-Out mode there are following phases:

• Alerting phase — receives a Call-Out message. The alarm tone indicates the message. Text is displayed and you
have following options to use: Accept, Reject or MENU. If you accept the alert, no other service from this point
can interrupt.

Note: You can stop the alert tone by pressing PTT or any of the soft keys.

• Information phase — you are still in the Call-Out mode and you can receive more detailed information about the
incident that occurred through subsequent text or the voice message. You can query for more information using
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voice group call or Call-Out text function which enables you to send a text message. You can always respond and
send back the text or the voice message using voice group call.

Shadow Groups (Address Bundle)

The Shadow Groups feature (also known as Address Bundle) offers a way of sending messages to multiple
destinations or recipients simultaneously. Three types of messages are supported by the feature:

• Status messages (including Emergency Alarms)
• GPS LIP (TETRA Location Information Protocol) reports
• RMS/FMS messages

Shadow Groups in TMO

Each Shadow Group may contain up to four target addresses. Each talkgroup may be configured to send status
messages, GPS LIP reports, or RMS/FMS messages to a specific Shadow Group.

Shadow Groups in DMO

In DMO, the Shadow Group contains one target address. Each talkgroup may be configured to send status messages
or GPS LIP reports to a specific Shadow Group.

Each radio can store up to 255 Shadow Groups (both in TMO and DMO).

The Shadow Groups feature may affect Emergency Calls setup time to be slightly elongated.

Note: This is a selling feature and needs to be enabled by your service provider.
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Appendix

A
Tones

Table 24: Radio Tones

Tone Name Default Tone Diagram

Back to Coverage
Back to Full Service

0 100 200 300 400

2400
2100
1800
1000
900
600
400
200

[Hz]

[ms]

Clear-to-send
0 100 200 300 400

2400
2100
1800
1000
900
600
400
200

[Hz]

[ms]

Bad Key Pressed
0 100 200 300 400

2400
2100
1800
1000
900
600
400
200

[Hz]

[ms]

From Out-of-Service to In
Service

0 100 200 300 400

2400
2100
1800
1000
900
600
400
200

[Hz]

[ms]

In Emergency
0 100 200 300 400[ms]

2400
2100
1800
1000
900
600
400
200

[Hz]

Talk Permit
0 100 200 300 400[ms]

2400
2100
1800
1000
900
600
400
200

[Hz]

• Talk prohibit
• System busy
• Time-out timer expire
• Called radio not available

or busy
0 100 200 300 400[ms]

2400
2100
1800
1000
900
600
400
200

[Hz]

Call Disconnected or Failed
Due to Network

0 100 200 300 400 500[ms]

2400
2100
1800
1000
900
600
400
200

[Hz]

Table continued…
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Tone Name Default Tone Diagram

Toggling Betwen DMO and
TMO

0 100 200 300 400[ms]

2400
2100
1800
1000
900
600
400
200

[Hz]

Entering/Exiting Local Site
Trunking

0 100 200 300 400[ms]

2400
2100
1800
1000
900
600
400
200

[Hz]

Receiving/Sending
Emergency Alarm

0 100 200 300 400[ms]

2400
2100
1800
1000
900
600
400
200

[Hz]

Emergency Alarm Failed
0 100 200 300 400 500 600[ms]

2400
2100
1800
1000
900
600
400
200

[Hz]

Entering Emergency
0 100 200 300 400 500 600[ms]

2400
2100
1800
1000
900
600
400
200

[Hz]

Exiting Emergency
0 100 200 300 400 500 600[ms]

2400
2100
1800
1000
900
600
400
200

[Hz]

Entering/Exiting TXI
0 100 200 300 400 500 600[ms]

2400
2100
1800
1000
800
600
400
200

[Hz]

Low Battery Alert
0 100 200 300 400[ms]

2400
2100
1800
1000
900
600
400
200

[Hz]

Remote Control
0 100 200 300 400

3000
2250
1500
1000
900
600
400
200

[Hz]

500 600[ms]

Note: All the audible indications can be disabled by your service provider.
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Appendix

B
LED Indications

Table 25: LED Indications

Indication Status

Solid green In use

Blinking green In service

Solid red Out of service

Blinking red Connecting to the network
Entering DMO

Solid orange Transmit inhibit in service
Channel busy in DMO

Blinking orange Incoming call

No indication Idle
Radio powered down
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Appendix

C
Troubleshooting

Your radio displays the following messages:

Table 26: Displayed Messages

Message Message Description

...-Received Call received but not answered, or rejected.

Attachment Failed Your radio could not perform talkgroup attachment. It keeps on
trying. If it does not succeed, try another talkgroup.

Authenticate Failure Your radio could not register on an authenticated system (for
example, the Authentication Key is incorrect, or authentication is
disabled).

Battery level too low. The battery charge level is too low to perform the required operation.

Call Cancelled You have canceled the call.

Call Ended • Faulty channel. Please try later.
• You have ended the call.

Call Forwarding The radio you are trying to call is not available and the call is being
forwarded to another radio.

Call Modified The call you are participating in has been modified.

Call Preempted Channel being used for priority.

Decryption Failed: An error occurred while decrypting a message or call.

Emergency In Use

Wait For Mic

The Hot Microphone feature is active, but the channel transmit grant
has been given to another Emergency call on the same talkgroup.
Your radio microphone is not active during this time, but it
automatically tries to regain talk permit after a predetermined time.

Emgcy Mic Ended The Hot Microphone timer automatically expired, or you pressed the
PTT button to cancel the Hot Microphone feature.

Emergency Mic On The Hot Microphone feature is active, and your radio is automatically
transmitting hands free emergency audio.

Empty Entry The speed number you dialed does not exist, or the number exists but
the group is non-selectable.

Faulty Unit

Error

Self-test failed. An operational fault has been detected with your
radio. Record the error number. Turn your radio off and contact
service.

Gateway available Your radio has connected to a gateway.
Table continued…
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Message Message Description

Gateway not available Your radio cannot connect to a gateway, or connection has been lost.

This group already exists The group you are attempting to add exists in the My Groups folder.

Individual Calls Only You can make only individual (private) calls.

Insufficient visible data Your radio is in the process of determining your location. This
process may take several minutes to complete.

Insufficient visible satellites Your radio is in the process of determining your location. This
process may take several minutes to complete.

Invalid ID The entered number is not valid.

Invalid Shortcut Position The entered number is not valid.

Limited Service Emergency Calls, Emergency Alarms, and mobility operations (for
example group attachment) are allowed. All other incoming and
outgoing call and data services are blocked.

List Empty There are no programmed entries in the scrolling list. Type the entry.

List Not Attached All talkgroups in the scan list are not attached.

List Partially Attached The scan list is active, but not all talkgroups are attached to it.

Message Delivered Indicates mail successfully delivered.

Message Failed Indicates mail delivery failure.

New Delivery Status You have received a new Delivery Status.

No Service Your radio is outside coverage. Return to coverage.

Not allowed in repeater mode The service or feature is not available in the Repeater Mode..

My Groups

Is Empty

You cannot view/delete groups when the My Groups folder is
empty.

My Groups

Is Full

You are not allowed to add a group to the My Groups folder as it
already contains the maximum allowed number of groups.

Network Trouble Network problems. Please try again later.

No Answer The called party does not answer.

No Entries This message is displayed when accessing an empty list.

No Group • Attachment failed. Your radio detached from current talkgroup.
Please wait until it attaches again to the current talkgroup.

• Displayed when you are out of the normal coverage area of your
selected talkgroup. Please select a new talkgroup that is valid for
your working location.

• Indicates a favorite group was removed from the My Groups
folder.

No List The network list is empty.

No New or Old Messages Indicates there are no new or old messages in the Inbox.
Table continued…
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Message Message Description

No Selected Scan List You selected an empty network list.

No Service Your radio is out of coverage.

Not Allowed To Initiate Call You are not allowed to dial a number which is not in the address
book.

Not Allowed To Transmit Release the PTT button and try again later. You are not allowed to
send a text message or a status message to a number which is not in
the address book.

Single TalkGroup Only There is only one programmed entry in the scrolling list.

Overheating, Please Turn Radio Off Your radio turns off. Keep it turned off for 5 minutes.

Party Busy Called radio is busy.

Party Not Available Called radio is out-of-range or turned off. Please try again later.

Please Try Again You could not call.

Please Wait Connecting A message during startup.

Reconnect Radio to the Charger The radio cannot detect the charger. Ensure that the charger is
connected correctly and that the pins on the radio and the charger are
clean.

Registration Failure Your radio could not register within the system. Please try again later.

Repeater available Your radio has connected to a repeater.

Repeater not available Your radio cannot connect to a repeater, or connection has been lost.

Service Denied Invalid number. Call your service provider.

Service Not Available This service is not available on the current network.

Service Restricted This service or feature is restricted by your service provider, it has
not been purchased, or it is not available.

TalkGrp ... cannot be deleted Your service provider set this group so you cannot delete it from the
favorite talkgroup folder.

Try Again Later The requested service is temporarily unavailable.

Radio Disabled Check with your service provider.

Unit is OK

Warn:

Self-test error. A minor fault has been detected. Your radio is still
fully operative. If this error recur, note the error code and contact
service.

Unit Not Attached You radio could not attach to the system. The talkgroup may not be
defined in the system. Please try another group.

Unassigned Button The message is displayed when no feature is assigned to a button.
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Appendix

D
Maintenance

Suggestion:

• Before using your radio for the first time, remove the plastic lens protector from the display, and charge
the battery until the LED green light appears.

• Battery charging must occur only in non-hazardous areas.
• Clean the connector frequently and before the programming procedure for example, with a soft brush

(do not use fluids).

Storage

• Do not store the battery where the temperatures exceed +65 °C or fall below -20 °C.
• New Lithium-Ion batteries may be stored in ventilated, cool and dry areas with some capacity loss in the life

cycle.
• It is not recommended to store the batteries when they are fully charged or discharged.

Extending Battery Life

A battery is an expendable part and may need replacing during the life of the radio. To ensure maximum service life
of your radio, always replace the battery with a genuine Motorola replacement. In order to ensure maximum life for
your battery:

• Do not charge it unless necessary (low battery indication).
• Charge it until full charge indication is on.

Battery Charging Temperature

When the battery is fitted to the radio, it charges within the temperature range of 0 °C to 45 °C. When the battery is
charged separately (without the radio), the temperature range of battery operation is from 0 °C to +45 °C in charger
mode, and from -10 °C to +60 °C in discharge mode.

If, during charging, the temperature is out of range, the battery might not be fully charged since the charging is
temporarily stopped until the temperature becomes suitable.
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Battery Charging Rules

Generally, to reduce the number of charge cycles as much as you can, wait for the Low Battery message to charge, as
it ensures maximum battery life. Do not use your charger as a radio holder or leave your radio and fully charged
battery connected to the charger while not charging. Continuous charging shortens the battery life.

Additional Battery Warnings/Cautions

• Battery storage above 60 °C and below -20 °C is not recommended.
• To prevent injury, do not allow metal objects to touch the battery contacts.
• Do not disassemble.
• Do not throw in fire.
• Do not dispose of battery in household waste.

Looking after Your Radio

Never leave your radio or battery in extreme temperatures (over 60 °C), for example, behind a windscreen in direct
sunlight.

Do not immerse your radio in water.

To clean your radio, use a moistened or antistatic cloth.

128 | Maintenance

Send Feedback  |   | 

http://docsurvey.motorolasolutions.com


Tartalom

Ábrák listája...................................................................................................................................11
Táblázatok listája...........................................................................................................................13

1. fejezet: Általános információk........................................................................... 15
Biztonsági előírások............................................................................................................................................ 15
Szerzői jogok.......................................................................................................................................................15
Jelmagyarázat...................................................................................................................................................... 16
Az útmutató használata....................................................................................................................................... 16
Funkciók és szolgáltatások elérhetősége.............................................................................................................17

2. fejezet: Az első lépések........................................................................................19
A termék műszaki adatai..................................................................................................................................... 19
Bekapcsolás előtt.................................................................................................................................................19

Az antenna csatlakoztatása......................................................................................................................20
Az akkumulátor behelyezése...................................................................................................................20
Az akkumulátor eltávolítása....................................................................................................................21
Az akkumulátor töltése............................................................................................................................21
A töltöttségi szint kijelzése......................................................................................................................22
Alacsony akkumulátortöltöttség jelzése..................................................................................................22

Kezelőgombok és jelzőfények.............................................................................................................................23
Kijelző................................................................................................................................................................. 26

Konfigurálható készenléti képernyő........................................................................................................27
Állapotjelző ikonok............................................................................................................................................. 27
A rádió bekapcsolása...........................................................................................................................................31
A rádió feloldása................................................................................................................................................. 31

A rádió zárolásának feloldása..................................................................................................................31
A billentyűzár bekapcsolása és kioldása............................................................................................................. 32
A rádió tartása..................................................................................................................................................... 32
Kijelzőelforgatás beállítása................................................................................................................................. 33
Váltás a TMO vagy a DMO módra..................................................................................................................... 33
Adástiltás (TXI) mód...........................................................................................................................................33
Beszédcsoportok kiválasztása............................................................................................................................. 34
Beszédcsoport-ikonok kiválasztása.....................................................................................................................34
Az időzített beszédcsoportváltás használata........................................................................................................35
A beszédcsoport-letapogatás bekapcsolása......................................................................................................... 35
Szórásos hívás..................................................................................................................................................... 35
Környezetlehallgatási (AL) hívás........................................................................................................................36
Egygombos funkció.............................................................................................................................................36
A készülék ideiglenes letiltása és engedélyezése................................................................................................ 37
A készülék végleges letiltása...............................................................................................................................38
Váltás a hangos és a halk üzemmód között.........................................................................................................38

A hangos üzemmód használata............................................................................................................... 38
A halk üzemmód használata....................................................................................................................38

Hívás közben....................................................................................................................................................... 38
Szöveg írása.........................................................................................................................................................39

A szövegbeviteli módok kiválasztása......................................................................................................39
A szövegbeviteli módok és a nyelvek kiválasztása.................................................................................39
Szövegbeviteli ikonok............................................................................................................................. 39
A gombok használata.............................................................................................................................. 40

Tartalom | 3



Írás iTAP alfanumerikus módban............................................................................................................42
Írás TAP alfanumerikus módban.............................................................................................................43
Szavak zárolása....................................................................................................................................... 43
Szavak hozzáadása a szótárhoz............................................................................................................... 43

Kezdőképernyő-üzenet........................................................................................................................................43

3. fejezet: Üzemmódok............................................................................................45
Hálózatok használata...........................................................................................................................................45
Trönkölt üzemmód.............................................................................................................................................. 45

Váltás TMO módra..................................................................................................................................46
Beszédcsoportok kiválasztása................................................................................................................. 46
Csoporthívások indítása TMO módban...................................................................................................46
Csoporthívás fogadása készenléti állapotban.......................................................................................... 46
Csoporthívás fogadása folyamatban lévő csoporthívás közben.............................................................. 46
Dinamikus csoportszám-kiosztás (DGNA)............................................................................................. 47
DGNA-vétel............................................................................................................................................ 47
DGNA – automatikus csoportkiválasztás................................................................................................47
DGNA – csoport automatikus újbóli kiválasztása.................................................................................. 47
DGNA-beszédcsoport megtekintése....................................................................................................... 47
Felhasználók által kezdeményezett szórásos hívás................................................................................. 48
Szórásos hívás inicializálása................................................................................................................... 48
Telefon- és PABX-hívások..................................................................................................................... 48
Privát hívás..............................................................................................................................................48
Privát hívások indítása.............................................................................................................................48
Segélyhívás..............................................................................................................................................49
Hívásmódosítás....................................................................................................................................... 49

Helyi cellás trönkölés.......................................................................................................................................... 49
Váltás helyi cellás trönkölésre.................................................................................................................49
Kilépés a helyi cellás trönkölésből..........................................................................................................50

Közvetlen mód.................................................................................................................................................... 50
Belépés DMO módba.............................................................................................................................. 50
Beszédcsoportok kiválasztása................................................................................................................. 51
Csoporthívások indítása TMO módban...................................................................................................51
Csoporthívás fogadása készenléti állapotban.......................................................................................... 51
Privát hívás..............................................................................................................................................51
Privát hívások indítása.............................................................................................................................52
Privát hívás jelenlét-ellenőrzéssel........................................................................................................... 52
Egyedi hívások számára létrehozott beszédcsoport................................................................................ 52
Jelismétlőkön keresztüli kommunikáció................................................................................................. 52
Átjárókon keresztüli kommunikáció....................................................................................................... 53
DMO csoporthívás beállításainak kiválasztása....................................................................................... 53

Adástiltás (TXI) mód...........................................................................................................................................54
Vészhívás.............................................................................................................................................................55

Csoportos vészhívás................................................................................................................................ 55
Csoportos vészhívások indítása...............................................................................................................56
Csoportos vészhívások fogadása............................................................................................................. 56
Nem taktikai vészhívás............................................................................................................................56
Egyedi vészhívások (Privát vagy MS-ISDN)..........................................................................................56
Vészjelzés................................................................................................................................................56
Vészhelyzeti SDS-állapot........................................................................................................................57
Vészhelyzeti élő mikrofon.......................................................................................................................57
Váltakozó éles mikrofon......................................................................................................................... 57
Csendes vészhívás mód...........................................................................................................................57
Láthatatlan vészhívás.............................................................................................................................. 58
Vészhívás mód aktiválása tárcsázással....................................................................................................58

4 | Tartalom



Katasztrófariasztás...................................................................................................................................58
Katasztrófariasztási hívások inicializálása.............................................................................................. 59
Kilépés a vészhívás módból.................................................................................................................... 59

Jelismétlő mód.....................................................................................................................................................59
Váltás a Jelismétlő módra........................................................................................................................60
A Figyelés opció beállítása......................................................................................................................60
Titkosítás jelismétlő módban...................................................................................................................60

4. fejezet: GPS helymeghatározási szolgáltatás....................................................61
A GPS teljesítményének növelése.......................................................................................................................62
A GPS engedélyezése..........................................................................................................................................62
GPS ikon............................................................................................................................................................. 62
A GPS különböző helykijelzési módjai...............................................................................................................62
A rádió pozíciójának megtekintése..................................................................................................................... 63
A GPS pontosságának megváltoztatása.............................................................................................................. 63
GPS – Fontos tudnivalók.....................................................................................................................................63

5. fejezet: Főmenü................................................................................................... 65
Navigálás a menüben...........................................................................................................................................65
Menüikonok.........................................................................................................................................................65
Üzenetek..............................................................................................................................................................67

Új üzenet..................................................................................................................................................67
Üzenetek küldése privát számra vagy telefonszámra..................................................................67
Üzenet küldése csoportoknak......................................................................................................67
Tárolt és továbbított üzenetek küldése........................................................................................ 67
Kézbesítési jelentés..................................................................................................................... 68
Kézbesítési jelentések megtekintése........................................................................................... 68
Kézbesítési jelentések konfigurálása...........................................................................................68

Bejövő üzenetek...................................................................................................................................... 69
A Bejövő üzenetek mappa megnyitása....................................................................................... 69
Új üzenetek fogadása...................................................................................................................69
Az almenük használata a Bejövő üzenetek és a Kimenő üzenetek mappában............................70
Beágyazott szám..........................................................................................................................70
Üzenetekben szereplő számok mentése...................................................................................... 70
Üzenetekbe ágyazott számok hívása........................................................................................... 71
Csoporthívás indítása az üzenet küldőjének beszédcsoportjára.................................................. 71
Azonnali üzenet...........................................................................................................................71

Kimenő üzenetek.....................................................................................................................................71
Eseményjelentés-tároló........................................................................................................................... 72
RMS-tároló..............................................................................................................................................72
WAP-tároló............................................................................................................................................. 72
Sablonok..................................................................................................................................................72

Felhasználó által beállított sablonok küldése.............................................................................. 72
A felhasználó által létrehozott sablonok beállítása..................................................................... 72

Előre beállított sablonok..........................................................................................................................73
Előre beállított sablonok megtekintése........................................................................................73
Előre beállított sablonok küldése................................................................................................ 73

Állapotüzenetek.......................................................................................................................................73
Állapotüzenet-szám megtekintése...............................................................................................73
Állapotüzenetek küldése..............................................................................................................73
Célzott állapotüzenetek............................................................................................................... 74
Célzott állapotüzenetek küldése.................................................................................................. 74

Névjegyek............................................................................................................................................................74
Névjegyek létrehozása.............................................................................................................................75

Tartalom | 5



Névjegyek szerkesztése...........................................................................................................................75
Hívószámok törlése................................................................................................................................. 76
Névjegyek törlése.................................................................................................................................... 76
A tárolókapacitás ellenőrzése..................................................................................................................76
Tárcsázás a névjegylistából..................................................................................................................... 76

Böngésző............................................................................................................................................................. 77
Biztonság.............................................................................................................................................................77

PIN-kódos védelem................................................................................................................................. 77
A rádió PIN-kódos védelme........................................................................................................ 77
A rádió zárolásának feloldása......................................................................................................77
PIN-kódok módosítása................................................................................................................ 77

Billentyűzár-beállítások...........................................................................................................................78
Billentyűzár-értesítés...................................................................................................................78
Automatikus billentyűzár késleltetésének beállítása...................................................................78
Billentyűzár a készülék bekapcsolásakor.................................................................................... 78

Rádiós titkosítás...................................................................................................................................... 78
A rádiós titkosítás állapotának megtekintése.............................................................................. 79
A rádiós titkosítási kulcsok törlése..............................................................................................79

K érvényessége........................................................................................................................................79
K érvényességének ellenőrzése................................................................................................... 79

SCK (rádiós közeg titkosítása, 2. osztály)...............................................................................................80
TMO SCK................................................................................................................................... 80
DMO SCK...................................................................................................................................80
DMO SCK módosítása................................................................................................................80

TMSCK érvényességének ellenőrzése.................................................................................................... 80
DMSCK érvényességének ellenőrzése....................................................................................................80
Rejtett mód.............................................................................................................................................. 81

Rejtett mód aktiválása................................................................................................................. 81
Rezgésre váltás rejtett módban....................................................................................................81

SDS távvezérlés.......................................................................................................................................81
SDS távvezérlés beállítása...........................................................................................................82

Beállítások...........................................................................................................................................................82
Rezgés..................................................................................................................................................... 82

Alapértelmezett rezgés beállítása................................................................................................ 82
Rezgési beállítások megadása..................................................................................................... 82

Csengőhang............................................................................................................................................. 83
A csengőhangok beállítása.......................................................................................................... 83

Hangerőbeállítás......................................................................................................................................83
A hangerő beállítása.................................................................................................................... 83

Nyelv....................................................................................................................................................... 84
A nyelv beállítása........................................................................................................................ 84

Adatátviteli beállítások............................................................................................................................84
Az adatátviteli funkció beállítása................................................................................................ 84

Hang........................................................................................................................................................ 84
Hangprofilok............................................................................................................................... 84
Hangprofilok beállítása............................................................................................................... 85
Gerjedésgátlás............................................................................................................................. 85
A gerjedésgátlás beállítása.......................................................................................................... 85
Hangforrás beállítása...................................................................................................................85
A hangforrás beállítása................................................................................................................85
Hangerőszabályozás módja......................................................................................................... 85
A hangerőszabályozás módjának beállítása................................................................................ 86

Hangjelzések........................................................................................................................................... 86
Billentyűhang.............................................................................................................................. 86
A billentyűhang beállítása........................................................................................................... 86
Minden hangjelzés.......................................................................................................................86

6 | Tartalom



Az összes hangjelzés be- és kikapcsolása................................................................................... 86
Beszédengedélyező hang.............................................................................................................86
Beszédengedélyező hang beállítása.............................................................................................86
Adásengedélyezés....................................................................................................................... 87
Az adásengedélyező hangjelzés beállítása.................................................................................. 87
Ismétlődő riasztás........................................................................................................................ 87
Ismétlődő riasztás beállítása........................................................................................................87
D-PTT hangok.............................................................................................................................87
A D-PTT hangjelzések beállítása................................................................................................ 88

Kijelző..................................................................................................................................................... 88
Kijelzőelforgatás beállítása......................................................................................................... 88
A betűméret beállítása................................................................................................................. 88
Nagyobb betűméret beállítása a készenléti képernyőn................................................................89
Extra nagyítás beállítása..............................................................................................................89
Bővített állapotikonok beállítása................................................................................................. 89
A képernyővédő beállítása.......................................................................................................... 89
A háttérvilágítás beállítása.......................................................................................................... 90
A háttérkép beállítása.................................................................................................................. 90
A kontraszt beállítása.................................................................................................................. 90

Idő és dátum............................................................................................................................................ 90
A kijelzőn látható idő és dátum beállítása...................................................................................91
Időformátum beállítása................................................................................................................91
Az idő kézi beállítása.................................................................................................................. 91
A dátum formátumának beállítása...............................................................................................91
A dátum kézi beállítása............................................................................................................... 92
Időeltolódás beállítása................................................................................................................. 92
A dátum és az idő automatikus frissítésének beállítása ............................................................. 92

Energiatakarékosság................................................................................................................................92
Energiatakarékossági funkció engedélyezése............................................................................. 92
Energiagazdálkodás megtekintése...............................................................................................93

Átviteliteljesítmény-osztály.....................................................................................................................93
A rádió teljesítményosztályának beállítása................................................................................. 93

Előjegyzés............................................................................................................................................... 93
Előjegyzési beállítások szerkesztése........................................................................................... 93

Forgatógomb........................................................................................................................................... 94
Forgatógomb üzemmódjának beállítása......................................................................................94
A forgatógomb lezárása...............................................................................................................94
A forgatógomb viselkedése billentyűzár esetén..........................................................................94
Körben járó görgetés beállítása................................................................................................... 95
Forgatógomb görgetési tartományának beállítása.......................................................................95
Forgatógombbal való beszédcsoport-választás beállítása........................................................... 95
A forgatógomb funkciógombjainak beállítása............................................................................ 95

Csoportbeállítások...............................................................................................................................................96
Letapogatás..............................................................................................................................................96

A beszédcsoport-letapogatás bekapcsolása................................................................................. 96
Beszédcsoportok beállítása az aktív letapogatási listában.......................................................... 96
Letapogatási listák kezelése........................................................................................................ 96
Beszédcsoportok törlése a letapogatási listából.......................................................................... 97

Saját csoportok........................................................................................................................................ 97
Kedvencek........................................................................................................................................................... 97

Kedvencek mappái.................................................................................................................................. 97
Kedvenc beszédcsoportok....................................................................................................................... 97
Kedvenc névjegyek számai..................................................................................................................... 98
Privát hívások indítása a Kedvencek között szereplő névjegy számára..................................................98
Mappák hozzáadása a Kedvencekhez..................................................................................................... 98
Névjegyek számainak hozzáadása a Kedvencekhez............................................................................... 98

Tartalom | 7



Beszédcsoportok hozzáadása a Kedvencekhez....................................................................................... 99
A Kedvencek mappáinak kezelése.......................................................................................................... 99
Elemek törlése a Kedvencek mappáiból................................................................................................. 99
Az összes elem törlése a Kedvencek mappáiból................................................................................... 100

Saját adatok....................................................................................................................................................... 100
Személyes adatok megtekintése és módosítása.....................................................................................100

Legutóbbi hívások............................................................................................................................................. 100
A legutóbbi hívások megtekintése........................................................................................................ 100
A legutóbbi hívások visszahívása..........................................................................................................101
Legutóbbi hívók mentése a Névjegyek mappába..................................................................................101
Legutóbbi hívások törlése..................................................................................................................... 102

Billentyűparancsok............................................................................................................................................102
Menü-gyorsbillentyűk létrehozása........................................................................................................ 102
A billentyűparancsok listájának szerkesztése........................................................................................102

RUI.................................................................................................................................................................... 103
Bejelentkezés.........................................................................................................................................103
Kijelentkezés......................................................................................................................................... 103

Hálózatok...........................................................................................................................................................103
Hálózati üzemmód kiválasztása............................................................................................................ 103
A hálózat kiválasztása........................................................................................................................... 104
Másik hálózaton való regisztrálás......................................................................................................... 104
Idegen hálózaton történő regisztráció....................................................................................................104
Bármely hálózat használata................................................................................................................... 104
Átlépés más hálózatra............................................................................................................................105

Hely................................................................................................................................................................... 105
A rádió pozíciójának megtekintése....................................................................................................... 105
A GPS pontosságának megváltoztatása................................................................................................ 105

Adatcsomag-átvitellel........................................................................................................................................105
Az adatátviteli statisztika megtekintése................................................................................................ 106
Az adattitkosítás állapotának megtekintése...........................................................................................106

6. fejezet: Funkciók............................................................................................... 107
Privát hívás........................................................................................................................................................107

Privát hívások indítása...........................................................................................................................107
Rádiós üzenetkezelő rendszer (RMS)............................................................................................................... 107

RMS-ikonok.......................................................................................................................................... 108
RMS állapotüzenet elküldése................................................................................................................ 108

Egygombos tárcsázás........................................................................................................................................ 108
Beszédcsoport tárcsázása sorszám alapján........................................................................................................108

Beszédcsoport gyorshívószámának megtekintése.................................................................................109
Beszédcsoportok kiválasztása sorszám alapján.....................................................................................109

Telefon- és PABX-hívások............................................................................................................................... 109
Telefonszámok és helyi mellékek hívása.............................................................................................. 109

Telefonszámok és helyi mellékek gyorshívása................................................................................................. 109
Telefonszámok és helyi mellékek gyorshívása..................................................................................... 110

DTMF-tárcsázás hívás közben.......................................................................................................................... 110
Rövid szám tárcsázása.......................................................................................................................................110
RUA/RUI...........................................................................................................................................................110
WAP.................................................................................................................................................................. 111

WAP-böngésző......................................................................................................................................111
A böngésző megnyitása.........................................................................................................................111
A böngészőmenü paneljeinek megnyitása............................................................................................ 111
Böngészési tippek..................................................................................................................................112

Könyvjelzők létrehozása a Navigáció panellel......................................................................... 112
Könyvjelzők létrehozása a Könyvjelzők panellel..................................................................... 112

8 | Tartalom



Könyvjelzők használata.............................................................................................................112
Billentyűparancsok létrehozása.................................................................................................112
Billentyűparancsok használata.................................................................................................. 113
Oldalak mentése........................................................................................................................ 113
Mentett oldalak megnyitása.......................................................................................................113

Ha nincs adatcsomag-szolgáltatás......................................................................................................... 113
A böngészőbe történő belépés letiltása................................................................................................. 113
A gombok használata............................................................................................................................ 114
A böngészőmenü paneleinek áttekintése...............................................................................................114
Navigáció panel.....................................................................................................................................115
Speciális.................................................................................................................................................115
Könyvjelzők panel.................................................................................................................................116

A kiválasztott könyvjelzőkhöz tartozó Opciók panel használata..............................................116
A Mentett oldalak mappa használata.........................................................................................116

Előzmények panel................................................................................................................................. 117
Nemrég felkeresett URL-címek megnyitása............................................................................. 117

Eszközök panel......................................................................................................................................117
Opciók panel..........................................................................................................................................117
Kép panel...............................................................................................................................................117
Szövegbevitel panel...............................................................................................................................117
WAP leküldés........................................................................................................................................118

Új WAP-üzenetek......................................................................................................................118
WAP-üzenetek megtekintése.................................................................................................... 119

Eseményjelentés................................................................................................................................................ 119
Eseményjelentések típusai.....................................................................................................................119
Az eseményjelentési funkció működése a különböző üzemmódokban................................................ 120
Az eseményjelentési szolgáltatás fázisai...............................................................................................120

Árnyékcsoportok (Címcsomag)........................................................................................................................ 120

A. függelék: Hangjelzések.................................................................................... 121

B. függelék: LED-jelzések.................................................................................... 123

C. függelék: Hibaelhárítás....................................................................................125

D. függelék: Karbantartás....................................................................................129
Tárolás...............................................................................................................................................................129
Az akkumulátor élettartamának növelése..........................................................................................................129
Az akkumulátor töltési hőmérséklete................................................................................................................ 129
Az akkumulátor töltésének szabályai................................................................................................................ 129
Az akkumulátorral kapcsolatos további figyelmeztetések................................................................................ 130
A rádió épségének megóvása............................................................................................................................ 130

Tartalom | 9



10 | Tartalom



Ábrák listája

1. ábra: Trönkölt üzemmód .............................................................................................................45
2. ábra: Közvetlen mód ...................................................................................................................50
3. ábra: Jelismétlő módban való működés ......................................................................................59
4. ábra: Eseményjelentési üzenet .................................................................................................. 119

Ábrák listája | 11



12 | Ábrák listája



Táblázatok listája

1. táblázat: Speciális jelölések ........................................................................................................ 17
2. táblázat: A termék műszaki adatai .............................................................................................. 19
3. táblázat: Akkumulátorikonok ..................................................................................................... 22
4. táblázat: Kezelőgombok és jelzőfények ..................................................................................... 23
5. táblázat: Kijelző .......................................................................................................................... 26
6. táblázat: A szoftvergomb terület színei ...................................................................................... 26
7. táblázat: Állapotjelző ikonok ......................................................................................................27
8. táblázat: Beszédcsoport-ikonok .................................................................................................. 34
9. táblázat: Egygombos funkciók ................................................................................................... 36
10. táblázat: Hívás közben ..............................................................................................................39
11. táblázat: Szövegbeviteli képernyő ikonjai ................................................................................ 40
12. táblázat: A gombok használata ................................................................................................. 40
13. táblázat: Egyéb billentyűk ........................................................................................................ 41
14. táblázat: Különböző helykijelzési módok .................................................................................62
15. táblázat: Menüikonok ............................................................................................................... 65
16. táblázat: Bejövő üzenetek ikonjai .............................................................................................69
17. táblázat: Kimenő üzenetek ikonjai ............................................................................................71
18. táblázat: Névjegytípusok .......................................................................................................... 74
19. táblázat: RMS-ikonok .............................................................................................................108
20. táblázat: A böngészőgombok használata ................................................................................ 114
21. táblázat: A böngészőmenü panelei ......................................................................................... 115
22. táblázat: További menüpanelek .............................................................................................. 115
23. táblázat: Böngésző szövegbeviteli ikonjai ..............................................................................118
24. táblázat: A rádió hangjelzései ................................................................................................. 121
25. táblázat: LED-jelzések ............................................................................................................123
26. táblázat: Megjelenített üzenetek ............................................................................................. 125

Táblázatok listája | 13



14 | Táblázatok listája



fejezet

1
Általános információk

Biztonsági előírások

Rádiófrekvenciás energiának való kitettségre és a termékbiztonságra vonatkozó
útmutató rádió adó-vevőkhöz
FIGYELEM!

A termék használata előtt olvassa el a rádióhoz mellékelt Rádiófrekvenciás energiának való kitettségre és biztonságra
vonatkozó útmutatót, amely a biztonságos működtetéssel és a vonatkozó rádiófrekvencia-kibocsátási szabványoknak
és előírásoknak való megfeleléssel kapcsolatos fontos tudnivalókat tartalmazza.

Szerzői jogok

A jelen dokumentumban bemutatott Motorola termékek között szerzői jog által védett Motorola számítógépes
programok is találhatók. Az Egyesült Államok és más országok fenntartanak bizonyos kizárólagos jogokat a Motorola
számára a szerzői jogvédelem alá eső számítógépes programokra vonatkozóan. Ennek megfelelően a Motorola írásos
engedélye nélkül a jelen dokumentumban bemutatott Motorola termékekhez tartozó Motorola számítógépes
programok semmilyen formában nem másolhatók, illetve nem reprodukálhatók.
© 2014 Motorola Solutions, Inc. Minden jog fenntartva.

A Motorola Solutions, Inc. előzetes engedélye nélkül jelen dokumentum semmilyen formában, sem részben, sem
egészben nem reprodukálható, tárolható és nem fordítható semmilyen más nyelvre vagy számítógépes nyelvre.

Továbbá a Motorola termékek megvásárlása nem tekinthető felhatalmazásnak, sem közvetlenül, sem hallgatólagosan,
sem más módon, kivéve a nem kizárólagos, normál szerzőijogdíj-mentes használati jogosítványt, amely a
termékeladásban alkalmazott törvényből következik.

Kizáró nyilatkozat
A jelen dokumentumban említettek közül bizonyos szolgáltatások, funkciók és képességek nem feltétlenül
használhatók adott rendszereken, illetve az adott mobil előfizetői egység jellemzőitől vagy bizonyos paraméterektől
függhetnek. További információért forduljon Motorola képviselőjéhez.

Védjegyek
A MOTOROLA, a MOTO, a MOTOROLA SOLUTIONS és a stilizált M embléma a Motorola Trademark Holdings,
LLC védjegye vagy bejegyzett védjegye, használatuk engedéllyel történik. Minden egyéb védjegy a tulajdonosa
tulajdona.
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Az Európai Unió (EU) elektromos és elektronikai berendezések hulladékára
vonatkozó (WEEE) direktívája

Az Európai Unió WEEE direktívája megköveteli, hogy az EU országokba értékesített termékeken, vagy azok
csomagolásán szerepeljen az áthúzott szemetest ábrázoló piktogram.

A WEEE elírások szerint ez az áthúzott szemetest ábrázoló címke azt jelenti, hogy az EU országok vásárlóinak és
végfelhasználóinak nem szabad háztartási hulladékként kezelni az elektronikai és elektromos berendezést vagy
kelléket.

Az EU országokban élő vásárlók vagy végfelhasználók feladata, hogy a berendezés gyártójának helyi képviselőjétől
tájékozódjanak az adott ország hulladékgyűjtő rendszeréről.

Nyílt forráskódú szoftverekre (Open Source Software, OSS) vonatkozó jogi
nyilatkozatok
Az OSS jogi nyilatkozatokat megtalálhatja a Motorola webhelyén (emeaonline.motorolasolutions.com), illetve a CPS
Plus lemezen.

Jelmagyarázat

Az alábbi ábrák a rádió megfelelő üzemeltetése és a felhasználók védelme szempontjából kulcsfontosságú helyzeteket
és beállításokat jelölik.

Veszély: A VESZÉLY! megjelölés és a hozzá tartozó ikon olyan információra utal, amelynek figyelmen
kívül hagyása halálhoz vagy súlyos sérüléshez vezet.

Vigyázat!: A VIGYÁZAT! megjelölés és a hozzá tartozó ikon olyan információra utal, amelynek
figyelmen kívül hagyása halálhoz, súlyos sérüléshez vagy a termék súlyos károsodásához vezethet.

Figyelem!: A FIGYELEM! megjelölés és a hozzá tartozó ikon olyan információra utal, amelynek
figyelmen kívül hagyása könnyebb vagy közepes sérüléshez vagy a termék súlyos károsodásához vezethet.

Figyelem!: A FIGYELEM! megjelölés a biztonsági ikon nélkül használva olyan potenciális kárra vagy
sérülésre utal, ami nem a termékkel kapcsolatos.

Fontos!: A FONTOS jelzésű részek olyan információt tartalmaznak, amely létfontosságú a tárgyalt téma
tekintetében, de nem a VIGYÁZAT! és a FIGYELEM! kategóriába tartozik. A FONTOS részekhez nem
tartozik veszélyességi fokozat.

Megjegyzés: A MEGJEGYZÉS megjelölés olyan szövegrészre utal, amely fontosabb információt közvetít,
mint a környező szöveg, például kivételeket vagy előfeltételeket ír le, bemutatja, hol találhat az olvasó
további információt, vagy emlékezteti az olvasót, hogyan kell egy adott műveletet végrehajtani (ha például
az nem része az aktuális műveletnek), esetleg ismertetik, hol található valami a képernyőn. A
megjegyzésekhez nem tartozik veszélyességi fokozat.

Javaslat: A JAVASLAT a Motorola javaslatát vagy tippjét jelenti, amelynek betartása nem kötelező, de
hasznos lehet. A JAVASLAT megjelölésű részekhez nem tartozik veszélyességi fokozat.

Az útmutató használata

Az útmutatóban a következőket használjuk meghatározott információk és dolgok kiemelésére:
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1. táblázat: Speciális jelölések

Példa Leírás

MENÜ gomb vagy VÉSZHÍVÁS gomb A gombok nevét nagy betűkkel írjuk.

Belépés TMO módba hangjelzés A hangjelzések nevét dőlt betűkkel szedtük.

Kikapcsolás A menüpontok, a felhasználói felület elemei, illetve a
rádión megjelenő üzenetek nevét félkövérrel szedtük.

Beállítások → Hangjelzések → Minden hangjelzés A félkövér, nyíllal elválasztott szavak a menüpontok
közötti navigálás módját jelzik.

Funkciók és szolgáltatások elérhetősége

Ez az útmutató a rádió összes elérhető funkcióját és szolgáltatását ismerteti. Előfordulhat, hogy a szolgáltató
módosította, az Ön igényeihez szabta a rádió beállításait. Az eltérésekkel kapcsolatban érdeklődjön a szolgáltatójánál.
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fejezet

2
Az első lépések

Ez a fejezet a rádió használatával kapcsolatos alapvető információkat mutatja be.

A termék műszaki adatai

2. táblázat: A termék műszaki adatai

Leírás Érték

Maximális feszültség 4,2 V

Maximális áramerősség 0,5 A

Maximális RF-teljesítmény 1 vagy 1,8 W (átkapcsolható)

Hangszóró maximális terhelése 0,5 W, 8 Ω terhelésen

Antennaimpedancia 50 Ω

Üzemeltetési hőmérséklet -25 °C – +60 °C

Működési idő Munkaciklus 4. osztály (1 W) 3L osztály (1,8 W, csak
380–430 MHz)

05/05/90

05/35/60

Beszédidő

> 23 óra

> 17 óra

3,5 óra

> 20,5 óra

> 15,5 óra

2,5 óra

Megjegyzés: A rádiós adás és vétel idejét (munkaciklus ideje) a kommunikációs rendszer határozza meg.
Túlterhelés vagy a rendszer specifikációit meghaladó környezeti hőmérsékleten való használat esetén a
rádió a hőmérséklet szabályozása érdekében csökkenti a kimeneti RF-teljesítményt, ezáltal pedig a rádió
hatótávolságát is.

Bekapcsolás előtt

A rádió bekapcsolása előtt olvassa el az alábbi részt.
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Az antenna csatlakoztatása
Eljárás:

1 Helyezze az antenna csavaros alsó részét a rádió tetején található aljzatba.
2 Csavarja az óramutató járásával megegyező irányba, amíg elég szoros nem lesz.

Az akkumulátor behelyezése
Eljárás:

1 Vegye ki az akkumulátort a védőtasakból.
2 Helyezze be az akkumulátor tetejét a rekeszbe, ahogy azt a képen látja.

3 Óvatosan nyomja lefelé az akkumulátor alsó részét, amíg a helyére nem kattan.
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Megjegyzés:

• A szolgáltatói beállításoktól függően előfordulhat, hogy az akkumulátor behelyezését követően a
rádió automatikusan bekapcsol.

• Ha az akkumulátort 3–5 másodpercnél rövidebb időre veszik csak ki, a készülék mindig
visszakapcsolódik.

Kapcsolódó hivatkozások
Az akkumulátor eltávolítása A következő oldalon:21

Az akkumulátor eltávolítása
Előfeltételek: Kapcsolja ki a rádiót.

Eljárás:

1 Nyomja meg a tolózárat.
2 Emelje ki az akkumulátort.

Kapcsolódó hivatkozások
Az akkumulátor behelyezése A következő oldalon:20

Az akkumulátor töltése
A töltő típusától függően töltheti az akkumulátort külön vagy/és a rádióra csatlakoztatva.

A rádióhoz csatlakoztatott akkumulátor töltése történhet a rádió bekapcsolt vagy kikapcsolt állapotában. Javasoljuk,
hogy a töltést kikapcsolt rádióval végezze, mert így a töltés hatékonyabb (az akkumulátor gyorsabban feltöltődik).

Fontos!: A Motorola által jóváhagyott töltők optimális működést biztosítanak. Más töltők esetében
előfordulhat, hogy a Motorola lítiumion-akkumulátorokat nem töltik fel teljesen, vagy hogy az akkumulátor
élettartamának csökkenését okozzák.

Előfeltételek:

Az akkumulátor töltésére kizárólag veszélyes anyagoktól mentes helyen kerülhet sor.

Eljárás:

1 A töltő specifikációja szerint csatlakoztassa a töltőt a megfelelő áramforráshoz (100–240 V, 12 V).
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2 Végezze el az alábbi műveletek egyikét:

• Asztali töltők – helyezze be az akkumulátort, illetve a rádiót és az akkumulátort a töltő megfelelő fészkébe.
Ügyeljen arra, hogy az akkumulátor, illetve a rádió és a töltő közötti csatlakozás megfelelő legyen, és a töltő
LED-je a folyamatban lévő töltést jelezze

• Úti töltők és autós töltők – csatlakoztassa a töltőt a rádióra csatlakoztatott akkumulátorhoz. Ügyeljen arra,
hogy a töltő stabilan csatlakozzon a rádióhoz, és hogy a rádió kijelzője folyamatban lévő töltést jelezzen.

Megjegyzés: Ha a rádió nem észleli a töltőt, és a Töltő keresése vagy Csatlakoztassa a rádiót a
töltőhöz üzenetek valamelyike látható, győződjön meg arról, hogy helyesen csatlakoztatta a töltőt,
valamint hogy a rádió és a töltő érintkezői tiszták.

Utófeltételek: A töltés során az akkumulátor felmelegedhet. A töltést követően a rádió használata előtt ellenőrizze,
hogy az akkumulátor és a rádió hőmérséklete az engedélyezett hőmérsékleti tartományban van-e.

A töltöttségi szint kijelzése
Ha a rádió töltés közben be van kapcsolva, a kijelzőn az akkumulátor töltését jelző ikon látható.

Ha a rádió töltés közben ki van kapcsolva, a töltés alatt lévő akkumulátor ikonját jeleníti meg, és bekapcsolja a kijelző
háttérfényét.

3. táblázat: Akkumulátorikonok

Akkumulátor töltöttsége Akkumulátortöltés állapota

Üres

5–10%

Alacsony

10–20%

Közepes

20–90%

Tele

90–100%

Üres

5–10%

Alacsony

10–20%

Közepes

20–90%

Tele

90–100%

Alacsony akkumulátortöltöttség jelzése
Ha az akkumulátor töltöttségi szintje nem éri el az előre beállított értéket, a rádió hangjelzést ad. Ez a hangjelzés a
szolgáltató által megadott beállításoktól függően a töltöttségi szint 5, 10 vagy 20 százalékának elérésekor szólal meg.
Az alapértelmezett beállítás 5 százalék. A szolgáltató állítja be a figyelmeztetés ismétlésének gyakoriságát is.
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Kezelőgombok és jelzőfények
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4. táblázat: Kezelőgombok és jelzőfények

Jelölés Leírás

1 VÉSZHÍVÁS gomb
A táblázat folytatódik…
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Jelölés Leírás

A VÉSZHÍVÁS gomb hosszabb megnyomásával vészhívás módba léphet. Ha a rádió ki van
kapcsolva, a gomb nyomva tartásával vészhívás módban kapcsolhatja be a készüléket.

2 FORGATÓGOMB

• Elforgatásával a hangerőt szabályozhatja.
• Megnyomásával és elforgatásával másik beszédcsoportot választhat.
• A FORGATÓGOMBOT nyomva tartással zárolhatja és oldhatja fel. A lezárt FORGATÓGOMBOT a

rádió kikapcsolásával is feloldhatja.

3 FÜLHALLGATÓ

4 OLDALGOMB

A FORGATÓGOMB és az OLDALGOMBOK úgy vannak beprogramozva, hogy a funkcióik
kiegészítsék egymást. Ha a FORGATÓGOMB beállítása Hangerő vagy Kettős, az OLDALGOMBOK

támogatják az egygombos funkció használatát. A felső OLDALGOMB alapértelmezés szerint a
fényerő szabályozására, az alsó OLDALGOMB pedig a képernyővédő funkció kezelésére
szolgál.

Megjegyzés: Az egygombos funkció aktiválásához alapértelmezés szerint 0,1
másodpercig kell nyomva tartania az OLDALGOMBOT.

5 PTT

• A gomb hosszabb megnyomásával csoporthívásokat kezdeményezhet, illetve átveheti a
szót az egyirányú hívások során. A gomb felengedésével átadhatja a szót a másik félnek.

• Megnyomásával állapot- és szöveges üzeneteket küldhet.

6 SZOFTVERGOMB

A bal és a jobb oldali SZOFTVERGOMB feletti opciót a gombok megnyomásával választhatja ki.

7 KÜLDÉS gomb

Megnyomásával kétirányú hívásokat indíthat, illetve vehet fel, és üzeneteket küldhet.

8 HANGSZÓRÓ

9 BILLENTYŰZET

A hívószámok, névjegyek és szöveges üzenetek bevitelére szolgál.

Az egygombos funkciónak köszönhetően a gyakran használt funkciókat a hozzárendelt
billentyű (0-9, * és #) hosszabb megnyomásával is elérheti.

Megjegyzés: Az egygombos funkció aktiválásához alapértelmezés szerint 1
másodpercig kell megnyomnia a megadott billentyűt.

10 HANGSZÓRÓKEZELŐ gomb

A HANGSZÓRÓKEZELŐ gomb segítségével válthat a fülhallgató (HALK) és a hangszóró
(HANGOS) használata között.

Megjegyzés: Csoportos vészhívás esetén a hangszóró a megadott beállításoktól
függetlenül bekapcsol.

11 KIEGÉSZÍTŐCSATLAKOZÓ

A táblázat folytatódik…
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Jelölés Leírás

Lehetővé teszi a kiegészítők és az adatátviteli kábelek csatlakoztatását.

Megjegyzés: A kiegészítők csatlakoztatása előtt ajánlott lekapcsolni a rádiót.

12 ANTENNA

13 LED-JELZŐFÉNY

14 FELSŐ MIKROFON

Használatára az egyirányú, hangos üzemmódú hívások, például a csoporthívások során kerül
sor.

15 KÜLSŐ ANTENNACSATLAKOZÓ

Digitális autóskészlet segítségével a rádiófrekvenciás jel külső antennára való átirányítására
szolgál.

16 KIJELZŐ

Szöveg és képek megjelenítésére alkalmas 65 536 színű, 130 × 130 pixeles kijelző
háttérvilágítással, állítható kontraszttal és skálázható betűkészletekkel.

17 MENÜ gomb

• A kezdőképernyőn való megnyomásával a főmenüt nyithatja meg.
• A helyi menü megnyitását is lehetővé teszi.

18 BE/KI/HÍVÁS VÉGE/KEZDŐKÉPERNYŐ gomb

• Hosszabb megnyomásával be- és kikapcsolhatja a rádiót.
• Megnyomásával befejezheti a hívásokat,
• és visszatérhet a kezdőképernyőre.

19 AUDIOKIEGÉSZÍTŐ-CSATLAKOZÓ

Lehetővé teszi az audiokiegészítők csatlakoztatását.

Megjegyzés: A kiegészítők csatlakoztatása előtt ajánlott lekapcsolni a rádiót.

20 NAVIGÁCIÓS gomb

A felfelé, lefelé, balra vagy jobbra mutató NAVIGÁCIÓS gombot megnyomva listákban
görgethet, navigálhat a menüben vagy görgetheti a szerkesztett szöveget.

A kezdőképernyőről a navigációs gombbal az alábbi funkciókat érheti el:

• lefelé mutató NAVIGÁCIÓS gomb – belépés a Legutóbbi hívások menüpontba.
• felfelé mutató NAVIGÁCIÓS gomb – a Saját csoportok beszédcsoportmappa megnyitására

szolgál.
• balra és jobbra mutató NAVIGÁCIÓS gomb – a beszédcsoportok közötti váltásra szolgál.

21 HÁTTÉRVILÁGÍTÁS-ÉRZÉKELŐ

Ha be van kapcsolva a háttérvilágítás, a rádió billentyűzete világít. A billentyűzet
háttérvilágítás-érzékelője a környezeti fény erőssége alapján kapcsolja ki és be a billentyűzet
háttérvilágítását. Ez a funkció javíthatja a készülék energiatakarékosságát. Ha a rádió

A táblázat folytatódik…
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Jelölés Leírás

akkumulátora töltődik, a billentyűzet háttérvilágítása a HÁTTÉRVILÁGÍTÁS-ÉRZÉKELŐ állapotától
függetlenül aktív marad.

22 ALSÓ MIKROFON

Megjegyzés: A kompatibilis kiegészítőket a Kiegészítők listájában (száma: 6866537D83) tekintheti meg.
A dokumentum beszerzése érdekében forduljon a szolgáltatóhoz.

Kijelző

Ez a fejezet a rádió alapbeállítás szerinti kezdőképernyőjének elemeit mutatja be.

5. táblázat: Kijelző

Jelölés Leírás

1 Állapotikonok területe

2 Szövegmegjelenítési terület

3 SZOFTVERGOMBOK területe

4 MENÜ/helyi menü ikonja

A SZOFTVERGOMB terület színe aszerint változik, hogy a rádió milyen módban van.

6. táblázat: A SZOFTVERGOMB terület színei

Szín Mód vagy állapot

Világoskék Normál TMO vagy DMO mód

Világosvörös Vészhívás mód vagy katasztrófariasztás

Olajzöld Helyi cellás trönkölési mód

Sárga Eseményjelentés – készenlét

Vörös Eseményjelentés – riasztás

Zöld Eseményjelentés – elfogadva
A táblázat folytatódik…
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Szín Mód vagy állapot

Kék Rádiós üzenetkezelő rendszer (RMS)

Szürke Rádiófelhasználó-hozzárendelés (RUA) – korlátozott szolgáltatás

Kapcsolódó hivatkozások
Kijelző A következő oldalon:88
Kijelző A következő oldalon:88
A kijelzőn látható idő és dátum beállítása A következő oldalon:91

Konfigurálható készenléti képernyő
A szolgáltató meghatározhatja, hogy milyen információk jelenjenek meg a kezdőképernyő állapotikon alatti területén.
A rádió konfigurációjától és a támogatott szolgáltatásoktól függően az alábbi információ jeleníthető meg:

• Hálózat aliasneve
• Tartomány aliasneve
• Beszédcsoport aliasneve
• Idő és dátum
• Otthoni mód kijelzése
• RMS/FMS
• ISSI
• Rádió állapota
• Hangprofil neve
• A SIM-kártya alapú végponti titkosítást támogató rádióknál: OPTA, BSI regisztráció állapota

Állapotjelző ikonok

Az állapotikonok egyes tevékenységek, illetve funkciók aktiválásakor jelennek meg.

Az ikonok megjelenhetnek nagy, illetve normál méretben. A nagyméretű állapotikonok manuális engedélyezéséhez és
letiltásához lépjen a Menü → Beállítások → Kijelző → Kiterjesztett állapotikonok menüpontba.

7. táblázat: Állapotjelző ikonok

Ikon Leírás

Trönkölt üzemmód

Működő szolgáltatás

Nincs szolgáltatás

Jelerősség – minél több a vonal, annál erősebb a jel.

RF-teljesítmény – azt jelzi, hogy a nagy RF-teljesítmény funkció engedélyezve van. A jel
erősségét jeleníti meg. Minél több a vonal, annál erősebb a jel.

Migráció – akkor jelenik meg, ha a rádió idegen hálózathoz csatlakozik.

A táblázat folytatódik…
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Ikon Leírás

Szórásos hívás – akkor jelenik meg, ha a rádió Szórásos hívás üzemmódban van.

Letapogatás – akkor látható, ha a beszédcsoport-letapogatás aktív.

Prioritásos letapogatás – akkor látható, ha a prioritásos letapogatás aktív.

Adatcsatlakozás — akkor látható, ha az adatcsatlakozás tétlen (készenlétben van).

Adatok adása/vétele — akkor látható, ha az adatcsatlakozás aktív. Az 1, 2, 3, vagy 4
számjegy azt jelzi, hogy adás közben mekkora sávszélesség van használatban (25%, 50%,
75%, vagy 100%).

Közvetlen mód

Közvetlen módú hívás – akkor látható, ha a rádió közvetlen módú hívást fogad. Minél több a
vonal, annál erősebb a jel.

 és a
Nagy RF teljesítmény: tétlen vagy adás közben – akkor látható, ha a nagy RF teljesítmény
opció be van kapcsolva, és a rádió vagy tétlen, vagy hívást ad.

Nagy RF teljesítmény: vétel közben – akkor látható, ha a nagy RF teljesítmény opció be van
kapcsolva, és a rádió hívást fogad.

Közvetlen mód – akkor látható, ha a rádió közvetlen üzemmódban működik (rádiók közötti
közvetlen kommunikáció).

DMO átjáró kommunikációs mód – akkor látható, ha DMO módban az átjáró lehetőség van
kiválasztva. Az ikonnak a következő állapotai vannak:

• Folytonos – a rádió szinkronizálva van az átjáróval.
• Villogó – a rádió nincs szinkronizálva, vagy a csatlakozás épp folyamatban van.
• Nincs ikon – rádióról rádióra történő hívás, jelismétlővel.

DMO jelismétlő kommunikációs mód – akkor látható, ha DMO módban a Jelismétlő vagy
az Átjáró + jelismétlő lehetőség van kiválasztva. Ennek az ikonnak a következő állapotai
vannak:

• Folytonos – a rádió felismerte a jelismétlőt (például a jelenlétjelzés fogadása esetén).
• Villogó – a rádió nem ismerte fel az ismétlőt, vagy a csatlakozás épp folyamatban van.
• Nincs ikon – rádióról rádióra történő hívás és átjáróval történő hívás.

Általános ikonok

Minden hangjelzés kikapcsolva/kétirányú és egyirányú csengés elnémítva – azt jelzi, hogy
minden figyelmeztető hang ki van kapcsolva, az egy- és kétirányú hívások csengési
hangereje pedig 0.

• Hangerő 0 (amikor a Hangerő beállítás módjának értéke Közös).
• A szimplex és duplex csengőhang hangereje is 0 (amikor a Hangerő beállítás

módjának értéke Egyedi).

Egyirányú csengés elnémítva – azt jelzi, hogy a szimplex csengés hangereje 0, a duplex
csengés hangereje viszont 0-nál nagyobb.

A táblázat folytatódik…
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Ikon Leírás

Kétirányú csengés elnémítva – azt jelzi, hogy a duplex csengés hangereje 0, a szimplex
csengés hangereje viszont 0-nál nagyobb.

Rezgő üzemmód – a rádió rezgéssel jelzi a bejövő hívást.

Rezgés, majd csengés – a rádió rezgéssel, majd csengéssel jelzi a bejövő hívást.

Halk üzemmód – azt jelzi, hogy a hangüzemmód halkra van állítva.

Hangos üzemmód – azt jelzi, hogy a hangüzemmód hangosra van állítva.

 /  /  /

 / 

Kiválasztott hangprofil – azt jelzi, hogy egy adott ikonhoz kapcsolódó hangprofil aktív. Az
ikonok vagy folyamatosan világítanak, vagy villognak. A rádión használható hangprofilok
részleteiről érdeklődjön szolgáltatójánál.

Fülhallgató csatlakoztatva – azt jelzi, hogy a fülhallgató csatlakoztatva van.

GPS ikon

• Folyamatosan világít – a rádió helymeghatározása kész
• Villog – a rádió helymeghatározása folyamatban van. Ez egy opcionális beállítás, és

előfordulhat, hogy az adott készülék nem rendelkezik vele.

RUI bejelentkezve – azt jelzi, hogy a felhasználó be van jelentkezve a rádióra.

RUI álbejelentkezés – azt jelzi, hogy a felhasználó álbejelentkezéssel van belépve.

RUI adatcsomag-átvitel – azt jelzi, hogy a felhasználó álbejelentkezéssel lépett be, az
adatcsomag-átvitel aktív, és egy aktív adatátviteli munkamenet folyamatban van.

RUI adatcsomag-átvitel – azt jelzi, hogy a felhasználó álbejelentkezéssel van belépve, az
adatcsomag-átvitel aktív, és egy külső eszköz adatkapcsolatot épített fel a rádióval.

Akkumulátortöltöttség – az akkumulátor töltöttségi szintjét jelzi.

Akkumulátor töltése folyamatban – azt jelzi, hogy az akkumulátor töltődik.

Vészhívás – akkor látható, ha a rádió Vészhívás módban van.

Katasztrófariasztás – akkor látható, ha a rádió Katasztrófariasztás módban van.

Listagörgetés – azt jelzi, hogy a FORGATÓGOMB listagörgetés módban van.

Új üzenet érkezett – új üzenet érkezését jelzi.

Új üzenet(ek) a Beérkezett üzenetek mappában – azt jelzi, hogy a beérkezett üzenetek
között olvasatlan üzenetek vannak.

A táblázat folytatódik…
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Ikon Leírás

Olvasatlan (új) WAP-üzenet – azt jelzi, hogy új oldal töltődött be a böngészőbe.

Eseményjelentés – eseményjelentési riasztást jelez.

Eseményjelentés érkezett – új eseményjelentési üzenet vételét jelzi.

Olvasatlan eseményjelentés – az Eseményjelentés-tárolóban olvasatlan riasztás található.

Végponti titkosítás módja (E2EE)
Folyamatosan világít, ha az E2EE engedélyezve van

• a kiválasztott beszédcsoportra vonatkozóan,
• a kijelölt privát számra vonatkozóan,
• a kézzel beírt privát számra vonatkozóan,
• hang küldésekor csoporthívásokban,
• hang küldésekor egyirányú privát hívásokban.

Villog, ha a végponti titkosítás engedélyezve van

• hang fogadásakor csoporthívásokban,
• hang fogadásakor egyirányú privát hívásokban,
• titkosított kétirányú privát hívások során.

SDS végponti titkosítás
Folyamatos, ha egy SDS üzenet E2E állapota, vagy egy üzenet fogadója címének E2E
állapota.
Nagy biztonságú módban, amikor a rádió csak a kódolt információkat dolgozza fel, ez az
ikon mindig látható, amikor az üzenetek menüben van (például a Bejövő üzenetekben).

Olvasatlan (új) WAP-üzenet – azt jelzi, hogy nem lépett a WAP mezőbe a legutóbbi WAP-
üzenet érkezése óta (villog, ha a prioritás magas).

WAP-üzenet ikon – a prioritás mellett látható az üzenetlista nézetben.

WAP-üzenet létrehozásának ideje – a létrehozási dátum mellett látható az üzenetlista
nézetben.

WAP-üzenet lejáratának ideje – a lejárati dátum mellett látható az üzenetlista nézetben.

WAP-üzenet címe ikon – a cím és a szöveg mellett látható az üzenetlista nézetben.

Billentyűk zárolva – Azt jelzi, ha a billentyűzár aktív.

Nem biztonságos hívás – Rádiós titkosítás nem elérhető
Villogása azt jelzi, hogy a rádiós titkosítás nem elérhető, amikor a rádió:

• Helyi cellás trönkölési módban van.
• Átjáróhoz próbál csatlakozni.

Nem biztonságos hívás – Rádiós titkosítás nem elérhető

A táblázat folytatódik…
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Ikon Leírás

Váltakozó villogása azt jelzi, hogy a rádiós titkosítás nem elérhető, amikor a rádió:

• TMO-módban van.
• Átjárón keresztül kommunikál.

Nem biztonságos hívás – Rádiós titkosítás nem elérhető
Villogása azt jelzi, hogy a rádiós titkosítás DMO módban nem elérhető. Az ikon a PTT
gomb megnyomását követően jelenik meg.

Távvezérlés
Azt jelzi, hogy a rádiót távirányítják, és a háttérben éppen parancsok végrehajtása folyik.
Ilyen eset például, amikor a rádiót speciális SD-üzenetekkel vezérlik, vagy valamilyen
feltétel GPS-helyjelentés küldését váltotta ki.
Az ikon Extra nagyítás módban nem látható.

Kapcsolódó hivatkozások
Rádiós titkosítás A következő oldalon:78

A rádió bekapcsolása

Eljárás:

1 Tartsa nyomva a BEKAPCSOLÓGOMBOT addig,.
2 A rádió önellenőrzést végez, majd regisztrál a hálózaton.
3 Ha a regisztráció sikerrel járt, a rádió használatra kész.

Megjegyzés: Rejtett módban a készülék bármiféle látható vagy hallható jelzés nélkül kapcsol be.

A rádió feloldása

Előfordulhat, hogy a rádió bekapcsoláskor zárolva van. A rádió zárolásának feloldásához adja meg a kódot a
bekapcsolás után. Ezután a rádió megjeleníti az alapértelmezett kezdőképernyőt.

Megjegyzés: A kioldókód alapértelmezett értéke 0000. A rádió átadását megelőzően a szolgáltató
megváltoztathatja a kódot.

Kapcsolódó hivatkozások
PIN-kódos védelem A következő oldalon:77
PIN-kódok módosítása A következő oldalon:77
Szöveg írása A következő oldalon:39

A rádió zárolásának feloldása
Előfeltételek: Ha háromszor egymás után rossz PIN-kódot ír be, a rádió zárolva lesz. (Alapértelmezés szerint)

Eljárás:

1 A rádió a Készülék zárolva, írja be a PUK-kódot üzenetet jeleníti meg.
2 Írja be a 8 jegyű PUK-kódot (Personal Unblocking Key, személyes feloldókulcs).
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Megjegyzés: A PUK-kód egy nyolcjegyű mesterkód, amelyet a szolgáltatótól kaphat meg.

3 Írja be az új PIN-kódot kétszer.

A billentyűzár bekapcsolása és kioldása

Nyomja meg a MENÜ, majd a * gombot.

Megjegyzés: A VÉSZHÍVÁS gomb nincs lezárva. A vészhívás módba történő belépés az összes gomb
lezárását feloldja.

Kapcsolódó hivatkozások
Billentyűzár-beállítások A következő oldalon:78

A rádió tartása

A rádión két mikrofon található;a felső mikrofon egyirányú diszpécserhívásokhoz és privát hívásokhoz, az alsó
mikrofon pedig kétirányú, telefonjellegű hívásokhoz használható.

A rádió rendelkezik egy beépített hangszóróval a nagy hangerőhöz (ez a készülék közepén helyezkedik el), valamint
egy beépített fülhallgatóval kis hangerőhöz (ez a készülék tetején található). A hangot a Hangforrás beállítása
menüben (MENÜ → Beállítás → Hang → Hangforrás beállítása), illetve a kijelölt egy gombnyomásos gombbal a
hangszóróra vagy a fülhallgatóra irányíthatja.

Megjegyzés: Lehetőleg a felső mikrofonba beszéljen.

Egyirányú hívások
A hangos üzemmód használata esetén a rádiót függőleges helyzetben tartsa, úgy, hogy a felső mikrofon 5–10
centiméterre legyen a szájától. A felső mikrofonba beszéljen. A másik felet a belső hangszórón keresztül hallgathatja.
Az antennát tartsa legalább 2,5 cm távolságra a fejétől és a testétől.

Kétirányú hívások
Halk üzemmódban úgy tartsa a rádiót, mint egy telefont. Az alsó mikrofonba beszéljen. A másik felet a fülhallgatón
keresztül hallgathatja. Az antennát tartsa legalább 2,5 cm távolságra a fejétől és a testétől.

Hajtókán vagy vállon való használat
Csoporthívások és privát hívások esetén fordítsa a fejét a válla vagy a hajtóka felé, és beszéljen közvetlenül a felső
mikrofonba. A másik felet a belső hangszórón keresztül hallgathatja.
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Kihangosított használat
A rádiót magától 30–60 centiméterre helyezze el. Zajos környezetben a jobb vétel érdekében helyezze közelebb a
rádiót.

Kijelzőelforgatás beállítása

Mikor és hol használja:

Ez a funkció azok számára hasznos, akik a rádiót vállon, övön vagy hajtókán hordják, és egyébként fejjel lefelé látnák
a kijelzőt.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Kijelző → Kijelző elforgatása lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Be – a funkció bekapcsolása.
• Ki – a funkció kikapcsolása.

Váltás a TMO vagy a DMO módra

Eljárás:

1 A kezdőképernyőn válassza az Opciók elemet.
2 Válassza a Trönkölt mód vagy a Közvetlen mód lehetőséget.

Kapcsolódó hivatkozások
Hálózati üzemmód kiválasztása A következő oldalon:103
Hálózatok A következő oldalon:103

Adástiltás (TXI) mód

Az adástiltás mód olyan üzemmód, amelyben a rádió nem ad rádiójeleket. Ezt a módot RF-érzékeny területeken,
például kórházak, repülőgépek területén, és olyan robbanásveszélyes helyeken érdemes aktiválnia, ahol a rádióadás
okozta sugárzás veszélyforrást jelenthet.

Az aktiváláshoz válassza a MENÜ → Tovább. . . → Hálózatok → Adástiltási mód → Aktiválás lehetőséget.

Ebben a módban a rádió kizárólag vészhívásokhoz használható adásra. Az összes olyan funkció és gomb, amely
adással jár, ki van kapcsolva. Ilyen tevékenységek pl. a hálózaton való regisztrálás, a beszédcsoport- vagy
mappaváltás, az SDS üzenetküldés vagy a PTT gomb megnyomása stb. Az adással járó műveletek aktiválásakor a
rádió hangjelzést ad, és az Adástiltás esetén nem engedélyezett értesítést jeleníti meg.

A rádió továbbra is fogadhat:

• Csoporthívásokat
• Üzeneteket, amelyek a Bejövő üzenetek mappába kerülnek
• Privát hívásokat, amelyek a Nem fogadott hívások listában lesznek tárolva, ugyanakkor felvenni már nem lehet

őket

Ha nincs már biztonsági kockázat (például, ha elhagyja az RF-érzékeny területet), az adástiltás mód kikapcsolható, és
a rádió visszatér a normál működéshez.
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Az adástiltási módot kikapcsolhatja a MENÜ → Tovább. . . → Hálózatok → Adástiltási mód → Inaktiválás
lehetőséget választva, megnyomva az egygombnyomásos gombot, illetve vészhívás indításával implicit módon.

Megjegyzés: A rádió nem sugároz rádiófrekvenciás jelet az alábbi esetekben:

• Az adástiltás mód aktív.
• Az akkumulátor el van távolítva.
• A rádió ki van kapcsolva.

Az adástiltás mód be- és kikapcsolásakor, ha a rádió egy adott cellában van, speciálisan kijelölt SDS állapotüzenetet
küld. Ez az SDS üzenet jelzi a kapcsolási és felügyeleti infrastruktúrának (SwMI), hogy a rádión az adástiltás módot
be- vagy kikapcsolták.

A készülék végrehajtja az olyan mobilitási eljárásokat, amelyekhez nem szükséges, hogy a rádió felmenő ágon adjon,
kivéve a cella-újraválasztást.

Adástiltás módban a rádió felveszi a csoporthívásokat azokban a csoportokban, amelyeket megfigyel, de az adás
továbbra is tiltva marad.

A rádió a beérkező SDS üzeneteket is megjeleníti a felhasználó számára. A nem fogadott hívás funkció adástiltás
módban is aktív, és segítségével megtekinthetők a nem fogadott hívások. Azonban a rádió megkísérli a hívásfelépítési
továbbadás külön hívásként történő rögzítését.

Ha vészhívást indít, a rádió azonnal kilép az adástiltás módból, és úgy kísérli meg a vészhívást, mintha használatra
készen állna.

Ha a rádió a kikapcsolásakor adástiltás módban volt, a bekapcsoláskor megkérdezi, hogy kilépjen-e az adástiltás
módból. Ha a válasza Nem, akkor a rádió kikapcsol.

Beszédcsoportok kiválasztása

A kezdőképernyőn válassza a következő lehetőségek egyikét:

• Nyomja meg a balra vagy a jobbra mutató NAVIGÁCIÓS gombot. Erősítse meg a kijelölt opciót a Kiválasztás
gombbal.

• Válassza az Opciók → Beszédcsoportok név szerint lehetőséget. Írja be egy beszédcsoport nevét, és válassza ki
a beszédcsoport nevét a listából.

• Válassza az Opciók → Beszédcsoportok mappa szerint lehetőséget. Válasszon mappát, majd válassza ki a
kívánt beszédcsoportot.

• Nyomja meg a FORGATÓGOMBOT, és forgassa addig, amíg meg nem jelenik a kívánt beszédcsoport neve. Erősítse
meg a kijelölt opciót a Kiválasztás gombbal.

Megjegyzés: Ha a FORGATÓGOMB görgetésre van állítva, akkor nem kell megnyomnia a görgetés mód
aktiválásához.

Megjegyzés: A rádió a mappastruktúra max. 3 szintjét képes elérni.

Beszédcsoport-ikonok kiválasztása

8. táblázat: Beszédcsoport-ikonok

Ikon Leírás

Akkor látható, ha a beszédcsoport nem az aktuálisan kiválasztott hálózathoz tartozik.
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Az időzített beszédcsoportváltás használata

Ezzel a funkcióval átkapcsolhatja a beszédcsoportot az aktuálisan kiválasztott beszédcsoport és az előre
meghatározott beszédcsoport (TMO vagy DMO) között, így előre meghatározott ideig az előre meghatározott
beszédcsoportot választja ki beszédcsoportnak az egygombos funkció segítségével . A beállított idő letelte után a
rádió visszatér az előzőleg kiválasztott beszédcsoportra.

Előfeltételek: Az időzített beszédcsoport módosítása funkció a következőhöz van rendelve: az egygombos funkció
segítségével .

Eljárás:

1 Tartsa megnyomva tartsa megnyomva az egy gombnyomásos gombot.
2 A rádió előre meghatározott időre átkapcsol a kiválasztott beszédcsoportról az előre meghatározott

beszédcsoportra.

Az előre meghatározott ideig a rádió az előre meghatározott beszédcsoporttal mint kiválasztott beszédcsoporttal
kezdeményezi, illetve veszi fel a kommunikációt (SDS, állapot SDS, illetve hívás).

A szolgáltató egygombos funkció megnyomásához az alábbi funkciókat rendelheti:

• Visszatérés az előzőleg kiválasztott beszédcsoporthoz
• Az előre beállított idő újraindítása
• Nincs művelet

3 Ha az idő lejárt (valószínűleg többszöri újraindítás után), akkor a rádió a korábban kiválasztott beszédcsoportra
kapcsol át.

A beszédcsoport-letapogatás bekapcsolása

Mikor és hol használja: TMO csoporthívás figyelésének beállítása a megadott beszédcsoport-listában:

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Csoportbeállítások → Letapogatás → Letapogatás.
3 Válassza a Lista kiválasztása lehetőséget, majd válasszon listanevet.

A listanév mellett a Kiválasztva jelzés jelenik meg.

4 Válassza a következőt: Letapogatás → Be.

A rádió az előre beállított letapogatási listában végez keresést.
Kapcsolódó hivatkozások

Letapogatás A következő oldalon:96

Szórásos hívás

A szórásos csoporthívás (más néven „az egész helyre kiterjedő hívás”) a diszpécser által az adott helyen vagy
helyeken lévő összes felhasználónak küldött magas prioritású csoporthívás. A rádiók folyamatosan figyelik a szórásos
hívásokat, de a felhasználók nem válaszolhatnak rájuk. A hívás érkezhet normál szórásos hívásként és szórásos
vészhívásként. A szórásos hívások felülbírálják a folyamatban lévő azonos vagy alacsonyabb prioritású
csoporthívásokat.
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Környezetlehallgatási (AL) hívás

Ez a szolgáltatás lehetővé teszi a diszpécser számára olyan speciális hívás indítását, amelynek során az adott rádió
mikrofonjának hatókörében hallható párbeszédeket és háttérzajt hallgathatja meg. A hívás felépítését az érintett
rádión semmi sem jelzi, és a hívás bármilyen folyamatban lévő, alacsonyabb prioritású beszédhívást megelőzhet.

A hívás elfogadása után a rádió egyirányú hívásként sugároz, és ezt a felhasználó felé semmilyen formában nem jelzi.
A környezetlehallgatási hívás automatikusan véget ér, ha Ön bármilyen beszédhívást indít, vészhívás vagy adástiltás
módba vált, illetve vészjelzést küld.

Egygombos funkció

Az egygombos funkció egyes funkciók gyors aktiválását teszi lehetővé a funkciókhoz hozzárendelt gombok
megnyomásával, illetve nyomva tartásával.

9. táblázat: Egygombos funkciók

Funkció Leírás

Háttérvilágítás be- és kikapcsolása A háttérvilágítás beállításait kapcsolja be és ki.

Hangprofil módosítása Módosítás az adott hangprofilra.

Beszédcsoport módosítása Módosítja a beszédcsoportot a szolgáltató által beprogramozott
beszédcsoportra.

Rejtett mód A rejtett mód be- és kikapcsolása.

Idő megjelenítése Megjeleníti az univerzális időt a kezdőképernyőn.

Dupla nyomásos PTT Elküldi a D- PTT hangot az éppen használt beszédcsoportnak.

Gerjedéselnyomás engedélyezése/letiltása A gerjedésgátlás be- és kikapcsolása.

Extra nagyítás/kicsinyítés Az extra nagyítás be- és kikapcsolása.

Kijelző elforgatása Elforgatja a képernyőt 180 fokkal.

GPS jelentés Egy meghatározott címre a rádió GPS adatait tartalmazó üzenetet
küld.

Hangos/halk üzemmód A hangos/halk üzemmód átkapcsolása.

Tartalék eseményjelentés-riasztás indítása Eseményjelentési tartalékos riasztást küld.

PABX-hívás Tárcsázza a névjegylistába mentett helyi mellékek egyikét.

Telefonhívás Telefonhívást indít a névjegylista egy előre meghatározott
hívószámára.

Előző beszédcsoport A rádió választott beszédcsoportját a korábban választott
beszédcsoportra (DMO vagy TMO) módosítja.

Privát hívás Privát hívást (egyutas vagy kétutas) kezdeményez a címlista egy előre
beállított hívószámához, vagy az utolsó csoporthívás indítójához.

Forgókapcsolók lezárása és feloldása Lezárja és feloldja a forgókapcsolókat.

RUA/RUI be- és kijelentkezés Megkérdezi a hitelesítő adatokat, vagy kijelentkezteti a rádiót.
A táblázat folytatódik…

36 | Az első lépések

Send Feedback  |   | 

http://docsurvey.motorolasolutions.com


Funkció Leírás

Képernyővédő aktiválása A képernyőkímélő funkció be-és kikapcsolása.

Hangprofilok végiggörgetése Az összes elérhető hangprofil végiggörgetése

Előre definiált üzenet küldése Előre beállított üzenet küldése egy dedikált címre.

Állapotküldés Dedikált állapotüzenet küldése egy dedikált címre.

Felhasználó által meghatározott üzenet
küldése

A felhasználó által meghatározott üzenetet küld egy dedikált címre.

Hangszóró hívásonkénti engedélyezése/
letiltása

Engedélyezi a kihangosítót a folyamatban lévő hívás időtartamára.

Időzített beszédcsoportváltás Megadott időtartamra egy előre meghatározott beszédcsoport lesz a
kiválasztott beszédcsoport. Az előre meghatározott beszédcsoport
használata során az egy gombnyomásos gomb ismételt
megnyomásának hatása: visszatér a korábban kiválasztott
beszédcsoporthoz, újraindítja az előre beállított időtartamot, vagy
nem történik semmi (a konfigurációtól függően). A beállított idő
letelte után a rádió visszatér az előzőleg csatlakoztatott
beszédcsoportra.

TMO<->DMO váltás A TMO és a DMO mód között vált.

TMO beszédcsoport-pásztázás A beszédcsoport-keresés be- és kikapcsolása TMO módban.

RF-energiaosztály váltása Váltás a nagy és a normál RF-teljesítmény között.

Adástiltás mód (TXI) Be- és kikapcsolja az adástiltás módot.

Jelismétlő mód be-/kikapcsolása Be- és kikapcsolja a jelismétlő módot.

Hangerőcsökkentés • Megnyomásával egy szinttel csökkenthető a hangerő.
• Nyomva tartásakor a hangerő folyamatosan csökken a minimális

szintig.

Hangerőnövelés • Megnyomásával egy szinttel növelhető a hangerő.
• Nyomva tartásakor a hangerő folyamatosan nő a maximális

szintig.

Szolgáltatója csak az oldalgombokhoz és a billentyűzet gombjaihoz tud egy gombnyomásos funkciókat
hozzárendelni.

Megjegyzés: Ha az egygombos funkció engedélyezve van, az egygombos tárcsázás ki van kapcsolva. Ha a
gombhoz nincs funkció rendelve, a rádión a Funkció nélküli gomb üzenet jelenik meg.

A készülék ideiglenes letiltása és engedélyezése

A rádió rendelkezik egy olyan funkcióval, amely lehetővé teszi, hogy a szolgáltató lopás esetén átmenetileg letiltsa a
készüléket. A rádió letiltott állapotban, illetve letiltott állapotban bekapcsolva úgy viselkedik és úgy néz ki, mintha ki
lenne kapcsolva.

Ha a rádiót megtalálják, a szolgáltató távolról engedélyezheti a készüléket. A rádió engedélyezése után ismét a
megszokott módon használhatja a készüléket.
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A készülék végleges letiltása

A szolgáltató a készüléket annak ellopása vagy elvesztése esetén véglegesen letilthatja. A végleges letiltás után a
rádió többé nem használható, . Ilyenkor még a szolgáltató sem tudja ismét feloldani a rádiót. A rádió végleges letiltása
csak abban az esetben ajánlott, ha nem valószínű, hogy a készülék megkerülhet. Ha mégis megtalálják, a véglegesen
letiltott rádió a Motorolának visszaküldve aktiválható újra.

Megjegyzés: Ez egy fizetős szolgáltatás.

Váltás a hangos és a halk üzemmód között

A felhasználó az HANGSZÓRÓKEZELŐ gomb segítségévével átválthat a külső fülhallgatóról a fő hangszóróra, anélkül,
hogy a külső fejhallgatót vagy a személyes kihangosító készletet le kellene választania.

Két lehetőség közül választhat:

• HANGOS – a hang a fő hangszóróból szól.
• HALK – a hang nem a fő hangszóróból, hanem a fülhallgatón vagy a kihangosító készlet fülhallgatóján keresztül

szól.

A hangos üzemmód használata
Mikor és hol használja: Telefonhívások, PABX-hívások és privát hívások indítása és fogadása esetén használja.

Eljárás:

1 Tartsa a rádiót függőleges helyzetben úgy, hogy a felső mikrofon 5–10 centiméterre legyen a szájától.
2 Beszéljen a felső mikrofonba; a másik fél hangja a belső hangszóróban fog szólni.

Az antennát tartsa legalább 2,5 cm távolságra a fejétől és a testétől.

A halk üzemmód használata
Mikor és hol használja: Telefonhívások, PABX-hívások és kétirányú privát hívások indítása és fogadása esetén
használja.

Eljárás:

1 Úgy tartsa a rádiót, mint a telefont.
2 Beszéljen az alsó mikrofonba; a másik fél hangja a fülhallgatóban fog szólni.

Az antennát tartsa legalább 2,5 cm távolságra a fejétől és a testétől.

Hívás közben

Hívás közben a következő módosítási lehetőséget a jobb oldali SZOFTVERGOMB szövege jelzi. A kiegészítők
alapértelmezett beállítása:
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10. táblázat: Hívás közben

Szoftvergomb felirata Hangbeállítás

Hangszóró A hang a fő hangszóróból szól (a Hangszóró HANGOS jelzés látható)

Fülhallgató A hang a fülhallgatóból szól (a Hangszóró HALK jelzés látható)

Kihangosító A hang a kihangosítóból szól (a Hangszóró HALK jelzés látható)

Szöveg írása

A szövegbeviteli képernyők használatához kövesse az alábbi utasításokat.

Kapcsolódó hivatkozások
A rádió feloldása A következő oldalon:31

A szövegbeviteli módok kiválasztása
Előfeltételek: A rádió kijelzőjén a szövegbeviteli képernyő jelenik meg.

Eljárás:

1 Nyomja meg a MENÜ → Szövegbeviteli mód elemet.
2 Válasszon egyet az alábbiak közül:

• Elsődleges – alfanumerikus karakterek bevitele.
• Numerikus – kizárólag számok bevitele.
• Szimbólum – kizárólag szimbólumok bevitele.
• Másodlagos – alfanumerikus karakterek bevitele (ez a mód opcionális, és hozzá kell adnia a listához).

Használata akkor javasolt, amikor alapvetően egy nyelvet használ, de néha másikra szeretne váltani.

Megjegyzés: A szövegbeviteli képernyőn a # gomb többszöri megnyomásával is válthat a beviteli
módok között.

A szövegbeviteli módok és a nyelvek kiválasztása
Előfeltételek: A rádió kijelzőjén a szövegbeviteli képernyő jelenik meg.

Eljárás:

1 Nyomja meg a MENÜ → Szövegbevitel beállításai lehetőséget.
2 Válasszon egyet az alábbiak közül:

• TAP – Betűk, számok és szimbólumok bevitele az alfanumerikus billentyűk egyszeri vagy többszöri
megnyomásával.

• iTAP – Engedélyezi, hogy a rádió az alfanumerikus billentyűk lenyomásakor előre jelezze a bevinni kívánt
szavakat.

Megjegyzés: Ezeket a módszereket a rádióba beprogramozott nyelvek esetén használhatja.

Szövegbeviteli ikonok
A szövegbeviteli képernyőn lévő ikonok azt jelzik, hogy mely szövegbeviteli módot és módszert használja. A
szövegbeviteli ikonon látható karakterszámláló a beírható karakterek számát jelzi.

A # gomb megnyomásával válthat a szövegbeviteli módok között.
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11. táblázat: Szövegbeviteli képernyő ikonjai

Elsődleges ikon Másodlagos ikonok Leírás

TAP – nincs nagybetű

TAP – csak az első betű nagybetű

TAP – mind nagybetű

iTAP – nincs nagybetű

iTap – csak az első betű nagybetű

iTap – mind nagybetű

Numerikus billentyűzet ikon Leírás

Számok bevitele.

Szimbólumbevitel ikon Leírás

Mondatvégi írásjelek és szimbólumok bevitele.

A gombok használata
Billentyűk és karakterek listája alfanumerikus módban (TAP/iTAP).

12. táblázat: A gombok használata

Gomb Alfanumerikus mód (TAP/iTAP) Szimbólum mód

SZÁMBILLENTYŰK Numerikus mód:

• A számbillentyűk megnyomásával beírhatja a
kívánt számot a megfelelő helyre.

• Bármely számbillentyűt nyomva tartva TAP
alfanumerikus módba válthat.

• A TAP alfanumerikus módból bármely
számbillentyű nyomva tartásával kiléphet.

0-S gomb Megnyomásával válthat az egyszeri Shift funkció, a
Caps Lock és a kisbetűs írásmód között.

+ - × * / \ [ ] = < > § #

1-ES gomb . , ? ! 0 1 @ ’ ” - ( ) / : _ ; + & % × * = < > € £ $ ¥ ¤ [ ] { } \ ~ ^ ¿ ¡ § #

2-ES gomb A B C 2

a b c 2

@ _ \

3-AS gomb D E F 3 / , ;

A táblázat folytatódik…
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Gomb Alfanumerikus mód (TAP/iTAP) Szimbólum mód

d e f 3

4-ES gomb G H I 4

g h i 4

” & ’

5-ÖS gomb J K L 5

j k l 5

( ) [ ] { }

6-OS gomb M N O 6

m n o 6

¿ ¡ ~

7-ES gomb P Q R S 7

p q r s 7

= < >

8-AS gomb T U V 8

t u v 8

€ £ $ ¥ ¤

9-ES gomb W X Y Z 9

w x y z 9

# % *

13. táblázat: Egyéb billentyűk

Gomb Leírás

Bármely számbillentyű • TAP bevitel esetén a szókiegészítés elvetéséhez nyomjon meg egy billentyűt, és
folytassa a szövegbevitelt. A TAP időkorlátjának leteltével, ha elérhető, új
kiegészítési javaslat jelenik meg.

• A TAP vagy iTAP alfanumerikus módban hosszan megnyomva numerikus módra
válthat.

* gomb • Megnyomásával szóköz illeszthető be.
• TAP módban megnyomva elvetheti a felajánlott szókiegészítést, és szóközt

illeszthet be.
• Új szót vehet fel a felhasználói szótárba.
• Nyomva tartásával kocsivissza karakter szúrható be.

# gomb • Egyszeri megnyomásával a különböző beviteli módok között váltogathat
(szimbólum, numerikus, elsődleges és másodlagos, ha be van állítva).

• Hosszabb megnyomásával visszatérhet az alapértelmezett beviteli módhoz.

Kiválasztás Megnyomásával kiválaszthatja a kiemelt elemet, és beillesztheti a fő szövegbeviteli
területre.

Törlés • Egyszeri megnyomásával törölheti az utoljára beírt karaktert.
• Nyomva tartásával törölheti a teljes szövegbeviteli területet.

Felfelé mutató NAVIGÁCIÓS

gomb
• TAP módban megnyomva elutasíthatja a felajánlott szókiegészítést, és felfelé

görgethet.

A táblázat folytatódik…
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Gomb Leírás

• TAP módban megnyomva a korábban kisbetűkkel beírt szöveget nagybetűssé
alakítja.

Lefelé mutató NAVIGÁCIÓS

gomb
• TAP módban megnyomva elutasíthatja a felajánlott szókiegészítést, és a

szövegbeviteli területen görgethet.
• TAP módban megnyomva a korábban nagybetűkkel beírt szöveget kisbetűssé

alakítja.

Balra mutató NAVIGÁCIÓS

gomb
• Megnyomásával balra léphet. Hosszabb megnyomásával folyamatosan jobbra

lépkedhet.
• TAP módban megnyomva elvetheti a felajánlott szókiegészítést (ha elérhető).

Jobbra mutató NAVIGÁCIÓS

gomb
• Megnyomásával jobbra léphet. Hosszabb megnyomásával folyamatosan jobbra

lépkedhet.
• TAP módban megnyomva elfogadhatja a szókiegészítést (ha elérhető).

MENÜ A helyi menüt nyitja meg, ha elérhető.

Írás iTAP alfanumerikus módban
Előfeltételek: A rádió kijelzőjén a szövegbeviteli képernyő jelenik meg.

Mikor és hol használja: Gyorsabb szövegbevitelt tesz lehetővé. Például próbálja beírni a következőt: David 232!

Eljárás:

1 Nyomja meg a MENÜ → Szövegbevitel beállításai → Elsődleges elemet.
2 Válassza az iTAPmagyar lehetőséget, és nyomja meg a Vissza gombot.
3 Nyomja meg a MENÜ → Szövegbeviteli mód elemet.
4 Válassza az Elsődleges lehetőséget.
5 Nyomja meg a 3-AS gombot.

Megjelenik az alternatívák sora, és a következőt mutatja: D E F 3.

6 Folytassa a betűkhöz tartozó billentyűk megnyomásával (egyszerre egy gombot nyomjon meg). Nyomja meg a 2-
es, a 8-as, a 4-es és a 3-as gombot.

Megjegyzés: A készülék automatikusan nagybetűt ír az üzenet elején, a pontok és a szóközök után,
valamint az új névjegybejegyzések első betűje esetében.

Az alternatívák sora a következőt mutatja: David.

7 Nyomja meg a * gombot.
8 Nyomja meg a 2-es gombot, és görgessen az alternatívák sorára. Nyomja meg a jobb NAVIGÁCIÓS gombot a

következő eléréséhez: 2.
A beviteli mód automatikusan numerikusra változik.

9 Nyomja meg a 3-AS és a 2-ES gombot.
10 Tartsa megnyomva az 1-es gombot, amíg a sor végén lévő 0 . karakterré nem változik.

Az alternatívák sora a következőt mutatja: 232..

11 Lépkedjen a lehetőségek között a jobbra mutató NAVIGÁCIÓS gombbal, amíg el nem éri a kívánt szimbólumot.
12 Nyomja meg a Kiválasztás gombot.

Beírta a következő kifejezést: David 232!.
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Írás TAP alfanumerikus módban
Előfeltételek: A rádió kijelzőjén a szövegbeviteli képernyő jelenik meg.

Eljárás:

1 Nyomja meg a MENÜ → Szövegbevitel beállításai → Másodlagos elemet.
2 Válassza a TAPmagyar lehetőséget, és nyomja meg a Vissza gombot.
3 Nyomja meg a MENÜ → Szövegbeviteli mód elemet.
4 Válassza a Másodlagos lehetőséget.
5 Ha a kívánt karakter az első helyen szerepel a billentyűn, egyszer nyomja meg, ha a második helyen, kétszer, és

így tovább.

Példa:
Az s betű beírásához nyomja meg négyszer a 7-ES gombot. A 7-es szám beírásához ötször nyomja
meg a 7-es gombot. Ha néhány másodpercig nem nyom meg gombot, a készülék elfogadja a
karaktert, és a kurzor a következő helyre lép.

Szavak zárolása
Előfeltételek: A rádió kijelzőjén a szövegbeviteli képernyő jelenik meg.

Mikor és hol használja: Olyan szavak hozzáadását teszi lehetővé, amelyek nem szerepelnek a szótárban.

Eljárás:

1 Nyomja meg a MENÜ → Szövegbevitel beállításai lehetőséget.
2 Válassza az iTAPmagyar lehetőséget.
3 Próbálja meg beírni a szót. Keresse meg a kívánt szót a lehetőségek sorában. A lehetőségek egymás után lesznek

kiemelve, és részben zárolva.
4 Adja meg a szó második felét. Az első rész változatlan (lezárt) marad. A készülék kijelöli az újonnan megadott

betűket, és a következő szólehetőségre történő görgetéssel lezárja őket.
5 Nyomja meg a * gombot. A szóköz megadásakor a szó megjelenik a szövegterületen, és automatikusan bekerül a

szótárba.

Szavak hozzáadása a szótárhoz
Minden nyelvhez saját szótár tartozik. Ön is létrehozhat szavakat (az alfanumerikus rövidítéseket is beleértve). Ha
egy szó után szóközt ír be, a szó automatikusan bekerül a szótárba, és a jövőben, ha ugyanazt a billentyűkombinációt
nyomja meg, megjelenik a javaslatok között.

Kezdőképernyő-üzenet

A rádió rendelkezik egy olyan funkcióval, amely lehetővé teszi, hogy a szolgáltató speciális szöveges üzeneteket
küldjön a kijelzőre. Az üzenet a kezdőképernyőn marad addig, amíg új üzenet nem érkezik. A kezdőképernyő-üzenet
előre beállított üzenetre cseréléséhez indítsa újra a rádiót.
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fejezet

3
Üzemmódok

Ez a fejezet a rádió által használt üzemmódokat mutatja be.

Hálózatok használata

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Hálózatok.
3 Válasszon egyet az alábbiak közül:

• Trönkölt mód
• Közvetlen mód
• Adástiltás mód

A rádió a kiválasztott módra vált.

Trönkölt üzemmód

A trönkölt üzemmód (TMO) használatához kapcsolási és felügyeleti infrastruktúra szükséges. Ez az üzemmód mód
sokféle típusú hang- és adatkommunikációt (például csoporthívások, rövid adatszolgáltatási üzenetek) és az
infrastruktúrával kapcsolatos funkciók elérését (például adatcsomag-átvitel) .

1. ábra: Trönkölt üzemmód
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Váltás TMO módra
Eljárás:

1 A kezdőképernyőn válassza az Opciók elemet.
2 Válassza a Trönkölt mód lehetőséget.

Beszédcsoportok kiválasztása
A kezdőképernyőn válassza a következő lehetőségek egyikét:

• Nyomja meg a balra vagy a jobbra mutató NAVIGÁCIÓS gombot. Erősítse meg a kijelölt opciót a Kiválasztás
gombbal.

• Válassza az Opciók → Beszédcsoportok név szerint lehetőséget. Írja be egy beszédcsoport nevét, és válassza ki
a beszédcsoport nevét a listából.

• Válassza az Opciók → Beszédcsoportok mappa szerint lehetőséget. Válasszon mappát, majd válassza ki a
kívánt beszédcsoportot.

• Nyomja meg a FORGATÓGOMBOT, és forgassa addig, amíg meg nem jelenik a kívánt beszédcsoport neve. Erősítse
meg a kijelölt opciót a Kiválasztás gombbal.

Megjegyzés: Ha a FORGATÓGOMB görgetésre van állítva, akkor nem kell megnyomnia a görgetés mód
aktiválásához.

Megjegyzés: A rádió a mappastruktúra max. 3 szintjét képes elérni.

Csoporthívások indítása TMO módban
A csoporthívást a kiválasztott csoport minden olyan tagja megkapja, akinek be van kapcsolva a készüléke és
hatótávolságon belül tartózkodik.

Eljárás:

1 Nyomja meg hosszabban a PTT gombot.
2 Várja meg a beszédengedélyező hangot (ha be van állítva), és beszéljen a mikrofonba. A másik fél

meghallgatásához engedje fel a PTT gombot.

Megjegyzés: A csoporthívás megszakításához még a beszédengedélyező hang lejátszása előtt tegye az
alábbiakat (a szolgáltató beállításaitól függően):

• Engedje fel a PTT gombot.
• Nyomja meg a HÍVÁS VÉGE gombot (alapértelmezett).

Ha a hívás megszakítása sikerrel járt, a Hívás megszakítva üzenet jelenik meg a rádió kijelzőjén (ha a
szolgáltató így állította be a készüléket).

Csoporthívás fogadása készenléti állapotban
Eljárás:

1 Ha a rádióra csoporthívás érkezik:

Megjegyzés: A csoporthívás beérkezését a Csoporthívás érkezett hangjelzés jelzi.

2 A hívás fogadásához nyomja meg hosszan a PTT gombot.

Csoporthívás fogadása folyamatban lévő csoporthívás közben
Ha aktív csoporthívásban van, és a rádió nagyobb prioritású csoporthívást kap,
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Az alábbiak történhetnek:

• A rádió befejezi az aktuális csoporthívást, és automatikusan csatlakozik a bejövő híváshoz.
• Megjelenik a bejövő csoporthívás képernyője, amely a következő opciókat tartalmazhatja:

• Csatlakozás – az aktuális csoporthívás befejezése és a bejövő hívás megkezdése.
• Befejezés – a bejövő csoporthívás megszakítása.

Dinamikus csoportszám-kiosztás (DGNA)
A DGNA lehetővé teszi, hogy a hálózati operátor dinamikus módon tehesse elérhetővé a beszédcsoportokat a rádiók
kezelőfelületén. A DGNA segítségével a hálózati operátor a következő műveleteket végezheti el:

• Beszédcsoportok hozzáadása
• Újonnan hozzáadott beszédcsoportok csatolása és kiválasztása
• Beszédcsoportok törlése
• Meglévő beszédcsoportok paramétereinek módosítása.

A fenti műveletek elvégzéséhez rádión keresztüli adatátvitel szükséges.

DGNA-vétel
DGNA-üzenet vételekor a rádió hangjelzést ad ki, és a Beszédcsoportlista frissítve üzenetet jeleníti meg. Ha a
szolgáltató engedélyezte, a rádió minden felvett és törölt beszédcsoportlistát megjelenít.

Ha a szolgáltató törli a jelenleg kiválasztott beszédcsoportot (megszünteti hozzárendelését), akkor a rádió a –
beállításoktól függően – a következők egyikét teheti:

• Belép a „csoport nélküli” állapotba – a rádió egyetlen beszédcsoporthoz sem csatlakozik automatikusan.
• Csatlakozik a legutóbb kiválasztott TMO beszédcsoporthoz. Ha a legutóbb kiválasztott TMO beszédcsoport nem

elérhető (törölték), akkor a rádió belép a „csoport nélküli” állapotba.
• A szolgáltató által beállított alapértelmezés szerinti beszédcsoporthoz csatlakozik. Ha az alapbeállítás szerinti

beszédcsoport nem elérhető (törölték), akkor a rádió belép a „csoport nélküli” állapotba.

Minden beszédcsoportváltásnál a megfelelő értesítés olvasható a kijelzőn.

Ha az összes beszédcsoport törlésére utasító DGNA-üzenet érkezik, a rádió a Minden beszédcsoport törölve
üzenetet jeleníti meg. A DGNA képernyőről való kilépéshez használhatja a Vissza SZOFTVERGOMBOT vagy a HÍVÁS

VÉGE gombot.

DGNA – automatikus csoportkiválasztás
A funkció használata esetén a DGNA-üzenet érkezésekor a rádió átvált a felvett beszédcsoportra.

DGNA – csoport automatikus újbóli kiválasztása
Ha a DGNA – csoport automatikus újbóli kiválasztása be van állítva, akkor a hálózati operátor által DGNA
használatával hozzárendelt beszédcsoport hozzárendelésének felhasználói művelet nélküli megszüntetésekor a rádió
visszatér a korábban kiválasztott csoporthoz.

DGNA-beszédcsoport megtekintése
Előfeltételek: Ha a rádióra DGNA-üzenet érkezik:

Eljárás:

1 A hozzáadott beszédcsoportok adatainak megtekintéséhez nyomja meg a Megtekintés gombot.
2 Görgetéssel keresse meg a listában a kívánt beszédcsoportot.
3 A DGNA-csoport kiválasztásához nyomja meg a Csatolás gombot.
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Felhasználók által kezdeményezett szórásos hívás
Ez a funkció lehetővé teszi, hogy egy előre meghatározott beszédcsoport felé kezdeményezzen szórásos hívást a
rádióról. A szórásos hívás nevét és prioritását a szolgáltató állítja be.

Megjegyzés: Ha a titkosítás típusát a SIM-kártya határozza meg, a szórásos hívás mindig titkosítás nélküli.
Amennyiben a rádió más típusú titkosítási szolgáltatást használ, a hívás titkosításának típusa a szolgáltatás
titkosítási beállításaitól függ.

Megjegyzés: Ezt a szolgáltatást a Dimetra infrastruktúra nem támogatja.

Szórásos hívás inicializálása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Szolgáltatások → Szórásos hívás lehetőséget.

A rádió kijelzőjén az alapértelmezett alias és a Szórásos hívás ikon jelenik meg.

3 A hívás elindításához nyomja meg a PTT gombot.

Telefon- és PABX-hívások
Telefonhívással vonalas és mobiltelefonszámokat hívhat. A PABX-hívás helyi (irodai) mellékek hívását teszi
lehetővé.

Privát hívás
Privát, pont-pont vagy egyéni hívásnak a két személy közti hívásokat nevezzük. Ezeket a beszélgetéseket más rádiók
nem hallhatják. Ez a hívástípus kétféleképpen hajtható végre:

• Kétirányú hívás (ha a rendszer engedélyezi), TMO üzemmódban Mindkét fél egyszerre beszélhet.
• Egyirányú hívás, TMO és DMO üzemmódban. Egyszerre csak egy fél beszélhet.

A DMO üzemmódú privát hívások esetében azok a rádiók, amelyek nem vesznek részt a hívásban, csatornafoglaltsági
jelzést kapnak. A rádiók azonosítása a rádiószámmal történik.

Kapcsolódó hivatkozások
Egyedi vészhívások (Privát vagy MS-ISDN) A következő oldalon:56

Privát hívások indítása
Eljárás:

1 A kezdőképernyőn írjon be egy számot.
2 Ha az első felajánlott hívástípus nem a privát hívás, nyomja meg ismét a Hívástípus gombot a kiválasztásához.
3 Ha a következő módban van:

a TMO – egyirányú hívásokhoz nyomja meg, majd engedje fel a PTT gombot. Csengést fog hallani. Ettől eltérő
esetben, nyomja meg hosszabban a PTT gombot. Csak a beszédengedélyező hang után szólaljon meg, a válasz
meghallgatásához pedig engedje fel a PTT gombot. Kétirányú hívásokhoz nyomja meg, majd engedje fel a
KÜLDÉS gombot. Csengést fog hallani.

b DMO – Csak egyirányú hívások lehetségesek. Nyomja meg hosszabban a PTT gombot. Csak a
beszédengedélyező hang után szólaljon meg, a válasz meghallgatásához pedig engedje fel a PTT gombot.

4 A hívás befejezéséhez nyomja meg a HÍVÁS VÉGE gombot.
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Segélyhívás
Ez a funkció lehetővé teszi, hogy normál és nem kritikus helyzetekben privát segítségkérő hívásokat indítson.

Megjegyzés: A szolgáltató konfigurálhatja a hívás számát, prioritását és típusát (egyirányú vagy
kétirányú).

A segélyhívást a következő módon indíthatja el:

• Tárcsázzon egy előre beállított számot, majd nyomja meg a KÜLDÉS gombot.
• Menü → További . . . → Szolgáltatások → Segélyhívás

Hívásmódosítás
A hívásmódosítás olyan funkció, amelynek segítségével a szolgáltató az optimalizálás és az adott helyzethez való
igazítás érdekében módosíthatja a hívást.

A módosítás az alábbiakra terjedhet ki:

• Hívás prioritása – a módosítása a hívás felépítése során történik.
• Hívás típusa – a módosítása a hívás felépítése során történik.
• Hívás titkosítása – a módosításra a folyamatban lévő hívás során (de nem az átviteli szakaszban) kerül sor.

A hívás módosítása esetén a rádión a Hívás módosítva üzenet jelenik meg.

Ha a módosított hívás átviteléhez a PTT gomb megnyomására van szükség, a rádión a Hívás módosítva Nyomja
meg a PTT gombot üzenet jelenik meg.

A módosításokat a szolgáltató végzi, a rádió csupán követi azokat. A folyamatban lévő hívásmódosításokat a
felhasználó semmilyen módon nem képes befolyásolni.

Ha a hívás prioritása Vészhelyzet:

• A kijelző jelzi a csoportos vészhívás érkezését.
• A rádió egyedi figyelmeztető hangjelzést játszik le.

Megjegyzés: Ha a csoporthívást csoportos vészhívássá alakítják, a vészhívások további funkciói nem
lesznek aktiválva.

Ha a szolgáltató által kért hívásmódosítást a rádió (a beállításai miatt) nem képes végrehajtani, a hívás módosítására
nem kerül sor, és a Szolgáltatás nem érhető el üzenet jelenik meg a rádió kijelzőjén.

Helyi cellás trönkölés

Ez az üzemmód, amelyet tartalék módnak is neveznek, lehetővé teszi, hogy az ugyanazon a területen lévő rádiók
akkor is tudjanak egymással kommunikálni, ha nem tudnak kapcsolódni a hálózat központi vezérlőjéhez. A helyi
cellás trönkölésbe történő belépés és a szolgáltatásból való kilépés (azaz a rendszerszintű szolgáltatásba való
visszatérés) automatikusan megy végbe. Ebben az üzemmódban egyes szolgáltatások nem érhetők el.

Megjegyzés: Ezt a módot a szolgáltató letilthatja.

Váltás helyi cellás trönkölésre
Ha a rádió a helyi cellás trönkölésről tájékoztató jelzést kap a rendszertől, az alábbiak történnek:

• A rádió a Belépés helyi cellás trönkölésbe hangjelzést játssza le.
• A kijelzőn a Helyi szolgáltatás üzenet jelenik meg.
• A kijelző ikonjai és szoftvergombjai olajzöldre változnak.
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Megjegyzés: Csak a színes kijelzőn észlelhető.

• A helyi cellás trönkölési módba történő belépéskor a készülék minden folyamatban lévő hívást bont.

Ha a szolgáltató beállította, rendszeresen ismétlődő üzenet/riasztás tájékoztatja arról, hogy a rádió még mindig a helyi
cellás trönkölési módban üzemel. Az alábbi szolgáltatások érhetők el:

• Regisztrálás
• Csatlakozás
• Csoporthívás
• Vészhívás
• Vészjelzés

Megjegyzés: A szolgáltató be- és kikapcsolhat minden vizuális és hangjelzést, amikor Ön helyi cellás
trönkölés módba lép.

Kilépés a helyi cellás trönkölésből
Ha a központi hálózati vezérlővel újra helyreáll a kapcsolat, a rádió kilép a helyi cellás trönkölésből, és az alábbiak
történnek:

• A rádió a Kilépés a helyi cellás trönkölésből hangjelzést játssza le.
• A készülék a helyi cellás trönkölés alatt indított hívásokat megszakítja.
• A kijelző ikonjai és szoftvergombjai kékre változnak.

Megjegyzés: A helyi cellás trönkölésből való kilépéskor lejátszott hang- és képi jelzéseket a kiszolgáló
kapcsolhatja ki és be.

Közvetlen mód

A közvetlen mód közvetlen és egyirányú kommunikációt tesz lehetővé a rádiók között.

2. ábra: Közvetlen mód

Belépés DMO módba
Belépés a DMO módba:
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• A kezdőképernyőn nyomja meg a MENÜ gombot. Válassza a következőt: További. . . → Hálózatok → Közvetlen
mód.

• A kezdőképernyőn Válassza az Opciók → Közvetlen mód lehetőséget.

Beszédcsoportok kiválasztása
A kezdőképernyőn válassza a következő lehetőségek egyikét:

• Nyomja meg a balra vagy a jobbra mutató NAVIGÁCIÓS gombot. Erősítse meg a kijelölt opciót a Kiválasztás
gombbal.

• Válassza az Opciók → Beszédcsoportok név szerint lehetőséget. Írja be egy beszédcsoport nevét, és válassza ki
a beszédcsoport nevét a listából.

• Válassza az Opciók → Beszédcsoportok mappa szerint lehetőséget. Válasszon mappát, majd válassza ki a
kívánt beszédcsoportot.

• Nyomja meg a FORGATÓGOMBOT, és forgassa addig, amíg meg nem jelenik a kívánt beszédcsoport neve. Erősítse
meg a kijelölt opciót a Kiválasztás gombbal.

Megjegyzés: Ha a FORGATÓGOMB görgetésre van állítva, akkor nem kell megnyomnia a görgetés mód
aktiválásához.

Megjegyzés: A rádió a mappastruktúra max. 3 szintjét képes elérni.

Csoporthívások indítása TMO módban
A csoporthívást a kiválasztott csoport minden olyan tagja megkapja, akinek be van kapcsolva a készüléke és
hatótávolságon belül tartózkodik.

Eljárás:

1 Nyomja meg hosszabban a PTT gombot.
2 Várja meg a beszédengedélyező hangot (ha be van állítva), és beszéljen a mikrofonba. A másik fél

meghallgatásához engedje fel a PTT gombot.

Csoporthívás fogadása készenléti állapotban
Eljárás:

1 Ha a rádióra csoporthívás érkezik:

Megjegyzés: A csoporthívás beérkezését a Csoporthívás érkezett hangjelzés jelzi.

2 A hívás fogadásához nyomja meg hosszan a PTT gombot.

Privát hívás
Privát, pont-pont vagy egyéni hívásnak a két személy közti hívásokat nevezzük. Ezeket a beszélgetéseket más rádiók
nem hallhatják. Ez a hívástípus kétféleképpen hajtható végre:

• Kétirányú hívás (ha a rendszer engedélyezi), TMO üzemmódban Mindkét fél egyszerre beszélhet.
• Egyirányú hívás, TMO és DMO üzemmódban. Egyszerre csak egy fél beszélhet.

A DMO üzemmódú privát hívások esetében azok a rádiók, amelyek nem vesznek részt a hívásban, csatornafoglaltsági
jelzést kapnak. A rádiók azonosítása a rádiószámmal történik.

Kapcsolódó hivatkozások
Egyedi vészhívások (Privát vagy MS-ISDN) A következő oldalon:56
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Privát hívások indítása
Eljárás:

1 A kezdőképernyőn írjon be egy számot.
2 Ha az első felajánlott hívástípus nem a privát hívás, nyomja meg ismét a Hívástípus gombot a kiválasztásához.
3 Ha a következő módban van:

a TMO – egyirányú hívásokhoz nyomja meg, majd engedje fel a PTT gombot. Csengést fog hallani. Ettől eltérő
esetben, nyomja meg hosszabban a PTT gombot. Csak a beszédengedélyező hang után szólaljon meg, a válasz
meghallgatásához pedig engedje fel a PTT gombot. Kétirányú hívásokhoz nyomja meg, majd engedje fel a
KÜLDÉS gombot. Csengést fog hallani.

b DMO – Csak egyirányú hívások lehetségesek. Nyomja meg hosszabban a PTT gombot. Csak a
beszédengedélyező hang után szólaljon meg, a válasz meghallgatásához pedig engedje fel a PTT gombot.

4 A hívás befejezéséhez nyomja meg a HÍVÁS VÉGE gombot.

Privát hívás jelenlét-ellenőrzéssel
Ezzel a funkcióval ellenőrizheti, hogy a hívó fél DMO-módban elérhető-e. Ha a funkció elérhető, csak akkor
kezdeményezhet privát hívást, ha a hívott rádió az Önével megegyező csatornán van, és a jelenlétét megerősítő
üzenetet küld.

Egyébként a rádió kijelzőjén A másik fél nem érhető el üzenet jelenik meg.

Egyedi hívások számára létrehozott beszédcsoport
Az egyedi hívások számára létrehozott beszédcsoport olyan önálló frekvencián működő beszédcsoport, amelyben
kizárólag egyedi (privát) hívások indíthatók. A segítségével optimalizálhatók a frekvenciaerőforrások, és
csökkenthető a többi beszédcsoport terhelése. Csak a privát hívásokat és a vészhívásokat (privát vagy csoportos)
támogatja. Ha privát hívást szeretne indítani, ezt a beszédcsoportot használja.

Egyedi hívások számára létrehozott beszédcsoport használata esetén a rádió nem képes vészhívásnál alacsonyabb
prioritású csoportos vagy szórásos hívásokat fogadni és indítani.

Ha az egyedi hívások számára létrehozott beszédcsoportban megnyomja a PTT gombot, hogy csoportos hívást
indítson, a rádió:

• Elutasítja a hívást
• Dallamot játszik le
• Megjeleníti a Csak egyedi hívások üzenetet

Jelismétlőkön keresztüli kommunikáció
Azok a rádiók, amelyek kívül esnek egymás hatótávolságán, és nem tudnak közvetlenül kommunikálni egymással
DMO módban, jelismétlő segítségével kommunikálhatnak. A jelismétlő olyan rádió, amely az adott csatornán zajló
teljes kommunikációt megismétli, megnövelve ezáltal a rádiók DMO-tartományát.
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DMODMO

Ha a rádió jelismétlőhöz csatlakozik, hangjelzést játszik le, a kijelzőjén pedig a Jelismétlő érhető el üzenet, valamint
a megfelelő ikon jelenik meg. Ha a rádió kapcsolata megszakad a jelismétlővel, a rádió hangjelzést játszik le, a
kijelzőjén pedig a Jelismétlő nem érhető el üzenet jelenik meg, valamint a jelismétlő ikon villog.

Átjárókon keresztüli kommunikáció
Az átjáró mód a DMO módban és a TETRA hálózaton működő rádiók között biztosít kapcsolatot, lehetővé téve, hogy
a DMO rádiók kommunikálhassanak a TMO rádiókkal.

DMO

TMO

TMO

Ha a rádió átjáróhoz csatlakozik, hangjelzést játszik le, és az Átjáró elérhető üzenetet, valamint a megfelelő ikont
jeleníti meg. Ha a rádió kapcsolata megszakad az átjáróval, hangjelzést játszik le, és az Átjáró nem érhető el
üzenetet, valamint a megfelelő ikont jeleníti meg.

DMO csoporthívás beállításainak kiválasztása
Mikor és hol használja: Az átjáró és a jelismétlő funkció megkönnyíti a beszédcsoport többi felhasználójával való
kommunikációt.

Eljárás:

1 A kezdőképernyőn válassza az Opciók elemet.
2 Nyomja meg a Konfigurálás gombot.
3 Válasszon egyet az alábbiak közül:
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• MS – MS – A rádió csak a hatótávolságán belüli rádiókkal kommunikálhat.
• Átjáró – A rádió átjárót használ a hálózati infrastruktúrával való kommunikációhoz.

• Automatikus – a rádió a beszédcsoporthoz elérhető első átjárót fogja használni.
• Speciális – a rádió csak a megadott című átjárót fogja használni az adott beszédcsoporthoz. Ha a rádió

kijelzőjén a Kiválasztott átjáró: Nincs felirat jelenik meg, válassza a Szerkesztés lehetőséget az aktuális
átjárócím szerkesztéséhez.

• Jelismétlő – a beszédcsoporthoz tartozó első elérhető jelismétlő használata.
• Átjáró és jelismétlő – a beszédcsoporthoz tartozó első elérhető átjáró vagy jelismétlő használata.

• Automatikus – a beszédcsoporthoz tartozó első elérhető átjáró használata.
• Speciális – csak a megadott című átjáró használata az adott beszédcsoporthoz. Ha a rádió kijelzőjén a

Kiválasztott átjáró: Nincs felirat jelenik meg, válassza a Szerkesztés lehetőséget az aktuális átjárócím
szerkesztéséhez.

Megjegyzés: Ha a beszédcsoporthoz tartozó átjáró vagy jelismétlő nem használható, a rádió
közvetlen MS-MS kommunikációt kísérel meg.

.

Ha a rádió észleli a megfelelő átjárót és/vagy jelismétlőt, akkor az Átjáró ikon, illetve a Jelismétlő ikon folyamatosan
fog világítani.

Adástiltás (TXI) mód

Az adástiltás mód olyan üzemmód, amelyben a rádió nem ad rádiójeleket. Ezt a módot RF-érzékeny területeken,
például kórházak, repülőgépek területén, és olyan robbanásveszélyes helyeken érdemes aktiválnia, ahol a rádióadás
okozta sugárzás veszélyforrást jelenthet.

Az aktiváláshoz válassza a MENÜ → Tovább. . . → Hálózatok → Adástiltási mód → Aktiválás lehetőséget.

Ebben a módban a rádió kizárólag vészhívásokhoz használható adásra. Az összes olyan funkció és gomb, amely
adással jár, ki van kapcsolva. Ilyen tevékenységek pl. a hálózaton való regisztrálás, a beszédcsoport- vagy
mappaváltás, az SDS üzenetküldés vagy a PTT gomb megnyomása stb. Az adással járó műveletek aktiválásakor a
rádió hangjelzést ad, és az Adástiltás esetén nem engedélyezett értesítést jeleníti meg.

A rádió továbbra is fogadhat:

• Csoporthívásokat
• Üzeneteket, amelyek a Bejövő üzenetek mappába kerülnek
• Privát hívásokat, amelyek a Nem fogadott hívások listában lesznek tárolva, ugyanakkor felvenni már nem lehet

őket

Ha nincs már biztonsági kockázat (például, ha elhagyja az RF-érzékeny területet), az adástiltás mód kikapcsolható, és
a rádió visszatér a normál működéshez.

Az adástiltási módot kikapcsolhatja a MENÜ → Tovább. . . → Hálózatok → Adástiltási mód → Inaktiválás
lehetőséget választva, megnyomva az egygombnyomásos gombot, illetve vészhívás indításával implicit módon.

Megjegyzés: A rádió nem sugároz rádiófrekvenciás jelet az alábbi esetekben:

• Az adástiltás mód aktív.
• Az akkumulátor el van távolítva.
• A rádió ki van kapcsolva.

Az adástiltás mód be- és kikapcsolásakor, ha a rádió egy adott cellában van, speciálisan kijelölt SDS állapotüzenetet
küld. Ez az SDS üzenet jelzi a kapcsolási és felügyeleti infrastruktúrának (SwMI), hogy a rádión az adástiltás módot
be- vagy kikapcsolták.
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A készülék végrehajtja az olyan mobilitási eljárásokat, amelyekhez nem szükséges, hogy a rádió felmenő ágon adjon,
kivéve a cella-újraválasztást.

Adástiltás módban a rádió felveszi a csoporthívásokat azokban a csoportokban, amelyeket megfigyel, de az adás
továbbra is tiltva marad.

A rádió a beérkező SDS üzeneteket is megjeleníti a felhasználó számára. A nem fogadott hívás funkció adástiltás
módban is aktív, és segítségével megtekinthetők a nem fogadott hívások. Azonban a rádió megkísérli a hívásfelépítési
továbbadás külön hívásként történő rögzítését.

Ha vészhívást indít, a rádió azonnal kilép az adástiltás módból, és úgy kísérli meg a vészhívást, mintha használatra
készen állna.

Ha a rádió a kikapcsolásakor adástiltás módban volt, a bekapcsoláskor megkérdezi, hogy kilépjen-e az adástiltás
módból. Ha a válasza Nem, akkor a rádió kikapcsol.

Vészhívás

A vészhívás kritikus helyzetekben használatos.

A VÉSZHÍVÁS gomb lenyomásakor, vagy a Vészhívószám menübe belépve, majd a KÜLDÉS gombot megnyomva egy
vagy több szolgáltatás aktívvá válik (a szolgáltatói beállításoktól függően):

• Vészjelzés
• SDS-állapot
• Néma vészhívás
• Élő mikrofon üzemmód
• Egyedi vészhívás (Privát vagy MS-ISDN)
• GPS-helyadatok

Megjegyzés: A rádió bekapcsolható a VÉSZHÍVÁS gomb megnyomásával. A szolgáltatói beállításoktól
függően a rádió automatikusan is elindíthatja a vészhívási műveleteket. Ha a rádiót PIN kód védi (a SIM-
kártya PIN kódjának kivételével), a vészhívás idejére kikapcsol a PIN-zárolás.

A vészhívás indításakor minden folyamatban lévő hanghívás, illetve adatcsomag-átvitel megszakad. A munkamenet
azonban nyitva marad.

Vészhívás közben a rádió automatikusan visszautasítja a telefonszámok és helyi mellékek hívását, valamint a privát
hívásokat, és nem figyeli a felhasználó által beállított letapogatási listában lévő beszédcsoportokat.

A vészhívás megszakításához nyomja meg a felsőSZOFTVERGOMBOT

Csoportos vészhívás
A csoportos vészhívás rendelkezik a legmagasabb kommunikációs prioritással, azaz felülbírál más hívásokat. A
csoportos vészhívás elérhető TMO és DMO módban is. Vészhívási műveletek során a csoportos vészhívás VÉSZHÍVÁS

gomb hosszabb megnyomásával indíthatja el. A rádió támogatja az éles mikrofon módot is, amelynek segítségével a
vészhívások a PTT gomb megnyomása nélkül is lefolytathatók.

Ha a rádió vészhívás prioritású bejövő csoporthívást kap, speciális hangjelzés szólal meg, a kijelzőn pedig a csoportos
vészhívás érkezését jelző értesítés jelenik meg.

A csoportos vészhívások az alábbiak szerint konfigurálhatók:

• Nem taktikai hívás – a szolgáltató által előre programozott beszédcsoportból kezdeményezett hívás. A nem
taktikai vészhívási módban nincs lehetőség a beszédcsoportok közötti váltásra.

• Taktikai hívás – az aktuálisan kiválasztott beszédcsoporton indítható hívás.

TMO módban ha a rádió vészhívás módba lép, miközben szórásos vészhívás van folyamatban, a rádió folytatja a
hívást, nem indít más hívásokat, és vészjelzést küld.
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Ha a csoportos vészhívás, amelyben részt vesz, véget ér, a rádió a szolgáltató beállításaitól függően többféle módon is
viselkedhet:

• Ha Ön a hívás kezdeményezője, a rádió vagy vészhívás módban marad, vagy visszatér TMO módba.
• Ha nem Ön kezdeményezte a hívást, a rádió mindig visszatér TMO módba.

Csoportos vészhívások indítása
Előfeltételek: Gondoskodjon róla, hogy a rádió vészhívás módban legyen.

Eljárás:

1 Nyomja meg hosszabban a PTT gombot.
2 Várja meg a beszédengedélyező hangot (ha be van állítva), és beszéljen.
3 A másik fél meghallgatásához engedje fel a PTT gombot.

Megjegyzés: TMO módban lehetőség van a csoportos vészhívás indításának megszakítására. Ennek
elvégzéséhez tegye a következők egyikét a beszédengedély megadása előtt (a szolgáltatói beállításoktól
függően):

• Engedje fel a PTT gombot.
• Nyomja meg a HÍVÁS VÉGE gombot (alapértelmezett).

Ha a hívás megszakítása sikerrel járt, a Hívás megszakítva üzenet jelenik meg a rádió kijelzőjén (ha a
szolgáltató így állította be a készüléket).

Csoportos vészhívások fogadása
A készülék csoportos vészhívást kap a kiválasztott előre programozott csoporttól. A bejövő hívást a megfelelő
hangjelzés, állapotikon és a kijelző vörös színe jelzi.

Nem taktikai vészhívás
A nem taktikai vészhívási módban a rádió a vészhívás megkezdésekor a kijelölt vészhívási beszédcsoportra vált át. A
rádió ezt a beszédcsoportot használja a vészhívás egész időtartama során (a beszédcsoport nem módosítható).

TMO módban a rádió beállítható nem taktikai csoportos vészhívás csatlakoztatás küldése nélküli indítására. Ha ez be
van állítva, akkor a rádió az ideiglenes cím vétele után implicit csatlakoztatást tételez fel.

DMO módban a nem taktikai vészhívás a korábban kiválasztott beszédcsoporttal azonos frekvencián folyik. A
szolgáltató kijelölhet tetszőleges ITSI-címet a vészhívással való használathoz (ez lehet nyílt csoportos szórási cím is).

A nem taktikai vészhívásból való kilépés után a rádió visszatér az előzőleg kiválasztott beszédcsoportba.

Egyedi vészhívások (Privát vagy MS-ISDN)
Az egyedi vészhívások vészhívás prioritású egyirányú vagy kétirányú hívások. A Vészhívás gomb megnyomásakor a
rádió egyedi hívást kezdeményez a megadott (privát vagy MS-ISDN) címre. Az ilyen típusú hívások során minden
felhasználói jelzés és egyéb szolgáltatás le van tiltva. A vészhívás az egyedi vészhívás véget érésekor lezárul.

Kapcsolódó hivatkozások
Privát hívás A következő oldalon:48

Vészjelzés
A vészjelzés egy olyan speciális állapotüzenet, amelyet a készülék a vészhívás módba lépéskor küld el a hálózatnak.
Előfordulhat, hogy a rádió az ismételt kísérlet előtt a hálózat vészjelzésnyugtázására vár.

A rádió a vészhívás módba való minden egyes belépéskor vészjelzést küld. A vészjelzés sikeres küldésekor megszólal
a megfelelő hangjelzés.
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A rádió további vészjelzést küld (kivéve élő mikrofon módban), ha a VÉSZHÍVÁS gomb megnyomásának
eredményeképp vészhívás módba lép.

Az üzenet mind TMO, mind DMO módban elküldhető.

Vészhelyzeti SDS-állapot
A rádió előre programozott értéket tartalmazó állapotüzenetet küld a szolgáltató által beállított célcímre. A
vészhelyzeti SDS-állapot csak TMO módban érhető el. Ha nem érkezik állapotnyugtázás vagy negatív visszaigazolás,
a rádió újra megpróbálkozik az üzenet küldésével. Ha a vészjelzés vagy az élő mikrofon van beállítva, akkor a rádió
nem küldi újra a helyzetet.

Vészhelyzeti élő mikrofon
Az élő mikrofon funkció lehetővé teszi, hogy vészhívás módban a PTT gomb megnyomása nélkül beszélhessen. Az
adás előre megadott ideig tart. Ha az élő mikrofon számára beállított időkeret lejárása előtt megnyomja a PTT
gombot, az adás befejeződik. Ezután a PTT gomb a csoporthívásban megszokott módon használható (azaz az adás
addig tart, amíg a PTT gombot nyomva tartják).

Vészhívás módban a vészhívás gomb újbóli megnyomásakor ismét aktiválódik az élő mikrofon használatával történő
átvitel.

Ha a csoport egy másik tagja megkapja az engedélyt a beszédre, akkor a Vészhívás érkezett hangjelzés hallható. Ha a
funkció konfigurálva van, a rádió automatikusan megpróbál beszédengedélyt szerezni.

A Hívás végeSZOFTVERGOMB vagy a Hívás vége gomb megszakítja az élő mikrofon működését.

Váltakozó éles mikrofon
A váltakozó éles mikrofon funkció az éles mikrofon funkció továbbfejlesztése. Az aktiválás után a rádió váltakozva
lép be az adási (ilyenkor a mikrofon aktív) és a vételi szakaszba (ilyenkor csak mások adását hallgathatja) a
szolgáltató által pontosan meghatározott ideig.

Amennyiben a funkció aktív, a Váltakozó éles mikrofon funkciót a VÉSZHÍVÁS gomb megnyomásával kapcsolhatja be.
Ha előbb be szeretné fejezni az adást vagy ki szeretné hagyni az adási szakaszt, akkor nyomja meg a HÍVÁS VÉGE

gombot.

Ha az alábbi követelmények egyike teljesül, a Váltakozó éles mikrofon funkció kikapcsol:

• A rádió kilép a Vészhívás módból:
• A Váltakozó éles mikrofon üzemmód időkerete lejár.
• A PTT gomb megnyomása.
• A felső SZOFTVERgombot (csak az adási szakasz alatt).

Megjegyzés: Ha a rádió szolgáltatási területen kívülre kerül, vételi módba lép, és a váltakozó éles mikrofon
funkció szünetel. Ha a rádió ismét a szolgáltatási területen belülre kerül, az Éles mikrofon és a Váltakozó
éles mikrofon funkció visszaáll.

Megjegyzés: Ha a felhasználó vészhívás módban van, a VÉSZHÍVÁS gomb megnyomása újraindítja a
váltakozó éles mikrofon funkciót.

Csendes vészhívás mód
A csendes vészhívás mód egy olyan vészhívási szolgáltatás, amelynél a hangjelzések és a billentyűhangok le vannak
tiltva. A kijelzőn ugyanazok az elemek láthatók, mint otthoni módban. Azonban a rádió nem használhat semmilyen
szolgáltatást, kivéve a következőket:

• Környezetlehallgatás fogadása
• Csendes vészjelzések küldése
• GPS-helyjelentések küldése
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Megjegyzés: Ha megpróbálja aktiválni a szolgáltatásokat, akkor azok az aktiváláskor blokkolva vannak.

Ha a Csendes vészhívás funkció engedélyezve van, a rádió a vészhívás gomb megnyomásának hatására Csendes
vészhívás módba lép. Az aktuális állapottól függően e módba lépéskor a rádió vagy TMO módban marad, vagy arra
vált át. A TMO módra váltás után a rádió csendes vészjelzést küld.

Megjegyzés: Ha privát vagy csoporthívás van folyamatban, a Csendes vészhívás módra való átváltásra
csak a hívás befejezése után kerül sor.

A rádió folyamatosan próbálkozik a vészjelzés elküldésével, amíg a küldésről megerősítést nem kap. A vészjelzés
sikeres kézbesítése után a rádió Csendes vészhívás módban marad, és a környezetlehallgatásra vár.

A Csendes vészhívás módból való kilépés az alábbi módon történhet:

• A Menü, majd 3 másodpercen belül a # gomb megnyomása
• A Menü és a jobbra mutató navigációs gomb egyidejű megnyomása
• A két szoftvergomb egyidejű megnyomása
• A csendes vészjelzés elküldése sikertelen, és a készülék elérte az újrapróbálkozások maximális számát.
• A vezérlőterem befejezi a csendes környezetlehallgatást.
• A környezetlehallgatás más okból megszakad.

Ha Csendes vészhívás módban kikapcsolja a rádiót, a rádió alvó állapotba vált. Ebben az állapotban úgy tűnik, mintha
a rádió ki lenne kapcsolva. A rádió azonban továbbra is be van kapcsolva, és Csendes vészhívás módban van. Ha az
alvó állapotú rádiót bekapcsolják, ugyanúgy viselkedik, mintha valódi bekapcsolásról lenne szó, és továbbra is
Csendes vészhívás módban marad.

Láthatatlan vészhívás
A szolgáltató letilthatja a rádió vészhelyzeti műveleteinek látható és hallható visszajelzéseit. E funkció célja a
vészhelyzeti tevékenységek elrejtése kritikus helyzetben (például a felhasználót érő közvetlen támadás esetén) és
ezáltal a biztonság fokozása.

Vészhívás mód aktiválása tárcsázással
Ez a funkció lehetővé teszi, hogy egy előre beállított szám tárcsázásával aktiválja a vészhívás módot. Ily módon
ugyanazokat a vészhívási szolgáltatásokat indíthatja el, mintha a VÉSZHÍVÁS gombot használná. A rádió legfeljebb
nyolc vészhívószámot tárolhat.

Megjegyzés: Ha a vészhívás módot vészhívószám (nem pedig a VÉSZHÍVÁS gomb) aktiválta, akkor a HÍVÁS

VÉGE gomb megnyomásával léphet ki a vészhívás módból.

Katasztrófariasztás
A katasztrófariasztás a rádió által indított olyan szórásos vészhívás, amely más hívásokat felülbíráló vészhívási
prioritással rendelkezik, és amelyet a szórási területen mindenki hall. Ez a funkció kifejezetten a katasztrófahelyzetek
– például földrengések – esetére készült, és a hívások között a legmagasabb prioritással rendelkezik. A
katasztrófariasztás során minden rádió vészhelyzeti jelzést jelenít meg képernyőjén. A riasztási üzenet, annak
időtartama és cél beszédcsoportja a codeplugban konfigurálható.

Katasztrófariasztás indításához váltsa a rádiót Katasztrófariasztás módba, és nyomja meg a PTT gombot. A hívás
végén a rádió kilép a katasztrófariasztási módból.

A katasztrófariasztási mód befolyásolja a többi funkció működését:

• Amikor a katasztrófariasztás megkezdődik, minden más szolgáltatás leáll.
• Ezt a fajta hívást más szolgáltatások nem szakíthatják meg.
• Az élő mikrofon funkció nem használható.
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• Csak a titkosítatlan beszéd engedélyezett akkor is, ha valamely titkosítási szolgáltatás engedélyezve van. Az
egyetlen kivétel ez alól az E2E titkosítási funkció.

Megjegyzés: Ezt a szolgáltatást nem támogatja minden infrastruktúra. A szolgáltatás engedélyezése előtt
érdeklődjön szolgáltatójánál.

Katasztrófariasztási hívások inicializálása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Szolgáltatások → Katasztrófariasztás.

A rádió katasztrófariasztás módba lép, a kijelzőn pedig megjelenik a katasztrófariasztás ikon.

3 A hívás elindításához nyomja meg a PTT gombot.
A Katasztrófariasztás Aktív üzenet jelenik meg a rádió kijelzőjén.

Kilépés a vészhívás módból
Előfeltételek: Győződjön meg róla, hogy a rádió vészhívás módban van.

Eljárás:

1 Ha a rádió képernyőjén a Vészhívó mikrofon be jelzés jelenik meg, nyomja meg a Hívás vége gombot.
2 Tartsa nyomva a Kilépés gombot.

Megjegyzés: Ha a vészhívás módot vészhívószám aktiválta (nem pedig a VÉSZHÍVÁS gomb), akkor a
HÍVÁS VÉGE gombbal léphet ki a vészhívás módból.

3 Ha a rádió kijelzőjén a Kilép? üzenet jelenik meg, a kilépéshez nyomja meg az Igen gombot.

A rádió kilép a vészhívás módból.

Jelismétlő mód

A jelismétlő mód jelismétlő által biztosítja a DMO módban üzemelő rádiók közötti összeköttetést.

3. ábra: Jelismétlő módban való működés

DMODMO
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A DMO jelismétlő a DMO-tartomány kibővítésére szolgál, az egyik rádió által a másiktól kapott információ
továbbadásával. Egy adott frekvencián továbbadja a csoporthívásokat, privát hívásokat és adatokat.

A jelismétlő rendszeresen jelenléti jelet küld egy szabad csatornán, hogy a többi rádió szinkronizálni tudjon egy adott
frekvenciára.

Csak az azonos beszédcsoportban lévő rádiók tudnak egymással jelismétlőn keresztül kommunikálni.

Megjegyzés: Ez egy fizetős szolgáltatás.

Váltás a Jelismétlő módra
A Jelismétlő módot az alábbi eljárások egyikével aktiválhatja:

• Válassza a kezdőképernyőn az Opciók → Jelismétlő mód lehetőséget.
• A kezdőképernyőn nyomja meg a MENÜ gombot. Válassza a következőt: További. . . → Hálózatok → Jelismétlő

mód.

A Figyelés opció beállítása
Eljárás:

1 A kezdőképernyőn válassza az Opciók elemet.
2 Nyomja meg a Figyelés gombot.
3 Válasszon egyet az alábbiak közül:

• Ki – A rádió csak jelismétlőként működik, és semmilyen művelet nem érhető el.
• Csak vétel – A rádió csak vételre képes, adásra nem.
• Vétel és adás – Lehetővé teszi a vételt, és – a PTT gomb megnyomása esetén – az adást is.

Titkosítás jelismétlő módban
A rádiós titkosítást a jelismétlő mód is támogatja, így a titkosított hívásokat és üzeneteket is képes megismételni.

Ha a rádión telepített SCK-kulcsok érvénytelenek:

• A rádió visszafejtés nélkül továbbítja a hívásokat és az üzeneteket (feltéve, ha a titkosítás szintje nem a
legmagasabb).

• a LED-jelzőfény narancssárgára vált.
• A PTT gomb megnyomásakor a Csatorna foglalt vagy a DMSCK érvénytelen üzenet jelenik meg.
• Nem indíthat hívásokat.

60 | Üzemmódok

Send Feedback  |   | 

http://docsurvey.motorolasolutions.com


fejezet

4
GPS helymeghatározási szolgáltatás

A GPS helymeghatározási funkció a Föld körül keringő GPS-műholdak által sugárzott információk segítségével
határozza meg a rádió hozzávetőleges földrajzi helyét.

A GPS helymeghatározási szolgáltatás elérhetősége, pontossága, valamint a pozíció kiszámításához szükséges idő a
rádió használati környezetétől függően változik. Amikor Ön aktiválja a vészszolgáltatást, a GPS helymeghatározási
szolgáltatás sokféleképpen segítheti a diszpécsert és kollégáit, például az erőforrások hatékonyabb hozzárendelésében
vagy a rádió megkeresésében.

A rádió a helyinformációt megjelenítheti közvetlenül a képernyőn, vagy elküldheti rádión a diszpécsernek, akinél ez
az információ megjelenik a vezérlőközpontban. A rádió konfigurációjával kapcsolatos részletes tájékoztatásért
forduljon a szolgáltatóhoz.

Fontos!: Ahol nem érhetők el műholdjelek, ott a GPS helymeghatározási szolgáltatás nem működik. Ez
általában olyankor fordul elő, amikor a rádiónak nincs tiszta rálátása a nyílt égre, például amikor a GPS-
antenna takarásban van vagy a föld felé néz. Ilyen helyzetek lehetnek az alábbiak:

• Föld alatti helyek
• Épületek, vonatok vagy más fedett járművek belsejében
• Bármilyen fém- vagy betontető, illetve -szerkezet alatt
• Nagy teljesítményű rádió- vagy televízióadó torony közelében
• A rádió működési hőmérséklet-tartományán kívüli, extrém hőmérsékletek esetén

Ha ilyen helyzetekben ki is számítható a pozícióinformáció, a számítás tovább tarthat. Ezért minden vészhelyzetben
jelentse a helyzetét a diszpécsernek. Amennyiben több műhold megfelelő jele is elérhető, a GPS helymeghatározási
szolgáltatás olyan helyinformációkat biztosít, amelyek nagy valószínűséggel az Ön tényleges tartózkodási helye
közelében található helyet jelölnek.

A rádió beállítható úgy, hogy különböző helyzetekben helyjelentést küldjön, például:

• Kérésre
• Vészhívás módba lépéskor
• Adott időközönként
• Adott távolságonként

A helyjelentés TMO-ban és DMO-ban az alábbi módokon küldhető el:

• SDS üzenetekkel
• Adatcsomag-átvitellel

A rádió konfigurálható úgy, hogy a helyjelentések elküldését audiovizuális jelzéssel jelezze.

A rádió beállításaitól függően meg lehet tekinteni a rádió pozícióját és a látható műholdak állapotát. A pozíció
földrajzi hosszúsággal és szélességgel, illetve brit vagy ír koordinátákkal is megjeleníthető.

Megjegyzés: Ez egy fizetős szolgáltatás.

Kapcsolódó hivatkozások
Hely A következő oldalon:105
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A GPS teljesítményének növelése

Előfordulhat, hogy a GPS szolgáltatás nem tudja sikeresen elvégezni a helymeghatározást. Ilyenkor hangjelzés
tájékoztatja arról, hogy a rádió nem látja a műholdakat.

A rádió helymeghatározási teljesítményének maximalizálásához tartsa be az alábbi irányelveket:

• Maradjon a szabadban – a GPS funkció akkor működik a leghatékonyabban, ha a rádió minél nagyobb égfelületre
lát rá. Ha teheti, hagyja el az épületet, és kerülje a fákat és a magas épületeket. Habár az ablak mellett állva a
készülék rendszerint jobb teljesítményt nyújt, egyes árnyékoló üvegbevonatok blokkolhatják a műholdjeleket.

• A rádiót úgy helyezze el, hogy a vétel a lehető legjobb legyen. A GPS műholdak jeleit a GPS antenna veszi, amely
a rádió antennája. A rádiót a testével ellentétes irányban tartsa, hogy az antenna közvetlenül érhesse el a
műholdjeleket. Ne takarja el az antenna körüli területet az ujjaival vagy bármi mással.

• Álljon egy helyben – ha lehetséges, álljon egy helyben, amíg a rádió be nem fejezte a helymeghatározást. A rádió
sétatempóban történő mozgatása a hozzávetőleges helyzet kiszámítása közben jelentősen csökkentheti a GPS-
teljesítményt.

A GPS engedélyezése

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Pozíció → Interfész.
3 Válassza a Be lehetőséget.

Megjegyzés: Ezt a funkciót a szolgáltató engedélyezheti.

GPS ikon

Ha bekapcsolta a GPS-t, az állapotikon-területen a következő ikon látható:  A GPS aktuális állapotától függően az
ikon vagy folyamatosan világít – ha a GPS meghatározta a helyet, vagy villog – ha a GPS a helymeghatározást végzi.
A szolgáltató a GPS ikon villogását engedélyezheti és letilthatja.

A GPS különböző helykijelzési módjai

14. táblázat: Különböző helykijelzési módok

Földrajzi széles-
ség/hosszúság Brit koordináták Ír koordináták UTM-koordináták MGRS-koordiná-

ták

Idő Idő Idő Idő Idő

Szélesség 2 betűs kód 1 betűs kód 3 betűs kód 3 betűs kód és 2 betűs
kód

Hosszúság Keleti és északi
irányú koordináta

Keleti és északi
irányú koordináta

Keleti és északi
irányú koordináta

Keleti és északi
irányú koordináta

A táblázat folytatódik…
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Földrajzi széles-
ség/hosszúság Brit koordináták Ír koordináták UTM-koordináták MGRS-koordiná-

ták

Tengerszint feletti
magasság

Tengerszint feletti
magasság

Tengerszint feletti
magasság

Tengerszint feletti
magasság

Tengerszint feletti
magasság

Műholdak Műholdak Műholdak Műholdak Műholdak

• Idő – azt jelzi, hogy a rádió mikor számította ki utoljára a helyet. Az idő UTC-formátumban van megadva.
• Betűkód – térképzóna különböző koordinátaszabványokhoz
• Földrajzi szélesség – fokban, ívpercben és ívmásodpercben kifejezve.
• Földrajzi hosszúság – fokban, ívpercben és ívmásodpercben kifejezve.
• Műholdak száma – a helyzet kiszámításához használt műholdak száma. Általában több műholddal nagyobb

pontosság érhető el. Maximum 12 műhold látható egyszerre.
• Keleti irányú koordináta – A keleti irányban mért távolság méterben kifejezve.
• Északi irányú koordináta – Az északi irányban mért távolság méterben kifejezve.

Megjegyzés: A keleti és az északi irányú koordináták egyes számjegyeinek átugrása a 10 adott hatványával
csökkenti a pontosságot.

A rádió pozíciójának megtekintése

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További.. . → Pozíció → Pozíció.
3 Görgetéssel megtekintheti, hogy utoljára mikor lett kiszámítva a pozíció:

Megjegyzés: A pozíció frissítése:

• Válassza a Pozíció lehetőséget – a rádió automatikusan frissíti a pozícióját
• Nyomja meg a Frissítés gombot.

A GPS pontosságának megváltoztatása

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Pozíció → Pontosság.
3 Válasszon egyet az alábbiak közül:

• Közepes (alapértelmezett) – optimális fogyasztás kisebb pozíciópontossággal.
• Nagy – pontosabb helymeghatározás kevésbé optimális fogyasztás mellett.

Megjegyzés: Külső töltőre csatlakoztatva rádió automatikusan a nagy pontosságú módra vált.

GPS – Fontos tudnivalók

Ahol nem érhetők el megfelelő műholdjelek, ott a rádió GPS-szolgáltatása nem működik. Ilyen helyzetek lehetnek
többek között az alábbiak:
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• Föld alatti helyek
• Épületek, vonatok vagy más fedett járművek belseje
• Bármilyen fém- vagy betontető, illetve -szerkezet alatt
• Nagy teljesítményű rádió- vagy televízióadó torony közelében
• Ha a GPS antenna le van takarva (például a keze vagy egyéb tárgy fedi), illetve a föld felé néz
• A rádió működési hőmérséklet-tartományán kívül eső extrém hőmérsékletek esetén

Ha ilyen helyzetekben ki is számítható a pozícióinformáció, a számítás tovább tarthat. Ezért vészhelyzetben mindig
mondja el a pontos helyzetét a diszpécsernek.

Továbbá felhívjuk figyelmét, hogy a GPS funkció csak hozzávetőleges pozícióinformációt biztosít még azokon a
helyeken is, ahol több műholdból is elérhető megfelelő jel, és a megállapított pozíció gyakran 20–100 méterrel is
eltérhet az Ön valódi helyzetétől.
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fejezet

5
Főmenü

Ez a fejezet a főmenüben található elemeket mutatja be.

A menüpontokat hívás közben is megnyithatja. Ha egy új hívás kezdetekor a menüben van, a rádió kilép belőle.

Fontos!: Egyes menüpontok a típusokra jellemzőek, és előfordulhat, hogy az adott rádión nem aktiválhatók
vagy nem elérhetők.

Navigálás a menüben

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Lépjen a kívánt menüpontra a NAVIGÁCIÓS gombokkal. A kiválasztáshoz nyomja meg a Kiválasztás funkcióhoz

rendelt SZOFTVERGOMBOT, vagy a jobbra mutató NAVIGÁCIÓS gombot.
Ha a kiválasztott menüpont alatt további menüpontok találhatók, akkor ismételje meg a 2. lépést.

Megjegyzés: A gyakran használt menüpontokhoz billentyűparancsokat rendelhet.

Menüikonok

Az alábbi ikonok a menüelemek felismerését könnyítik meg.

15. táblázat: Menüikonok

Menüikon Leírás

Főmenü pontjai/helyi menü

A MENÜ gombhoz van rendelve, ha a főmenü pontjai vagy a helyi menü aktív.

Üzenetek

Állapotüzenetek küldése
Szöveges üzenetek küldése (szabadon szerkeszthető szöveg, illetve a felhasználó által
szerkesztett vagy előre megadott sablonok)
A Bejövő üzenetek mappában található üzenetek.

Névjegyek

Bejegyzések hozzáadása, keresése, szerkesztése vagy törlése a hívószámok listájában.

A táblázat folytatódik…
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Menüikon Leírás

Böngésző

A WAP-böngésző indítása.

Biztonság

Lehetővé teszi a biztonsági funkciók be- és kikapcsolását, meghatározását, valamint a
jelszavak módosítását.

Beállítások

A rádió testreszabását teszi lehetővé.

További...

További módosítható paramétereket tartalmaz.

Csoportbeállítások

Itt találhatók a beszédcsoport-letapogatási funkciókhoz tartozó további menüelemek.

Kedvencek

A gyakran használt beszédcsoportok és névjegyekhez tartozó számok parancsikonjait
tartalmazza.

Saját adatok

A rádióval és a hozzárendelt számokkal kapcsolatos információk megjelenítése.

Legutóbbi hívások

A legutóbbi hívások listáját tartalmazza.

Billentyűparancsok

A menüelemekre mutató billentyűparancsok megtekintését és kezelését teszi lehetővé.

RUI

Bejelentkezés és kijelentkezés a rádió felületén.

Hálózatok

A hálózatválasztást teszi lehetővé.

Hely

A rádió helyének megjelenítése.

Adatcsomag-átvitellel

Adatok küldését teszi lehetővé a rádióról más készülékekre.

Szolgáltatások

A szórásos, a segély- és a katasztrófahívások kezelését teszi lehetővé.
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Üzenetek

Ezzel a funkcióval szöveges üzeneteket küldhet és fogadhat. Az üzenetek max. 1000 karaktert tartalmazhatnak, a
pontos érték a szolgáltató beállításától függ.

A szolgáltató beállításától függően a következők történhetnek, ha egy kijelölt üzeneten nyomja meg a PTT gombot:

• A rádió figyelmen kívül hagyja a PTT gomb kérelmét.
• A rádió privát hívást kezdeményez az üzenet küldőjével.
• A rádió csoportos hívást kezdeményez egy aktuálisan kiválasztott beszédcsoporttal.

Új üzenet
Ez a menüpont új üzenetek írását teszi lehetővé.

Üzenetek küldése privát számra vagy telefonszámra
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza az Üzenetek → Új üzenet lehetőséget.
3 Írja be az üzenetét, és nyomja meg a Küldés gombot.
4 Amennyiben szükséges, válassza a Privát/Telefon lehetőséget.
5 Írja be a címzett telefonszámát, vagy nyomja meg az abc gombot, és válasszon a névjegyek közül.

Megjegyzés:

A Privát cím kiválasztásához beírhatja a címzett önálló rövid előfizető-azonosítóját (ISSI) vagy a
csoportos rövid előfizető-azonosítót (GSSI).

ISSI – minden rádióhoz hozzárendelt egyedi azonosító.

GSSI – a Dimetra rendszerekben a neve csoportazonosító vagy beszédcsoport-azonosító.
6 Nyomja meg a Küldés elemet, a KÜLDÉS vagy a PTT gombot.

Üzenet küldése csoportoknak
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza az Üzenetek → Új üzenet lehetőséget.
3 Írja be az üzenetét, és nyomja meg a Küldés gombot.
4 Amennyiben szükséges, válassza a Csoport lehetőséget.
5 Válassza ki a csoportot, amelynek el szeretné küldeni az üzenetet.

Tárolt és továbbított üzenetek küldése
Előfeltételek: Ha a szolgáltató engedélyezi a Tárolás és továbbítás funkció használatát:

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza az Üzenetek → Új üzenet lehetőséget.
3 Nyomja meg a MENÜ gombot, és válassza az Üzenetbeállítások → Online és offline felhasználók lehetőséget.
4 Írja be az üzenetét, és nyomja meg a Küldés gombot.
5 A Címzett kiválasztása lehetőségnél az alábbiak közül választhat:
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• Privát – írja be a privát számot, vagy nyomja meg az abc gombot a célszám kiválasztásához a
hívószámlistából.

• Telefon – írja be a telefonszámot, vagy nyomja meg az abc gombot a célszám kiválasztásához a
hívószámlistából.

Megjegyzés: Az is előfordulhat, hogy a szolgáltató a tárolt és továbbított üzenetek beszédcsoportnak
való küldését is engedélyezi.

6 Válassza a Küldés lehetőséget, vagy nyomja meg a KÜLDÉS vagy a PTT gombot.

Kézbesítési jelentés
A kézbesítési jelentés az üzenet kézbesítésének állapotáról nyújt tájékoztatást. A felhasználó ki- és bekapcsolhatja a
funkciót, és azt is beállíthatja, hogy a rádió milyen típusú kézbesítési jelentést kérjen.

Ha a kézbesítési jelentés röviddel az üzenet kézbesítése után megérkezik:

• A következő felugró üzenetek egyike jelenik meg:

• Üzenet elküldve – ha nem kértek kézbesítési jelentést (és amikor a tárolt és továbbított üzenet megérkezett a
tároló és továbbító szerverhez)

• Üzenet kézbesítve – ha kézbesítési jelentést kértek, és a célrádió megkapta az üzenetet
• Üzenet elolvasva

– ha a Megtekintett kézbesítési jelentést kérték, és az üzenetet megnyitották a célrádión
• Üzenet sikertelen – ha kézbesítési jelentést kértek, és a célrádió egy meghatározott időtartamon belül nem

kapta meg az üzenetet
• A kézbesítési jelentés a Kimenő üzenetek mappába, az üzenet másolatával együtt lesz elmentve.

Ha a kézbesítési jelentés csak hosszabb idő múlva érkezik meg:

• A kézbesítési jelentés a Kimenő üzenetek mappába, az üzenet másolatával együtt lesz elmentve.
• Ha a kézbesítési jelentés funkciót a szolgáltató állítja be:

• A kézbesítési jelentések ideiglenesen a Bejövő üzenetek mappába kerülnek. A figyelmeztetés elolvasás után
törlődik.

• Megjelenik az Új üzenet ikon.
• Megjelenik az Új kézbesítési állapot értesítési képernyő (amennyiben elérhető).

Kézbesítési jelentések megtekintése
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza az Üzenetek → Bejövő üzenetek lehetőséget.
3 Keresse meg a kívánt üzenetet, és válassza az Olvasás lehetőséget.
4 Nyomja meg a MENÜ gombot.
5 Válassza a Kézbesítési állapot lehetőséget.

Kézbesítési jelentések konfigurálása
Előfeltételek: Szolgáltatója engedélyezte a kézbesítési jelentés konfigurálását.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza az Üzenetek → Új üzenet lehetőséget.
3 Nyomja meg a MENÜ gombot, és válassza a Kézbesítési jelentés lehetőséget.
4 Válasszon egyet az alábbiak közül:
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• Nincs – a rádió nem kér kézbesítési jelentést.
• Fogadott – a rádió értesítést kér az üzenetei fogadásáról.
• Megtekintett – a rádió értesítést kér az üzenetei elolvasásáról.
• Mindkettő – a rádió kézbesítési jelentést kér a fogadott és elolvasott üzenetekről is.

Bejövő üzenetek
Legfeljebb 100 új és régi bejövő üzenetet képes tárolni.

16. táblázat: Bejövő üzenetek ikonjai

Ikon Leírás

Olvasatlan (új) üzenet

Olvasott (régi) üzenet

Feladó adatai üzenetnézetben – név vagy szám

Dátum és idő feltüntetése üzenetnézetben – beérkezés dátuma és ideje

Kézbesítési állapot – beérkezett – a tárolt és továbbított üzenetek kézbesítési állapotát jelzi.

Az Üzenetek almenüben az üzenetek száma látható. Ha a kijelzett érték 2/4, az azt jelenti, hogy két olvasatlan, és
összesen négy üzenet van a Bejövő üzenetek mappában.

A Bejövő üzenetek mappa megnyitása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza az Üzenetek → Bejövő üzenetek lehetőséget.

Megjegyzés: A képernyőn néhány másodpercre megjelenik a mappa állapota (elérhető):

• Nincs sem új, sem régi üzenet – a kijelző néhány másodpercen belül visszatér az előző képernyőre.
• Bejövő üzenetek megtelt – nyomja meg az Ok gombot.

Új üzenetek fogadása
Eljárás:

1 Új üzenet érkezésekor:
A rádió animációt jelenít meg, és az Új levél érkezett hangjelzést játssza le.

2 Válasszon egyet az alábbiak közül:

• Olvasás – a teljes üzenet megnyitása.
• Vissza – az üzenet megtekintésének elhalasztása. Az üzenetet később is megtekintheti a Bejövő üzenetek

mappában.
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Az almenük használata a Bejövő üzenetek és a Kimenő üzenetek
mappában

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza az Üzenetek → Bejövő üzenetek vagy Kimenő üzenetek lehetőséget.
3 Jelölje ki a kívánt üzenetet, és nyomja meg a MENÜ gombot.
4 Válasszon egyet az alábbiak közül:

• Tárolás – az üzenet sablonként való elmentése. Módosítsa az alapértelmezett sablonnevet, és nyomja meg az
Ok gombot.

• Törlés – a kiválasztott üzenet törlése. A megerősítéshez nyomja meg az Igen gombot.
• Összes törlése – Az összes üzenet törlése a Bejövő üzenetek/Kimenő üzenetek mappából. A megerősítéshez

nyomja meg az Igen gombot.
• Válasz (csak a Bejövő üzenetek esetében) – megnyitja a szerkesztőképernyőt, amelyen alapértelmezett

szövegként a régi üzenet, címzettként pedig az üzenet feladója szerepel. A szerkesztést követően az üzenetet a
Küldés elem, a PPT gomb vagy a KÜLDÉS gomb segítségével küldheti el.

• Újraküldés (csak a Kimenő üzenetek mappában) – megnyitja a szerkesztőképernyőt a korábban bevitt
szöveggel és ugyanazzal a címzettel. A szerkesztést követően az üzenetet a Küldés elem, a PPT gomb vagy a
KÜLDÉS gomb segítségével küldheti el.

• Továbbítás – Megnyitja a szerkesztőképernyőt a régi üzenettel, amelyet ily módon más címzettnek is
elküldhet. A szerkesztést követően az üzenetet a Küldés elem, a PPT gomb vagy a KÜLDÉS gomb segítségével
küldheti el.

• Frissítés – az üzenetlista újrarendezése és az új üzenetek megjelenítése.
• Kézbesítési állapot (csak a Kimenő üzenetek mappában) – megjeleníti az üzenet állapotát (elküldve,

kézbesítve, elolvasva, lejárt és nem érkezett meg, lejárt és nem olvasták el, sikertelen ismeretlen okból) és az
állapot bekövetkeztének dátumát és idejét.

Beágyazott szám
Ez a funkció az üzenetekben szereplő telefonszámok felhívását, valamint csoporthívás indítását teszi lehetővé az
üzenet küldőjének beszédcsoportján.

Üzenetekben szereplő számok mentése
Előfeltételek: A beágyazott szám funkciót a szolgáltatónak kell engedélyeznie.

Mikor és hol használja: A küldő számát vagy az üzenetben szereplő számot új hívószámként mentheti el, vagy
meglévő bejegyzéshez rendelheti hozzá.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza az Üzenetek → Bejövő üzenetek lehetőséget.
3 Jelölje ki a kívánt üzenetet, és válassza az Olvasás lehetőséget.
4 Nyomja meg a PTT gombot.
5 A rádió megjeleníti a számok listáját (a lista a küldők számát is tartalmazza).
6 Jelölje ki a kívánt számot, és válassza a Tárolás lehetőséget.
7 Jelölje ki a kívánt hívószámot, és válassza a Megtekintés lehetőséget.

Megjegyzés: Szám új névjegyként való tárolásához válassza az [Új hívószám] lehetőséget, és töltse ki
a szükséges mezőket. A mentéshez nyomja meg a Kész gombot.

8 Válassza a Szerkesztés lehetőséget.
9 Válassza ki az új szám típusát (Típus), és nyomja meg a Kész gombot.
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Üzenetekbe ágyazott számok hívása
Előfeltételek: A beágyazott szám funkciót a szolgáltatónak kell engedélyeznie.

Mikor és hol használja: Lehetővé teszi az üzenet feladója vagy az üzenetben található telefonszámok felhívását.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza az Üzenetek → Bejövő üzenetek lehetőséget.
3 Jelölje ki a kívánt üzenetet, és válassza az Olvasás lehetőséget.
4 Nyomja meg a PTT gombot.
5 A rádió megjeleníti a számok listáját (a lista a küldők számát is tartalmazza).
6 A híváshoz jelölje ki a kívánt számot, és nyomja meg a PTT vagy a KÜLDÉS gombot.
7 A kívánt hívástípus (Privát, Telefon vagy PABX) kiválasztásához nyomja meg a Hívástípus gombot.
8 Nyomja meg a PTT gombot vagy a KÜLDÉS gombot.

Csoporthívás indítása az üzenet küldőjének beszédcsoportjára
Előfeltételek: A beágyazott szám funkciót a szolgáltatónak kell engedélyeznie.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza az Üzenetek → Bejövő üzenetek lehetőséget.
3 Lépjen a kívánt üzenetre, majd nyomja meg a PTT gombot.

Azonnali üzenet
Amikor új azonnali üzenet érkezik, a rádió lejátssza az Új üzenet érkezett hangjelzést, és megjeleníti az üzenet
tartalmát a korábban megjelenített képernyő felett. A készülék az összes azonnali üzenetet a Bejövő üzenetek
mappában tárolja. Ha a rádió PIN-zárja aktív, akkor az azonnali üzenet a helyes PIN kód megadása után jelenik meg.

Megjegyzés: Ez egy fizetős szolgáltatás.

Kimenő üzenetek
A Kimenő üzenetek tartalmazza az összes elküldött üzenetet.

17. táblázat: Kimenő üzenetek ikonjai

Ikon Leírás

Kézbesítés folyamatban

Sikeres kézbesítés

Sikertelen kézbesítés

Üzenet sikeresen elküldve

Üzenet küldése sikertelen
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Eseményjelentés-tároló
Az Eseményjelentés-tároló tárolja a beérkező és kimenő eseményjelentési üzeneteket időrendi sorrendben (a
legújabb üzenet jelenik meg a lista elején). Ha egy eseményjelentés címsorának Kiválasztás lehetőségére kattint, az
adott elemről részletesebb információk jelennek meg.

Ha a rádió normál módban van, az Eseményjelentés-tárolóban lévő összes üzenet között böngészhet. Ha azonban a
rádió eseményjelentési módban van, csak az aktuális eseményjelentés információi böngészhetők.

Kapcsolódó hivatkozások
Eseményjelentés A következő oldalon:119

RMS-tároló
Az RMS-tároló tárolja az összes beérkező és kimenő RMS üzenetet (mind az állapotüzeneteket, mind a szabad
szöveges üzeneteket).

WAP-tároló
Minden WAP leküldési üzenet azonnal betölthető, illetve üzenetként tárolható a WAP-tárolóban. Ezt követően az
üzenetek MENÜ → Üzenetek → WAP-tároló paranccsal érhetők el. A rendszer minden WAP push üzenetet továbbít
a böngészőnek.

Kapcsolódó hivatkozások
WAP A következő oldalon:111
WAP leküldés A következő oldalon:118

Sablonok
A funkciónak köszönhetően akár 100 előre beállított és saját üzenetsablon tárolható. A Beérkezett üzenetek és a
Kimenő üzenetek is tárolhatók sablonként. A sablonok neve és szövege később is módosítható.

Felhasználó által beállított sablonok küldése
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza az Üzenetek → Sablonok lehetőséget.
3 Jelölje ki a kívánt sablonnevet, és nyomja meg a Küldés gombot.
4 Válassza az alábbiak valamelyikét:

• Írja be a számot, vagy nyomja meg az abc gombot a névnek a névjegylistából való kiválasztásához. Nyomja
meg a Küldés gombot.

• Válassza ki a kívánt beszédcsoportot a beszédcsoportlistából.

A felhasználó által létrehozott sablonok beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza az Üzenetek → Sablonok lehetőséget.
3 Jelölje ki a kívánt sablont, és nyomja meg a MENÜ gombot.
4 Válasszon egyet az alábbiak közül:

• Megtekintés – a sablon szövegének megjelenítése.
• Törlés – a sablon törlése.
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• Szöveg szerkesztése – a sablon szövegének megnyitása a Szerkesztés képernyőn. Módosítsa a szöveget, és
nyomja meg a MENÜ gombot. Válassza a Módosítások mentése lehetőséget a szerkesztett sablon mentéséhez,
vagy a Tárolás lehetőséget a szerkesztett sablon újként való elmentéséhez.

• Név szerkesztése – a sablon nevének megnyitása a Szerkesztés képernyőn. A sablon mentéséhez nyomja meg
az OK gombot.

Előre beállított sablonok
Az előre beállított üzenetsablonok be vannak programozva a rádióba. Az előre meghatározott sablonokat csupán
korlátozott mértékben szerkesztheti. A szerkesztett sablonokat elküldheti, de a módosításokat nem mentheti el, és nem
törölheti őket az előre beállított sablonok listájából.

Előre beállított sablonok megtekintése
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza az Üzenetek → Előre beállított lehetőséget.
3 Jelölje ki a kívánt sablont, és nyomja meg a MENÜ gombot.
4 Válassza a Megtekintés lehetőséget.

Előre beállított sablonok küldése
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza az Üzenetek → Előre beállított lehetőséget.
3 Jelölje ki a kívánt sablont, és nyomja meg a Küldés elemet, a PTT gombot vagy a KÜLDÉS gombot.

Megjegyzés: Elküldés előtt az előre beállított sablonokat szerkesztheti is. Nyomja meg a MENÜ gombot,
és válassza a Szerkesztés lehetőséget. Megnyílik a szerkesztési képernyő a sablon szövegével. Csak a
meglévő szöveget módosíthatja.

Állapotüzenetek
A rádió kétféle állapotüzenet küldését teszi lehetővé: állapotüzenetek és célzott állapotüzenetek. Szolgáltatója
határozza meg, hogy melyik típust engedélyezi a rádión.

Az állapotüzenet küldhető egy kiválasztott beszédcsoportnak vagy a szolgáltató által beprogramozott privát számra. A
célzott állapotüzenetek küldhetők a rádión meghatározott bármely beszédcsoportnak, illetve bármelyik privát számra
(a hívószámok listájából választva vagy kézzel beírva).

Állapotüzenet-szám megtekintése
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza az Üzenetek → Állapotüzenet küldése lehetőséget.
3 Nyomja meg a MENÜ gombot, és válassza a Megtekintés lehetőséget.

Állapotüzenetek küldése
Ezzel az eljárással állapotüzeneteket küldhet egy kiválasztott beszédcsoportnak vagy egy beprogramozott privát
számnak. Egyszerre csak egy funkciót engedélyezhet.

Előfeltételek:
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• Ha engedélyezi az állapotüzenet küldését a beszédcsoportoknak: kapcsoljon arra a beszédcsoportra, amelynek az
állapotüzenetet küldeni kívánja.

• Ha engedélyezi az állapotüzeneteknek a privát számokra történő küldését: nem kell tennie semmit, a privát számot
a szolgáltató állítja be

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza az Üzenetek → Állapotüzenet küldése lehetőséget.
3 Válassza az alábbiak valamelyikét:

• Lépjen a kívánt állapotüzenetre, majd válassza a Kiválasztás lehetőséget, a PTT vagy a KÜLDÉS gombot.
• Ha az állapotlista üres, írjon be állapotüzenet-számot, és nyomja meg a Küldés gombot.

Célzott állapotüzenetek
Ez a funkció az állapotüzeneteknek a felhasználó által kiválasztható címekre történő küldését teszi lehetővé.
Alapbeállításként a célzott állapotüzeneteket privát vagy beszédcsoport címekre küldheti el. Szolgáltatója
korlátozhatja a Hívószámok mappában tárolt címek használhatóságát.

Célzott állapotüzenetek küldése
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza az Üzenetek → Állapotüzenet küldése lehetőséget.
3 Válassza az alábbiak valamelyikét:

• Lépjen a kívánt állapotüzenetre, majd válassza a Kiválasztás lehetőséget, a PTT vagy a KÜLDÉS gombot.
• Ha az állapotlista üres, írjon be állapotüzenet-számot, és nyomja meg a Küldés gombot.

4 Válassza az alábbiak valamelyikét:

• Írja be a számot, vagy nyomja meg az abc gombot a névnek a névjegylistából való kiválasztásához. Nyomja
meg a Küldés gombot.

• Válassza ki a kívánt beszédcsoportot a beszédcsoportlistából.

A képernyőn a következő kézbesítési jelentések egyike jelenik meg:

• Állapotüzenet elküldve.
• Állapotüzenet elküldése sikertelen.

Névjegyek

Ez az almenü tárolja az összes névjegyet. A bejegyzéseknél az alábbi információkat kell megadni:

• Név – akkor szükséges megadni, ha a bejegyzés egynél több számot tartalmaz.
• Típus – az alábbi típusok közül választhat:

18. táblázat: Névjegytípusok

Névjegyikon Leírás

Privát

Nem lehet gyorshívószáma.

A táblázat folytatódik…
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Névjegyikon Leírás

Mobil

Otthoni

Munkahelyi

PABX

Egyéb

Választóikonok

Azt jelzik, hogy az adott bejegyzéshez több telefonszám is tartozik.

• # (szám) – minden hívószámbejegyzésnek tartalmaznia kell egy számot.
• Gyorshívó szám – az alapértelmezett gyorshívó szám elfogadása vagy megváltoztatása.

Névjegyek létrehozása
Eljárás:

1 A kezdőképernyőn válassza a Névjegyek elemet.
2 Válassza az [Új hívószám] lehetőséget.
3 Jelölje ki a Név elemet, és nyomja meg a Módosítás gombot. Írja be a névjegyhez tartozó nevet, és nyomja meg

az OK gombot.
4 Lépjen a Típus elemre, és nyomja meg a Módosítás gombot. Válassza ki a kívánt névjegytípust.

Megjegyzés: A balra és jobbra mutató NAVIGÁCIÓS gombokkal kiválaszthatja a névjegy típusát a
Névjegyadatok képernyőn.

5 Lépjen a Szám elemre, és nyomja meg a Módosítás gombot. Írja be a névjegyhez tartozó telefonszámot, és
nyomja meg az OK gombot.

6 Ha szükséges, lépjen a Gyorshívószám elemre, és nyomja meg a Módosítás gombot. Írja be a kívánt
gyorshívószámot (1–1000), és nyomja meg az OK gombot.

Megjegyzés: Ha a beírt szám létezik, a rádió a Felülírja? üzenetet jeleníti meg. Az Igen gombbal
felülírhatja az előző gyorshívószámot, a Nem gomb megnyomása esetén pedig új gyorshívószámot
adhat meg.

7 Nyomja meg a Kész gombot.

A névjegy elkészült. További számok hozzáadásához ismételje meg a 4–6. lépéseket.

Névjegyek szerkesztése
Eljárás:

1 A kezdőképernyőn válassza a Névjegyek elemet.
2 Lépjen a szerkeszteni kívánt névjegyre.
3 Nyomja meg a MENÜ gombot.
4 Nyomja meg a Szerkesztés gombot.
5 Jelölje ki a következő bejegyzések egyikét, és nyomja meg a Módosítás elemet a szerkesztéshez:

• Név
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• Típus
• # Szám
• Gyorshívószám

6 Nyomja meg a Kész gombot.

Hívószámok törlése
Eljárás:

1 A kezdőképernyőn válassza a Névjegyek elemet.
2 Válassza ki a szerkeszteni kívánt névjegyet.
3 A bal és jobb NAVIGÁCIÓS gombok használatával válassza ki a kívánt számot.
4 Nyomja meg a MENÜ gombot.
5 Válassza a Szám törlése lehetőséget.

Megjegyzés: Ha a bejegyzés csak egy számot tartalmaz, a szám törlésével a bejegyzést is törli.

6 Nyomja meg az Igen gombot.

Névjegyek törlése
Eljárás:

1 A kezdőképernyőn válassza a Névjegyek elemet.
2 Jelölje ki a törölni kívánt névjegyet.
3 Nyomja meg a MENÜ gombot.
4 Válassza a Névjegy törlése elemet.
5 Válassza az Igen lehetőséget.

A tárolókapacitás ellenőrzése
Mikor és hol használja: A rádióban tárolt hívószámok számának megtekintése:

Eljárás:

1 A kezdőképernyőn válassza a Névjegyek elemet.
2 Nyomja meg a MENÜ gombot.
3 Válassza a Tárhely lehetőséget.
4 Válasszon egyet az alábbiak közül:

• Privát
• Telefonszám / PABX
• Névjegy

Tárcsázás a névjegylistából
Eljárás:

1 A kezdőképernyőn válassza a Névjegyek elemet.
2 Lépjen a kívánt névjegyre a felfelé és lefelé mutató NAVIGÁCIÓS gombokkal, vagy írjon be max. 12 karaktert a

névjegyhez tartozó névből.
3 Ha a névjegyhez több szám is tartozik, a balra és jobbra mutató NAVIGÁCIÓS gombokkal választhatja ki a kívánt

számot.
4 Privát számra történő egyirányú hívás indításához nyomja meg a PTT gombot. Kétirányú hívást a KÜLDÉS gomb

megnyomásával indíthat.
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Böngésző

Ez a menüpont aktiválja a WAP-böngészőt, amellyel a rádióról böngészhető az internet.

Kapcsolódó hivatkozások
WAP A következő oldalon:111

Biztonság

Ez az almenü tartalmazza az összes biztonsági beállítást.

PIN-kódos védelem
Ezzel a funkcióval a PIN-kódos hitelesítést aktiválhatja, amely a következő bekapcsolástól kezdve lép érvénybe. A
kód használatával elkerülhető, hogy a telefont jogosulatlan személyek használják.

Ha nem tudja feloldani a rádiót, csak vészhívásokat küldhet és fogadhat, illetve a hangerőt szabályozhatja a
FORGATÓGOMBBAL.

Kapcsolódó hivatkozások
A rádió feloldása A következő oldalon:31
PIN-kódok módosítása A következő oldalon:77

A rádió PIN-kódos védelme
Eljárás:

1 A kezdőképernyőn válassza a MENÜ → Biztonság → PIN-kódos védelem lehetőséget.
2 Válassza a Be lehetőséget.
3 Írja be a 4 jegyű PIN-kódot. A PIN-kód alapértelmezés szerint 0000 (négy darab nulla).

Javaslat: A hatékonyabb védelem érdekében saját PIN-kódot állítson be.

Utófeltételek: A PIN-kódot a rádió minden egyes bekapcsolásakor meg kell adnia.

A rádió zárolásának feloldása
Előfeltételek: Ha háromszor egymás után rossz PIN-kódot ír be, a rádió zárolva lesz. (Alapértelmezés szerint)

Eljárás:

1 A rádió a Készülék zárolva, írja be a PUK-kódot üzenetet jeleníti meg.
2 Írja be a 8 jegyű PUK-kódot (Personal Unblocking Key, személyes feloldókulcs).

Megjegyzés: A PUK-kód egy nyolcjegyű mesterkód, amelyet a szolgáltatótól kaphat meg.

3 Írja be az új PIN-kódot kétszer.

PIN-kódok módosítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Biztonság → Kód módosítása lehetőséget.
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3 A rádió bekéri a régi kódot (Régi kód). Írja be a jelenlegi 4 jegyű biztonsági kódot (az alapértelmezett beállítás a
0000).

4 Ha a beírt kód megegyezik a régi kóddal, a rádió kétszer bekéri az új kódot.

A rádió a Kód elfogadva üzenetet jeleníti meg.
Kapcsolódó hivatkozások

A rádió feloldása A következő oldalon:31
PIN-kódos védelem A következő oldalon:77

Billentyűzár-beállítások
A billentyűzár funkcióval lezárhatja a billentyűzetet, megakadályozva a gombok véletlen megnyomását. A billentyűk
lezárása és feloldása a rádió menüjének megfelelő menüpontjával, illetve egy előre meghatározott billentyűparanccsal
történhet. Nyomja meg a MENÜ gombot, majd a következőt: * gomb .

A szolgáltató beállításai határozzák meg, hogy a billentyűzár aktiválása az alábbi menüelemek közül melyeket tiltja
le:

• PTT gomb
• Oldalgombok
• A FORGATÓGOMB

• A BE/KI/VÉGE/KEZDŐKÉPERNYŐ gomb

A VÉSZHÍVÁS gomb mindig működik.

Kapcsolódó hivatkozások
A billentyűzár bekapcsolása és kioldása A következő oldalon:32

Billentyűzár-értesítés
A szolgáltató az alábbi utasításokat állíthatja be arra az esetre, ha a billentyűzet le van zárva:

• Nincs – nem jelenik meg értesítés.
• Csak értesítés – A billentyűk zárolva üzenet jelenik meg.
• Értesítés és utasítás – A Nyomja meg a Menü és a * gombot a billentyűzet zárolásához/feloldásához üzenet

jelenik meg.

Automatikus billentyűzár késleltetésének beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Biztonság → Billentyűzár-beállítások → Késleltetés lehetőséget.
3 A felfelé és lefelé mutató NAVIGÁCIÓS gombok használatával állítsa be a kívánt időtartamot (percben), és nyomja

meg a Kész gombot.

Billentyűzár a készülék bekapcsolásakor
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Biztonság → Billentyűzár-beállítások → Zárolás indításkor lehetőséget.
3 Válassza a Be/Ki lehetőséget.

Rádiós titkosítás
A rádiós titkosítással a rádió és az infrastruktúra között zajló teljes kommunikációt titkosíthatja, amely a hívások,
üzenetek és adatok még biztonságosabb kezelését teszi lehetővé.
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Ha a szolgáltató beállította, a rádió hangjelzést ad, valamint megjeleníti a Nem titkosított hívás / adatok üzenetet, ha
bekapcsolt titkosítás mellett titkosítatlan hívás érkezik. Ez a funkció bizalmas kommunikációt biztosít Ön és a
rendszer között.

TMO módban, ha a rádiós titkosítás engedélyezve van, de a használata az infrastruktúra hibája miatt nem támogatott,

az alábbi ikon jelenik meg a kijelzőn: .Ha a funkció DMO módban nem érhető el, a következő elem jelenik meg a

rádió kijelzőjén:  .

Ez a menüpont csak a rádiós titkosítás állapotának megtekintését teszi lehetővé.

Megjegyzés: Ez egy fizetős szolgáltatás.

Kapcsolódó hivatkozások
Állapotjelző ikonok A következő oldalon:27

A rádiós titkosítás állapotának megtekintése
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Biztonság → Rádiós titkosítás lehetőséget.
3 A rádió a következőt jeleníti meg:

a Rádiós titkosítás kikapcsolva.
b Rádiós titkosítás bekapcsolva.

A rádiós titkosítási kulcsok törlése
Érdeklődjön a szolgáltatónál arról, hogy a rádió tartalmazza-e a rádiós közeg titkosítási kulcsait. A rádiós közeg
titkosítási kulcsait az alábbi kódsorozat megadásával törölheti a rádióból: **00##.

Megjegyzés:

• Egy percig is eltarthat, amíg ez a funkció az összes titkosítási kulcsot törli a rádióról. Ez idő alatt ne
távolítsa el az akkumulátort.

• A törlést TMO, DMO vagy Vészhívás módban kell végrehajtani, ha a készülék épp nem végez hívást.

Figyelem!: Ez a funkció letiltja a készüléket, és azt a szolgáltatónak újra engedélyeznie kell.

K érvényessége
A K (mint kulcs) egy olyan titkos kulcs, amelyet a hálózat a rádió hitelesítéséhez használ. Ez a kulcs annak a
hitelesítési eljárásnak a része, amely a rádió és a rendszer közötti szolgáltatás titkosságát biztosítja.

K érvényességének ellenőrzése
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Biztonság → K érvényessége lehetőséget.
3 A rádió a következőt jeleníti meg:

• K érvényes – a hálózat hitelesíti a rádiót.
• K nem érvényes – a hálózat nem tudja hitelesíteni a rádiót. A rádió K kulcsának visszaállítása érdekében

forduljon a szolgáltatóhoz.
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SCK (rádiós közeg titkosítása, 2. osztály)
Az SCK (statikus rejtjelkulcs) a rádiós közeg titkosítására szolgáló 2. osztályú rejtjelkulcs. Segítségével a hívások és
az adatok titkosíthatók a TMO-ban és DMO-ban. Az SCK rádiós közeg titkosítása biztosítja a bizalmas
kommunikációt TMO esetében a rádiók és az infrastruktúra között, DMO esetében pedig a rádiók között. Egy rádióba
legfeljebb 32 SCK tölthető. Az egyes kulcsok a rádiós közeg titkosítására szolgálnak.

A rádiók és/vagy az infrastruktúra közötti bármilyen eltérés befolyásolja a kommunikációt – csak azok képesek a
kommunikáció dekódolására és vételére, akik az adó készülékével azonos kulcsot használnak.

TMO SCK
A TMO-ban az SCK funkciót csak akkor használhatja, ha a szolgáltató engedélyezte. A TMO-ban használt SCK-k
neve TMSCK.

DMO SCK
A DMO-ban az SCK funkciót csak akkor használhatja, ha a szolgáltató engedélyezte. A DMO-ban használt SCK-k
neve DMSCK.

DMO SCK módosítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Biztonság → DMO SCK lehetőséget.
3 Nyomja meg a Következő gombot.
4 A rádió a Váltás a következő verzióra üzenetet jeleníti meg.
5 Válasszon egyet az alábbiak közül:

• Igen – a kulcs módosítása. A rádió a Kulcsverzió megváltozott üzenetet jeleníti meg.
• Nem – a kulcs elvetése. A rádió a Kód nem változott üzenetet jeleníti meg.

TMSCK érvényességének ellenőrzése
Mikor és hol használja: A rádió TMSCK-inak érvényességét ellenőrzi, és a rádiós közeg titkosítására használható.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Biztonság → TMSCK érvényessége lehetőséget.
3 A rádió a következőt jeleníti meg:

• DMSCK érvényes – a rádió képes DMO módban titkosítva működni.
• DMSCK érvénytelen – a rádió nem képes DMO módban titkosítva működni. A rádió SCK kulcsainak

visszaállítása érdekében forduljon a szolgáltatóhoz.

DMSCK érvényességének ellenőrzése
Mikor és hol használja: A rádió DMSCK-inak érvényességét ellenőrzi, és a rádiós közeg titkosítására használható.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Biztonság → DMSCK érvényessége lehetőséget.
3 A rádió a következőt jeleníti meg:

• DMSCK érvényes – a rádió képes DMO módban titkosítva működni.
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• DMSCK érvénytelen – a rádió nem képes DMO módban titkosítva működni. A rádió SCK kulcsainak
visszaállítása érdekében forduljon a szolgáltatóhoz.

Rejtett mód
Ez a funkció a rádió összes látható és hallható jelzését kikapcsolja, hogy a készülék csendes és sötét helyen is
észrevehetetlen maradjon.

Rejtett módban a Beállítások menü alábbi menüpontjai nem érhetők el:

• Rezgés.
• Hangerőbeállítás
• Hangjelzések
• Háttérvilágítás (a Kijelző menüpont alatt)

Ha a rejtett mód be van kapcsolva:

• Minden hangjelzés Ki értékre van állítva (a Hangforrások kezelése menüpontban).
• A csoport hangbeállításai a Hangszórókezelés értékre vannak állítva (a Hangforrás beállítása menüpontnak

megfelelően).
• A privát hangszóró beállítása Ki (e beállítás hatására minden hívás a fülhallgatóból fog szólni).
• A Háttérvilágítás beállítás Letiltva (a Háttérvilágítás menüpontban).
• A LED-jelzőfény kikapcsol.

Bekapcsoláskor a rádió mindig a kikapcsolás előtti üzemmódba tér vissza. Ezért ha a kikapcsolás előtt a rejtett mód
volt beállítva, akkor a rádió bekapcsolás után is rejtett módban marad.

A rejtett mód kikapcsolása után minden megváltozott beállítás visszaáll a korábbi állapotába.

A rejtett mód egygombos funkcióként is beállítható.

Rejtett mód aktiválása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Biztonság → Rejtett mód lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Be – minden hangjelzés kikapcsol, és a háttérvilágítás és a LED is azonnal kikapcsol. A csoporttól jövő hang a
fülhallgatóra lesz irányítva. A rádió a Rejtett mód be üzenetet jeleníti meg.

• Ki – az összes hangjelzéssel, háttérvilágítással és hanggal kapcsolatos beállítás visszatér a korábbi értékre. A
rádió a Rejtett mód ki üzenetet jeleníti meg.

Rezgésre váltás rejtett módban
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Biztonság → Rejtett mód → Rezgés lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Be – Az összes rezgés visszaállítása.
• Ki – Az összes rezgés letiltása.

SDS távvezérlés
Az SDS távvezérlés funkció lehetővé teszi a rádió viselkedésének és konfigurációjának távoli vezérlését speciális
SDS üzenetek használatával. Az üzeneteket mind TMO, mind DMO módban (Jelismétlő módban is) küldheti
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bármely, más rádiók vezérlésére képes rádió. A távvezérlő üzenetek végrehajtása során a szolgáltató beállításaitól
függően a rádió hangjelzést adhat, rezeghet, vagy megjelenítheti a megfelelő ikont az állapotikon területen.

Megjegyzés: Ez egy fizetős szolgáltatás.

SDS távvezérlés beállítása
Mikor és hol használja: A rádió távvezérlésére szolgáló speciális SDS üzenetek támogatásának be- és kikapcsolása.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Biztonság → Távvezérlés lehetőséget.
3 A távvezérlést a Be elemmel engedélyezheti, a Ki elemmel pedig letilthatja.

Beállítások

Ez az almenü a rádió következő beállításainak módosítását teszi lehetővé:

Rezgés
Ez az almenü annak beállítását teszi lehetővé, hogy hívás fogadásakor a rádió rezegjen, csengjen vagy rezegjen és
csengjen is.

Alapértelmezett rezgés beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Rezgés lehetőséget
3 Válasszon egyet az alábbiak közül:

• Rezeg, majd cseng
• Csak rezeg
• Csak cseng

Rezgési beállítások megadása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Rezgés → Részletek... lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Kétirányú hívások – a telefon-, PABX- és a kétirányú privát hívások rezgési beállításainak megadása.
• Egyirányú hívások – az egyirányú privát hívások rezgési beállításainak megadása.
• Csoporthívások – a csoporthívások rezgési beállításainak megadása.
• Üzenetek – az állapot- és szöveges üzenetek rezgési beállításainak megadása.

4 Válassza ki a kívánt beállítást, és nyomja meg a Kiválasztás gombot.

Megjegyzés: A Kétirányú hívások, Egyirányú hívások vagy Üzenetek beállítás választásakor
rendelkezésre álló beállítások a Rezeg, majd cseng (üzenetek esetén Rezeg és cseng), a Csak rezeg és
a Csak cseng. Ha a Csoporthívás lehetőséget választja, csak a Rezgés be és a Rezgés ki beállítások
érhetők el.
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Csengőhang
Ez az almenü lehetővé teszi a bejövő hívások csengőhangjának beállítását.

A csengőhangok beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Csengőhang lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Kétirányú – új csengőhang beállítása a kétirányú hívásokhoz.
• Egyirányú – új csengőhang beállítása az egyirányú hívásokhoz.

Megjegyzés: Ebbe az almenübe lépve a jelenleg használt csengőhangot láthatja.

4 Keresse meg a kívánt stílust, és nyomja meg a Kiválasztás gombot.

Megjegyzés: A rádió néhány másodpercre lejátssza az új csengőhangot. Szükség esetén módosítsa a
hangerőt

Hangerőbeállítás
Ez a menüpont lehetővé teszi az egyirányú és a kétirányú hívások, a fülhallgató, a hangszóró és a billentyűhang
hangerejének beállítását.

Kapcsolódó hivatkozások
Hangerőszabályozás módja A következő oldalon:85

A hangerő beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítás → Hangerő-beállítás lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Kétirányú csengőhangok hangereje – a kétirányú hívást jelző csengőhangok hangerejének beállítása.
• Egyirányú csengőhangok hangereje – az egyirányú hívást jelző csengőhangok hangerejének beállítása.
• Fülhallgató – a fülhallgató hangerejének beállítása.
• Hangszóró – a hangszóró hangerejének beállítása.
• Billentyűhangok hangereje – a billentyűhangok hangerejének beállítása.

Megjegyzés: Ha a kijelzőn csak egy beállítási lehetőség, a Hangerő látható, akkor valamennyi fenti
beállítás értékét egyszerre módosíthatja. Ha a Hangerő-beállítás módja beállítás értéke Egyedi, az
egyes beállítások értékét külön-külön is módosíthatja.

4 Az érték módosításához nyomja meg a jobbra vagy a balra mutató NAVIGÁCIÓS gombot.

Megjegyzés: Ha az akkumulátor töltöttsége alacsony, nem javasolt a 4 ohmos hangszórót a rádióhoz
csatlakoztatni, mivel a rádió újraindulását vagy leállását okozhatja.

Kapcsolódó hivatkozások
A hangerőszabályozás módjának beállítása A következő oldalon:86
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Nyelv
Ez az almenü a rádió nyelvének módosítását teszi lehetővé.

A nyelv beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Nyelv lehetőséget.
3 Válassza ki a kívánt nyelvet.

Adatátviteli beállítások
Ez a menüpont lehetővé teszi annak beállítását, hogy a rádió külső eszközre küldjön, illetve onnét fogadjon adatokat.

A rádió kiegészítő csatlakozójának külső eszközhöz történő csatlakoztatásához használja a PMKN4025 cikkszámú
kábelt A külső eszköznek a TETRA szabvánnyal kompatibilis alkalmazást kell futtatnia.

Megjegyzés:

• Az adatszolgáltatások csak TMO módban érhetők el.
• Az adatszolgáltatásokat a rádió adástiltás módban blokkolja.
• A Csak beszéd beállítás esetén a beépített adatmodem az energiatakarékosság érdekében kikapcsol.

Az adatátviteli funkció beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Adatátviteli beállítások lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Csak beszéd – a rádió csak hanghívásokat fogadhat és indíthat.
• Csak adat – a rádió modemként működik. A rádió elutasítja a bejövő és kimenő hanghívásokat (kivéve a

vészhívásokat), valamint az állapot- és szöveges üzeneteket.
• Beszéd és adat – A rádió modemként működik, de a hanghívások prioritást élveznek az adathívások felett, és

megszakíthatják azokat.

Hang
Ez a menüpont a rádió hangbeállításainak módosítását teszi lehetővé.

Hangprofilok
A hangprofil a hangparaméterek – például riasztóhangok hangerejének – készlete, amelyet a szolgáltató konfigurált az
adott működési környezetnek megfelelően. A hangparaméterek hozzáigazíthatók a rádió használati környezetéhez,
például az épületek belteréhez vagy zajos utcákhoz.

Ha beprogramozzák, a rádió megjeleníti az aktuálisan használt hangprofil nevét (a kezdőképernyőn), és/vagy a
profilhoz kapcsolódó megfelelő ikont (az állapotikonok területén).

A szolgáltató legfeljebb tíz hangprofilt konfigurálhat.

Az adott hangprofil részletes leírásáért forduljon a szolgáltatójához.
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Hangprofilok beállítása
Mikor és hol használja: A rádió audioparamétereinek az aktuális működési környezethez igazítására szolgál.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Hang → Hangprofil lehetőséget.
3 Válassza ki a megfelelő profilt.

Gerjedésgátlás
A gerjedésgátlás az akusztikus visszacsatoló hurok stabilitását növelő üzemmód. A rádió megszünteti a gerjedést,
amit egyutas hívások során a vevő rádiókból az adó rádióba irányuló visszacsatolás okoz. A gerjedésgátlást egy aktív
hívás során be- és kikapcsolhatja.

A gerjedésgátlás funkció bekapcsolására használhatja a rádió menüjét, vagy a megfelelő egy gombnyomásos gombot.

A gerjedésgátlás beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Hang → Gerjedésgátlás lehetőséget.
3 Válassza ki a kívánt beállítást.

Megjegyzés: A szolgáltató beállíthatja a gerjedségátlás állapotát a rádió bekapcsolásakor. A beállítástól
függően a rádió vagy letiltja a gerjedésgátlást, vagy az utolsó beállítást őrzi meg.

Hangforrás beállítása
Az erre szolgáló HANGSZÓRÓKEZELŐ gombbal bármely privát vagy csoporthíváshoz kiválaszthatja a használni kívánt
hangforrást (hangszóró/fülhallgató). A menüben megadhatja, hogy minden csoporthívás hangos üzemmódú legyen-e,
vagy az üzemmódot a HANGSZÓRÓKEZELŐ gombbal lehessen szabályozni.

A hangforrás beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Hang → Hangforrás beállítása lehetőséget.
3 Válasszon egyet az alábbiak közül:

a Mindig hangos – e beállítás esetén a hangok a hangszórón keresztül szólnak (hangos audió).A
HANGSZÓRÓKEZELŐ gomb le van tiltva.

b Hangszórókezelő gomb használata – a hang a fülhallgatón vagy a hangszórón keresztül hallható. A halk és a
hangos mód között a HANGSZÓRÓKEZELŐ gombbal válthat.

Hangerőszabályozás módja
A hangerőszabályozás Egyedi vagy Közös lehet. Ha a beállítás Egyedi, akkor a beszéd, a kétirányú és egyirányú
hívások, valamint a fülhallgató, a hangszóró és a billentyűhangok hangerejét külön-külön szabályozhatja. A Közös
beállítás használata esetén minden elem hangerejét egyszerre módosíthatja.

Kapcsolódó hivatkozások
Hangerőbeállítás A következő oldalon:83
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A hangerőszabályozás módjának beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Hang → Hangerő-szabályozás módja lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Egyéni – a kétirányú és egyirányú hívások, valamint a fülhallgató, a hangszóró és a billentyűhangok
hangerejét a felhasználó külön-külön állíthatja a MENÜ → Beállítás → Hangerő-beállítás helyen.

• Közös – A MENÜ → Beállítás → Hangerő-beállítás helyen egy értéket állíthat be az összes elemhez.

Kapcsolódó hivatkozások
A hangerő beállítása A következő oldalon:83

Hangjelzések
Ebben a mezőben állítható be a hangkészlet hangereje.

Billentyűhang
Be- és kikapcsolhatja a minden billentyűlenyomásnál hallható billentyűhangot.

A billentyűhang beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Hangjelzések → Billentyűhang lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Be – a billentyűhangok bekapcsolása.
• Ki – a billentyűhangok kikapcsolása.

Minden hangjelzés
A készülék összes hangjelzésének be- és kikapcsolását teszi lehetővé.

Az összes hangjelzés be- és kikapcsolása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Hangjelzések → Minden hangjelzés lehetőséget.
3 Válasszon egyet az alábbiak közül:

a Be – az összes hangjelzés bekapcsolása.
b Ki – az összes hangjelzés kikapcsolása.

Beszédengedélyező hang
A PTT gomb megnyomása után hallható hangjelzés beállítása.

Beszédengedélyező hang beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
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2 Válassza a Beállítás → Hangjelzések → Beszédengedélyező hang lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Nincs hang – nem hallható hangjelzés a PTT gomb megnyomásakor.
• Rövid hang – rövid hangjelzés hallható a PTT gomb megnyomásakor.
• Normál hang – a gyári alapértelmezésként beállított hang hallható a PTT gomb megnyomásakor.

Adásengedélyezés
A vevő fogadókészségét jelző hangjelzés be- és kikapcsolása az adást végző rádióban.

Az adásengedélyező hangjelzés beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Hangjelzések → Adásengedélyezés lehetőséget
3 Válasszon egyet az alábbiak közül:

• Hangjelzések be – az adásengedélyező hangjelzés bekapcsolása.
• Hangjelzések ki – az adásengedélyező hangjelzés kikapcsolása.

Ismétlődő riasztás
A nem fogadott hívásokat, az olvasatlan üzeneteket és az alacsony akkumulátortöltöttséget jelző ismétlődő hangjelzés
ki- és bekapcsolása. A készülék minden egyes értesítésnél az olvasatlan üzenetet jelző hangjelzést játssza le, a LED-
JELZŐFÉNY pedig sárgán világít.

Ismétlődő riasztás beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Hangjelzések → Ismétlődő riasztás lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Riasztás – az ismétlődő hangjelzés be- és kikapcsolása.
• Időköz – az egyes hangjelzések közötti időköz.

D-PTT hangok
Ez a menüpont tartalmazza a Dupla PTT funkció beállításait.

A Dupla PTT funkció segítségével hangmintát (egyszeres, kétszeres vagy háromszoros) küldhet a PTT gomb kétszeri
megnyomásával, ha a rádió készenléti vagy csoportos hívás módban van.

A D-PTT hangjelzés után a felhasználó a PTT gomb újbóli hosszabb megnyomásával engedélyt kérhet a
beszélgetésre. Ha viszont a felhasználó a D-PTT hangjelzés közben nyomja meg a PTT gombot, a készülék figyelmen
kívül hagyja.

Ha viszont a PTT gomb hosszabb megnyomására a D-PTT hangjelzés után kerül sor, a készülék megadja az
engedélyt a beszédre. A küldő készüléken a D-PTT hang nem hallható.

Megjegyzés: A funkciót csak akkor használhatja, ha azt a szolgáltató engedélyezi.
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A D-PTT hangjelzések beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Hangjelzések → D-PTT hangjelzések lehetőséget.
3 Válasszon egyet az alábbiak közül:

• D-PTT mód – a D-PTT hangjelzések be- és kikapcsolása.
• Hangjelzés stílusa – itt adható meg, hogy hányszor játssza le a rádió a D-PTT hangjelzést.

Kijelző
Ez a menüpont a rádió kijelzőbeállításainak módosítását teszi lehetővé.

Kapcsolódó hivatkozások
Kijelző A következő oldalon:26
Kijelző A következő oldalon:26
A kijelzőn látható idő és dátum beállítása A következő oldalon:91

Kijelzőelforgatás beállítása
Mikor és hol használja:

Ez a funkció azok számára hasznos, akik a rádiót vállon, övön vagy hajtókán hordják, és egyébként fejjel lefelé látnák
a kijelzőt.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Kijelző → Kijelző elforgatása lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Be – a funkció bekapcsolása.
• Ki – a funkció kikapcsolása.

A betűméret beállítása
Mikor és hol használja: A betűméret növelésével és csökkentésével a felhasználói felület olvashatóságát a fennálló
körülményekhez igazíthatja.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Kijelző → Betűméret lehetőséget.
3 Válasszon egyet az alábbiak közül:

• 1 – kis betűméret
• 2 – közepes betűméret
• 3 – nagy betűméret

Megjegyzés: Egyes nyelvek esetén csak kevesebb betűméret érhető el.
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Nagyobb betűméret beállítása a készenléti képernyőn.
Mikor és hol használja: A készenléti képernyőn látható nagy betűméret be- és kikapcsolása.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Kijelző → Nagy betűméret a készenléti képernyőn lehetőséget.
3 A kezdőképernyőn a nagyméretű betűk megjelenítésének engedélyezéséhez válassza a Be, tiltásukhoz pedig a Ki

lehetőséget.

Megjegyzés: A Nagy betűméret a készenléti képernyőn funkció nem érhető el minden nyelven.

Extra nagyítás beállítása
Az extra nagyítás beállítása egyszerre három beállítást is módosít: a legnagyobb betűméret értéket állítja be,
bekapcsolja a Nagy betűméret a készenléti képernyőn beállítást, valamint beállítja a Bővített állapotikonok
számára a Csak készenlét értéket.

Ha ezek közül bármely beállítást is módosítja (például csökkenti a betűméretet), a rádió kilép az extra nagyítási
módból. Ha azonban mindhárom beállítást visszaállítja a korábbi értékre, akkor kézzel kell módosítania a Betűméret,
a Nagy betűméret a készenléti képernyőn és a Bővített állapotikonok értékét. Ha valamely beállítást nem tudja
visszaállítani, forduljon a szolgáltatóhoz.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Kijelző → Extra nagyítás lehetőséget.
3 Az extra nagyítást a Be elemmel engedélyezheti, a Ki elemmel pedig letilthatja.

Megjegyzés: Az Extra nagyítás a SIM-kártyás titkosítást használó rádiókon nem érhető el.

Bővített állapotikonok beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Kijelző → Bővített állapotikonok.
3 Válasszon egyet az alábbiak közül:

• Letiltva – a rádió mindig a normál méretű ikonokat jeleníti meg.
• Csak készenlét – a rádió csak a kezdőképernyőn jelenít meg nagyobb ikonokat.
• Mindig – a rádió nagy ikonokat jelenít meg a kezdőképernyőn és a menüben is.

A képernyővédő beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Kijelző → Képernyővédő lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Aktiválás – A funkció be- és kikapcsolása.
• Szöveg – A funkció aktiválásakor a képernyőn megjelenő szöveg beállítása.
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A háttérvilágítás beállítása
Mikor és hol használja: Az energiafogyasztás csökkentése:

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Kijelző → Háttérvilágítás lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Automatikus – A háttérvilágítás a készülék bekapcsolásakor, valamint a készülék vagy a hozzá csatlakoztatott
kiegészítők gombjainak megnyomásakor kapcsol be. A háttérvilágítás emellett az akkumulátor töltése és az
alábbi jelzések érkezésekor is bekapcsol: eseményjelentési üzenetek, RUA-kérések, DGNA- és TX-
időtúllépések prioritásos hívás esetén.

• Félautomatikus – A háttérvilágítás a rádió bekapcsolása, a háttérvilágítást szabályozó gomb megnyomása és
töltés esetén kapcsol be.

• Letiltva – a háttérvilágítás ki van kapcsolva, a kijelző mindig sötét.
• Be – A háttérvilágítás mindig be van kapcsolva.

Megjegyzés: A háttérvilágítás fényerejének a HÁTTÉRVILÁGÍTÁS gombbal történő állítása a LED-
eknek, a billentyűzet háttérvilágításának és a VÉSZHÍVÁS gomb háttérvilágításának az intenzitását is
megváltoztatja.

A háttérkép beállítása
Mikor és hol használja: A készenléti képernyő kinézetének módosítása:

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Kijelző → Háttér lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Be – a funkció bekapcsolása
• Ki – a funkció kikapcsolása.

A kontraszt beállítása
Mikor és hol használja: Ez a funkció beállítja a kijelző kontrasztját a felhasználói felület láthatóságának növelése
érdekében.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Kijelző → Kontraszt lehetőséget.
3 Az értéket a balra és a jobbra mutató NAVIGÁCIÓS gombokkal módosíthatja.
4 Nyomja meg az OK gombot.

Idő és dátum
Ebben az almenüben kezelheti a kezdőképernyőn látható dátumot és időt.

Megjegyzés: Ha aktív a Szöveges üzenet jelenjen meg a kezdőképernyőn funkció, akkor a Konfigurálható
készenléti képernyő beállításaitól függően a Kezdőképernyő szövege tartalmazhatja a dátumot és az időt.

Megjegyzés: Az időt és a dátumot a szolgáltató infrastruktúrája szinkronizálja. Az infrastruktúra hatókörén
kívül az értékek beállítása manuálisan lehetséges.
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A kijelzőn látható idő és dátum beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítás → Idő és dátum → Megjelenítés lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Idő és dátum – Az idő és a dátum jelenik meg a képernyőn.
• Csak idő – A rádió csak az időt jeleníti meg. A Dátumformátum menüpont nem jelenik meg.
• Csak dátum – A rádió csak a dátumot jeleníti meg. Az Időformátum menüpont nem jelenik meg.
• Ki – A rádió sem az időt, sem a dátumot nem jeleníti meg. A Formátum menü ki le van tiltva.

Kapcsolódó hivatkozások
Kijelző A következő oldalon:26
Kijelző A következő oldalon:88

Időformátum beállítása
Előfeltételek: Ha a MENÜ → Beállítás → Idő és dátum → Megjelenítés értéke Idő és dátum vagy Csak idő.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Idő és dátum → Formátum → Időformátum lehetőséget.
3 Válasszon egyet az alábbiak közül:

• 12 órás – Az időt de. (délelőtt) és du. (délután) jelzéssel írja ki.
• 24 órás

Az idő kézi beállítása
Mikor és hol használja: Ha a dátum nem frissíthető a hálózatról automatikusan:

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Idő és dátum → Beállítás → Idő beállítása lehetőséget.
3 Állítsa be a pontos időt a NAVIGÁCIÓS gombokkal vagy a számbillentyűkkel .
4 Nyomja meg a Kész gombot.

A dátum formátumának beállítása
Előfeltételek: Ha a MENÜ → Beállítás → Idő és dátum → Megjelenítés értéke Idő és dátum vagy Csak dátum.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Idő és dátum → Formátum → Dátumformátum lehetőséget.
3 Válasszon az alábbi lehetőségek közül (N – nap, H – hónap, É – év):

• NN/HH/ÉÉ
• HH/NN/ÉÉ
• NN-HHH-ÉÉ
• ÉÉ/HH/NN
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A dátum kézi beállítása
Mikor és hol használja: Ha a dátum nem frissíthető a hálózatról automatikusan:

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Idő és dátum → Beállítás → Dátum beállítása lehetőséget.
3 Állítsa be a pontos időt a NAVIGÁCIÓS gombokkal vagy a számbillentyűkkel .
4 Nyomja meg a Kész gombot.

Időeltolódás beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Idő és dátum → Beállítás → Időeltolódás lehetőséget.
3 A NAVIGÁCIÓS gombokkal állítsa be az időeltolódást.

Megjegyzés: Az eltolódás értékét 15 perces lépésekben, legfeljebb 14 órával előre vagy hátra állíthatja.

4 Nyomja meg a Kész gombot.

A dátum és az idő automatikus frissítésének beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítás → Idő és dátum → Rendszerfrissítés lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Ki – A rádió figyelmen kívül hagyja a hálózatról érkező információkat. A rádió a belső időt és eltolódást
használja.

• Csak idő – A megjelenített időt úgy számítja ki a rendszer, hogy hozzáadja a szolgáltató által beprogramozott
időeltolódást a hálózati időhöz, vagy kivonja belőle.

• Idő és eltolódás – Az időadatok és az eltolódás a hálózatról érkező adatok alapján frissülnek.

Energiatakarékosság
Az Energiatakarékosság mód célja, hogy az akkumulátor minél tovább használható maradhasson. A rádió nem
figyeli a fő vezérlőcsatorna összes downlink időrését. Ha a rádió a töltőre csatlakozik, az Energiatakarékosság
módra nincs szükség.

Energiatakarékossági funkció engedélyezése
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Energiagazdálkodás → Energiagazdálkodási beállítások lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Be – az energiatakarékos mód bekapcsolása.
• Ki – az energiatakarékos mód kikapcsolása.
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Energiagazdálkodás megtekintése
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Energiagazdálkodás → Energiagazdálkodás módja lehetőséget.
3 Az energiagazdálkodás módja a következők egyike lesz:

• A rendszer energiatakarékos módban működik.
• A rendszer nem energiatakarékos módban működik.

Átviteliteljesítmény-osztály
Annak beállítását teszi lehetővé, hogy a rádió 3L vagy 4 teljesítményosztály szerint sugározzon-e. A jelerősség ikon
mutatja, ha a rádió használja ezt a funkciót.

A rádió teljesítményosztályának beállítása
Mikor és hol használja: Ha olyan területre lép, amely nagyobb jelerősséget igényel:

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Rádió teljesítménye lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Nagy teljesítmény – a funkció aktiválása
• Normál teljesítmény – a funkció kikapcsolása

Megjegyzés:

• Ha a rádiófrekvenciás teljesítményosztályt hívás közben normál teljesítményre váltja át,
előfordulhat, hogy a hívás megszakad. Lehet, hogy a teljesítményszint nem elegendő az átvitel
fenntartásához.

• A Nagy teljesítmény beállítás több energiát igényel.

Megjegyzés: Ez egy fizetős szolgáltatás.

Előjegyzés
Ebben a menüpontban, a RUA/RUI funkció beállításainak módosításával, azt adhatja meg, hogy a rádió
automatikusan elfogadja-e, vagy inkább elutasítsa az előjegyzési kéréseket.

Kapcsolódó hivatkozások
RUI A következő oldalon:103
RUA/RUI A következő oldalon:110

Előjegyzési beállítások szerkesztése
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Előjegyzési beállítások lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Előjegyzés elfogadása – a rádió az összes előjegyzési kérést elfogadja.
• Előjegyzés elutasítja – a rádió az összes előjegyzési kérést értesítés nélkül elutasítja.
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Forgatógomb
Ez a menüpont a FORGATÓGOMB, a .

Forgatógomb üzemmódjának beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Forgatógomb → Forgatási mód lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Kettős – mindkét mód elérhető. A FORGATÓGOMB elfordításával beállíthatja a hangerőt, vagy megnyomva és
forgatva átválthat egy másik beszédcsoportra.

• Hangerő – A forgatógombbal csak hangerő-szabályozás végezhető. A hangerő növeléséhez forgassa el az
óramutató járásával megegyező irányban.

• Görgetés – a forgatógomb csak a beszédcsoport módosítására, illetve a menüben a menüpontok görgetésére
használható.

Megjegyzés: Ha a Görgetés lehetőséget választja, és a kijelzőn az alábbi üzenet olvasható:

• Görgetés kiválasztva – a hangerő beállításához vissza kell térnie a főmenübe, és a Beállítás →
Hangerő-beállítás lehetőséget kell választania.

• Hangerőszabályozás a funkciógombokkal – a hangerőt a programozható OLDALGOMBOKKAL

állíthatja be.

Megjegyzés: A FORGATÓGOMB és az OLDALGOMBOK úgy vannak beprogramozva, hogy a funkcióik
kiegészítsék egymást. Ha a FORGATÓGOMB beállítása Hangerő vagy Kettős, az OLDALGOMBOK támogatják
az egygombos funkció használatát.

Kapcsolódó hivatkozások
Egygombos funkció A következő oldalon:36

A forgatógomb lezárása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Forgatógomb → Forgatógomb lezárása lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Lezárás – A FORGATÓGOMB lezárása. A forgatógombot a Feloldás lehetőséggel, illetve a FORGATÓGOMB, .
• Feloldás – a FORGATÓGOMB, .
• Letiltva – a forgatógomb lezárása nem érhető el. A FORGATÓGOMB, a mindig használható.

A forgatógomb viselkedése billentyűzár esetén
Mikor és hol használja: Beállíthatja, hogy hogyan viselkedjen a forgatógomb, ha le van zárva a billentyűzet.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Forgatógomb → Billentyűzár esetén lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Nincs lezárás – a görgetés és a hangerőszabályozási funkció is elérhető.
• Hangerő-szabályozás zárolása – A FORGATÓGOMB csak görgetésre használható.
• Görgetés zárolása – A FORGATÓGOMB csak a hangerő beállítására használható.
• Mindkettő lezárása – sem a görgetési, sem a hangerő-beállítási funkció nem érhető el.
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Körben járó görgetés beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Forgatógomb → Körben járó lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Ki – A beszédcsoport-listában való görgetés elölről kezdődik, vagy a következő mappában folytatódik.
• Be – a beszédcsoport-listában való görgetés megáll az aktuális mappa első és utolsó beszédcsoportjánál.

Megjegyzés: Csak akkor lehet más mappára átgörgetni, ha a Körben járó beállítás értéke Be, a
Görgetési tartomány beállítás értéke pedig Görgetés a következőre.

Forgatógomb görgetési tartományának beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Forgatógomb → Görgetési tartomány lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Tartományon belül marad – a görgetés során a rádió az aktuális mappában marad.
• Görgetés a következőre – az összes beszédcsoport és mappa egyszerre végiggörgethető.

Megjegyzés: Csak akkor lehet más mappára átgörgetni, ha a Körben járó beállítás értéke Be, a
Görgetési tartomány beállítás értéke pedig Görgetés a következőre.

Forgatógombbal való beszédcsoport-választás beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Forgatógomb → Kiválasztott beszédcsoport megerősítése lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Be – A kiválasztott beszédcsoportot meg kell erősítenie a Kiválasztás gombbal, az azonnali hívásindításhoz
pedig meg kell nyomnia a PTT gombot.

• Ki – A rádió kérdés nélkül a kiválasztott beszédcsoporthoz csatlakozik

A forgatógomb funkciógombjainak beállítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítások → Forgatógomb → Funkciógombok lehetőséget.
3 Válasszon egyet az alábbiak közül:

• Automatikus – az OLDALGOMBOKAT a Forgató mód beállításai alapján állítja be.

Megjegyzés: Ha a Forgató mód beállítása:

• Kettős vagy Hangerő – A kijelzőn az Automatikusan kiválasztva (OTB) felirat látható, és a
hangerő csak a FORGATÓGOMBBAL állítható.

• Görgetés – a kijelzőn az Automatikusan kiválasztva (hangerő) felirat látható, és a hangerő
csak az OLDALGOMBOKKAL állítható.

• Hangerőbeállítás – a hangerő az OLDALGOMBOKKAL módosítható.
• Egygombos funkció – Az OLDALGOMBOK az előre beállított egygombos funkciót hajtják végre.
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Csoportbeállítások

Ez az almenü lehetővé teszi a letapogatás és a Saját csoportok mappa beállítását.

Letapogatás
Ez a menüpont lehetővé teszi a letapogatás be- és kikapcsolását, az aktív letapogatási lista megtekintését és a
letapogatási listák szerkesztését. Ez a funkció csak TMO módban érhető el. A rádió akkor csatlakozik a
csoporthívásokhoz, ha az illető csoport szerepel a letapogatási listában, és a letapogatás be van kapcsolva.

Kapcsolódó hivatkozások
A beszédcsoport-letapogatás bekapcsolása A következő oldalon:35

A beszédcsoport-letapogatás bekapcsolása
Mikor és hol használja: TMO csoporthívás figyelésének beállítása a megadott beszédcsoport-listában:

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Csoportbeállítások → Letapogatás → Letapogatás.
3 Válassza a Lista kiválasztása lehetőséget, majd válasszon listanevet.

A listanév mellett a Kiválasztva jelzés jelenik meg.

4 Válassza a következőt: Letapogatás → Be.

A rádió az előre beállított letapogatási listában végez keresést.
Kapcsolódó hivatkozások

Letapogatás A következő oldalon:96

Beszédcsoportok beállítása az aktív letapogatási listában
Mikor és hol használja: Az aktív letapogatási listában lévő beszédcsoportok szerkesztése:

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Csoportbeállítások → Letapogatás → Aktív lista.

Megjegyzés: Ha A letapogatás ki van kapcsolva felirat jelenik meg, válassza a Tovább . . . →
Csoport beállítás → Letapogatás → Letapogatás → Be lehetőséget a letapogatás engedélyezéséhez.

3 Válassza a Megtekintés lehetőséget, és jelölje ki a kívánt beszédcsoportot.
4 Nyomja meg a MENÜ gombot.
5 Válasszon egyet az alábbiak közül:

• Törlés – a csoport törlése az aktív letapogatási listáról.
• Prioritás – az új prioritás értéke Alacsony, Közepes vagy Magas lehet.

Letapogatási listák kezelése
Mikor és hol használja: A letapogatási listák beállításainak módosítása:

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További.. . → Csoportbeállítások → Letapogatás → Letapogatási listák.
3 Jelölje ki a kívánt letapogatási listát, és nyomja meg a MENÜ gombot a további beállítások megtekintéséhez:

96 | Főmenü

Send Feedback  |   | 

http://docsurvey.motorolasolutions.com


• Átnevezés – a letapogatási lista új nevének beállítása.
• Kapacitás – a letapogatási lista hozzárendelt és nem hozzárendelt beszédcsoportjainak száma
• Törlés – a letapogatási listához rendelt valamennyi beszédcsoport törlése
• Csoport hozzáadása – beszédcsoport hozzáadása a letapogatási listához Válasszon egy beszédcsoportot a

beszédcsoport-mappákból, és rendeljen hozzá megfelelő prioritást.
• Szerkesztés – a kívánt beszédcsoport prioritásának módosítása vagy törlése

Beszédcsoportok törlése a letapogatási listából
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További . . . → Csoportbeállítások → Letapogatás → Letapogatási listák lehetőséget.
3 Jelölje ki a kívánt letapogatási listát, és nyomja meg a MENÜ → Szerkesztés gombokat.
4 Jelölje ki a kívánt beszédcsoportot, és nyomja meg a MENÜ → Törlés gombokat.

Saját csoportok
A Saját csoportok ekvivalens a Kedvencek mappával (következő szakasz). Mindkét menüpont a kedvenc
beszédcsoportokra és névjegyekhez tartozó számokra mutató parancsikonokat tartalmaz, valamint ugyanazokat a
műveleteket lehet elvégezni velük. A funkció részletes leírását illetően tekintse át a Kedvencek című szakaszt.

Kedvencek

A Kedvencek a gyakran használt beszédcsoportokra és névjegyekhez tartozó számokra mutató parancsikonokat
tartalmaznak, amelyek a kedvencek mappáiba vannak rendezve.

A kedvencek mappáiban szereplő elemek gyors eléréséhez a kezdőképernyőn nyomja meg a felfelé mutató
NAVIGÁCIÓS gombot. A kedvencek mappáiban szereplő elemek görgetéséhez a NAVIGÁCIÓS gombok vagy a
FORGATÓGOMB használható.

Kedvencek mappái
A kedvenc beszédcsoportokat és kedvenc névjegyekhez tartozó számokat a rádió a kedvencek mappáiban tárolja. A
mappák minden típusú beszédcsoport és névjegyhez tartozó szám esetén közösek, azaz egy mappában különböző
módokban elérhető elemek is szerepelhetnek. Az egyes elemek típusának jelzéséhez a rádió az elem mellett kisméretű
ikont jelenít meg.

Alapértelmezés szerint a rádió egy kedvenceket tartalmazó mappával rendelkezik, melyben 128 kedvenc elem
tárolható. Azonban a Kedvencek alatt két további mappa is létrehozható, amelyeknek a tartalmukra utaló nevet adhat.

Ha a Kedvencek csak egy kedvenceket tároló mappát tartalmaz és az üres, akkor csak az elemek mappához adására, a
mappa átnevezésére, valamint új mappa létrehozására van lehetőség.

Kedvenc beszédcsoportok
A rádióban beprogramozott bármely beszédcsoport hozzáadható a Kedvencek listájához. A rádió működési módját az
aktuálisan kiválasztott kedvenc beszédcssoporthoz igazítja. Ha például a rádió DMO módban van, és Ön TMO
beszédcsoportot választ, a rádió TMO módra vált, illetve fordítva.

A kedvenc beszédcsoportok közötti hívás közbeni görgetés nem fejezi be a hívást. Ugyanígy nem fejezi be a hívást az
aktuálisan kiválasztott beszédcsoport Kedvencek közüli hívás közbeni törlése sem.

Ha a kikapcsolás előtti utoljára választott beszédcsoport szerepel a Kedvencek között, akkor a rádió:

• DMO módban történő bekapcsolás esetén a legutoljára kiválasztott kedvenc DMO beszédcsoporthoz csatlakozik.
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• TMO módban történő bekapcsolás esetén a legutoljára kiválasztott kedvenc TMO beszédcsoporthoz csatlakozik.

Ha valamely kedvenc beszédcsoportban szeretne hívást indítani, használja a jelen dokumentumban a csoporthívások
esetén részletezett eljárásokat

Kedvenc névjegyek számai
A Névjegyek közül bármely névjegyet hozzáadhatja a Kedvencekhez listájához. Ha egy névjegyhez több szám is
tartozik, a balra vagy jobbra mutató NAVIGÁCIÓS gombbal ki kell választani a hozzáadni kívánt számot. A névjegyek
egyes számainak Kedvencekhez adására nem vonatkozik korlátozás – az összes névjegy számát hozzáadhatja külön
bejegyzésként. Amikor eltávolít egy névjegyhez tartozó számot a Névjegyek közül, akkor az automatikusan törlődik
a Kedvencek közül is. Ehhez hasonlóan a névjegyekNévjegyek közül való eltávolításakor is automatikusan törlődik
az összes kapcsolódó szám a Kedvencek közül.

Vészhívás közben nem lehet hívást indítani a kedvenc névjegyek számaira.

Privát hívások indítása a Kedvencek között szereplő névjegy számára
Eljárás:

1 A hívni kívánt szám kiválasztásához a kezdőképernyőről indulva tegye a következők valamelyikét:

• Nyomja meg a jobbra vagy balra mutató NAVIGÁCIÓS gombot.
• Lépjen az Opciók → Beszédcsoportok mappa szerint területre, válassza ki a Kedvencek kívánt mappáját, és

jelölje ki a névjegy számát.
2 Ha a következő módban van:

a TMO – egyirányú híváshoz nyomja meg, majd engedje fel a PTT gombot. Csengést fog hallani. Ettől eltérő
esetben, nyomja meg hosszabban a PTT gombot. Csak a beszédengedélyező hang után szólaljon meg, a válasz
meghallgatásához pedig engedje fel a PTT gombot. Kétirányú híváshoz nyomja meg, majd engedje fel a
KÜLDÉS gombot. Csengést fog hallani.

b DMO – Csak egyirányú hívás lehetséges. Nyomja meg hosszabban a PTT gombot. Csak a beszédengedélyező
hang után szólaljon meg, a válasz meghallgatásához pedig engedje fel a PTT gombot.

3 A hívás befejezéséhez nyomja meg a HÍVÁS VÉGE gombot.

Mappák hozzáadása a Kedvencekhez
Előfeltételek: A Kedvencek területen háromnál kevesebb kedvenceket tartalmazó mappa található.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Kedvencek lehetőséget.
3 Válassza az [Új mappa] lehetőséget.
4 Írja be a nevet, és nyomja meg az OK gombot.

Névjegyek számainak hozzáadása a Kedvencekhez
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Névjegyek lehetőséget
3 Jelölje ki a Kedvencek listájához hozzáadni kívánt névjegyet, és a jobbra vagy balra mutató NAVIGÁCIÓS gombbal

válassza ki a kívánt számot.
4 Nyomja meg a MENÜ gombot, és válassza a Hozzáadás a Kedvencekhez lehetőséget.
5 Válassza ki azt a mappát, amelyhez hozzá szeretné adni a névjegy számát, majd nyomja meg a Kiválasztás

gombot.
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Beszédcsoportok hozzáadása a Kedvencekhez
Előfeltételek:

DMO beszédcsoport hozzáadása előtt győződjön meg róla, hogy a rádió DMO módban van.
TMO beszédcsoport hozzáadása előtt győződjön meg róla, hogy a rádió TMO módban van.

Eljárás:

1 A kezdőképernyőn nyomja meg az Opciók gombot.
2 Válasszon egyet az alábbiak közül:

• Beszédcsoportok mappa szerint – mappákba rendezett beszédcsoportokat tartalmaz.
• Beszédcsoportok név szerint – betűrendbe rendezett beszédcsoportokat tartalmaz.

3 Keresse meg és jelölje ki a Kedvencekhez hozzáadni kívánt beszédcsoportot.
4 Nyomja meg a MENÜ gombot, és válassza a Hozzáadás a Kedvencekhez lehetőséget.
5 Válassza ki azt a mappát, amelyhez hozzá szeretné adni a beszédcsoportot, majd nyomja meg a Kiválasztás

gombot.

Kapcsolódó hivatkozások
Belépés DMO módba A következő oldalon:50

A Kedvencek mappáinak kezelése
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Kedvencek lehetőséget.
3 Jelölje ki a kívánt mappát.
4 Nyomja meg a MENÜ gombot.
5 Válasszon egyet az alábbiak közül:

• Mappa átnevezése – a mappa nevének módosítása. Adja meg a mappa új nevét, és nyomja meg az Ok
gombot.

• Mappa törlése – a kiválasztott mappa eltávolítása a Kedvencek közül. A törlés megerősítéséhez nyomja meg
az Igen gombot.

Megjegyzés: A Kedvencek utolsó mappája, valamint a legalább egy nem törölhető elemet
tartalmazó mappák nem törölhetők.

Elemek törlése a Kedvencek mappáiból
Mikor és hol használja: Egy névjegyhez tartozó számának vagy egy beszédcsoport törlése a kedvenceket tartalmazó
mappákból.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Kedvencek lehetőséget.
3 Válassza ki az eltávolítani kívánt elemet tartalmazó mappát.
4 Jelölje ki az elemet, és válassza a Törlés lehetőséget. A törlés megerősítéséhez nyomja meg az Igen gombot.
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Az összes elem törlése a Kedvencek mappáiból
Mikor és hol használja: A Kedvencek valamely mappájában található összes beszédcsoport és névjegyekhez tartozó
szám törlése.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Kedvencek lehetőséget.
3 Válassza ki a megfelelő mappát.
4 Nyomja meg a MENÜ gombot, és válassza az Összes törlése lehetőséget. A törlés megerősítéséhez nyomja meg az

Igen gombot.

Saját adatok

Ez az almenü a saját priváthívás-, telefon- és rádióinformációk megtekintését teszi lehetővé.

Személyes adatok megtekintése és módosítása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Saját adatok.
3 Válasszon egyet az alábbiak közül:

• Saját hívószám – a rádió privát száma
• Saját telefonszám – a rádió telefonszáma

Megjegyzés: A megjelenített telefonszám módosításához válassza a Szerkesztés lehetőséget. Írja be
a számot, és nyomja meg az OK gombot.

• Rádióadatok – a rádióadatok megjelenítése (gyártó, termék típusa, ISSI, TEI, sorozatszám és OPTA).

Megjegyzés: Az OPTA információ opcionális.

Legutóbbi hívások

A híváselőzmények megtekintése:

• Tárcsázott – az Ön által indított hívások.
• Fogadott – azok a hívások, amelyeket felvett.
• Nem fogadott – azok a hívások, amelyek kicsengtek, de nem vették fel őket vagy elutasították őket.

Minden hívástípus listája legfeljebb 50 számot tartalmazhat, és a legutóbbi hívás jelenik meg a lista legelején. Ha az
adott híváshoz tartozó hívószám szerepel a névjegylistában, akkor a számhoz tartozó név jelenik meg a legutóbbi
hívások listájában. Az egynél többször tárcsázott számok csak egyszer jelennek meg a listában.

A legutóbbi hívások megtekintése
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Legutóbbi hívások.
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3 Válasszon egyet az alábbiak közül:

• Tárcsázott
• Fogadott
• Nem fogadott

4 Válassza ki a kívánt hívást a listából.
5 Nyomja meg a MENÜ gombot.
6 Válassza a Megtekintés lehetőséget.

Javaslat: Az első két lépés átugrásához nyomja meg a lefelé mutató NAVIGÁCIÓS gombot.

Megjegyzés: A hívás időpontja csak akkor áll rendelkezésre, ha a dátum és az idő be van állítva a
rádión. A nem fogadott hívások listájában a hívások időtartama nem szerepel.

A legutóbbi hívások visszahívása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Legutóbbi hívások.
3 Válasszon egyet az alábbiak közül:

• Tárcsázott (a Tárcsázott hívások listát a kezdőképernyőn a KÜLDÉS gomb megnyomásával érheti el)
• Fogadott
• Nem fogadott

Megjegyzés: A Legutóbbi hívások menüelem megjelenítéséhez nyomja meg a lefelé mutató
NAVIGÁCIÓS gombot a kezdőképernyőn.

4 Jelölje ki a kívánt hívást, és indítson privát hívást a PTT gombbal, vagy telefonhívást a KÜLDÉS gomb
megnyomásával.

Megjegyzés: A telefonhívások csak TMO módban érhetők el.

Legutóbbi hívók mentése a Névjegyek mappába
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Legutóbbi hívások.
3 Válassza a Tárcsázott, a Fogadott vagy a Nem fogadott lehetőséget.
4 Nyomja meg a Tárolás gombot.

Megjegyzés: Ha a bal oldali SZOFTVERGOMBHOZ nem a Tárolás funkció van hozzárendelve, akkor a szám
már szerepel a névjegylistában.

5 A szám új bejegyzésként történő tárolásához válassza az [Új névjegy] parancsot. A szám meglévő bejegyzéshez
adásához válassza ki a bejegyzést, nyomja meg a Megtekintés gombot, majd válassza a Szerkesztés lehetőséget.

6 Ha a névjegytípus mező van kiválasztva, balra és jobbra görgetve választhatja ki azt a névjegytípust, amelyhez
hozzá kívánja rendelni a számot.

7 Válassza a Kész lehetőséget.
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Legutóbbi hívások törlése
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Legutóbbi hívások.
3 Válassza a Tárcsázott, a Fogadott vagy a Nem fogadott lehetőséget.
4 Lépjen a kívánt hívásra, és nyomja meg a MENÜ gombot.
5 Válassza a Törlés lehetőséget.

Megjegyzés: A hívások törléséhez válassza az Összes törlése lehetőséget.

Billentyűparancsok

Ezzel az almenüvel billentyűparancsokat állíthat be a gyakran használt menüpontok eléréséhez.

Menü-gyorsbillentyűk létrehozása
Mikor és hol használja: Billentyűparancs menüponthoz rendelése:

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Görgessen arra a menüpontra, amelyhez billentyűparancsot szeretne rendelni.
3 Ha a menüpont ki van jelölve, nyomja meg hosszan a MENÜ gombot.

Példa:
Billentyűparancs létrehozása a Minden hangjelzés menüponthoz:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Beállítás → Hangjelzések lehetőséget.
3 Lépjen a Minden hangjelzés elemre, majd nyomja meg hosszabban a MENÜ gombot, amíg meg

nem jelenik a Billentyűparancs hozzárendelése:Minden hangjelzés elem.
4 Válassza az Igen lehetőséget – megjelenik a Billentyűparancs: 1 felirat.
5 Nyomja meg a Kész gombot.

Megjegyzés: A billentyűparancs használata: nyomja meg a kezdőképernyőn a
MENÜ gombot és az 1-es gombot.

A billentyűparancsok listájának szerkesztése
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Billentyűparancsok.
3 Jelölje ki a kívánt billentyűparancsot, és nyomja meg a MENÜ gombot.
4 Válasszon egyet az alábbiak közül:

• Szerkesztés – a menüponthoz rendelt billentyű módosítása. Írja be a kívánt számot, és nyomja meg az OK
gombot.

Megjegyzés: Írjon be egy 1 és 20 közötti számot.
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• Törlés – a kijelölt billentyűparancs törlése. A megerősítéshez válassza az Igen lehetőséget.
• Összes törlése – az összes billentyűparancs törlése. A megerősítéshez válassza az Igen lehetőséget.

RUI

Ez a menüpont a rádióra való be- és kijelentkezést teszi lehetővé.

Kapcsolódó hivatkozások
RUA/RUI A következő oldalon:110
Előjegyzés A következő oldalon:93

Bejelentkezés
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → RUI → Bejelentkezés.
3 Lépjen a

• Felhasználói azonosító menüpontra, majd nyomja meg a Kiválasztás gombot a Felhasználói azonosítók
listája megnyitásához. Ha először használja a rádiót, válassza az [Új felhasználói azonosító] elemet, és adja
meg a felhasználói azonosítóját. Ellenkező esetben válassza ki a felhasználói azonosítóját a listából.

• Lépjen a második sorba, nyomja meg a Szerkesztés gombot, írja be a felhasználói azonosítóját, és nyomja
meg az OK gombot.

4 Válassza a Felhasználó PIN-kódja lehetőséget, írja be hitelesítő adatait, és nyomja meg az OK gombot.
5 Megjelenik a bejelentkezési képernyő.

Kijelentkezés
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → RUI → Kijelentkezés lehetőséget.
3 Nyomja meg az Elfogadás gombot.

Hálózatok

Ebben a menüpontban a rádió üzemmódjai között válthat.

Kapcsolódó hivatkozások
Váltás a TMO vagy a DMO módra A következő oldalon:33
Hálózati üzemmód kiválasztása A következő oldalon:103

Hálózati üzemmód kiválasztása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Hálózatok.
3 Válasszon egyet az alábbiak közül:

• Hálózatválasztás – annak megadása, hogy a rádió mely hálózatokra regisztrálhat.
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• Trönkölt mód – átváltás a hálózati infrastruktúrát használó módra.
• Közvetlen mód – átváltás a hálózati infrastruktúrát nem használó módra.
• Jelismétlő mód – átváltás a jelismétlő módra.
• Adástiltás mód – az Aktiválás lehetőséget választva valamennyi rádióadást letilthatja.

Megjegyzés: Ha a rádió adástiltás módban van, nem lehet a közvetlen módról a trönkölt módra
vagy a jelismétlő módra váltani.

Kapcsolódó hivatkozások
Váltás a TMO vagy a DMO módra A következő oldalon:33
Hálózatok A következő oldalon:103

A hálózat kiválasztása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Hálózatok → Hálózatválasztás → Csak honos.
3 A rádió regisztrál az otthoni hálózaton. Ha több otthoni hálózat is meg van adva, akkor a rádió a listáról az

elsőként elérhető hálózatra regisztrál.

Másik hálózaton való regisztrálás
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Hálózatok → Hálózatválasztás → Hálózatválasztás.
3 Válassza ki a kívánt hálózatot a listából.

A rádió regisztrál a kiválasztott hálózaton.

Idegen hálózaton történő regisztráció
Mikor és hol használja: Ez a szolgáltatás lehetővé teszi, hogy a rádió más előre beállított hálózathoz csatlakozzon,
ha a hálózat hatókörén kívülre kerül, és a rádió kijelzőjén a Nincs szolgáltatás üzenet jelenik meg.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Hálózatok → Hálózatválasztás → Idegen hálózat lehetőséget.

Bármely hálózat használata
Mikor és hol használja: A rádió kívül került az anyahálózat lefedettségi körén, és bármilyen hálózatra regisztrálhat.
Csak a nyílt hitelesítés támogatott a hálózatokon.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Hálózatok → Hálózatválasztás → Bármely hálózat.
3 A rádió kiválasztja a hálózatot az előre beállított listából, és automatikusan regisztrál rá.
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Átlépés más hálózatra
Mikor és hol használja: Ez a szolgáltatás lehetővé teszi, hogy a rádió más előre beállított hálózathoz csatlakozzon,
ha a hálózat hatókörén kívülre kerül, és a rádió kijelzőjén a Nincs szolgáltatás üzenet jelenik meg.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Hálózatok → Hálózatválasztás lehetőséget, és válasszon egyet az alábbi

lehetőségek közül:

• Cél – a kívánt hálózat kiválasztása a listából. A hálózati azonosító megtekintéséhez nyomja meg a Menü
gombot, majd nyomja meg a Kiválasztás gombot.

• Automatikus – A rádió automatikusan kapcsolódik az előre definiált hálózathoz.

Hely

További információért tekintse meg a GPS-alapú helymeghatározással foglalkozó részt.

Kapcsolódó hivatkozások
GPS helymeghatározási szolgáltatás A következő oldalon:61

A rádió pozíciójának megtekintése
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További.. . → Pozíció → Pozíció.
3 Görgetéssel megtekintheti, hogy utoljára mikor lett kiszámítva a pozíció:

Megjegyzés: A pozíció frissítése:

• Válassza a Pozíció lehetőséget – a rádió automatikusan frissíti a pozícióját
• Nyomja meg a Frissítés gombot.

A GPS pontosságának megváltoztatása
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Pozíció → Pontosság.
3 Válasszon egyet az alábbiak közül:

• Közepes (alapértelmezett) – optimális fogyasztás kisebb pozíciópontossággal.
• Nagy – pontosabb helymeghatározás kevésbé optimális fogyasztás mellett.

Megjegyzés: Külső töltőre csatlakoztatva rádió automatikusan a nagy pontosságú módra vált.

Adatcsomag-átvitellel

Az adatcsomag-átviteli (PD) szolgáltatás az internetprotokollon (IP) keresztüli adatátvitelt teszi lehetővé a TETRA
rendszerekben.
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Megjegyzés: Számítógépről történő adatátvitelhez csatlakoztassa a számítógépet és a rádiót PMKN4025
adatkábellel. A szolgáltatónak további alkalmazásokat kell telepítenie a számítógépen.

Ha a szolgáltató engedélyezi, az adatátvitel az MSPD (többréses adatcsomag-átvitel) szolgáltatással is felgyorsítható.

Megjegyzés: Ez egy fizetős szolgáltatás.

Az adatátviteli statisztika megtekintése
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Adatcsomag-átvitel.

Megjegyzés: Az adatszolgáltatások csak TMO módban érhetők el. Az adatátvitel beállítását Beszéd és
adat vagy Csak adat értékre kell állítani.

3 Válasszon egyet az alábbiak közül:

• Elküldött adatok – az adatcsomag-szolgáltatás aktiválása óta küldött adatok mennyisége kilobájtban, illetve a
küldés sebessége.

• Fogadott adatok – a adatcsomag-szolgáltatás aktiválása óta fogadott adatok mennyisége kilobájtban, illetve a
fogadás sebessége.

• Sávszélesség – az aktív adatátviteli munkamenet sávszélessége százalékban.
• Sikertelen átvitel – a sikertelenül küldött/fogadott csomagok százalékos aránya.

Megjegyzés: N.A. – készenléti adatcsomag-átviteli munkamenet.

Az adattitkosítás állapotának megtekintése
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a következőt: További. . . → Adatcsomag-átvitel → Titkosítás.
3 Megjelenik a folyamatban lévő csomagadat-munkamenet titkosításának állapota:

• Adatcsomag-csatorna nyílt
• Adatcsomag-csatorna titkosított
• TitkosításN. a. (nyílt)
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fejezet

6
Funkciók

Privát hívás

Privát, pont-pont vagy egyéni hívásnak a két személy közti hívásokat nevezzük. Ezeket a beszélgetéseket más rádiók
nem hallhatják. Ez a hívástípus kétféleképpen hajtható végre:

• Kétirányú hívás (ha a rendszer engedélyezi), TMO üzemmódban Mindkét fél egyszerre beszélhet.
• Egyirányú hívás, TMO és DMO üzemmódban. Egyszerre csak egy fél beszélhet.

A DMO üzemmódú privát hívások esetében azok a rádiók, amelyek nem vesznek részt a hívásban, csatornafoglaltsági
jelzést kapnak. A rádiók azonosítása a rádiószámmal történik.

Kapcsolódó hivatkozások
Egyedi vészhívások (Privát vagy MS-ISDN) A következő oldalon:56

Privát hívások indítása
Eljárás:

1 A kezdőképernyőn írjon be egy számot.
2 Ha az első felajánlott hívástípus nem a privát hívás, nyomja meg ismét a Hívástípus gombot a kiválasztásához.
3 Ha a következő módban van:

a TMO – egyirányú hívásokhoz nyomja meg, majd engedje fel a PTT gombot. Csengést fog hallani. Ettől eltérő
esetben, nyomja meg hosszabban a PTT gombot. Csak a beszédengedélyező hang után szólaljon meg, a válasz
meghallgatásához pedig engedje fel a PTT gombot. Kétirányú hívásokhoz nyomja meg, majd engedje fel a
KÜLDÉS gombot. Csengést fog hallani.

b DMO – Csak egyirányú hívások lehetségesek. Nyomja meg hosszabban a PTT gombot. Csak a
beszédengedélyező hang után szólaljon meg, a válasz meghallgatásához pedig engedje fel a PTT gombot.

4 A hívás befejezéséhez nyomja meg a HÍVÁS VÉGE gombot.

Rádiós üzenetkezelő rendszer (RMS)

A Rádiós üzenetkezelő rendszer (RMS) teszi lehetővé, hogy a rádió a TETRA hálózaton keresztül üzeneteket küldjön
és fogadjon a rövid adatszolgáltatás használatával.

Az RMS üzeneteknek két típusuk van:

• RMS állapot – előre meghatározott kód, amely a rádió és a szolgáltató között két irányban kerül küldésre. A rádió
legfeljebb 10 állapotot képes tárolni, amelyek a numerikus billentyűkhöz (0 és 9) rendelhetők hozzá. A legutóbb
érkezett vagy küldött RMS állapotüzenet a következő kikapcsolásig a rádió képernyőjén marad. A fogadott RMS
állapotüzenetek kék betűszínnel jelennek meg a kezdőképernyőn.

RMS szabad szöveg – a szolgáltató által a rádiónak küldött egyirányú üzenet, amely megkötés nélküli szöveget
tartalmaz. Mivel az ilyen típusú üzenetek hosszabbak, a rádió csak az üzenet elejét jeleníti meg a kezdőképernyőn.
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A teljes üzenet olvasásához be kell lépni a Menü → Üzenetek → RMS-tároló menüpontba. A legutóbb érkezett
vagy küldött szabad szöveges RMS üzenet a következő kikapcsolásig a rádió képernyőjén marad.

A szabad szöveges RMS üzenetek, valamint a beérkező és kimenő RMS állapotüzenetek (a küldött RMS
állapotüzenetek) kivételével az RMS-tárolóban találhatók. A tároló legfeljebb tíz beérkező vagy kimenő RMS
üzenetet tud tárolni. Ha az RMS-tároló megtelik, az új beérkező és kimenő RMS üzenetek felülírják a tárolóban
található legrégebbi (fogadott vagy küldött) üzenetet.

A rádió csak a szolgáltató által előre meghatározott számokra küld, illetve csak azokról fogad RMS üzeneteket.

Megjegyzés: Ez egy fizetős szolgáltatás.

RMS-ikonok
19. táblázat: RMS-ikonok

Ikon Leírás

RMS állapotüzenet érkezett

Új RMS állapotüzenet érkezését jelzi.

RMS állapot elküldve

RMS-tároló – olvasott üzenet

RMS-tároló – olvasatlan üzenet

RMS állapotüzenet elküldése
Előfeltételek: A szolgáltató engedélyezte a funkciót, és rádió RMS módban van.

Mikor és hol használja: Előre definiált RMS állapotüzenet küldése a számbillentyűkkel.

Eljárás:

Nyomja meg hosszan a megfelelő gombot. Ha túl rövid ideig nyomja a gombot a rádió privát, telefon- vagy
PABX-hívást indít.

Egygombos tárcsázás

Ez a funkció lehetővé teszi, hogy az 1–9 gombok egyikének nyomva tartásával indítson hívást.

Megjegyzés: Ha az egygombos funkció engedélyezve van, az egygombos tárcsázás ki van kapcsolva. Ha a
gombhoz nincs funkció rendelve, a rádión a Funkció nélküli gomb üzenet jelenik meg .

Beszédcsoport tárcsázása sorszám alapján

Ez a funkció lehetővé teszi, hogy a kívánt beszédcsoporthoz – a mappákból vagy listákból való kiválasztás helyett – a
sorszám tárcsázása alapján csatlakozzunk.
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Megjegyzés: Más néven beszédcsoport-gyorshívásnak hívják.

Beszédcsoport gyorshívószámának megtekintése
Eljárás:

1 A kezdőképernyőn válassza az Opciók elemet.
2 Válasszon egyet az alábbiak közül:

• Beszédcsoportok mappa szerint – válasszon mappát, és lépjen a kívánt beszédcsoportra.
• Beszédcsoportok név szerint – maximum 15 karakter beírásával szűkítheti a beszédcsoportok neveinek körét,

majd kijelölheti a kívánt beszédcsoportot.
3 Válassza a MENÜ → Megtekintés lehetőséget.

Példa:
A Gyorshívószám:1* szöveg jelenik meg, ami azt jelenti, hogy a beszédcsoport gyorshívó száma 1.

Beszédcsoportok kiválasztása sorszám alapján
Eljárás:

1 A kezdőképernyőn írja be a beszédcsoport gyorshívószámát, majd nyomja meg a * gombot.
2 Nyomja meg a Csatolás gombot.

Javaslat: Csoporthívás indításához nyomja meg a PTT gombot.

Telefon- és PABX-hívások

Telefonhívással vonalas és mobiltelefonszámokat hívhat. A PABX-hívás helyi (irodai) mellékek hívását teszi
lehetővé.

Telefonszámok és helyi mellékek hívása
Eljárás:

1 A kezdőképernyőn írja be a számot.
2 Ha az első felajánlott hívástípus nem a telefonszám vagy a PABX, nyomja meg ismét a Hívástípus gombot a

kiválasztásához.
3 Nyomja meg a KÜLDÉS gombot.

Telefonszámok és helyi mellékek gyorshívása

Ez a funkció lehetővé teszi, hogy a teljes szám helyett egy rövidebb, legfeljebb 3 számjegyű számot tárcsázzon. A
gyorshívószám hozzárendelésére a tárcsázott szám névjegylistához adásakor kerül sor.

Megjegyzés: Ez a funkció csak TMO-módban érhető el.
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Telefonszámok és helyi mellékek gyorshívása
Eljárás:

1 A kezdőképernyőn írja be a telefonszámhoz vagy helyi mellékhez tartozó előre beállított gyorshívószámot, majd
nyomja meg a # gombot.

2 Nyomja meg a KÜLDÉS gombot.

DTMF-tárcsázás hívás közben

Ez a funkció lehetővé teszi, hogy privát telefon- vagy PABX-hívás közben automatikus üzenetrögzítő eszközzel
(például hangpostafiókkal vagy üzenetrögzítővel) kommunikáljon.

A privát telefon- vagy PABX-hívás alatt nyomja meg a DTMF-gombok egyikét (0–9, *, #). A DTMF-gombok
lenyomáskor hangot adnak, és a beírt számok megjelennek a képernyőn.

Rövid szám tárcsázása

Ez a funkció lehetővé teszi, hogy úgy tárcsázzon, hogy a hívni kívánt személy teljes számának csak egy részét adja
meg. A rádió automatikusan kiegészíti a számot.

A rádió száma 4282564.

1 A teljes szám, a 4282564 helyett tárcsázza az 564 számot.
2 A hívás indításához nyomja meg a PTT vagy a KÜLDÉS gombot.

RUA/RUI

A rádiófelhasználó-hozzárendelés (RUA) és a rádiófelhasználó-azonosító (RUI) a felhasználók hitelesítésére szolgál.
A rádió szolgáltatásait és az állandó számát kizárólag sikeres bejelentkezés esetén használhatja. Ha nem sikerül
bejelentkeznie, csak korlátozott szolgáltatást vehet igénybe.

A RUA/RUI állapotot az interfész színe alapján különböztetheti meg:

• Kék – be van jelentkezve
• Szürke – ki van jelentkezve

A készülék állapotai
• Teljes szolgáltatás – a felhasználói bejelentkezés sikeres volt. A rádió valamennyi funkciója elérhető.
• Korlátozott szolgáltatás – a felhasználó nem jelentkezett be. A szolgáltató állítja be.
• Álbejelentkezés – csak helyi cellás trönkölés (LST) esetén. A rádióban az összes funkció elérhető (a szolgáltató

beállításaitól függően), kivéve néhány olyan szolgáltatást, mint a hívásátirányítás. Megjelenik az RUI
álbejelentkezés ikon.

Előjegyzés
A szolgáltató az adott rádiót előre meghatározott időre egyetlen személyhez rendeli. Csak a bejelentkezési képernyő
jelenik meg, és a rádió teljes szolgáltatást biztosít.
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Kiléptetés
A szolgáltató kijelentkeztetheti Önt. A Kiléptetve üzenet jelenik meg a kijelzőn.

Megjegyzés: Ez egy fizetős szolgáltatás.

Kapcsolódó hivatkozások
RUI A következő oldalon:103
Előjegyzés A következő oldalon:93

WAP

A Wireless Application Protocol (WAP) alkalmazásrétegbeli hálózati kommunikációs szabvány olyan vezeték nélküli
környezetek számára, mint például a TETRA hálózat. Ezzel a protokollal a rádiókon WAP-böngésző segítségével
lehet elérni a mobil webet.

Megjegyzés: Ez egy fizetős szolgáltatás.

Kapcsolódó hivatkozások
WAP-tároló A következő oldalon:72
WAP leküldés A következő oldalon:118

WAP-böngésző
Az Openwave Mobile Browser egy WAP-képes böngésző. A WAP-böngésző a számítógépes webböngészők minden
alapvető szolgáltatását biztosítja. Ha a böngészést nagyobb prioritású üzenet szakítja meg, a böngészőt kézzel kell
ismét megnyitni. A WAP-böngésző nem támogatja a jobbról balra író nyelveket (arab, héber); ezek helyett az angol
nyelvet használja. Az ilyen nyelvű tartalmak esetében a karakterek nem jelennek meg.

Megjegyzés: A rádió beállításaitól és a hálózati környezettől függően előfordulhat, hogy a WAP-böngésző
nem tudja megfelelően megjeleníteni a képeket (vagy csak késve jeleníti meg azokat).

A böngésző megnyitása
Előfeltételek: A kezdőképernyőn nyomja meg a MENÜ gombot. A Beállítások → Adatátviteli beállítások számára
adja meg a Csak adat vagy a Beszéd és adat értéket.

Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza a Böngésző lehetőséget.
3 Opcionális: A böngésző bezárásához tartsa megnyomva a HÍVÁS VÉGE gombot.

A böngészőmenü paneljeinek megnyitása
Előfeltételek: Nyissa meg a böngészőt.

Eljárás:

1 Nyomja meg a Menu vagy a MENÜ gombot.
2 Ez általában a Navigálás panelt vagy a böngészőmenü legutoljára használt paneljét jeleníti meg.

Megjegyzés: Ha a böngészett weblap két vagy több képernyőfüggő gombot/lehetőséget tartalmaz,
akkor a Options panel jelenik meg. A bal és a jobb navigációs gombokkal másik panelre görgethet,
vagy választhatja a Browser Menu lehetőséget, és a kívánt panelre görgethet.
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Böngészési tippek
A könnyebb böngészés érdekében hozza létre és használja az alábbiakat.

Könyvjelzők létrehozása a Navigáció panellel
Eljárás:

1 Lépjen be a böngészőbe, és navigáljon a kívánt oldalra.
2 Lépjen be a böngésző menüjébe a Menu gomb megnyomásával.
3 Válassza ki a Mark Page lehetőséget.
4 A kijelzőn megjelenik a megjelölt oldal címe és URL-címe.
5 Mentés:

a Az oldal könyvjelzőkbe történő mentéséhez nyomja meg a Save (vagy Select) gombot.
b Válassza a Menu lehetőséget, és válasszon az alábbiak közül:

• Save – megerősíti a könyvjelző létrehozását.
• Edit – lehetővé teszi a létrehozott könyvjelző nevének, választott mappájának és URL-címének

szerkesztését.

Könyvjelzők létrehozása a Könyvjelzők panellel
Eljárás:

1 Lépjen be a böngészőbe.
2 Görgessen a Bookmarks panelre.
3 Válassza az Organise (ha nincsenek mentett könyvjelzők) vagy a More... lehetőséget.
4 Válassza ki a Menu lehetőséget.
5 Görgessen ide: New Bookmark.
6 Adja meg a könyvjelző nevét és URL-címét, és válassza ki a helyét.
7 Nyomja meg a következő gombot: Save.

Könyvjelzők használata
Eljárás:

1 Lépjen be a böngészőbe.
2 Görgessen a Bookmarks panelre.
3 Keresse meg a kívánt könyvjelzőt, és válassza a következőt: Go. A böngésző megnyitja a könyvjelzőhöz rendelt

weboldalt.

Billentyűparancsok létrehozása
Eljárás:

1 Lépjen be a böngészőbe.
2 Görgessen a Bookmarks panelre.
3 Keresse meg a kívánt könyvjelzőt.
4 Nyomja meg a MENÜ gombot. Válassza ki a Hotkeys lehetőséget.
5 Válasszon egy olyan billentyűt, amelyet még nem osztott ki (0–9).
6 Kattintson ide: Assign. A kijelzőn megjelenik a könyvjelző és a hozzá rendelt billentyűparancs.
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Billentyűparancsok használata
Eljárás:

1 Lépjen be a böngészőbe.
2 Nyomja meg hosszan a megfelelő billentyűparancsot a hozzárendelt könyvjelzőhöz tartozó weboldal letöltéséhez.

Oldalak mentése
Mikor és hol használja: Oldalak elmentése kapcsolat nélküli böngészéshez:

Eljárás:

1 Lépjen be a böngészőbe, és navigáljon a kívánt oldalra.
2 Nyomja meg a következő gombot: Menu.
3 Görgessen a Tools panelre.
4 Válassza ki a Save Page lehetőséget. Ha szükséges, módosítsa az oldalhoz felajánlott nevet. Görgessen a

képernyő aljára, és válassza a következőt: Save. Az oldal a Bookmarks Saved Pages mappában mentésre kerül.

Mentett oldalak megnyitása
Eljárás:

1 Lépjen be a böngészőbe.
2 Görgessen a Bookmarks panelre.
3 Válassza az Organise (ha nincsenek mentett könyvjelzők) vagy a More... lehetőséget.
4 A Mentett oldalak mappába történő belépéshez válassza az Ugrás lehetőséget.
5 Válasszon ki egy mentett oldalt, és nyomja meg a következő gombot: Ok. A kijelzőn megjelenik a mentett oldal.

A mentett oldaltól függően más webhelyekre is továbbléphet.

Ha nincs adatcsomag-szolgáltatás
Ha nincs adatcsomag-szolgáltatás, a rádió a böngésző első megnyitásakor a Hiba:Nincs elérhető hálózat üzenetet
jeleníti meg. A böngésző újbóli megnyitásához nyomja meg a bal oldali SZOFTVERGOMBOT, a jobb oldali
SZOFTVERGOMBBAL pedig a böngésző menüjébe léphet.

A böngésző újbóli megnyitásakor a készülék az utoljára – adatcsomag-szolgáltatással vagy kapcsolat nélkül –
megtekintett oldalt jeleníti meg.

A böngészőbe történő belépés letiltása
A böngészőbe történő belépés le van tiltva:

• bármilyen hanghívás, kivéve a környezetlehallgatási hívás közben,
• DMO módban,
• vészhívás módban,
• PIN-zár esetén,
• ha a szolgáltató nem állította be ezt a funkciót,
• ha a rádió le van tiltva,

Megjegyzés:

• ha a böngészőbe történő belépés engedélyezve van környezetlehallgatás közben. Ha korábban eltárolt
oldalakra navigál, a környezetlehallgatás továbbra is fennmarad.

• Az adatcsomag-szolgáltatás első aktiválásakor a környezetlehallgatási funkció szétkapcsol, és a
készülék ugyanúgy viselkedik, mintha korábban nem környezetlehallgatási funkcióban használta volna.
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A gombok használata
Ha a böngésző aktív, a gombok a szerkesztőfelületen és azon kívül a következőképpen használhatók.

20. táblázat: A böngészőgombok használata

Gombnyomás Művelet

0–9 gombok A szerkesztőben: számjegy és/vagy karakter bevitele
a kiválasztott szövegbeviteli módtól függően.
Szerkesztésen kívül: a számozott listákban a kívánt
listaelemek kiválasztása.

0–9 gombok (nyomva tartás) A szerkesztőben: normál használat.
Szerkesztésen kívül: a számozott könyvjelzők
megnyitását lehetővé tévő billentyűparancs

* gomb (megnyomás vagy nyomva tartás) A szerkesztőben szóközt illeszt be.

# gomb (megnyomás vagy nyomva tartás) A szerkesztőben megjeleníti a Szövegbevitel panelt.
Egyéb esetben téves billentyűlenyomást jelző hangot ad.

Bal vagy jobb SZOFTVERGOMB A közvetlenül a bal vagy jobb szoftvergomb felett látható
opció kiválasztása a képernyőn.

Felfelé mutató NAVIGÁCIÓS gomb Egy sorral feljebb lépés a listában.

Felfelé mutató NAVIGÁCIÓS gomb (nyomva tartás) Felfelé görgetés az oldalon.

Lefelé mutató NAVIGÁCIÓS gomb Egy sorral lejjebb lépés a listában.

Lefelé mutató NAVIGÁCIÓS gomb (nyomva tartás) Lefelé görgetés az oldalon.

Balra mutató NAVIGÁCIÓS gomb Visszalépés az előző panelre.
A szerkesztőben: balra lépés.

Balra mutató NAVIGÁCIÓS gomb (nyomva tartás) Visszalépés.

Jobbra mutató NAVIGÁCIÓS gomb A következő panelre lépés
A szerkesztőben: a kurzor jobbra történő mozgatása,
és szóköz beszúrása a szavak végén.

Jobbra mutató NAVIGÁCIÓS gomb (nyomva tartás) Előrelépés.

A NAVIGÁCIÓS gombok közepe (nyomva tartás) Automatikus ismétlés

MENÜ gomb A böngésző menüjének megjelenítése.

HÍVÁS VÉGE gomb A böngésző inaktiválása.

KÜLDÉS gomb A böngésző aktív állapotában le van tiltva.

FORGATÓGOMB Csak a hangerő módosítására használható.

VÉSZHÍVÁS gomb A böngésző kikapcsolása. A rádió vészhívás módba lép.

A böngészőmenü paneleinek áttekintése
A böngésző menüje a következő paneleket tartalmazza:
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21. táblázat: A böngészőmenü panelei

Menüpanel Leírás

Navigáció Használatával elérhető a kezdőoldal és a gyakran használt menüpontok.

Könyvjelzők Lehetővé teszi a tárolt könyvjelzők és mentett oldalak elérését, szerkesztését és
tárolási beállításainak módosítását.

Előzmények Lehetővé teszi a legutóbb meglátogatott oldalak elérését, és megjeleníti az
aktuálisan betöltött oldal pozícióját az előzményekben.

Eszközök Lehetővé teszi az alkalmazások és segédprogramok elérését.

A használattól függően az alábbi panelek is megjelenhetnek:

22. táblázat: További menüpanelek

Menüpanel Leírás

Beállítások Csak akkor jelenik meg, ha további lehetőségek érhetők el a panelhez vagy az
oldalon.

Kép Csak kép kiválasztásakor jelenik. Lehetővé teszi a kép részleteinek, tárolási
helyének és megjelentési adatainak megtekintését.

Szövegbevitel Csak szövegbevitel esetén jelenik meg. Különböző szövegbeviteli módok
elérését teszi lehetővé (pl.: szimbólumok bevitele).

Navigáció panel
Az alábbi elemek közül választhat:

• Home – kezdőlap betöltése.
• Open Page – URL beírása.
• Search – az elem nem érhető el.
• Mark Page – könyvjelző létrehozása (mentése) az aktuális dokumentumhoz. Megjelenik a könyvjelző neve és

URL-címe, és a hely mentéséhez kiválasztható a gyökérmappa.
• Forward – navigálás a navigálási előzményekben soron következő dokumentumhoz. Ha nincsenek előzmények,

ez a menüpont nem érhető el.
• Reload – az aktuális dokumentum újbóli betöltése.
• Advanced... – lásd a következő fejezetet.

Speciális...
A navigációs panelről válassza az Advanced... lehetőséget a következők eléréséhez:

• Settings...

• Downloads – a letöltési beállítások módosítása. Kikapcsolhatja a képek és objektumok letöltését. A böngésző
ebben az esetben egy speciális ikont fog megjeleníteni a képek és objektumok helyett.

• Scroll Mode – a görgetés módjának és sebességének beállítása.
• Key Press Timeout – a gombnyomási időkorlát beállítása. Ezt az időkorlátot a szövegbevitelkor alkalmazza a

böngésző.
• Set Proxy – a WAP-proxy kiválasztása (1, 2, 3). A böngésző a kiválasztott proxyn vagy átjárón keresztül

kapcsolódik az internetre. A proxy telepítését és konfigurálását a hálózati szolgáltató végzi. Biztonságos
munkamenet létrehozásához válasszon biztonságos proxyt. Érdeklődjön szolgáltatójától, hogy melyik proxy
van biztonságos munkamenetekre konfigurálva. Kiválaszthatja a kezdőoldalt, azonban előfordulhat, hogy a
szolgáltató ezt felülírja, és a saját kezdőoldalát jeleníti meg a készüléken.
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• Circuit Prompt – a körzeti értesítés be- és kikapcsolása.
• Resend Data Prompt – az adat-újraküldési értesítés be- és kikapcsolása.

• Security...

• Secure Prompt – be- és kikapcsolhatja, hogy a böngésző értesítse a biztonságos és a nem biztonságos
kapcsolatok közötti váltáskor.

• Current Certificate – az aktuális dokumentumot biztosító kiszolgálót azonosító digitális tanúsítvány
megtekintése. A tanúsítványt egy hitelesítésszolgáltató (CA) hitelesíti azáltal, hogy digitálisan aláírja.
Legfeljebb tíz további WTLS-tanúsítvány adható hozzá a telepített tanúsítványok alapértelmezett listájához.
Ha szeretné hozzáadni ezeket az egyéni WTLS-tanúsítványokat a listához, forduljon a szolgáltatóhoz.

• CA Certificates – a böngészőben telepített és hitelesítésszolgáltató (CA) által aláírt digitális tanúsítványok
megtekintése.

• Send Referrer – a HTTP-hivatkozó fejléc HTTP-kérések részeként történő küldésének be- és kikapcsolása. A
hivatkozó fejléc a hivatkozás forrásának URL-címét küldi el a kiszolgáló számára.

• Authentication – a HTTP-hitelesítési adatok gyorsítótárba mentésének ki- és bekapcsolása. A HTTP
hitelesítés a kiszolgálón lévő tartalomhoz való hozzáférés biztonságát garantálja. Ha védett tartalmat próbál
elérni, meg kell adnia bejelentkezési adatait (felhasználónév és jelszó).

• Clear... – a böngészőadatok törlése (előzmények, gyorsítótár, sütik és automatikus kitöltés).
• Restart Browser – a böngésző újraindítása.
• About... – a(z) aktuális verziójára vonatkozó adatok megjelenítése Openwave Mobile Browser .

Könyvjelzők panel
Ha vannak könyvjelzők a gyökérmappában, a Lehetőségek panel eléréséhez válassza a More... lehetőséget. Ha a
gyökérmappa üres, a Lehetőségek panel eléréséhez válassza az Organise... lehetőséget, majd nyomja meg a MENÜ

gombot. Az Opciók panel a könyvjelzők kezelésére szolgál. A Saved Pages mappa mentett oldalak pillanatképeit
tartalmazza.

A kiválasztott könyvjelzőkhöz tartozó Opciók panel használata
Eljárás:

1 A Könyvjelzők panelen válassza a More... lehetőséget.
2 Keressen egy könyvjelzőt.
3 Válassza a MENÜ lehetőséget az adott könyvjelzőhöz tartozó Opciók panel megnyitásához.
4 Válasszon egyet az alábbiak közül:

• Back – a könyvjelzőhöz rendelt oldal megjelenítése (a készülék letölti az oldalt, ha nincs meg a
gyorsítótárban).

• Details – a könyvjelző nevének és URL-címének módosítása.
• Delete – a könyvjelző törlése.
• New Bookmark – új könyvjelző létrehozása.
• New Folder – új mappa létrehozása.
• Move – a könyvjelző áthelyezése új mappába (vagy a Könyvjelzők mappába).
• Delete All – az összes könyvjelző törlése.
• Hotkeys – gyorsbillentyűk kijelölése az elérhető könyvjelzőkhöz.

A Mentett oldalak mappa használata
Eljárás:

1 A Könyvjelzők panelen válassza a Saved Pages mappát.
2 A böngésző megjeleníti az Eszközök panel Oldal mentése funkciójával mentett oldalt (pillanatképet).
3 Keressen egy mentett oldalt.
4 Válassza a Menu lehetőséget a mentett oldal Opciók paneljének megnyitásához.
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5 Válasszon egyet az alábbiak közül:
a Back – az oldal megjelenítése a gyorsítótárból.
b Details – a mentett oldal címének és URL-címének módosítása.
c Update Page – a mentett változat felülírása az oldal aktuális állapotával (a kiszolgálóról letöltve).
d Delete – az oldal törlése a gyorsítótárból.
e Delete All – az összes mentett oldal törlése a gyorsítótárból.
f Cancel – kilépés a panelből és visszatérés az utoljára megjelenített oldalhoz.

Előzmények panel
Ez a panel a nemrégiben meglátogatott oldalak listáját jeleníti meg (legfeljebb 9 előzményt). Minden egyes oldal
látható (amennyiben rendelkezik ilyennek). Egyébként a No Title felirat jelenik meg.

Nemrég felkeresett URL-címek megnyitása
Eljárás:

1 Válassza ki az URL-címet.
2 Nyomja meg a következő gombot: Ok.

Eszközök panel
Eljárás:

1 Az Eszközök panelen válassza a More... lehetőséget
2 Keressen egy dokumentumot.
3 Válassza a MENÜ lehetőséget az adott dokumentumhoz tartozó Opciók panel megnyitásához.
4 Válasszon egyet az alábbiak közül:

• Show URL – az aktuális oldal URL-címének megjelenítése.
• Save Page – pillanatkép létrehozása az aktuális dokumentumról.
• Find Text – szöveges karakterlánc keresése az aktuális dokumentumban.
• Copy Text – szöveg másolása az aktuális dokumentumból a vágólapra.

Opciók panel
Ennek a panelnek a tartalma a megjelenített oldaltól vagy paneltől függ.

Kép panel
Ez a panel akkor jelenik meg a böngésző menüjében, ha engedélyezte a képek letöltését itt: Navigáció panel >
Advanced... > Settings... .

Az alábbi lehetőségek érhetők el:

• Save – a kép mentése a terminálon.
• [Send] – a kép küldése a kiválasztott helyre.
• Reload – a kép újratöltése.
• Details – a kép részleteinek megjelenítése.
• Show Image – a kép megjelenítése saját oldalán.

Szövegbevitel panel
Előfeltételek: Ez a panel akkor látható, ha a böngésző menüje meg van nyitva, és a szövegbeviteli mező aktív.
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Mikor és hol használja: Az URL szövegének beírása:

Eljárás:

1 Válassza ki az URL-címet.
2 Nyomja meg a következő gombot: abc.

Megjelenik a szövegbeviteli panel.

3 Válassza ki a www lehetőséget.
4 Keresse meg a kívánt kiterjesztést (például: .com).
5 Nyomja meg a következő gombot: .com. A képernyőn a kiválasztott kiterjesztéssel jelenik meg az URL-cím.

23. táblázat: Böngésző szövegbeviteli ikonjai

Mód Szoftvergomb Művelet

Alfabetikus karakterek – kisbetűk abc Szöveg bevitele kisbetűkkel.

Alfabetikus karakterek – nagybetűk ABC Szöveg bevitele nagybetűkkel.

Numerikus 123 Számok és szimbólumok bevitele.

HTTP mód www URL-kiterjesztések bevitele.

WAP leküldés
A WAP push segítségével WAP-tartalmak továbbíthatók a rádióra. A küldés során speciálisan formázott (Push
Access Protocol) XML-dokumentumot küldenek a leküldési proxyátjáróra, amely továbbítja a dokumentumot a
rádióra.

A WAP leküldéses üzenet kódolt üzenet, mely egy WAP-címre mutató hivatkozást tartalmaz. A WAP leküldéses
üzenet fogadásakor a WAP-képes rádió automatikusan lehetővé teszi a WAP-tartalom elérését. Az implementált
WAP leküldési funkció megfelel a WAP 2.0 szabványnak.

A rádió a WAP 2.0 használatát csak proxyn keresztül támogatja. A proxy nélküli kapcsolatok nem támogatottak

Ez egy fizetős szolgáltatás.

Kapcsolódó hivatkozások
WAP-tároló A következő oldalon:72
WAP A következő oldalon:111

Új WAP-üzenetek
A WAP-üzenetek típusai és prioritási fokozatai:

Megjegyzés: Az üzenet prioritását a szolgáltató állítja be.

• Push üzenet

• Magas – animáció és villogó ikon jelenik meg, valamint megszólal az új WAP-üzenet hangjelzése.
• Közepes – animáció és ikon jelenik meg, valamint megszólal az új WAP-üzenet hangjelzése.
• Alacsony – ikon jelenik meg, valamint megszólal az új WAP-üzenet hangjelzése.
• Törlés – csak akkor érhető el, ha a WAP-mezőben van. Ilyenkor a WAP-üzenet távolról törölve üzenet

jelenik meg, más esetben nincs jelzés.

Megjegyzés: Nem jelenik meg az animáció, ha hívás van folyamatban, vészhívás módot használ,
eseményjelentés van folyamatban, az üzenetszerkesztő fut, PIN-zár van érvényben, vagy ha a készülék
DMO módra vált.

• Push üzenet betöltése

118 | Funkciók

Send Feedback  |   | 

http://docsurvey.motorolasolutions.com


• Magas – megjelenik a böngésző, és megszólal az új WAP-üzenet hangjelzése.
• Alacsony – ikon jelenik meg, és megszólal az új WAP-üzenet hangjelzése.

Megjegyzés: Nem nyílik meg a böngésző, ha hívás van folyamatban, vészhívás módot használ,
eseményjelentés van folyamatban, az üzenetszerkesztő fut, PIN-zár van érvényben, vagy ha a készülék
DMO módra vált.

WAP-üzenetek megtekintése
Eljárás:

1 A kezdőképernyőn nyomja meg a MENÜ gombot.
2 Válassza az Üzenetek → WAP-tároló lehetőséget.
3 Válassza ki a kívánt üzenetet.
4 Válassza a Go to lehetőséget az üzenet böngészőben való megtekintéséhez.

Eseményjelentés

Ez a funkció eseményjelentési riasztások fogadását teszi lehetővé. A rádió az eseményjelentési üzenetek érkezésekor
azonnal megszakítja az aktuális szolgáltatásokat, és csak az eseményjelentési riasztásokat figyeli. Ha az
eseményjelentés véget ért, a készülék kilép az Eseményjelentés módból, és visszaáll a normál módra.
Eseményjelentési módban csak vészhívások fogadhatók.

Megjegyzés: A teljes eseményjelentési üzenet olvasásához görgessen a képernyő aljára a lefelé mutató
NAVIGÁCIÓS gombbal. Az üzenet hosszát a képernyő bal oldalán megjelenő függőleges vörös sáv jelzi.

4. ábra: Eseményjelentési üzenet

Megjegyzés: Ez egy fizetős szolgáltatás.

Kapcsolódó hivatkozások
Eseményjelentés-tároló A következő oldalon:72

Eseményjelentések típusai
Az eseményjelentéseknek négy típusa van:

• Normál eseményjelentés – a diszpécser által egy rádiónak vagy több rádióból álló csoportnak küldött riasztási
üzenet.

• Mozgósítás – a diszpécser által több rádióból álló csoportnak küldött riasztási üzenet. A nagyobb megbízhatóság
érdekében az üzenetet többször is elküldik. Az eseményjelentésekre nem tud válaszolni, és bármely gomb
megnyomása az információs fázisba viszi.

• Tartalék mód – hangkommunikációra korlátozott riasztási üzenet. Ilyen típusú eseményjelentés
kezdeményezéséhez nyomja meg a szolgáltató által előre meghatározott gombot. Manuálisan törölhető.

Megjegyzés: A Tartalék mód csak akkor érhető el, ha a készülék helyi cellás trönköléssel működik.
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• Eseményjelentés tesztelése – speciális eseményjelentési riasztás, amelyet a diszpécser a funkció tesztelése
érdekében küld. Az eseményjelentés tesztelésének vételekor a rádió hangjelzést ad, és az Eseményjelentés
tesztelése feliratot jeleníti meg. A válaszadáshoz és a riasztás törléséhez nyomja meg a Teszt OK
SZOFTVERGOMBOT.

Az eseményjelentési funkció működése a különböző üzemmódokban
Az eseményjelentési funkció a különböző üzemmódokban más-más módon működik:

• Adástiltás mód – elolvashatja az üzenetet, de nem válaszolhat rá. Az adástiltás módból a megfelelő szoftvergomb
megnyomásával vagy az eseményjelentés visszautasításával léphet ki.

• DMO mód – az eseményjelentés funkció nem támogatott.
• Vészhívás mód – a készülék az összes eseményjelentést figyelmen kívül hagyja.

Az eseményjelentési szolgáltatás fázisai
Az eseményjelentési mód a következő fázisokból áll:

• Értesítési fázis – a készülék felhasználója eseményjelentési üzenetet kap. Az üzenet érkezését riasztási hangjelzés
jelzi. Megjelenik az üzenet szövege, a felhasználó pedig az Elfogadás, Elutasítás és a MENÜ lehetőség közül
választhat. Ha elfogadja az üzenetet, akkor a továbbiakban semmilyen más szolgáltatás nem avatkozhat közbe.

Megjegyzés: A riasztási hangot a PTT gomb vagy a szoftvergombok egyikének megnyomásával
állíthatja le.

• Információs fázis – a felhasználó továbbra is Eseményjelentés módban van, és az eseményről újabb szöveges vagy
hangüzenetek révén kaphat további, részletesebb információkat. A felhasználó a beszédcsoporthívás vagy a
szöveges eseményjelentési funkció segítségével további információkat kérhet, amely szöveges üzenetek küldését
lehetővé teszi . A felhasználó bármikor válaszolhat szöveges üzenet küldésével, hangüzenettel, vagy
csoporthívással.

Árnyékcsoportok (Címcsomag)

Az Árnyékcsoportok (más néven Címcsomag) funkció lehetővé teszi, hogy több célnak vagy fogadónak küldjenek
egyidejűleg üzeneteket. A funkció három üzenettípust támogat:

• Állapotüzenetek (a Vészjelzéseket is)
• GPS LIP (TETRA helyinformációs protokoll) jelentései
• RMS/FMS üzenetek

Árnyékcsoportok TMO-ban

Minden Árnyékcsoport legfeljebb négy célcímet tartalmazhat. Minden beszédcsoport beállítható állapotüzenetek,
GPS LIP jelentések, vagy RMS/FMS üzeneteknek egy adott Árnyékcsoport számára történő küldésére.

Árnyékcsoportok DMO-ban

A DMO-ban az Árnyékcsoport egy célcímet tartalmaz. Minden beszédcsoport beállítható állapotüzenetek, vagy GPS
LIP jelentéseknek egy adott Árnyékcsoport számára történő küldésére.

Minden rádióban legfeljebb 255 árnyékcsoport tárolható (a TMO-ban és DMO-ban egyaránt).

Az Árnyékcsoport funkció miatt a Vészhívás beállítási ideje enyhén megnövekedhet.

Megjegyzés: Ez egy fizetős funkció, és csak akkor használható, ha a szolgáltató engedélyezte.
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függelék

A
Hangjelzések

24. táblázat: A rádió hangjelzései

Hangjelzés neve Alapértelmezett hangjelzésábra

Lefedettség visszatérése
A teljes szolgáltatás
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• Beszédtiltás
• A rendszer foglalt
• Adás időkorlátja lejárt
• A hívott rádió foglalt

vagy nem érhető el
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A hívás szétkapcsolt vagy a
hálózat hibája miatt nem járt
sikerrel
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Hangjelzés neve Alapértelmezett hangjelzésábra

Váltás DMO és TMO mód
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Megjegyzés: A szolgáltató minden hangjelzést letilthat.
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függelék

B
LED-jelzések

25. táblázat: LED-jelzések

Jelzés Állapot

Folyamatos zöld Használatban

Villogó zöld Működő szolgáltatás

Folyamatos piros Nincs szolgáltatás

Villogó piros Csatlakozás a hálózathoz
Belépés DMO módba

Folyamatos narancssárga Adástiltás folyamatban
Foglalt DMO módú csatorna

Villogó narancssárga Bejövő hívás

Nincs jelzés Készenléti állapot
A rádió ki van kapcsolva
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függelék

C
Hibaelhárítás

A rádió a következő üzeneteket jeleníti meg:

26. táblázat: Megjelenített üzenetek

Üzenet Üzenet leírása

...-Fogadott A hívás beérkezett, de nem vették fel vagy elutasították.

Csatlakozás sikertelen A rádió nem tudott beszédcsoporthoz csatlakozni. A rádió tovább
próbálkozik. Ha a csatlakozás továbbra is sikertelen, próbálkozzon
egy másik beszédcsoporttal.

Hitelesítés sikertelen A rádió nem tudott regisztrálni egy hitelesített rendszeren (például a
hitelesítő kulcs nem megfelelő, vagy a hitelesítés ki van kapcsolva a
rádióban).

Az akkumulátorszint túl alacsony. Az akkumulátor töltöttsége túl alacsony a kért művelet elvégzéséhez.

Hívás törölve Sikeresen megszakította a hívást.

Hívás vége • Hibás csatorna. Próbálkozzon később.
• Sikeresen befejezte a hívást.

Hívásátirányítás A hívott rádió nem érhető el, és a hívást nem lehet másik rádiónak
továbbítani.

Hívás módosítva A hívást, amelyben részt vesz, módosították.

Hívás felülbírálva A csatornát nagyobb prioritású kommunikációhoz használják.

Visszafejtés sikertelen: Hiba történt az üzenet vagy a hívás visszafejtése során.

Vészhívás használatban

Várakozás a mikrofonra

Az Éles mikrofon funkció aktív, de a csatornán való küldés jogát
ugyanazon beszédcsoport egy másik vészhívása kapta meg. A rádió
mikrofonja ekkor nem aktív, de a meghatározott idő letelte után
automatikusan megpróbálja visszanyerni a beszédengedélyt.

Vészhívás – mikrofon vége Az Éles mikrofon funkció időkorlátja letelt, vagy a felhasználó a PTT
gomb megnyomásával leállította az Éles mikrofon funkciót.

Vészhívási mikrofon bekapcsolva Az Éles mikrofon funkció aktív, és a rádió automatikusan
kihangosított hangalapú vészhívást közvetít.

Üres bejegyzés A tárcsázott gyorshívószám nem létezik, vagy a szám létezik, de a
csoport nem választható ki.

Hibás készülék

Hiba

Sikertelen önteszt. A rádió működése nem megfelelő. Jegyezze fel a
hiba számát. Kapcsolja ki a rádiót, és forduljon a szervizhez.

A táblázat folytatódik…
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Üzenet Üzenet leírása

Átjáró elérhető A rádió egy átjáróhoz csatlakozott.

Átjáró nem érhető el A rádió nem képes csatlakozni az átjáróhoz, vagy a kapcsolat
megszakadt.

Ez a csoport már létezik A Saját csoportok mappához hozzáadni kívánt csoport már létezik a
mappában.

Csak egyedi hívások Csak egyedi (privát) hívásokat indíthat.

Nincs elegendő látható adat A rádió helymeghatározást végez. Ennek befejezése akár percekig is
eltarthat.

Nincs elegendő látható műhold A rádió helymeghatározást végez. Ennek befejezése akár percekig is
eltarthat.

Érvénytelen azonosító A megadott szám nem érvényes.

Érvénytelen billentyűparancs A megadott szám nem érvényes.

Korlátozott szolgáltatás A vészhívások, a vészjelzések és a mobilitási műveletek (pl.:
csoportcsatlakoztatás) engedélyezettek. Az összes többi bejövő és
kimenő hívás és adatszolgáltatás blokkolva van.

A lista üres Nincsenek programozott bejegyzések a listában. Adja meg a
bejegyzést.

A lista nincs csatlakoztatva Nincs a letapogatási lista összes beszédcsoportja csatlakoztatva.

A lista csak részben van csatlakoztatva A letapogatási lista aktív, de nem minden beszédcsoport van
csatlakoztatva hozzá.

Üzenet kézbesítve Az üzenet kézbesítése sikeres volt.

Üzenet sikertelen Az üzenet kézbesítése nem járt sikerrel.

Új kézbesítési állapot Új kézbesítési állapot érkezett.

Nincs szolgáltatás A rádió lefedettségi területen kívül található. Újra van lefedettség.

Jelismétlő módban nem megengedett Jelismétlő módban a szolgáltatás vagy funkció nem elérhető.

Saját csoportok

üres

Ha a Saját csoportok mappa üres, nem tekinthet meg, és nem
törölhet csoportokat.

Saját csoportok

tele

Nem adhat csoportot a Saját csoportok mappához, mert a mappa
már elérte a maximálisan engedélyezett csoportok számát.

Hálózati hiba Hálózati problémák léptek fel. Később próbálja újra.

Nincs válasz A hívott fél nem veszi fel.

Nincs bejegyzés Ez az üzenet üres lista megnyitásakor jelenik meg.

Nincs csoport • Csatlakozás sikertelen. A rádió nem csatlakozik a jelenlegi
beszédcsoporthoz. Várja meg, amíg a rádió újra nem csatlakozik a
jelenlegi beszédcsoporthoz.

A táblázat folytatódik…
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Üzenet Üzenet leírása

• Akkor jelenik meg, ha a kiválasztott beszédcsoport normál
lefedettségi területén kívül tartózkodik. Válasszon egy olyan
csoportot, amely a tartózkodási helyéről is hívható.

• Egy kedvencnek jelölt csoportot eltávolítottak a Saját csoportok
mappából.

Nincs lista A hálózatlista üres.

Nincs sem új, sem régi üzenet A Beérkezett üzenetek mappában sem új, sem régi üzenetek nem
találhatók.

Egy letapogatási lista sincs kiválasztva. Üres hálózatlistát választott ki.

Nincs szolgáltatás A rádió a lefedettségi területen kívül van.

A hívás nem indítható el Nem tárcsázhat olyan számot, amely nincs a címjegyzékben.

Adás nem engedélyezett Engedje fel a PTT gombot, és próbálja újra később. Nem küldhet
szöveges üzenetet vagy állapotüzenetet olyan számra, ami nincs a
címjegyzékben.

Csak egy beszédcsoport található Csak egy programozott bejegyzés található a listában.

Túlmelegedés, kapcsolja ki a rádiót! A rádió kikapcsol. Hagyja kikapcsolva 5 percig.

Másik fél foglalt A hívott rádió foglalt.

Másik fél nem érhető el A hívott fél a rádió hatósugarán kívül található, vagy ki van
kapcsolva. Később próbálja újra.

Próbálja újra A hívás nem járt sikerrel

Várjon, amíg a készülék csatlakozik A készülék bekapcsolásakor megjelenő üzenet.

Csatlakoztassa a rádiót a töltőhöz A rádió nem észleli a töltőt. Ügyeljen, hogy helyesen csatlakoztassa a
töltőt, valamint hogy a rádió és a töltő érintkezői tiszták legyenek.

Regisztráció sikertelen A rádió nem tudott regisztrálni a rendszerben. Később próbálja újra.

Jelismétlő érhető el A rádió egy jelismétlőhöz csatlakozott.

Jelismétlő nem érhető el A rádió nem képes csatlakozni a jelismétlőhöz, vagy a kapcsolat
megszakadt.

Szolgáltatás megtagadva Érvénytelen szám. Hívja szolgáltatóját.

Szolgáltatás nem érhető el A szolgáltatás nem érhető el a jelenlegi hálózaton.

Korlátozott szolgáltatás A szolgáltatást vagy funkciót a szolgáltató korlátozta, Ön nem
vásárolta meg a szolgáltatást, vagy az nem elérhető.

A(z) ... beszédcsoport nem törölhető A szolgáltató úgy állította be ezt a csoportot, hogy Ön nem törölheti a
kedvenc beszédcsoportok mappájából.

Próbálja újra később A kívánt szolgáltatás átmenetileg nem érhető el.

Készülék letiltva Forduljon szolgáltatójához.

Készülék rendben

Figyelmeztetés:

Hiba az önteszt során. A rádió kisebb hibát észlelt. A rádió továbbra
is teljesen működőképes. Ha a hiba megismétlődik, jegyezze fel a
hibakódot, és forduljon a szervizhez.

A táblázat folytatódik…
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Üzenet Üzenet leírása

Eszköz nincs csatlakoztatva A rádió nem tudott csatlakozni a rendszerhez. Előfordulhat, hogy a
beszédcsoport nincs létrehozva a rendszerben. Próbálkozzon másik
csoporttal.

Funkció nélküli gomb Ez az üzenet olyankor látható, ha az illető gombhoz nincs funkció
rendelve.
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függelék

D
Karbantartás

Javaslat:

• A rádió első használata előtt távolítsa el a képernyőt védő műanyag fóliát, és a teljes kapacitás elérése
érdekében addig töltse az akkumulátort, amíg a zöld LED ki nem gyullad.

• Az akkumulátor töltésére kizárólag veszélyes anyagoktól mentes helyen kerülhet sor.
• Rendszeresen tisztítsa meg a csatlakozót – különösen programozás előtt – például egy puha kefével (ne

használjon folyadékot).

Tárolás

• Ne tárolja az akkumulátort olyan helyen, amelynek hőmérséklete +65 °C fölötti, illetve -20 °C .
• Az új lítiumion-akkumulátorokat jól szellőző, hűvös és száraz helyen kell tárolni. A tárolás az élettartam kis

mértékű csökkenésével jár.
• Nem javasolt az akkumulátorokat teljesen feltöltve vagy teljesen lemerítve tárolni.

Az akkumulátor élettartamának növelése

Az akkumulátor fogyóeszköz, amelyet a rádió élettartama alatt esetleg cserélni kell. A rádió maximális élettartamának
elérése érdekében a rádiót mindig eredeti Motorola akkumulátorral használja. Az akkumulátor maximális
élettartamának biztosítása érdekében:

• Ne töltse, csak ha szükséges (alacsony töltöttségi szint esetén).
• Addig töltse, amíg a készülék el nem éri a teljes feltöltöttséget.

Az akkumulátor töltési hőmérséklete

Ha az akkumulátor a rádióban van, 0 és 45 °C közötti hőmérséklet-tartományban tölthető. Ha az akkumulátort külön
(a rádió nélkül) tölti, az akkumulátor üzemi hőmérséklete 0 és +45 °C között van töltési módban, illetve -10 és +60 °C
között van kisütéskor.

Ha töltés közben a hőmérséklet a töltési tartományon kívülre kerül, előfordulhat, hogy az akkumulátor nem töltődik
fel teljesen, mert a töltés átmenetileg – amíg a hőmérséklet megfelelő nem lesz – leállhat.

Az akkumulátor töltésének szabályai

Általánosságban a töltési ciklusok számának csökkentése érdekében a lehető legritkábban töltse az akkumulátort
(csak amikor az Akkumulátor merülőben üzenet megjelenik ), mivel csak így érhető el a maximális élettartam. A
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töltőt ne használja a rádió tartóállványaként, és ne tartsa a rádiót teljesen feltöltött akkumulátorral a töltőre
csatlakoztatva. A folyamatos töltés csökkenti az akkumulátor élettartamát.

Az akkumulátorral kapcsolatos további figyelmeztetések

• Az akkumulátor 60 °C feletti és -20 °C alatti hőmérsékleten való tárolása nem ajánlott.
• A sérülések megelőzése érdekében ügyeljen arra, hogy a fémtárgyak nehogy rövidzárlatot okozzanak az

akkumulátor érintkezőin.
• Tilos szétszerelni.
• Tilos tűzbe dobni.
• Tilos az akkumulátort a háztartási hulladékban elhelyezni.

A rádió épségének megóvása

Soha ne hagyja a rádiót vagy az akkumulátort extrém hőmérsékleten (60 °C felett) – például a szélvédő mögött
közvetlen napsütésben.

Ne merítse vízbe a rádiót.

A rádió tisztításához nedves vagy antisztatikus rongyot használjon.
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